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ABSS Licence Agreement

IMPORTANT - READ THIS CAREFULLY BEFORE USE. This is the Software 
Licence Agreement (“Licence Agreement”). As you have purchased the 
Product (consisting of the User Documentation and the Software) 
following notification of the Licence Agreement you are now legally bound 
by its conditions.

HOWEVER, if the Licence Agreement contains anything of which you were 
not aware prior to purchasing the Product or do not agree to be bound by, 
DO NOT INSTALL THE SOFTWARE but return the Product to the seller in its 
entirety and a full refund of the purchase price will be made. By installing 
the Software and keeping the Product you are confirming that you have 
purchased the Product subject to this Licence Agreement and are bound by 
its provisions. 

TRIAL VERSION SOFTWARE LIMITATION. If you use this Software on a trial 
basis prior to purchase, then additional restrictions govern its use. The Trial 
Version is intended to be used only for evaluation purposes and whilst you 
may create your own company data files (“Company Files”) you will have 
access to your Company Files only until the earlier of 30 days from the date 
of creation of each Company File or until you have entered a total of 1000 
transactions into the Company Files you have created.

Thereafter, you will be able to access the Company Files created by you 
only upon your purchase of the full version of the Product. Upon your 
purchase of the full version of the Product, the restrictions in this 
paragraph (Trial Version Software Limitation) shall no longer apply, but you 
acknowledge that your use of the full version of the Product will be 
conditioned on your agreeing to the terms of the Licence Agreement 
(including the limitation on the number of Company Files) accompanying 
the full version of the Product.

1 Scope of Licence
ABSS Pte Ltd (the Publisher), through its local publishers and distribution 
agents, hereby grants to you, the original purchaser, a paid-up, personal, 
non-exclusive and non-transferable Licence to use the Software and the 
User Documentation only in the region, territory or country specified on 
the packaging or download, subject to the terms and conditions of this 
Licence Agreement.

a Activation of Company Files You must register the Product and 
activate the Company Files you create or upgrade with the Software. 
Company Files may only be activated or upgraded in respect of the 
business that you operate. You are entitled to activate or upgrade only 
the Company Files you have purchased. If you are upgrading from a 
previous version of the Product you are entitled to activate the same 
number of files as your previous version. If required, you can obtain 

additional Company files by contacting Asian Business Software 
Solutions Pte Ltd.Activated company files cannot be re-used or 
recycled.
i)  New Company Files You may only access each new company file 

you create for 30 days without registering the Product and 
activating the company file. After 30 days each new company file 
will become read-only until you activate it. 

b Product Installation and usage If you have purchased:
i)  Single User Software Licence then you may install the Software 

on any computer that you operate at your principal place of business 
in respect of company files you have activated, provided that you do 
not use or permit the usage of the Software on more than one 
computer or computer terminal at a time. In event of an upgrade or 
Product exchange the Licence hereby granted shall automatically 
transfer to the new version or Product.

ii)  Multi-User Software Licence then you may use the Software on 
only one computer network that you operate at a single physical 
location and only then in respect of company files created and 
activated by you or by another licensed user. You may transfer the 
Software from one computer to another that you own or operate on 
this network provided that you only use or permit the usage of the 
Software on the number of computers or computer terminals at a 
time for which you have purchased user licences and do not permit 
the usage of the Software on more than one network at any one 
time, nor permit the Software to be used in respect of company files 
that you have not activated or have not been created by you or by 
another licensed user.

c Number of Users At any given time, you or your delegated agents 
may only launch and simultaneously run the number of Software 
runtime instances equivalent to or less than the number of user licences 
you have purchased and open and simultaneously work with only the 
same number of company files, which must be created and activated by 
you or your related entities.

d Updates and Upgrades In the event of an upgrade, update or 
product exchange, the Licence hereby granted shall automatically 
transfer to the new version or product tied to the respective product 
Serial Number. All rights in respect of the original Product shall lapse and 
no further use of these shall be permitted.Older versions will no longer 
be published or supported by the Publisher.

e Portable or Home Computer and Archive Copies You may make 
a copy of the Software and install it on either a portable computer or a 
computer located in your home provided that the copy is for your own 
exclusive use and is not operated simultaneously with the original of 
the Software. Otherwise you may not copy or duplicate the Software, 
except as necessary solely for archival purposes, Software error 
verification, or to replace defective storage media, provided you keep 
the original and the copies. You may not alter, decompile or disassemble 
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the Software. You may make copies of the User Documentation up to 
but not exceeding the number of multi-user Licences you have 
purchased.

f Transfers You may not sub-license, lease, rent or lend the Software or 
the User Documentation or otherwise transfer any of your rights under 
this Licence Agreement. Subject to the prior written consent of the 
Publisher and the agreement of the transferee to be bound by the terms 
of this Licence Agreement, you may permanently transfer the Software 
(together with any backup copies you have made) and the User 
Documentation. However, you may not retain any copies of either the 
Software or the User Documentation.

g Term The Licence granted in this Licence Agreement is effective until 
terminated. You may terminate it at any time by destroying the 
Software and User Documentation, together with all copies, or by 
returning them to the Publisher. If you fail to meet the ongoing 
obligations accepted by you at the time of registration (if applicable) 
or if you fail to comply with any term or condition of this Licence 
Agreement, this Licence will terminate and, upon any such termination, 
you agree to destroy the Software and User Documentation, together 
with all copies, or to return them to the Publisher. Termination of this 
Licence Agreement shall be in addition to and not in lieu of any other 
remedies available to the Publisher. In the event that the Publisher 
deems this product to be redundant then the Publisher may at its 
option supply you with an alternative product and terminate this 
Licence Agreement.

h Protection and Security This Licence Agreement specifically 
prohibits the reverse engineering or decompiling or interference in any 
manner with the Software's source code. Further you agree to use your 
best endeavours and to take all reasonable steps to safeguard the 
Software to ensure that no unauthorised person has access to the 
Product and that there is no unauthorised copying or distribution of the 
Software or User Documentation.

i Partner Program If this Product is being used in the context of the 
ABSS Professional Partner Program in either Australia or New Zealand, 
then the usage of the Software and any Company files is strictly 
restricted to being within the practice itself. Without in any way 
limiting the scope of this restriction, the sharing of Company files or 
Software with any clients of the practice is specifically prohibited.

2 Limited Warranty & Disclaimer
The Publisher warrants that the media on which the Software is recorded 
or the downloaded installer and the User Documentation provided with 
them are free from defects in materials and workmanship under normal use 
for a period of 90 days from the date of your original purchase. Except for 
the limited warranty described above, the Software is sold 'as is', and you 
are assuming the entire risk as to its quality and performance. It is your 
responsibility to verify the results obtained from the use of the Software.

If during the 90 day limited warranty period, you discover physical defects 
in the media on which the Software was recorded or the downloaded 
installer or in the User Documentation, the Publisher will replace them at 
no charge to you, provided you return the item to be replaced with proof 
of purchase to the Publisher. THIS IS YOUR SOLE REMEDY. IN NO EVENT 
WILL THE PUBLISHER BE LIABLE TO ANY PERSON FOR ANY DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR SIMILAR DAMAGES, 
EVEN IF THE PUBLISHER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.

Some jurisdictions do not allow the exclusion or limitation of implied 
warranties or of liability for incidental or consequential damages, so the 
above limitations or exclusions may not apply to you. This warranty gives 
you specific legal rights and you may also have other rights that vary across 
regions. In the event that any of the above limitations or exclusions are held 
to be unenforceable, the Publisher's total liability shall not exceed the 
amount of the Licence fee you paid.

3 Entire Agreement
This Licence Agreement constitutes the entire agreement between the 
Publisher and the Licensee and any prior representations, statement or 
undertaking howsoever made are expressly cancelled. No amendment or 
modification to this Licence Agreement shall be valid unless it shall be in 
writing and signed by an authorised representative of the Publisher.
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1  Introduction
Before you begin, take some time to explore the software and find out about the basic features of navigation and transaction entry. This 
chapter provides an overview of your software and describes the tools, resources and primary features of your ABSS software.

Learning about your ABSS software

ABSS is committed to developing accounting software that is 
easy to use. To that end, your ABSS software is accompanied 
by comprehensive information resources to help you learn 
and to provide support as you set up your records and enter 
transactions.

Printed manuals
Two manuals are available to help you learn about your 
sofware: a Getting Started guide and a User Guide (this 
publication). 

Manuals available as PDF files Each manual is also 
available as a PDF (Portable Document Format) file on the 
installation CD. This enables you to print copies of the 
manuals. It also gives customers who are upgrading to a new 
version of ABSS software, a copy of the up-to-date User Guide.

NOTE : You need a PDF reader to view a PDF file. You can install 
Adobe Reader from the installation CD.

To access the PDF files

1 Insert the installation CD. An installation window appears.

2 Click Resources.

3 Click CD Library.

4 Click the name of the manual you want to view.

User Guide
The User Guide introduces the principal features, functions and 
capabilities of your ABSS software. It is designed to be used 
as a reference for everyday transaction entry and periodic 
tasks, such as issuing invoices, making payments and 
end-of-period processing. 

This guide is intended for use with ABSS Accounting, ABSS 
Premier and ABSS Premier Plus on the Windows operating 
system.

If you purchased ABSS Accounting, some of the features in 
ABSS Premier and ABSS Premier Plus that are described in this 
guide will not be relevant to you. In this case, you can simply 
skip these sections. 
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If you purchased ABSS Premier or ABSS Premier Plus, the term 
‘ABSS Premier range’ refers to features included in both ABSS 
Premier and ABSS Premier Plus.

This guide covers use of the software in the Asia region, 
including Malaysia and Singapore, but excluding Hong Kong 
and China. It uses British English spelling, for example, cheque 
rather than check, and financial rather than fiscal. See 
‘Glossary’ on page 288 for a list of technical and often-used 
terms and their definitions.

The User Guide is not intended to be exhaustive. It is 
complemented by the online help (see ‘ABSS Help’ below), 
which covers all the functions of your ABSS Software. 

Getting Started guide
The Getting Started guide provides information on:

 installing or upgrading your ABSS Software

 creating and activating your company file

 new features in your ABSS Software.

ABSS Help
ABSS Help is a comprehensive online resource that 
complements the User Guide by addressing all functions and 
features of your ABSS Software. It also includes helpful 
information for solving common bookkeeping problems.

To display ABSS Help

 In any window, press the F1 key. 

 In any window—other than command centre 
windows—click the Help button ( ) and choose Help 
for This Window. 

 Choose ABSS Accounting Help (or ABSS Premier 
Help) from the Help menu.

Help in ABSS windows

Opening ABSS Help from any window—other than the 
command centre windows—displays descriptions or 
procedures relevant to that window. Click the Help button 
and choose Help for This Window, Tell Me How, Tips & 
Troubleshooting or Search the Help. 

The help options are described below.

Select... If you want to....

Help for This 
Window

• see a description of the window, which 
includes links to more detailed descriptive 
and procedural topics.

• see a description of each field in the 
window. 

• display links to topics that give you tips to 
solving common problems or that direct you 
to other sources of help.

Tell Me How display a list of procedural topics that tell you 
how to perform various tasks in the window, or 
other related tasks. 

Tips & 
Troubleshooti
ng

display links to topics that give you tips on 
solving common problems or that direct you to 
other sources of help.

Search the 
Help

locate topics by keywords. Searches can be as 
widely or as narrowly defined as you like. 



W H E R E  T O  S T A R T   9

Command centres help

The main windows in ABSS Software are known as command 
centres. A help icon appears in the top right corner of each 
command centre window. For more information, see 
‘Command centres’ on page 10.

When you click the help icon, ABSS Help displays a 
description of the command centre and its various functions.

Other resources
There are various web-based resources available at 
https://www.abssasia.com/my [Malaysia] or 
https://www.abssasia.com/sg [Singapore]. For example, you 
can check for product updates, access a database of 
frequently asked questions or find the location of your 
nearest ABSS Certified Consultant. You can also access these 
resources from your ABSS software by choosing Additional 
Resources on the Web from the Help menu.

Where to start 

When you start your ABSS Software, a window displays the 
following options:

 Open your company file—open an existing company 
file. 

 Create new company file—create a company file for 
your business. See Chapter 2, ’Setting up your company 
file,’ starting on page 14.

 Explore the sample company—experiment with a 
sample company’s data and learn how to use your ABSS 
Software.

 What’s New in this version—learn about the new 
features in this version of ABSS Software.

 Exit—close your ABSS Software.
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Experiment with a sample company’s 
data
Before you create a new company file, we recommend that 
you experiment with a sample company’s data.

To explore the Clearwater company file

 Start your ABSS Software and in the welcome window, 
click Explore the sample company. A Command 
Centre window appears.

A command centre window is always displayed on your 
computer screen when a company file is open. Notice that 
the name of the sample company, Clearwater, appears at the 
top of the window.

Now that the Clearwater company file is open, you can 
browse the software, explore the transactions that have 
already been entered and enter some transactions yourself.

Exploring your ABSS software

You should become familiar with the following tools and aids:

Command centres 
There are six command centres in ABSS Accounting, seven in 
ABSS Premier, and eight in ABSS Premier Plus. The following is 

an illustration of the Sales command centre in ABSS Premier 
Plus.

Each command centre contains a row of icons in the top 
section of the window. These icons allow you to quickly 
switch between command centres.

The selected icon represents the current command centre, 
and the flowchart displayed below the icons illustrates the 
major tasks associated with that command centre. 

Tool See

Command centres below

Calendar (date entry) page 11

Calculator page 12

Zoom arrows page 12

Search icons page 12

Select columns page 12

Mouse shortcuts page 12

Spell-check feature page 13
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For example, when the Sales icon is selected, tasks such as 
Enter Sales and Print/Email Statements—typical tasks 
you would complete in relation to sales—appear in the 
command centre’s flowchart.

Command centre menus

There are four menus at the bottom of each command centre. 
The options available from these menus are described below.

There are two ways to select an option from the command 
centre menus: 

 Click the menu name to display the window relevant to 
the command centre you are in. 

 Click the down arrow ( ) next to the menu name and 
select from a list of the available options for all command 
centres (not just the command centre you are currently 
in).

Actions Menu
The Actions menu provides shortcut access to a list of tasks. 
The menu is located in the Cards List window, in each Card 
Information window and in the Reconcile Accounts and 
Unmatched Statement Transactions windows. Note 
that some tasks, which were previously accessed using 

buttons in these windows, are now accessible from the 
Actions menu.

When you click Actions ( ) in one of these 
windows, a menu of associated tasks is displayed. For 
example, if you select a customer card in the Cards List 
window and click Actions, you can print invoices, create a 
sale, or view reminder logs.

Calendar (date entry)
The calendar simplifies date entry. For example, suppose 
you’re entering a sale and have promised the goods to the 
customer on the last Friday of the month. Rather than figure 
out the date and enter it manually, display the calendar in the 
Promised Date field and click the date. 

To display the calendar, put the cursor in a date field and press 
either = (equals) or the SPACEBAR on your keyboard. 

Select a date by clicking it, or by using the arrow keys on your 
keyboard and then pressing ENTER. The selected date appears 
in the date field. 

To close the calendar without selecting a date, press ESC.

Select... If you want to...

To Do List record and manage tasks that need your 
attention, such as paying invoices to take 
advantage of early-payment discounts.

Find 
Transactions

view summary information about your 
accounts, sales, purchases, cards, items and 
jobs. 

Reports view a list of the available reports.

Analysis analyse a number of key aspects of your 
business.

The current date appears in a red box. 

You can use the arrow icons next to 
the month to display a different 
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Calculator
A pop-up calculator is available to 
simplify calculating and entering 
numeric data, including money 
amounts, item quantities and units. 
The calculator is available from 
every window where you enter 
numeric data.

Pressing = (equals) or the SPACEBAR when the cursor is in a 
numeric data field displays the calculator. In the calculator, 
enter your calculation and then press ENTER. 

The result appears in the numeric data field. Press ESC to close 
the calculator without entering numeric data.

Zoom arrows
Zoom arrows, displayed next to various fields, allow you to 
display more detailed information about a specific entry such 
as a transaction or customer record. 

A white zoom arrow  indicates that you can display 
more detailed information about a transaction and make 
changes to or delete the transaction.

A grey zoom arrow  allows you to display more detailed 
information about a transaction, but the information is 
read-only (that is, it cannot be changed). If you want to 
change the information, you need to reverse the transaction 
and re-enter it (see ‘Reversing a transaction’ on page 166). 
Alternatively, you can change your security preference 
selection to make all transactions changeable (see ‘Set up 
preferences’ on page 24).

Search icons 
Search icons displayed next to various fields allow you to 
open selection lists containing records that you have 

previously entered, such as customers and delivery methods, 
or records provided by default. 

Select columns 
Select columns allow you to select items from a list. 
Select columns are indicated by a select icon (see left) 

located at the top of the list column. You select a required 
item by clicking in the select column next to it. You can select 
all listed items by clicking the select icon at the top of the list 
column, and clear all selected items by clicking the select icon 
again. 

Mouse shortcuts
You can right-click in a window to open a shortcut menu with 
options relevant to the window and to the location of the 
pointer.
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Spell-check feature
When entering sale, purchase or item information, you can 
check your spelling in the following fields:

You can choose to set a preference to automatically check 
spelling or manually check spelling.

You can also customise your spelling preferences. For example, 
you can change the main dictionary language and choose a 
preference to ignore words that include numbers.

To set spelling preferences

1 Go to the Setup menu and choose Preferences. The 
Preferences window appears.

2 Click the Windows tab.

3 If you want to automatically check spelling, select the 
Automatically Check Spelling in Text Fields 
Before Recording Transactions option.

4 If you want to customise your spelling preferences, click 
the Spelling button. The Spell Check Preferences 
window appears.

5 Select your preferences and click OK.
 For more information about the spelling feature, see 

ABSS online help.

Window Field

Sales • Description (for Service, Professional, Item 
and Miscellaneous layouts)

• Notes (for Time Billing layout).

Purchase • Description (all layouts).

Item 
Information

• Name (Item Profile tab)
• Description (Item Details tab).
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2  Setting up your company file
Your ABSS software stores your financial data in a company file. If you do not already have a company file, you must create it before you 
can begin recording transactions.

Overview

When you create a company file, you record basic information 
about your business, such as the business name and your 
contact details. You must also specify the month and financial 
year in which you want to start recording transactions.

Depending on the features you want to use, there are some 
tasks that you should complete. This chapter guides you 
through the essential ones.

Essential tasks The tasks you need to do depend on 
whether your accountant has created and set up a company 
file for you, the information you currently have and when your 
business started.

Advanced tasks Once you have completed the essential 
tasks, you can start recording transactions. However, if you 
need to use the advanced features of this software, (such as 
the sales or inventory features) you will need to do further 
setup tasks. These tasks are covered in Chapter 3, ’Advanced 
setup,’ starting on page 28.

Tas
k See

1 Create a company file page 15

2 Activate the company file page 17

3 Set up accounts page 19

4 Enter account opening balances page 22

5 Set up preferences page 24

6 Set a password for the Administrator user ID page 25
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Create a company file

When you make entries in your software, that information is 
stored in a file called a company file. 

You can create a company file using the New Company File 
Assistant. This assistant is a series of interactive windows 
that guide you through the process of creating a new 
company file.

NOTE : Do you already have a company file? If your 
accountant or ABSS consultant has provided you with a 
company file, or if you want to use a file that you created with a 
test drive version of this software, you do not need to create a 
company file.

Before you start, you need to know: 

To create a new company file

1 Start your ABSS software. A welcome window appears.

2 Click Create new company file. The introduction 
page of New Company File Assistant appears.

3 Click Next. The Company Information page appears.

4 Enter your business contact and registration details. If 
available, also enter your ABSS software serial number.

5 Click Next. The Accounting Information page 
appears.

Your current 
financial year

This is the financial year for which you want to 
start recording transactions in your company file.
Note that a financial year is represented by the 
calendar year in which the financial year ends. For 
example, if your financial year ends in December 
2009, your financial year is 2009.

The last month 
of your 
financial year

This is the month in which your financial year ends. 
For most businesses, the last month is December. 

Your 
conversion 
month

This is the earliest month for which you want to 
record transactions. For example, if you want to 
enter transactions dated 1 September or later, 
your conversion month is September. 
You cannot enter transactions dated before the 
conversion month.

The number of 
accounting 
periods in your 
financial year

You can choose to have 12 or 13 accounting 
periods. A 13th period is a period for recording 
entries which you do not want included in the 
accounting figures for a particular month. For 
example, you can use it to record year-end 
adjustments that are attributed to all months. If in 
doubt, choose 13 periods.

The default list 
of accounts 
that you want 
to start with

Accounts are the categories that you will allocate 
each of your transactions to. When you create a 
company file, you need to select a default list of 
accounts. You can:
• start with an accounts list provided by 

ABSS. You can select a predefined accounts 
list suitable for your business.

• import a list of accounts. You can import 
an accounts list from another company file or 
from one that has been provided by your 
accountant or ABSS partner.

• build your own list. You can start with an 
accounts list that has the minimum required 
accounts and then add to it.

Note that you can modify your accounts list after 
creating your company file.
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6 Enter your financial year details and conversion month.

TIP : Current financial year Remember that this is the 
financial year for which you want to start recording 
transactions in your company file. It does not need to be the 
financial year that your business is currently operating in.

7 Click Next. A confirmation page appears.

8 Check the financial year and conversion month and then 
click Next. The Accounts List page appears. 

9 Select the default accounts list you want to start with.

10 Click Next. An accounts list selection page appears.

11 Select the type of industry and business that best 
matches your own business. 

A suitable accounts list for the business type you selected 
appears. If you want to print the list, click Print. Later you 
can tailor the list to meet the needs of your business.

12 Click Next. The Company File page appears.

13 If you want to change you company file name and 
location:
a Click Change. The New window appears. 
b Select the required location.
c If necessary, type a new file name. 
d Click Save. The Conclusion page appears. 
e Continue with step 15 on page 17.

If you choose to... Continue 
with...

start with an accounts list provided by 
ABSS

step 10

import a list of accounts step 12

build your own list step 12
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NOTE : Restricted access to the Program Files folder 
in Windows Vista User Account Control (UAC) is a 
security feature in Windows Vista. If UAC is active, files saved 
in the Program Files folder can only be opened by the 
Windows user who saved the files. If other users need to 
access your company file, do not save it in this folder. For 

more information about User Account Control, see Windows 
help.

14 Click Next. Your company file is created and the 
Conclusion page appears.

15 Click Command Centre to display the Command 
Centre window.

Activate the company file

Activation is a process that verifies you have a legal 
installation of your ABSS software. You can activate your 
company file online or over the phone via an automated 
service.

NOTE : Do you need to complete this task? You do not 
need to activate a company file that you have created for 
testing purposes or any file you are no longer entering 
transactions into.

After creating a company file, you can use it for 30 days in 
trial mode, after which you must activate the file if you want 
to continue entering transactions into it.

If you do not activate the file within 30 days, it will become 
read-only, which means you can open, view, print and export 
information, but you will not be able to enter new 
information into the file until you activate it.

After activating a file, you must confirm the company file 
once or twice a year, that is, extend its activation throughout 
its working life. For more information, see ‘Confirming 
activated company files’ on page 265.

NOTE : Automatic confirmation If you want, you can set a 
preference to automatically confirm an activated company file 
over the Internet when required.

Activation limits You can initially activate up to five 
company files. If you need to create more than five company 
files (for example, yours is a bookkeeping business looking 
after many clients), you can obtain license extensions to 
activate as many additional company files as required. 
Contact ABSS Customer Care on (+65) 6505 6582 
(Singapore) or 1300 88 0883 (Malaysia) if you need a license 
extension. Each additional license extension allows you to 
activate a further five files.

Activating after purchasing additional 
workstation licenses [ABSS Premier range only] When 
you purchase your ABSS software, the license allows one user 
to access a company file during the trial period. If you extend 
your license to support additional simultaneous users, you 
must activate your company file again. See also ‘[ABSS 
Premier Plus range only] To obtain additional workstation 
licences’ on page 261.
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Before you begin
Before you can activate a company file, you need to:

 know your ABSS product serial number. If you 
didn’t enter your serial number when creating the 
company file, you will need to enter it during the 
activation process.

 register your software. Registration enables ABSS to 
contact you should there be any issues with your software. 
See the Getting Started guide for information on how to 
register your software.

To activate a company file

1 Open the company file to be activated and sign on.

The Company File Activation window appears. 

2 Activate your company file:

3 Follow the on-screen instructions until the Command 
Centre window appears. 

4 If you want to activate another company file:
a Go to the File menu and choose Open. The Open 

window appears.
b Open the company file to be activated and sign on to 

the file.

Metho
d Steps

Online 1 Ensure you are connected to the Internet.

2 Click I want to activate my company file 
online and then click Continue. The 
Company File Activation – Online window 
appears.

3 If you have not previously entered your ABSS 
serial number, type it in the Serial Number 
field and press TAB. The code in the Company 
File Code field is generated automatically.

4 Click Continue to activate the file.

Phone 1 Click I want to activate my company file 
by phone and then click Continue. The 
Company File Activation – By Phone 
window appears.

2 If you have not previously entered your ABSS 
serial number, type it in the Serial Number 
field and press TAB. The code in the Company 
File Code field is generated automatically.

3 Call ABSS on the telephone number displayed 
under the Company File Code field and 
follow the instructions to receive your 
confirmation code.

4 Type the confirmation code in the 
Confirmation Code field and click 
Continue.

Note that you cannot use this code to activate 
another company file nor can you use this code 
to confirm an activated company file.
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c Continue from step 2 above.

Set up accounts

Accounts provide a means for grouping similar transactions. 
For example, if your business pays rent for the use of its 
premises, you would create a rent account and then allocate 
all rent payments to that account.

The accounts you use for your business are grouped in an 
accounts list.

NOTE : Do you need to complete this task? If your 
accountant or ABSS partner has provided you with a company 
file, this task may have been completed for you. In this case, go 
to ‘Enter account opening balances’, on page 22.

When you created your company file, you selected a default 
accounts list to start with. This list may already have the 
accounts you need. If not, you can change the list to suit your 
needs. If you are unsure, ask your accountant which accounts 
you should create, edit or delete.

If you selected to import a list of accounts, you should import 
this list now. See ‘Importing data’ on page 275.

Account numbers Each account is identified by a unique 
five digit number. The first digit indicates the account’s 
classification (for example, accounts starting with 1 are asset 
accounts). The remaining four digits determine its location 
within the classification. The lower the number, the higher up 
in the list it appears. For example, account 1-1100 appears 
above 1-1200. 

Account classifications and types The accounts list 
groups accounts into eight classifications—Assets, Liabilities, 
Equity, Income, Cost of Sales, Expenses, Other Income and 

Other Expenses. Within each account classification there is at 
least one account type. 

Account classifications and types are described in the 
following table.

Classificati
on

Type Description

Asset 
(1-xxxx)

Bank Money in the bank, for example, 
in a cheque or savings account.

Accounts 
Receivable

Money owed to you by your 
customers.

Other 
Current 
Asset

Assets that, if required, can be 
turned into cash within a year. 
These may include your term 
deposits.

Fixed Asset Assets which have a long life, for 
example, buildings, cars and 
computers. Fixed assets are 
usually depreciated.

Other Asset Other assets you own such as 
loans made to others and 
goodwill.

Liability
(2-xxxx)

Credit Card Repayments required to service 
credit card debt.

Accounts 
Payable

Money owed by you to your 
suppliers.

Other 
Current 
Liability

Money owed by you that is due 
in less than a year. 
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Header accounts Your accounts list consists of detail 
accounts (the accounts to which you allocate transactions) 
and header accounts. Header accounts group related detail 
accounts to help you organise your accounts list.

For example, you could group your telephone, electricity and 
gas expense accounts using a Utilities header account. This 
makes it easier for you to locate the utility expense accounts 
in the accounts list and to see your combined utility expenses.

You group accounts by indenting the detail accounts located 
directly below a header account.

Long Term 
Liability

Money owed by you that is due 
in more than one year, for 
example, a business loan.

Other 
Liability

Other money you owe.

Equity 
(3-xxxx)

Equity The business’s net worth, that 
is, its assets minus its liabilities. 
Common equity accounts are 
current year earnings, retained 
earnings and shareholders’ 
equity.

Income
(4-xxxx)

Income Revenue from the sale of goods 
and services.

Cost of 
Sales
(5-xxxx)

Cost of Sales The direct cost of selling your 
goods and providing services, 
for example, purchase costs and 
freight charges.

Expense
(6-xxxx)

Expense The day-to-day expenses of 
running your business, for 
example, utility bills, employee 
wages and cleaning.

Other 
Income
(8-xxxx)

Other 
Income

Other revenues, for example, 
interest earned on savings and 
dividends paid from shares.

Other 
Expense
(9-xxxx)

Other 
Expense

Other expenses, for example, 
interest charged.

Classificati
on

Type Description

Header accounts

Detail accounts
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Note:

 You cannot allocate transactions to a header account. 

 The balance of a header account is the sum of the detail 
accounts indented directly below it. 

 You can create up to three header account levels.

Setting up accounts

To create an account

1 Go to the Accounts command centre and click 
Accounts List. The Accounts List window appears.

2 Click New. The Edit Accounts window appears. 

3 If you want to create a detail account, select the Detail 
Account option.

4 Select the account type from the Account Type list. The 
Account Classification field changes according to the 
selection you make. For more information on account 
classifications, see ‘Account classifications and types’ on 
page 19.

5 Enter a four-digit number for the account in the Account 
Number field. The number must be unique within each 
account classification.

6 Press TAB and type a name for the account. 

7 Click the Details tab.

8 If you want, type a brief description of the account in the 
Description field.

9 In the Tax Code field, select the tax code that you use 
most often with transactions that will be posted to this 
account.

10 If you are creating an asset, liability or equity account 
(other than an asset that has the account type of Bank), 
select an option from the Classification for 
Statement of Cash Flows list.

If you want to... See

Create an account below

Delete an account page 156

Change the details of an account page 155

Group detail accounts with a header account page 22

Import an accounts list page 275
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Classifying the accounts allows you to generate a 
statement of cash flows. This report shows how your cash 
position has changed over time, profit earned and where 
your cash was spent. If you’re unsure about which 
classification to use, consult your accountant or an ABSS 
Certified Consultant.

11 [ABSS Premier range only] If you enter transactions in 
multiple currencies, type or select the currency for 
transactions that will be posted to this account in the 
Currency field. You will need to have indicated that you 
deal in multiple currencies in your preferences. See ‘Set up 
preferences’ on page 24.

12 If you are creating a bank or credit card account, and you 
want to keep a record of your bank account details, click 
the Banking tab and enter your account details.

[ABSS Premier Plus only] If you want to pay your 
employees electronically using this account, select the I 
Create Bank Files For Payroll Using This Account 
option and enter the payment code that has been 
provided to you by your bank.

13 [Detail accounts only] If you want to enter historical 
balances, complete the Last FY column on the History 

tab. That way you can compare the year’s monthly 
account balances with those of the corresponding 
months last year.

14 [Detail accounts only] If you want to set up a budget:
a Click Budgets. The Prepare Budgets window 

appears. 
b Type the budget amounts in the monthly columns.
c Click Close.

For more information, see ‘Budgets’ on page 234.

15 Click OK when you have finished. The account you 
created now appears in your accounts list. 

To group detail accounts with a header 
account

You group accounts by indenting the accounts located below 
a header account.

1 Go to the Accounts command centre and click 
Accounts List. The Accounts List window appears.

2 Select the detail account you want to group. 

3 Click Down to group the account with the header 

Enter account opening balances

Account opening balances are the balances of your accounts 
as of the first day of your conversion month.

NOTE : Do you need to complete this task? If you were in 
business prior to your conversion month, most of your accounts 
probably already have balances. If you want to produce financial 
reports that included these balances (such as a balance sheet), 
or you want to track the balance of accounts with a cumulative 

balance (such as your bank account), you need to enter these 
balances. 

You can find your account opening balances on a trial balance 
report, a balance sheet or a profit & loss report prepared for 
the period immediately prior to your conversion date. You can 
ask your accountant to prepare these reports.
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You may also be able to find your account opening balances 
using your previous software or paper-based records.

The balances you enter depend on whether your conversion 
month is also the first month of your financial year. If your 
conversion month:

 is the first month of your financial year, enter the 
opening balances of your asset, liability and equity 
accounts only. The opening balances of your income, cost 
of sales and expense accounts should be zero.

 is not the first month of your financial year (for 
example, if your financial year starts in April but your 
conversion month is January), enter the opening balances 
of all your accounts.

Opening bank account balances You can enter either 
of the following amounts as the opening balance of a bank 
account:

 the bank account balance that appears on your balance 
sheet or trial balance reports as of the day prior to your 
conversion date. For example, if your conversion date is 1 
January 2009, this is the bank account balance as of 31 
December 2008. 

These reports can be provided by your accountant, or, if 
you were previously using another accounting software, 
printed using that software.

 the cashbook balance of the account as of the end of the 
day prior to your conversion date. You can calculate your 
cashbook balance by taking into account the transactions 
not yet cleared by your bank as of the conversion date and 
the balance that appears on your bank statement at that 
date. 

For example, assume that $500 worth of deposits and 
$1000 worth of payments were unpresented as of your 
conversion date (that is, they had not appeared on a bank 
statement). The cashbook balance would be calculated as 
shown below:

To enter opening balances

1 Go to the Setup menu, choose Balances and then 
Account Opening Balances. The Account Opening 
Balances window appears.

2 Enter the balances in the Opening Balance column.

NOTE : You should enter opening balances as positive 
numbers Do not, for example, enter your liability account 
balances as negative numbers. Enter negative amounts only 
if accounts truly have negative balances. As a rule, these will 
be asset accounts that record accumulated depreciation.

Bank statement balance as of the 
conversion date

$21,000.0
0

ADD uncleared deposits + $500.00

SUBTRACT uncleared payments –
$1,000.00

Cashbook balance as of the conversion 
date

$20,500.
00
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3 Check that the amount in the Amount left to be 
allocated field at the bottom of the window shows 
$0.00. 

If this field displays an amount other than $0.00, check 
your opening balances again because they are either 
incomplete or incorrect. However, you can continue the 
setup process if there is an amount in the Amount left 
to be allocated field. The amount will be assigned to a 
special equity account called Historical Balancing.

4 Click OK.

Set up preferences

Preferences are settings that enable you to tailor your 
software to your business requirements and processes.

NOTE : Do you need to complete this task? While you can 
complete this step later, you should review the default 
preferences that have been set before you start entering 
transactions. 

You can set preferences to customise the way your software 
operates. For example, you can choose to automatically print 
invoices after recording them, or prevent users from editing 
transactions.

You can set up your preferences using the:

 Customise Easy Setup Assistant. This assistant 
guides you through setting up some key preferences. To 
access the assistant, go to the Setup menu, choose Easy 
Setup Assistant and then click Customise.

 Preferences window. This window lists all of the 
preferences. To view this window, go to the Setup menu 
and choose Preferences.

Some preferences you should consider choosing include:

 Use Audit Trail Tracking  If you want to keep a 
record of transactional, tax, payroll (ABSS Premier Plus 
only), account and system changes, select this option. 
This is useful if more than one person will be entering 
transactions into your file. For more information about 
audit trail tracking, see ‘Auditing your records’ on 
page 237.
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 Transactions CAN’T be Changed; They Must be 
Reversed  If you do not want to allow users to edit or 
delete transactions, select this option. If they want to 
change or delete a transaction, they will need to do so by 
recording a reversal transaction. For more information, see 
‘Reversing a transaction’ on page 166.

Also, an audit trail entry is created when you select this 
option and edit a Receive Items transaction. The 

original transaction is reversed, locked and a new 
transaction is recorded that includes the changes you have 
made.

 I Deal in Multiple Currencies [ABSS Premier range 
only] If you want to enable multi-currency accounting, 
select this option. For more information about working 
with multiple currencies, see ‘International transactions’ 
on page 141.

Set a password for the Administrator user ID

When you created your company file, a user ID called 
Administrator was automatically created. 

A user ID is the means for:

 controlling access to a company file 

 tracking a transaction record history

 saving individual preferences. 

By default, the Administrator user ID does not have a 
password assigned to it. Anyone who signs on with the 
Administrator user ID will have complete access to all 
command centres, functions and windows and will be able to 
create, edit and delete other user IDs.

For that reason, as soon as you create a company file, you 
should assign a password to the Administrator user ID; 
otherwise, anyone can sign on and then enter, edit and delete 
transactions in your file.

To set a password for the Administrator user 
ID

1 Start your ABSS software and click Open your 
company file in the welcome window that appears. 

2 In the Open window, select the company file to be 
opened, and click Open. The Sign-on window appears.

3 Click Change Password. 
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4 In the Change Password window, leave the Existing 
Password field blank, type the password in both the 
New Password and Confirm Password fields. 

5 Click Record.

NOTE : Access restrictions If you want to restrict other users 
from accessing certain features or information, you can create 
additional user IDs and specify their access restrictions. For more 
information, see ‘Managing user accounts’ on page 260.
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3  Advanced setup
When you have created a company file and completed the essential setup tasks, you can start recording transactions in your company file. 
However, if you want to use the advanced features of your software (such as tracking amounts you owe or the quantity of items sold), you 
need to complete additional setup tasks. This chapter details the additional tasks.

Overview

The setup tasks you need to complete depend on the features 
you want to use and whether your business was operating 
prior to your conversion month.

What features do you want to use?

The following table provides some examples of different 
setup requirements.

Your needs Setup required

Basic If you only want to use your software to fulfil 
basic accounting requirements (such as report 
tax payable or produce a year-end balance sheet), 
you may only need to do an initial bank 
reconciliation for each of your bank accounts. 
Reconciling accounts helps ensure the integrity 
of the information you record in your company 
file (see ‘Do an initial bank reconciliation’ on 
page 34). 

Intermedia
te

If you want to track the money that you owe 
suppliers or that are owed by customers, you will 
need to use the Purchases and Sales command 
centres. 
Before you can use these command centres, you 
need to complete the sales and purchases setup 
tasks in this chapter. 

Advanced If you want to track the on-hand quantity and 
value of items you buy and sell, you need to 
create records to store the details of your items. 
You do this using the Inventory command 
centre.
Also, when you buy and sell an item, you will need 
to record details about each transaction (such as 
who you purchased the items from, how many 
you purchased and the price). You do this using 
the Sales and Purchases command centres. 
Hence, you need to complete the sales and 
purchases setup tasks in this chapter. 

Your needs Setup required
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When did your business start operating?

The setup tasks you need to complete will also depend on 
whether your business was operating prior to your conversion 
month.

The following table describes the setup required for new and 
existing businesses.

Advanced tasks
You may not need to do every task. An introduction to each 
task helps you determine whether you need to do the task 
and, if so, the information you need.

Busines
s status Setup required

New If you have just started your business, you may have 
very little information about your future customers, 
suppliers, employees and items that you buy or sell. You 
can add these details later when you have more 
information.
However, if you intend using the advanced features of 
your software (such as recording invoices or tracking 
departmental profit), you should read through the 
setup tasks to see which features you might use and 
the tasks you need to complete to start using them.

Existing If your business was operating prior to your conversion 
month, it is likely that transactions that occurred prior 
to your conversion month still affect your business. 
For example, a customer may owe you money for sales 
you made prior to your conversion month, or you may 
have outstanding bills to pay. You will need to enter 
these historical details in your company file.

Tas
k See

1 Set up sales page 30

2 Set up purchases page 31

3 Set up payroll (ABSS Premier Plus only) page 32

4 Do an initial bank reconciliation page 34

5 Create item records page 36

6 Enter your inventory opening balances page 37
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Set up sales

You can use the sales features to:

 prepare sales quotes, orders and invoices

 generate statements

 view customer sales history

 see how much your customers owe you.

NOTE : Do you need to do this task? If you want to record 
sales and print invoices or statements, you need to set up the 
sales features.

Before you start using the sales features, you should enter the 
following information:

 Credit terms and credit limits Enter the credit 
terms and credit limits you generally extend to your 
customers. 

 Customer details Create a record for each of your 
customers and enter such details as their addresses and 
phone numbers. 

 Historical sales [Existing businesses only] If 
customers owed you money on the first day of your 
conversion month, you will need to record some details 
about the corresponding sales, such as the invoice date 
and the amount that is outstanding.

You can use the Sales Easy Setup Assistant to do these 
tasks. To access the assistant, go to the Setup menu, choose 
Easy Setup Assistant, and then click Sales. 

You can also use the Sales Easy Setup Assistant to 
specify your preferred invoice layout, the income account you 
will allocate most of your sales to, and several other settings. 
These settings will automatically be selected for new 

customer records you create; however, you can change them 
as required.

Optional sales setup tasks
In addition to the Sales Easy Setup Assistant tasks, you 
may also want to do the following tasks if they are relevant to 
your business.

Task See

Customise 
forms

Change the appearance of the 
default invoice and statement 
forms.

page 189

Import cards Import customer information 
from: 
• another ABSS company file
• another accounting system
• a spreadsheet 
• a text file.

page 27
5

Synchronise 
customer 
records with 
Outlook

Synchronise your customer card 
records with your contact 
records in Microsoft Outlook.

page 20
6

Create job 
records

Create job records to track the 
progress and profitability of the 
work you do for your clients.

page 23
2

Group cards Use identifiers and custom lists 
to group the cards of customers 
who have similar attributes.

page 20
4



S E T  U P  P U R C H A S E S   3 1

Set up purchases

You can use the purchases features to:

 record quotes, orders and bills

 view your purchase history

 see what you owe your suppliers.

NOTE : Do you need to do this task? If you want to record 
the orders and purchases you make with suppliers and track the 
amounts you owe, you need to set up the purchases features.

Before you start using the purchases features, you should 
enter the following information:

 Supplier details Create a card record for each of your 
suppliers and enter such details as their addresses and 
phone numbers.

 Historical purchases [Existing businesses only] If you 
had outstanding bills on the first day of your conversion 
month, you will need to record some details about them, 
such as the bill amounts and the credit terms. 

You can use the Purchases Easy Setup Assistant to do 
these tasks. To access the Purchases Easy Setup 
Assistant, go to the Setup menu, choose Easy Setup 
Assistant and then click Purchases. 

You can also use the Purchases Easy Setup Assistant to 
choose your preferred purchase order layout and several other 
settings that will help you record purchases faster. These 
settings will automatically apply to new cards you create for 
your suppliers; however, you can change them as required.

Optional purchases setup tasks
In addition to the Purchases Easy Setup Assistant tasks, 
you may also want to do the following tasks if they are 
relevant to your business.

Task See

Customise 
forms

Change the appearance of the 
default purchase orders and other 
forms.

page 189

Import cards Import supplier information from: 
• another ABSS company file
• another accounting system
• a spreadsheet 
• a text file.

page 27
5

Synchronise 
supplier 
records with 
Outlook

Synchronise your supplier card 
records with your contact 
records in Microsoft Outlook.

page 20
6

Group cards Use identifiers and custom lists to 
group the cards of suppliers who 
have similar attributes.

page 20
4
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Set up payroll

Payroll is only available in ABSS Premier Plus.

You use the payroll feature to:

 process pays for your employees

 track employee entitlements (such as sick and holiday 
leave)

 pay accrued payroll deductions

 print payslips and paycheques

 print statutory forms

 print tax forms.

NOTE : Do you need to do this task? If you want to process 
employee pays, you need to set up the payroll features.

Before you start using the payroll features, you need to:

 [Malaysia] Load tax/SOCSO tables The amount of 
tax and SOCSO to be deducted from employee pays is 
taken from the tax/SOCSO tables. These tables contain 
calculation  rules and amounts established by the Inland 
Revenue Board (IRB) and the Social Security Organisation 
(SOCSO).

Note that you need to load new tax/SOCSO tables when 
new calculation rules and amounts are introduced by the 
government.

 [Singapore] Load CPF table The amount of CPF to 
be deducted from employee pays is taken from the CPF 
table. The CPF table contains calculation rules and 
amounts established by the Central Provident Fund (CPF) 
Board.

Note that you need to load a new CPF table when new 
calculation rules and amounts are introduced by the 
government.
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 Enter general payroll information Enter the 
current payroll year, the number of hours in your normal 
working day and week, the tax file or tax reference 
number, provident fund number, and SOCSO number.

 Review payroll categories The components of an 
employee’s pay, such as wages and entitlements, are called 
payroll categories. These are assigned to an employee’s 
card to calculate their standard pay.

It’s a good idea to review the details of each payroll 
category to make sure it matches the way you do business. 

 Enter employee details Create a card record for 
each of your employees and enter such details as their 
addresses and payroll information.

 Enter pay history [Existing businesses only] If you 
have already paid the employee in the current payroll year, 
you should enter the amounts you have paid your 
employees.

You can use the Payroll Easy Setup Assistant to do these 
tasks. To access the Payroll Easy Setup Assistant, go to 
the Setup menu, choose Easy Setup Assistant and then 
click Payroll. 

Optional payroll setup tasks
In addition to the Payroll Easy Setup Assistant tasks, you 
may also want to do the following tasks if they are relevant to 
your business.

Task See

Set up 
timesheets

Use timesheets to record all the 
hours and days worked by hourly and 
daily employees or to record extra 
hours and days worked by employees 
that are paid based on a standard 
pay. If you pay employees for 
time-billing activities, you can also 
enter activity details on timesheets 
and use these details to create 
activity slips. 

page 122

Customise 
forms

Change the appearance of the 
default payslip and paycheque forms.

page 189

Import cards Import employee information from: 
• another ABSS company file
• another accounting system
• a spreadsheet 
• a text file.

page 275

Synchronise 
employee 
records with 
Outlook

Synchronise your employee card 
records with your contact records in 
Microsoft Outlook.

page 206

Group cards Use identifiers and custom lists to 
group the cards of employees who 
have similar attributes.

page 204
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Do an initial bank reconciliation

To ensure the accuracy of your business records, you should 
ensure that the record of your bank account balances 
matches the amounts on your bank statements. This task is 
called reconciling accounts.

If your business traded prior to your conversion month and 
you have uncleared banking transactions as of the first day of 
your conversion month, you need to do an initial bank 
reconciliation.

Uncleared banking transactions are withdrawals and deposits 
that have not been cleared by your bank as of the start of your 
conversion month.

NOTE : Do you need to complete this task? The initial 
bank reconciliation procedure needs to be done for each bank 
account that had uncleared transactions as of the first day of 
your conversion month.

To do an initial bank reconciliation:

Task 1: Identify uncleared withdrawals 
and deposits
Compare your banking source information (such as your 
chequebook and deposit book) with your bank statements 
for the period that includes your conversion date. If you find 

transactions that have not been cleared by your bank as of 
this date, you will need to record the details of these 
transactions in your company file.

For example, in March, the month prior to your conversion 
month, you wrote a cheque for $510 and deposited $250 you 
received from a customer. If these transactions had not 
appeared on a bank statement by 31 March, you need to 
record both transactions in your company file.

Task 2: Record uncleared withdrawals 
and deposits
You need to record uncleared transactions in such a way that 
the opening bank account balance is not affected. To do this, 
you need to post a debit and a credit of equal amounts for 
each transaction against the applicable bank account.

Task See 

1 Identify uncleared withdrawals and deposits below

2 Record uncleared withdrawals and deposits below

3 Reconcile page 3
6
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To record uncleared withdrawals

1 Go to the Banking command centre and click Spend 
Money. The Spend Money window appears.

2 In the Account field, type or select the bank account you 
want to reconcile.

3 In the Cheque No field, enter a reference number for the 
withdrawal. 

4 In the Date field, type the first day of your conversion 
month. For example, if your conversion month is April 
2009, enter 01/04/09.

5 In the Amount field, type the amount of the withdrawal.

6 Enter details of the withdrawal in the Memo field.

7 In the Acct # field, type or select the bank account you 
want to reconcile. This must be the account entered in 
step 2 above.

8 In the Tax field, select the N-T tax code.

9 Click Record.

10 Repeat from step 3 above for each uncleared withdrawal.

To record uncleared deposits

1 Go to the Banking command centre and click Receive 
Money. The Receive Money window appears.

2 In the Deposit to Account field, type or select the bank 
account you want to reconcile.

3 In the Date field, type the first day of your conversion 
month. For example, if your conversion month is April 
2009, enter 01/04/09.

4 In the Amount Received field, type the amount of the 
deposit.

5 Enter details of the deposit in the Memo field.

6 In the Acct # field, type or select the bank account you 
want to reconcile. This must be the account entered in 
step 2 above.

7 In the Tax field, select the N-T tax code.

8 Click Record. 

9 Repeat from step 3 above for each uncleared deposit.
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Task 3: Reconcile

To reconcile the account

1 Go to the Banking command centre and click 
Reconcile Accounts. The Reconcile Accounts 
window appears.

2 In the Account field, select the bank account you want to 
reconcile. 

3 In the New Statement Balance field, type the closing 
bank balance as of the day prior to your conversion month 
(for example, the closing balance as of 31/03/2009). 

4 In the Bank Statement Date field, type the first date 
of your conversion month. (For example, if your 
conversion month is April 2009, enter 01/04/09.) Your 
uncleared transactions appear.

When you recorded uncleared transactions, the same 
account was debited and credited with the same amount. 
Therefore, an uncleared transaction appears as both a 
deposit and a withdrawal.

5 For each uncleared withdrawal, click the select column 
next to the deposit. 

6 For each uncleared deposit, click the select column next 
to the withdrawal.

When each uncleared transaction is selected, $0.00 
appears in the Out of Balance field. 

7 Click Reconcile. A confirmation window appears.
 To print a report, click Print Report. When the report 

is printed, click Reconcile.
 To reconcile without printing a report, click Reconcile.
 To change any details you entered in the Reconcile 

Accounts window, click Cancel.

Create item records

You can use item records to store information about a 
product and to track the quantities you buy and sell. You can 
also create records for each type of service you provide.

NOTE : Do you need to complete this task? If you buy and 
sell items, such as finished goods, components used in 
production and raw materials, you need to create records for 
them.

Item records enable you to view the sales and purchase 
history of the products you sell or use in production. You can 
determine which items are your best sellers and what you 
have in stock. This can help you identify sales trends and 
reorder items before you run out of them.

You can also create item records for the services you provide. 
This enables you to list the items and services you buy and sell 
on the same purchase order or invoice.



E N T E R  Y O U R  I N V E N T O R Y  O P E N I N G  B A L A N C E S   3 7

For example, if you are a plumber, you could set up items for 
the materials you buy in order to carry out your work. You 
could also set up item records for the services you provide, 
such as installation and repairs. You can then record the labour 
and material charges on the same invoice.

 For more information about creating item records, see 
‘Creating items’, on page 105.

Optional inventory setup tasks
You may want to do the following tasks if they are relevant to 
your business.

Enter your inventory opening balances

If you had items on hand as of the first day of your conversion 
month, and you want to track on-hand quantities and values 
of these items, you need to enter your inventory opening 
balances. 

Before you enter your opening inventory balances, you need 
to count the actual items in your inventory. To help you do 
this, you can print the Inventory Count Sheet report, 

Task See

Import 
items

Import item information from:
• another ABSS company file
• another accounting system
• a spreadsheet 
• a text file.

page 275

Set up 
pricing 
levels

[ABSS Premier range only] 
Customise item pricing according 
to customer status and sales 
quantities.

page 121

Create 
locations

[ABSS Premier range only] If you 
hold inventory at several 
locations, you can keep track of 
item quantities held at each 
location.

page 110

Group items 
using 
custom lists

Group and sort items by assigning 
attributes to your items from 
custom lists you define.

page 123

Create 
custom 
fields

Set up fields to record additional 
information about your inventory 
items.

page 124

Task See
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which lists all your inventoried items, and manually record 
quantities on it.

To print the inventory count sheet

1 Go to the Inventory command centre and click Count 
Inventory. The Count Inventory window appears.

2 Click Print. The Inventory Count Sheet report is 
printed with a list of all your items.

3 Enter all your on hand quantities on this sheet. 

To enter opening on hand inventory and 
values

1 Go to the Inventory command centre and click Count 
Inventory. The Count Inventory window appears with 
a list of your inventory items. 

2 [ABSS Premier range only] If you store your items at 
several locations, select the method you want to use to 
group your items. You can group items by item number or 
by location.

3 [ABSS Premier range only] If you store your items at 
several locations, select the Include Zero On-Hand 
Quantities option. A list of all your items appears.

4 In the Counted column, type the quantity counted for 
each item. The Difference column will change to show 
the difference between the On Hand column and the 
Counted column.

5 When you have entered all your item quantities, click 
Adjust Inventory. The Adjustment Information 
window appears. 

When you are entering opening on-hand balances, you do 
not need to enter a default expense account.

6 Click Continue. The window that appears depends on 
whether you have entered an opening balance for your 
inventory asset account (see ‘Enter account opening 
balances’ on page 22):
 If you entered an inventory opening balance, the 

Adjust Stock window appears.
 If you did not enter an inventory opening balance, the 

Opening Balance Check window appears. Click 
Opening Balances and then click Adjust Balances. 
The Adjust Inventory window appears.
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The Adjust Inventory window displays a line for each 
item whose opening quantity you entered in the Count 
Inventory window. The line items display each item's 
number, name, quantity and the account to which the 
opening balance will be posted. This account is either 
your inventory asset account, or, if you have not entered 
an opening balance for your inventory asset account, your 
historical balancing account.

7 Enter any changes to the default entries in the Inventory 
Journal Number, Date and Memo fields.

8 Type the unit cost of each item (that is, how much a single 
unit of each item costs you, not how much you are selling 
it for).

NOTE : Do not change the account number in the 
Account column. The selection you made at step 6 
determines the default account used to record your opening 
balances. 

9 Click Record. The value of each item in the list is 
updated.

You can print the Items List Summary report to check 
your inventory status. For more information on printing 
reports, see ‘Reports’ on page 175. 
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4  Banking
This chapter shows you how to record the cheques you have written, the cheques and credit card payments you have received, your credit 
card purchases, your credit card payments and your ATM and Internet withdrawals and transfers.

ABSS software can handle any number of bank and credit card accounts and allocate them to as many accounts as you like. If you are 
accustomed to a manual multi-column cashbook system, you can think of your ABSS software as having the capacity to run multiple 
cashbooks with an infinite number of columns.

Receiving money
In your ABSS software, the term receiving money refers 
specifically to recording receipts other than payments 
relating to invoices. These include equity injections, interest, 
adjustments and so on. These types of receipts can be 
entered using the Receive Money window or by selecting 
the Receive Money transaction type in the Bank Register 
window.

Note that in your ABSS software, invoices are processed 
through the Sales command centre. So any payments 
received against invoices you have issued need to be entered 
using the Receive Payments window or by selecting the 
Receive Payment transaction type in the Bank Register 
window. See ‘Receiving payments’ on page 71 for more 
information.

The options for recording receipts and invoice payments are 
summarised in the following diagram.
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Printing payment receipts You can print payment 
receipts for transactions that you enter in the Receive 
Money and Bank Register windows. For more information 
about printing payment receipts, see ‘Printing payment 
receipts’ on page 74.

There are two ways to record money received without an 
invoice:

 in the Receive Money window

 in the Bank Register window.

The Receive Money window lets you record more details 
about the receipt and to allocate the receipt to more than 
one account. This is the procedure covered in this section. If 
you want to use the Bank Register window—which lets you 
enter a receipt with minimum details—see ‘To enter a 
transaction in the Bank Register window’ on page 48.

To record money you receive

1 Go to the Banking command centre and click Receive 
Money. 

2 Choose one of the following options:
 Deposit to Account. In the Deposit to Account 

field, type or select the required bank account.
 Group with Undeposited Funds. Choose this 

option if you want the deposit to be recorded in the 
undeposited funds account. After you have grouped all 
the deposit transactions you want, you can make one 
bank deposit for all the undeposited funds. For more 
information, see ‘Preparing a bank deposit’ on page 43.

3 If the deposit amount includes tax, select the Tax 
Inclusive option. If it excludes tax, deselect this option.

4 In the Payor field, type or select the payor’s name. 

5 Enter the amount received.

6 [Optional] In the Payment Method field, select the 
payment method. 

7 [Optional] To record additional details about the 
payment, such as a cheque number, click Details and 
record the details in the Applied Payment Details 
window that appears.

8 Type the date of the payment.

9 [Optional] Type a detailed comment in the Memo field to 
help you identify the payment later.

10 Allocate the amount to the appropriate account or 
distribute it to a number of accounts, as described in the 
table below.

11 If you want to view or change the tax amounts assigned to 
the transaction, click the zoom arrow ( ).

12 If you want to assign the transaction to a particular 
category, select a category from the Category list. 

A Type or select an account to assign the payment or part 
of the payment to.

B Type the amount you want to assign to each account. 
The total amount in this column must equal the amount 
in the Amount Received field before you can record 
the transaction.

C [Optional] Assign the amount to a job by entering the job 
code here.

D [Optional] Type a memo for each entry in the 
transaction.

E The tax code that is linked to the allocation account 
appears here automatically. You can change it or delete it 
if necessary.

BA DC E
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If you have not turned on category tracking, the 
Category field won’t appear. (To turn on category 
tracking, go to the Setup menu, choose Preferences, 
click the System tab and select the Turn on Category 
Tracking option.) For more information, see ‘Categories’ 
on page 231. 
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13 If you want to store the transaction as a recurring 
transaction, so that you can use it again, click Save as 
Recurring. In the Edit Recurring Schedule window, 
enter the necessary details and click Save. (For more 
information, see ‘Recurring transactions’ on page 167.)

14 Complete the transaction in any one of the following 
ways:
 To print and record the transaction, click Print. 
 To record the transaction, click Record. 

15 If you do not want to record the transaction at this time, 
click Cancel.

Preparing a bank deposit

When you want to deposit payments (such as credit card, 
cash and cheque payments) in a batch, you need to post the 
payments to a temporary holding account until you create a 
bank deposit. This holding account is known as an 
Undeposited Funds account.

You can post a customer payment to the Undeposited Funds 
account by selecting the Group with Undeposited Funds 
option in the Receive Money window or Receive 
Payments window when recording a payment.

When you make a bank deposit in a batch, funds are 
transferred from the Undeposited Funds account to the 
account of your choice as a single transaction. You can record 
the deposit in the Prepare Bank Deposit window. 

To prepare a bank deposit

1 Go to the Banking command centre and click Prepare 
Bank Deposit. The Prepare Bank Deposit window 
appears. 

2 In the Deposit to Account field, type or select the 
account into which the funds will be deposited.

3 If you want to group payments by payment method, 
select the payment method in the Select Receipts by 
field. Select one or more payment types in the adjacent 

field. (For credit cards, select one or more credit card 
types.) Only payments made using that method are listed.

4 Type a date to display undeposited funds up to and 
including that date.

5 [Optional] To record the purpose of the transaction, type 
a description in the Memo field. 

6 Select the receipts you want to include in the bank 
deposit by marking the corresponding field in the 
Deposit column. Alternatively, if you want to select or 
deselect all receipts, click the select icon ( ) at the top 
of the Deposits column.
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7 If you want to enter a transaction to adjust the deposit 
amounts, click Deposit Adjustment. Enter transaction 
fees charged by your credit card provider if the fees are 
deducted before payments are deposited in your account.

You may also adjust a deposit if, instead of depositing the 
total amount of a deposit, you keep part of the deposit as 
cash. In the Bank and Deposit Adjustments window:
a Type the fees and cash back and/or the adjustment 

amount.

b Type the date and an ID number.
c Select an expense account for the fees and cash-back 

entry and/or an income account for adjustment 
amounts.

d Type a memo and other information, as necessary.
e Click Record. If you need to record additional 

adjustments or fees, click Deposit Adjustment 
again.

8 Click Record to record the transaction.

Spending money

The term spending money refers specifically to recording 
payments for transactions for which purchases have not been 
created. These include equity drawings, bank charges, 
telephone bills and so on. These types of payment can be 
entered in the Spend Money window or by selecting the 
Spend Money transaction type in the Bank Register 
window. 

If you want to make payments for purchases entered using the 
Purchases command centre, you will need to enter the 
payment in the Pay Bills window or by selecting the Pay 
Bill transaction type in the Bank Register window.
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The options for recording payments are summarised in the 
following diagram.

To record money you spend

There are two ways to record money you spend:

 in the Spend Money window

 in the Bank Register window.

The Spend Money window lets you record more details 
about the payment and to allocate the payment to more than 
one account. This is the procedure covered in this section. If 
you want to use the Bank Register window—which lets you 
enter a payment with minimum details—see ‘To enter a 
transaction in the Bank Register window’ on page 48. 

1 Go to the Banking command centre and click Spend 
Money. The Spend Money window appears.

2 In the Account field, type or select the bank account 
that will be used to make this payment.

3 Select the Tax Inclusive option if the amount is tax 
inclusive. Deselect this option if the amount is tax 
exclusive.

NOTE : Make your selection now Do not select or 
deselect the Tax Inclusive option after you type an 
amount in the Amount field. 

4 Fill in the information in the cheque area of the window, 
just as you would if you were writing a paper cheque. 

If the transaction is an ATM withdrawal or an electronic 
payment, type a non-numeric word or phrase to describe 
the withdrawal in the Cheque No. field. That way you 
will know the transaction is not an actual cheque when 
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you view it in a list or on a report. This will also allow you 
to skip the transaction when you print a range of 
numbered cheques.

5 If you want to change the default payee address, type or 
select the payee’s address in the Payee field.

6 Allocate the payment to the correct account.

7 If you want to view or change the tax amounts assigned to 
the transaction, click the zoom arrow ( ).

8 If you want to assign the transaction to a particular 
category, select a category from the Category list. For 
more information, see ‘Categories’ on page 231.

9 If your payment covers more than one account, repeat 
from step 6. You would do this, for example, when paying 
for the purchase of a number of different items from the 
same supplier: postage, magazines, stationery, etc.

TIP : Recap transaction Before you record this 
transaction, you can use the recap transaction feature to 
view the journal entries that will be created when the 
transaction is recorded. This is useful for confirming that the 

journal entries are posted to the correct accounts. To recap, 
choose Recap Transaction from the Edit menu.

10 If you are paying by cheque and have already written a 
cheque, select the Cheque Already Printed option.

11 If you want to send remittance advice in a batch, select an 
option from the Remittance Advice Delivery Status 
list. 

After you have recorded a number of payments, say, the 
day’s payments, you can print or email remittance advices 
in a batch. For more information, see ‘Sending forms’ on 
page 186.

TIP : Save the payment as a recurring transaction
If you want to store the payment as a recurring transaction, 
click Save as Recurring. In the Edit Recurring 
Schedule window, enter the necessary information and 
click Save. For more information, see ‘Recurring 
transactions’ on page 167. 

12 If you want to print a cheque or remittance advice now, 
click Print and select the form type you want to print. 
Note that the payment is recorded before it is printed.

13 Click Record.

A Type or select the account to which you want to assign 
the cheque amount. 

B Type the allocation amount. 

C [Optional] Assign the cheque amount to a job by 
entering the job code here. 

D [Optional] Type a memo for each line item you enter in 
the transaction.

E The tax code that is linked to the allocation account 
appears here automatically. You change or delete it if 
necessary.

BA C D E
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To void a cheque

Follow the steps below to void a cheque that you have not 
recorded in your ABSS software. If you want to make changes 
to a cheque you have already recorded, see ‘Changing or 
deleting a transaction’ on page 165.

1 Display the Spend Money window and choose the 
cheque account from which you want to void the cheque. 

2 In the Cheque No. field, type the number of the cheque 
you want to void.

3 Leave all the other fields blank.

4 Click Record and then click OK to confirm that you want 
to void the cheque.
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Entering transactions in the Bank Register window

You can enter the following transactions in the Bank 
Register window: cheques, deposits, payments to suppliers, 
payments from customers, sales and purchases.

The main advantages of using the Bank Register window 
to enter transactions are speed and convenience. For 
instance, unlike a Spend Money transaction, you can record 
a customer payment, pay a bill and then write a cheque 
without having to move between multiple windows. The 
Bank Register window allows you to enter transactions 
with minimal detail, which can save you time. 

Importing your online bank and credit card 
statements You can also use the Bank Register 
window to import your bank and credit card statements. If a 
statement contains any transactions that you have not 
entered, you can add them quickly in the Bank Register 
window. For more information, see ‘Reconcile your bank 
accounts’ on page 51.

To enter a transaction in the Bank Register 
window

1 Go to the Banking command centre and click Bank 
Register. The Bank Register window appears.

2 In the Account field, type or select the bank or credit 
card account that will be used for this transaction. 

3 In the lower part of the window, select the type of 
transaction from the Type list.

4 Enter a transaction reference:
 If you select Pay Bill, Spend Money or Enter 

Purchase from the Type list, enter a cheque number 
(or other transaction reference) in the Cheque No 
field. 

 If you select Receive Payment, Receive Money or 
Enter Sale from the Type list, type a transaction 
reference in the adjacent ID No. field.

5 In the Date field, type the date of the transaction.

6 In the Card field, type or select the name of the card for 
this transaction.

7 In the Amount field, type the total amount of the 
transaction, including tax. 

8 If you want to allocate the amount to only one account, 
type in the Account field the account that will be used 
for this transaction.
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If you want to allocate the amount to more than one 
account, click Split. The corresponding transaction 
window will appear, and you can then allocate the amount 
to multiple accounts of your choice.

Note that you can also use the Split button to:
 apply payments to a particular invoice or purchase
 enter the payment method
 print the transaction.

NOTE : When the Split button is not available If the 
transaction type is Enter Sale or Enter Purchase, the 
Split button is not available. To open the transaction 
window, you will need to record the transaction, then click 
the zoom arrow ( ) next to the transaction in the Bank 
Register window.

9 If you are entering a sale or a purchase, select the 
appropriate tax code in the Tax field. 

10 [Optional] Assign the payment to a job by entering the 
job code in the Job field. This is not applicable for Pay Bill 
and Receive Payment transactions.

11 If you want to record the purpose of the transaction, type 
a description in the Memo field.

12 If you want to assign the transaction to a category, select 
a category from the Category list. This is not applicable 
to Receive Payment and Pay Bill transactions. For more 
information, see ‘Categories’ on page 231.

13 To save the transaction as a recurring transaction, so that 
you can use it again, click Save as Recurring. In the Edit 
Recurring Schedule window, enter the necessary 
information and click Save. (Note that this option is 
available only for Spend Money and Receive Money 
transactions). For more information, see ‘Recurring 
transactions’ on page 167.

After saving the recurring template, if you want to record 
the transaction, click Record in the Bank Register 
window (or in the transaction window if you clicked 
Split). If you do not want to record the transaction at this 
time, click Cancel.

14 To record the transaction, click Record. 

Transferring money between accounts

You can transfer money between bank accounts, including 
bank and credit card accounts, using the Transfer Money 
window. You can also use this window to record Internet or 
phone-banking transfers.

To transfer money between accounts

1 Go to the Accounts command centre and choose 
Transfer Money. The Transfer Money window 
appears.

2 Type a date for the transfer.

3 In the Transfer Money From field, type or select the 
account from which the funds will be paid. 

4 In the Transfer Money To field, type or select the 
account into which the funds will be paid. 
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5 In the Amount field, type the amount to be transferred. 6 If you want to record the purpose of the transaction, type 
a description in the Memo field.

7 If you want to assign the transaction to a particular 
category, select the category from the Category list.

TIP : Save the transfer as a recurring transaction If 
you want to store the transfer as a recurring transaction click 
Save as Recurring. In the Edit Recurring Schedule 
window, enter the necessary information and click Save. For 
more information, see ‘Recurring transactions’ on page 167. 

8 To record the transaction, click Record.

Tracking petty cash expenses

Most businesses keep a small amount of cash handy at the 
office for miscellaneous expenses—postage, staff amenities, 
and so on. You can track this petty cash amount separately 
using a petty cash account and allocating any miscellaneous 
expenses to that account. 

Check your accounts list for an account named ‘Petty Cash’. If 
it doesn’t exist, you need to create it. For information on 
creating an account, see ‘To create an account’ on page 21.

To transfer money to your petty cash account

1 Go to the Accounts command centre and click Transfer 
Money. The Transfer Money window appears.

2 In the Transfer Money From field, type or select the 
account from which you are transferring money. 

3 In the Transfer Money To field, type or select the petty 
cash account.

4 In the Amount field, type the amount.

5 Click Record.
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To allocate expenses to the petty cash 
account

Let’s assume you spent RM80 on stationery from your petty 
cash float. You would record this transaction in the following 
way. 

1 Go to the Banking command centre and click Spend 
Money. 

2 In the Account field, type or select the Petty Cash 
account. 

3 Type the date and amount of the expense. Enter the 
expense as a line item and allocate it to the relevant 
expense account (in this example, the Office Supplies 
account).

4 Since you do not need to print a cheque for this 
transaction, select the Cheque Already Printed 
option.

5 Click Record. 

Reconcile your bank accounts

To ensure the accuracy of your business records, you should 
keep your record of each bank account balance matched up 
with your bank’s records.

If you are reconciling your bank account for the first time 
since you started using ABSS software, see ‘Do an initial bank 
reconciliation’ on page 34. 

To reconcile your bank account

NOTE : Reconciling bank accounts using the Company 
Data Auditor If you are using the Company Data Auditor 
(see step 3 in ‘To run the company data auditor’  on page 244), 
select the account you want to reconcile in the Account 
Reconciliation Review window and click Reconcile 
Accounts. Continue this procedure from step 3.
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1 Go to the Banking command centre and click 
Reconcile Accounts. The Reconcile Accounts 
window appears.

2 In the Account field, type or select the account you want 
to reconcile.

3 In the New Statement Balance field, type the closing 
balance that appears on the statement your bank sent you.

4 In the Bank Statement Date field, type the closing 
date that appears on your bank statement, and then press 
TAB. Only unreconciled transactions dated on or before 
that date are displayed.

NOTE : If you want to import bank statement data 
electronically, click Actions and choose Bank Feeds 
function to import your bank statement data, see ‘Importing 
statements’ on page 54.

5 For each entry on your bank statement, select the 
corresponding transaction by clicking in the select 
column ( ) next to it. The transaction line is highlighted 
and the amount in the Calculated Statement 
Balance field is updated.

6 If there are entries on the statement relating to bank 
charges or bank interest and the entries do not appear 
among the transactions on the Reconcile Accounts 
window, you need to manually add these transactions.

a Click Bank Entry. The Bank and Deposit 
Adjustments window appears.

b Fill in the appropriate transaction details and click 
Record. The Reconcile Accounts window 
reappears.

7 Click Reconcile. A window appears, indicating whether 
your account is reconciled or out of balance.
 If your account is reconciled, you can print the 

Reconciliation report by clicking Print 
(recommended). Once the report is printed, the 
Reconcile Accounts window appears. Click 
Reconcile again to complete the reconciliation 
process. If you do not want to print the report, simply 
click Reconcile. The transactions you marked are 
considered cleared and won’t appear in the Reconcile 
Accounts window the next time you display it.

 If your account is out of balance, the window will 
indicate the amount by which your account is out of 
balance, and will provide you with a few ideas as to why 
this may have occurred. To correct the unreconciled 
amount, follow the procedure below.

To correct an unreconciled amount

1 Check the following:
 Did you type the correct figure in the New 

Statement Balance field? Note that you have to 
enter the closing balance from your bank statement, 
not the opening balance.)

 Did you type the correct date (that of the closing 
balance from your bank statement) in the Bank 
Statement Date field? An incorrect date may 
prevent some transactions from appearing in the list.

 Did you select all transactions that appear on the 
bank statement? If not, some transactions might not 
have been accounted for in the reconciled balance.
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 Did you select a transaction that didn’t appear on 
your bank statement? If yes, you need to deselect the 
transaction.

 Did you record all bank charges and bank interest 
entries that appear on the bank statement? If not, 
you need to record them and select them for 
reconciliation.

2 Repeat the reconciliation procedure ‘To reconcile your 
bank account’ on page 51. 

If your account is still out of balance, then you may have 
deleted a transaction that has been reconciled previously. 

NOTE : Identifying deleted transactions using the 
Audit Trail report If you set the Use Audit Trail 
Tracking preference, you can use the Audit Trail report 
to search for deleted transactions. This preference must be 
set before deleted transactions will appear in the report.

3 If you have deleted a previously reconciled transaction: 
a Re-enter the transaction into your company file.
b Select it for reconciliation.
c Repeat the reconciliation procedure.

Undoing an account reconciliation
If you have reconciled a transaction in error or deleted a 
previously reconciled transaction, you can undo the previous 
account reconciliation. When you undo a reconciliation, all 
transactions for that period return to an unreconciled status.

If the error was made in a reconciliation earlier than your last 
reconciliation, you can undo several reconciliation periods in 
succession in your current financial year. 

Note, when you undo an account reconciliation, you will need 
to reconcile each transaction again and reprint your 
reconciliation reports. 

CAUTION : Purged transactions cannot be re-reconciled
Do not undo a reconciliation for a period containing purged 
transactions.

We recommend that you back up your company file before 
you undo a reconciliation. Then, if you want to reverse the 
undo reconciliation, you can restore the backup file.

To undo an account reconciliation

1 Go to the Banking command centre and click 
Reconcile Accounts. The Reconcile Accounts 
window appears.

2 In the Account field, type or select the account for 
which you want to undo the reconciliation.

3 Click Actions and choose Undo Reconciliation. The 
Undo Last Reconciliation window appears, 
confirming the account and date of the reconciliation you 
are undoing.

4 Click Undo Reconciliation. A confirmation window 
appears.

5 Click OK. The Reconcile Accounts window reappears.
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Importing statements 

If you have an online banking facility, you can use the Bank 
Feeds feature to import bank statement or credit card 
statement files. 

This feature enables you to import transactions that you have 
not recorded in your company file (e.g. bank fees). It also 
enables you to use the imported transactions as part of your 
reconciliation process. Namely, your ABSS software can 
automatically match transactions on your statement with the 
transactions in your company file. Matched transactions will 
be marked as cleared for reconciliation, making it easy for you 
to reconcile your account at month-end. 

If some transactions cannot be matched, you have the option 
of matching them manually with uncleared transactions, 
adding them or skipping them altogether. Unmatched 
transactions are usually account fees and penalty charges 
applied by the bank.

If your business uses multiple currencies (ABSS Premier only) 
and your bank provides foreign currency statements in the 
OFX file format (such as the Hang Seng bank), you can import 
these statements using the Bank Feeds feature.

If your business uses Singapore DBS bank, you can import your 
bank transaction using MT940 format.

NOTE : Download your statement Before you can import 
your bank or credit card statement, you need to download the 
statement file from your bank. Your bank’s website should 
provide instructions on downloading this file. The following file 
formats are supported: OFX, QFX, QIF, OFC and MT940.

To import your statement

1 Go to the Banking command centre and click Bank 
Register. The Bank Register window appears. 

2 In the Account field, type or select the account that 
corresponds to the bank or credit card statement.

3 Click Bank Feeds.button and the below window appears.

4 Select the statement format that your bank provides, and 
click the Import button. 

5 Locate your bank statement file and click Open. The 
message shows number of transaction read appears.

6 Click OK. 

The statement transactions are automatically matched 
with the transactions in your company file by using the 
cheque number and amount as the criteria for matching 
payments and deposits. 
 If there are any unmatched transactions, the 

Unmatched Statement Transactions window 
appears. Go to step 7.
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 If all your transactions match, these transactions will be 
marked as cleared in the Reconcile Accounts 
window and you can ignore the rest of this procedure.

7 Choose what you want to do with the unmatched 
transactions.
 If you want to match a transaction, highlight that 

transaction, click Actions and choose Match 
Transaction. The Match Transaction window 
appears, listing the uncleared transactions in your 
company file for the specified account. Select the 
transaction that you want to match with the statement 
transaction and click Match. The transaction will be 
marked as cleared. Repeat this step for each transaction 
that you want to match. 

 If you want to add a transaction to your company file, 
highlight the transaction, click Actions and choose 
Add Transaction. The Spend Money window or the 
Receive Money window appears (depending on the 
type of transaction you are adding). Enter the details of 
the transaction and record it. The transaction is shown 
as cleared. Repeat this step for each transaction you 
want to add.
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CAUTION : Match or add all transactions We 
recommend you finish adding or matching every 
transaction in the unmatched transaction list before you 
click Done. Otherwise, if you re-open the statement file, 
the original unmatched statement list would appear in 
the Unmatched Statement Transactions window.

8 Repeat step 7 for each uncleared transaction you want to 
add or match.

9 When you have finished matching and adding 
transactions, click Done. A list of all the transactions that 
were cleared appears. 

Credit card purchases and payments to credit card providers

Before you record credit card purchases, you need to create a 
credit card liability account for each credit card you will use. 
Name the accounts VISA, American Express, etc. These 
accounts will keep track of the amount owed to the credit 
card provider. For information on creating an account, see ‘To 
create an account’ on page 21.

Recording purchases made using a 
credit card
You record a payment made using a credit card by specifying 
the credit card account in the Pay Bills, Spend Money or 
Bank Register window. When you record the transaction, 
the payment amount is assigned to your credit card liability 
account.

For more information on recording payments, see: 

 ‘Spending money’ on page 44

 ‘Entering transactions in the Bank Register window’ on 
page 48

 ‘Paying bills’ on page 96.
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Recording payments to credit card 
providers
When the time comes to pay your credit card provider, you 
use the Spend Money window to record a payment from 
your bank account to your credit card account.

To record a payment to a credit card provider

1 Go to the Banking command centre and click Spend 
Money. The Spend Money window appears. 

2 In the Pay from Account field, select the bank account 
you want to use to make this payment.

3 In the Card field, type or select the credit card provider’s 
name.

4 Type the payment date in the Date field.

5 Type the amount you want to pay.

6 Type a comment in the Memo field to provide a brief 
description of the payment you are recording.

7 In the scrolling list area of the Spend Money window, 
type or select the liability account you have created to 
track purchases made with this credit card.

8 Click Record to record the credit card payment.
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5  Sales
This chapter explains how to enter information about sales to your customers. You record a sale by specifying the customer’s details, the 
invoice layout (item, service, professional, time billing or miscellaneous), the status of the sale (quote, order or invoice) and the details of 
the items or services sold. 

The chapter also explains the various ways of sending an invoice, how to record customer payments, how to issue a customer credit and 
how to analyse sales activities with a variety of reports and other analytical tools.

Creating a customer card

Before you can record a sale, you need to create a card for 
your customer.

To create a customer card

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears.

2 Click New. The Card Information window appears.

3 Select Customer from the Card Type list.

4 Select the designation of the card: company or individual.

5 Type the customer name and press TAB. Additional fields 
appear.

6 Enter a code to identify this customer in the Card ID 
field. For more information, see ‘Card identification 
codes’, on page 212.

7 Enter contact details for the customer. 

If you want to enter more contact information, select 
Address 2 from the Locations list and enter the 
additional details. You can enter contact details for five 
locations.

8 Click the Card Details tab. You can enter notes about 
the customer, insert a picture and assign attributes to 
group and sort the card.

If you want to... See

insert a picture page 213

assign identifiers to the card page 204

assign an attribute from a custom list page 205

enter additional information in a 
custom field 

page 212
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9 Click the Selling Details tab and enter your selling 
details.

10 Click the Payment Details tab and select the method 
of payment your customer will use to pay you.

11 [Optional] Click the Jobs tab and create new codes for 
each job you have started or are about to start for the 
customer. For more information about jobs, see ‘Jobs’ on 
page 232.

12 [Optional] Click the History tab and type the dollar value 
of the sales made prior to your conversion month. You can 
also type or select the date that the contact became a 
customer.

13 Click OK to close the Card Information window.

A Selling 
informati
on

The selections you make here will be used, 
by default, on quotes, orders and invoices 
that you create for this customer. You can 
override these selections when recording 
the sale. 

B Credit 
terms

The credit terms you entered earlier appear 
here by default. You can override them here 
for this customer. The credit terms entered 
here are used as the default terms for all 
sales to the customer, but can be changed 
at any time.

C Tax 
informati
on

The customer’s tax information is entered 
here. If the customer’s tax status takes 
precedence over that of the item or service 
being sold, select the Use Customer’s 
Tax Code option. For more information, 
see ‘Assigning tax codes to cards’ on 
page 153.
MSIC code [Malaysia] is available in 
Customer type of Card Information for you 
to enter the major industry code that you 
sell to the particular customer.

A

B

C
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Entering sales

You enter a sale as a quote, order or invoice. 

 A quote is used to record a price you have quoted to a 
customer without creating a transaction. A quote has no 
impact on your inventory levels and can be changed to an 
order or an invoice when your customer is ready to buy. 

 An order is a sale that you expect will occur. While orders 
do not affect your financial figures, they do affect your 
committed inventory numbers. Orders do not create 
transactions unless the customer has paid you a deposit. 
An order can be changed to an invoice.

 An invoice is usually created when you deliver the items or 
services the customer ordered. It will update the 
appropriate accounts, including the account for tracking 
receivables. Invoices can be open (unpaid), closed (paid) 
or credit (negative sale). An invoice cannot be changed to 
a quote or an order. 

You can enter a sale in:

 the Sales window

 the Bank Register window.

Entering a sale in the Sales window—the procedure 
described in this chapter—enables you to record more details 
about the sale than entering it in the Bank Register 
window. To use the Bank Register window, see ‘To enter a 
transaction in the Bank Register window’ on page 48. 

Entering a sales transaction
Complete the following steps to enter a sales transaction:

Task 1: Enter information about the 
customer
1 Go to the Sales command centre and click Enter Sales. 

The Sales window appears.

2 In the Customer field, select the customer’s name.

NOTE : Customer credit limits and accounts on 
hold You may not be able to record sales for customers 
who have exceeded their credit limit or whose account has 
been placed on hold. For more information, see ‘Credit 
control’ on page 75.

The terms and ship-to address shown in the Sales window 
are the details recorded in the customer’s card.

Task See 

1 Enter information about the customer below

2 Choose the type of sale page 61

3 Enter the items or services you are 
selling

page 61

4 Enter additional information about the 
sale

page 62

5 Complete the sale page 63
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3 If you want to change a customer’s delivery address, type 
the alternative address in the Ship to field or choose 
another address from the customer’s card by clicking the 
down arrow ( ) next to the Ship to field.

Task 2: Choose the type of sale 
In this step, choose the required status and layout for the 
transaction you are creating. The layout initially displayed in 
the Sales window is determined by the default selection you 
made when setting up sales details (using the Sales Easy 
Setup Assistant) or when creating the customer’s card. 

1 Check if the default layout is appropriate. There are five 
layouts: Service, Item, Professional, Time Billing [ABSS 
Premier range only] and Miscellaneous. The layout 
determines what fields appear on the Sales window. If 
you want to change the default layout:
a Click Layout. The Select Layout window appears.

NOTE : Miscellaneous layout The Miscellaneous 
layout is used only for sales where a printed form is not 
needed.

b Select the appropriate layout and click OK. 

2 Select the status from the list in the top left corner of the 
window: Quote, Order or Invoice.

Task 3: Enter the items or services you 
are selling
The scrolling list in the middle of the Sales window is where 
you enter details of what you are selling. In this area you will 
enter item numbers, descriptions, account numbers (or 
names depending upon your selection in the Preferences 
window) and other information to describe your transaction.

One row in the scrolling list is one line item of the transaction. 
You can enter as many line items for a sale as you want.

The fields that appear in the scrolling list depend on the sales 
layout you are using. The following illustration shows the 
layout for an item sale.

A Click the zoom arrow ( ) to alter the credit terms for 
this sale only. Note that if you want to change the credit 
terms for all future sales to this customer, you must make 
that change on the Selling Details tab of the 
customer’s card. 

B Type the invoice number here or accept the default 
number.

C If the customer gave you a purchase order for this 
transaction, type that purchase order number here.

D If the sale amounts you want to enter include tax, select 
the Tax Inclusive option. Do not change this option 
after entering an amount in the Amount column. 

BA

C

D

A Ship Type the quantity to be shipped.

B Backorder Type the quantity of the item to be placed on 
backorder. An order for this amount will be 
created automatically when you click Record. 

C Item 
Number

Type your item number or press TAB and select an 
item from your item list.

D Descriptio
n

A description of the item appears automatically. 
You can change this if you want. 

A B C E F G HD

Item sale

I J
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The following illustration shows the layout for a service sale in 
the Sales window:

NOTE : Add lines, subtotals and headers to sales 
transactions You can add lines, headers and subtotals to 
invoices to make it easy to separate and subtotal different 
groups of line items on one invoice. See ‘Adding and deleting 
transaction lines, subtotals and headers in sales transactions’ on 
page 63.

Task 4: Enter additional information 
about the sale
The fields that appear at the bottom of the Sales window 
depend on the type of sale you are creating. 

E Location [ABSS Premier range only] This field only appears 
if you store inventory in multiple locations. Select 
the location of the item being sold.

F Price The price of the item appears automatically. You 
can change this if you want.

G Disc% [Optional] Type a volume discount as a 
percentage.

H Total The total price of the items is calculated 
automatically.

I Job [Optional] Type or select a job number here to 
assign a line item to a specific job. For more 
information about jobs, see ‘Setting up jobs and 
sub-jobs’ on page 232.

J Tax Type or select a tax code for the line item.

A Descriptio
n

On a service, professional or miscellaneous 
invoice, type a description of the goods or 
services sold.

B Acct# or 
Name

On a service, professional or miscellaneous 
invoice, type the account to which the sale will 
be allocated or press TAB to select an account 
from your accounts list. This is usually an income 
account. You should not select your receivables 
account for ordinary sales. 

C Tax Type or select a tax code for the line item.

Service sale

B CA
A Salesperso

n,
Comment,
Ship Via,
Promised 
Date

Enter optional information, such as the name of 
the salesperson, a comment, shipping method, 
promised date of goods or services. Type text or 
click the search icon ( ) to choose from the 
Select From List window.

B Invoice 
Delivery 
Status

Select a delivery method to indicate how you 
want to send the invoice. You can also print or 
email the invoice in a batch after selecting the 
required delivery method. For more information, 
see ‘Sending forms in a batch’ on page 187.

C Journal 
Memo

The journal memo is generated automatically. 
You can change this if you want.

D Freight Type any charges for freight. 

E Freight tax Type or select the tax code for the freight 
charges. 

A

B

D

H

C

G

E

F
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NOTE : Recap transaction Before you record this transaction, 
you can use the recap transaction feature to view the journal 
entries that will be created when the transaction is recorded. 
This is useful for confirming that the journal entries are being 
posted to the correct accounts. To recap, choose Recap 
Transaction from the Edit menu.

Task 5: Complete the sale
After you have finished entering the details in the Sales 
window, there are several ways to complete the transaction.

TIP : Save the sale as a recurring sale Click Save as 
Recurring. In the Edit Recurring Schedule window, enter 
the necessary information and click Save. For more information, 
see ‘Recurring transactions’ on page 167.

 If you want to record the sale without printing or sending 
it, click Record (for a sales quote, click Save Quote). 

 If you want to record the sale and create a purchase order, 
click Create PO. The quote or order is recorded and the 
purchases window appears. For more information, see ‘To 
create a purchase order from a sale’ on page 92.

 If you want to record the sale and print, send or save it as a 
PDF, complete the relevant procedure below.

Adding and deleting transaction lines, 
subtotals and headers in sales 
transactions
You can add and delete transaction lines, headers and 
subtotals in sales transactions. 

To insert a blank line 

1 In the Sales window, click anywhere in the line below 
where the blank line is to appear.

2 Go to the Edit menu and choose Insert Line. A blank line 
will appear in the scrolling list with the cursor positioned 
in the Description column.

F Tax  Click the zoom arrow ( ) if you want to view or 
change the tax amounts assigned to the sale.

G Paid Today Type an amount here to indicate how much 
money the customer paid you at the time of the 
sale or, if you are creating an order, how much 
money the customer gave you as a deposit. 

H Payment 
Method

Type or select the payment method. Click 
Details if you want to enter details about the 
payment. For example if you are being paid by 
credit card, you can record the credit card 
number, expiry date and other details.

To… Do this...

Print Click Print and choose the type of form you want 
to use. For more information about printing, see 
Chapter 13, ’Forms,’ starting on page 185.

Print 
preview

Click Print and choose Preview to preview the 
sales form for this transaction.
Note that the transaction will be recorded before 
the form is displayed.

Email Click Send To and choose Email. Review and 
make entries in the Email window and click Send. 
The email, which will include a PDF (Portable 
Document Format) attachment, will be sent to 
the Outbox of your default email software. Send 
the email from your email software. 

Fax Click Send To and choose Fax. A window from 
your fax software appears. Send the fax, using your 
fax software as you normally do.

Save as 
PDF

Click Send To and choose Disk. In the window 
that appears, enter a name and location for the 
PDF file and click Save. 
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To insert a header

You can group several line items by inserting a header.

1 In the Sales window, click anywhere in the line below 
where the header is to appear.

2 Go to the Edit menu and choose Insert Header. A blank 
line will appear in the scrolling list with the cursor 
positioned in the Description column.

3 Type the text for the header. The text appears in grey.

4 Press TAB to complete the header entry.

To insert a subtotal

1 In the Sales window, click anywhere in the line below the 
items to be subtotalled.

2 Go to the Edit menu and choose Insert Subtotal. A line 
appears displaying the subtotal of the amounts that 
appear above the subtotal line and below the last 
subtotal, if there is one.

To delete a blank line, line item, header or 
subtotal

1 In the Sales window, click anywhere in the blank line, line 
item, header or subtotal you want to delete.

2 Go to the Edit menu and choose Delete Line.

Recording sales with insufficient on-hand item quantities

If you track item quantities and values, and you want to 
record a sales invoice for an item with insufficient on-hand 
quantities, you can:

 record the sale and allow a negative on-hand item 
quantity and value to be recorded for the item

 build, buy or backorder the item.

Allow negative on-hand quantities and 
values
If you want, you can set a preference to allow the recording of 
sales with insufficient on-hand quantities. With this 
preference set, the sale of an item that is not in stock results 
in a negative on-hand item quantity and value.

NOTE : This feature affects your inventory reporting
Allowing negative item amounts to be recorded in your 
inventory affects the reporting of inventory values and cost of 
goods sold. This feature may not be suitable for some 
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businesses. Consult your accountant or financial adviser before 
using this option.

When you record the sale of an item with insufficient on-hand 
quantities, an estimated item cost is recorded for the sale. 
The estimated cost used depends on the item information 
available, as described in the following table.

When you record a purchase to replenish the items, a journal 
entry automatically records the price variation between the 
estimated cost and the actual cost, if there is one.

To allow the recording of sales with 
insufficient on-hand quantities

1 Go to the Setup menu and choose Preferences. The 
Preferences window appears.

2 Click the Inventory tab and select the Allow the Sale 
of Items with Insufficient On-Hand Quantities 
option.

Cost 
type Description

Average 
cost

Average cost is used if you have sufficient on-hand 
stock for which an average price can be determined. 
For example, if you have ten units of an item on-hand, 
but make a sale for 12 units, average cost is based on 
the value of the ten units in stock.

Last 
Cost

Last cost is used if the average cost is unavailable. For 
example, if you have purchased an item before but 
currently have none on-hand, the last purchase price is 
used.

Standar
d Cost

Standard cost is used if you have never purchased an 
item before, and you have entered a standard cost in 
the item information card.

Zero 
cost

Zero cost is used if you have never purchased the item 
before and you select this option when recording the 
sale.
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Build, buy or backorder items
If you attempt to record a sales invoice with an insufficient 
on-hand quantity, and you do not allow the recording of sales 
with insufficient quantities, the Backorder List window 
appears. In this window, you need to build or buy the required 
quantity, or create a customer sales order (backorder) for the 
unavailable quantity, before you can record the sale.

Before you begin Before you can auto-build an item in 
the Backorder List window, you need to set up your item 
details. For more information, see ‘Auto-building items’ on 
page 113. If you want to record a bill using this window, you 
need to enter a default supplier for the item. For more 
information, see ‘Creating items’ on page 105.

To build, buy or backorder items
When you record a sale and you have insufficient on-hand 
quantity of an inventory item, the Backorder List window 
appears. You will need to make an entry in this window before 
you can complete the sale.
1 Go to the Sales command centre and click Enter Sales. 

The Sales window appears. 

2 Enter the details of a sale. (See ‘Entering sales’ on 
page 60.)

3 Click Record. If you have insufficient on-hand quantities, 
the Backorder List window appears. 

This window lists items that are either out of stock or 
would be as a result of recording the sale.

4 Choose one of the following options:

NOTE : Multiple items with insufficient quantities
You can use the Backorder List window to perform various 
tasks. However, you can only perform one of these tasks at a 
time and in the following order: build, buy and then 
backorder. For example, if you want to backorder some items 
and buy others, you need to buy the required items first and 
then return to this window (by clicking Record in the Sales 
window again) to complete the backorder. 

5 Complete the sale. For more information, see ‘Complete 
the sale’ on page 63.

To... Do this...

Auto-buil
d items

1 Click in the Build column next to the item 
you want to auto-build and then click Build. 
The Auto-Build Items window appears. 

2 Click Build Items. The Build Items 
window appears. 

3 Click Record to build the finished item.

Record a 
purchase

1 Click in the Buy column next to the item you 
want to purchase and then click Buy. The 
Enter Purchase window appears.

2 Select Purchase as the status from the list 
in the top left corner and complete the 
purchase. For information about completing 
the purchase, see ‘Entering purchases’ on 
page 85.

Record a 
sales 
order

Click in the Backorder column next to the item 
you want to place on backorder and then click 
Backorder. The Sales window appears with 
the Ship and Backorder columns adjusted. A 
sales order is automatically recorded for the item 
when you record the invoice.
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Changing the status of a sale

The following sale types can be converted:

You can change the status of a sale from the Sales window or 
from the Sales Register window.

To convert a quote to an order or invoice

1 Locate and display the quote. To do this:
 In the Sales window, type or select the name of the 

customer whose quote you want to convert. Select the 
quote from the Select from List window that 
appears and click Use Sale, or

 In the Sales Register window, click the Quotes tab. 
Find the quote using the search filters at the top of the 
window, and highlight it. 

2 Convert the quote to an order or invoice. To do this: 
 Click Order (in the Sales window) or Change to 

Order (in the Sales Register window) to convert the 
quote to an order, or

 Click Invoice (in the Sales window) or Change to 
Invoice (in the Sales Register window) to convert 
the quote to an invoice.
The Sales window appears with the selected status. 
Three new fields appear: Paid Today, Payment 
Method and Balance Due.

3 Make any necessary changes to these and other fields. For 
example, you might want to change the transaction date 
to today’s date.

4 Click Record. The new order or invoice is created. 

The original quote will remain in the Sales Register 
window unless you have indicated in the Sales view of 
the Preferences window that you want quotes to be 
deleted once they are converted to orders or invoices.

To convert an order to an invoice 

You can convert an order to an invoice from the Sales 
window or from the Sales Register window. If you want to 

Sale type Can be converted to…

Quote • order
• invoice

Order • invoice

Invoice The status of an invoice cannot be 
changed.
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convert several orders at once, see ‘To simultaneously convert 
several orders to invoices’ below.

1 Locate and display the order. To do this: 
 In the Sales window, type or select the name of the 

customer whose order you want to convert. Select the 
order from the Select from list window that appears 
and click Use Sale, or

 In the Sales Register window, click the Orders tab. 
Find the order using the search filters at the top of the 
window, and highlight it. 

2 Click Invoice (in the Sales window) or Change to 
Invoice (in the Sales Register window) to convert the 
order to an invoice.

3 Review and update the information in the Sales window 
as necessary. For example, you might want to change the 
transaction date to today’s date.

4 Click Record. The new invoice is created and the original 
order is removed. 

To simultaneously convert several orders to 
invoices

You can simultaneously convert several orders to invoices in 
the To Do List window.

1 Click To Do List from any command centre. The To Do 
List window appears. 

2 Click the Orders tab to display a list of all your orders. 

3 If you want to view the details of a specific order, click the 
zoom arrow ( ) to the left of the customer’s name. 

4 Select the orders you want to convert to invoices by 
clicking in the select column ( ) next to them.

5 Click Record as Actual. A window appears, requiring 
you to type a date for the selected transactions. This is 
the date that the transactions will be recorded in your 
sales journal. 

6 Type the date and click OK. 

Reviewing your sales information

There are several tools that you can use to review your sales 
information. 

Tool Description See

Business 
Insights

Use Business Insights to analyse sales 
and customer information.

below

To Do List The To Do List displays all open 
sales, recurring sales and orders 
sorted by overdue dates. 

page 70

Analyse 
Receivable
s

The Analyse Receivables window 
displays ageing information for all 
open invoices. 

page 70

Analyse 
Sales

The Analyse Sales window 
provides a graphical snapshot of your 
sales activities. 

page 70

Sales 
reports

Sales reports help you keep track 
of your sales activities.

page 71

Tool Description See
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To analyse sales information using Business 
Insights

Business Insights presents a summary of your sales 
information, including which customers owe you money and 
how much money is overdue. You can also see how much your 
customers owe you for each ageing period, as well as the sales 
history of your customers. 

To find information specific to your needs, sort the table 
columns by clicking a column heading. For example, you can 
sort the list of outstanding invoices to find the most overdue 
invoice or the largest overdue amount.

You can use Business Insights to analyse customer information 
and sales performance. 

To analyse customers

1 Go to the Accounts command centre and click Business 
Insights. The Business Insights window appears.

2 View the Customers who owe me money panel.

This panel shows the total you are owed and details of 
each overdue customer payment (based on their invoiced 
credit terms), including the number of days overdue.

3 Click Analyse customers to view graphs and 
information about the money your customers owe you and 
the payment history of each customer. 

You can use this information to:
 Contact customers for overdue 

payments Identify which customer payments are 
the most overdue or which customers owe you the most 
money.

Sales 
history

History lets you view seven years of 
sales history for an item, a customer 
or an employee. 

page 71

Sales 
Register

The Sales Register window gives 
you a complete picture of your sales 
activity—open and closed invoices, 
orders, quotes, returns, credits and 
so on. 

page 162

Find 
Transactio
ns

Find Transactions helps you find 
individual sales transactions quickly. 

page 162

Transactio
n Journal

The Transaction Journal lists 
journal entries of your sales and 
other transactions. 

page 164

Tool Description See
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 Renegotiate a customer’s credit terms View 
the customer’s outstanding balances and payment 
history, such as the average number of days it takes for 
them to pay you.

4 If you want to copy a graph and use it in another 
document, right-click it and choose: 
 Copy to Clipboard. This copies the graph to the 

Windows clipboard, ready to paste into a document. 
 Save As. Choose where you want to save the image 

and click Save. This saves the graph as an image file, so 
you can use it later.

5 If you want to copy the data from a table and paste it in 
another document where you can edit it, such as an Excel 
spreadsheet:
a Right-click the table and choose Copy to Clipboard. 

This copies the data to the Windows clipboard
b Open the document or spreadsheet and press CTRL+V 

to paste. Note that table totals are not included in the 
pasted data. 

6 Click Close to return to the main Business Insights 
window.

To view a list of all unpaid sales sorted by 
days overdue 

1 Click To Do List in any command centre. The To Do List 
window appears.

2 Click the A/R (accounts receivable) tab. A list of all 
unpaid sales appears. 

3 The Overdue column shows the number of days an 
invoice is overdue. (A negative number in the Overdue 
column indicates that the payment is not yet due.) The 
number of days an invoice is overdue is calculated by 
checking the original date of the invoice, comparing it to 
today’s date and looking at the customer’s credit terms.

4 If you want to send a collection letter to customers with 
overdue payments:
a Select those customers by clicking in the select column 

( ) next to the customer’s name.
b If you have installed OfficeLink, click Mail Merge to 

create the letter directly in your word processor. 
Otherwise, click Disk, choose a file format and click 
Save. 

To analyse your receivables

1 In the Sales command centre, click the Analysis down 
arrow ( ). 

2 Select Receivables from the Analysis list. The 
Analyse Receivables window appears. 

3 Click Filters and choose the time periods and any other 
criteria you want to view.

4 Click OK. The information you selected appears in the 
Analyse Receivables window.

To analyse your sales activities

The Analyse Sales window provides various 
illustrations—in graphs or in lists—of your sales activities.

1 In the Sales command centre, click the Analysis down 
arrow ( ). 

2 Select Sales from the Analysis list. The Analyse Sales 
window appears. 

3 Click Filters and choose the sales figures, time periods 
and other criteria you want to view.

4 Click OK. The information you selected appears in the 
Analyse Sales window.

5 Use the buttons in the Analyse Sales window to view 
charts showing your sales activities. 
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To view sales reports 

There are several sales reports that can help you track your 
sales activities. For example, you can run an Aged 
Receivables Summary report to view your customers’ 
current balances sorted by ageing periods. The Sales Item 
Summary report shows you which inventory items are 
selling best. The Referral Source report is useful for 
finding out which referral source is bringing your business the 
most money. 

1 Go to the Reports menu and choose Index to 
Reports. The Index to Reports window appears.

2 Click the Sales tab. A list of available sales reports 
appears.

For information, see Chapter 12, ’Reports,’ starting on 
page 175.

To view sales history

You can view sales history for an item, a customer or an 
employee. 

1 Display the Item Information window (via the Item 
List in the Inventory command centre) for an item or 
the Card Information window (via the Cards List in 
the Card File command centre) for a customer or an 
employee.

2 Click the History tab.

The History tab displays a total of seven years of sales 
history for the item or card: the five years preceding the 
current financial year (as displayed in the Company 
Information window), the current financial year and the 
next year. 

NOTE : Employee sales history To record an employee’s 
sales history, that employee must be selected as the 
salesperson on the Sales window.

Receiving payments

When customers make payments against invoices you have 
issued to them, you record the payments in the Receive 
Payments window. You can record the payments against 
one or more of the customer’s outstanding invoices. If you do 
not want to create an invoice for a customer, you can enter 
their payment in the Receive Money window. See ‘To record 
money you receive’ on page 41.

You can also record payments from your customers in the 
Bank Register window. If you are recording several 
customer payments and do not want to record detailed 
information (such as payment methods and discounts) for 
each payment, the Bank Register window can save you 
time. For more information, see ‘To enter a transaction in the 
Bank Register window’ on page 48.
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The options for recording receipts and invoice payments are 
summarised in the following diagram.

NOTE : Customer payments at point of sale If customers 
make payments when purchasing merchandise or services and 
you are issuing them an invoice, you can type the payment 
amount in the Paid Today field of the invoice. See ‘Enter 
additional information about the sale’ on page 62.

To record payments against invoices

1 Go to the Sales command centre and click Receive 
Payments. The Receive Payments window appears. 

2 Choose the account that will be used to deposit the 
payment.
 If you received a cheque:

 Deposit to Account. Select this option and 
select the required bank account in the adjacent 
field.

 Group with Undeposited Funds. Select this 
option if you want the deposit to be recorded in the 
undeposited funds account (and not in a bank 
account). After you have grouped all the deposit 
transactions you want, you can then make a bank 
deposit. For more information, see ‘To prepare a bank 
deposit’ on page 43.

 If you received a credit card payment, select Group 
with undeposited funds. 

After you have grouped all the deposit transactions you 
want, you can make a bank deposit. For more information, 
see ‘To prepare a bank deposit’ on page 43.

3 In the Customer field, type or select the customer’s 
name.

4 Type the amount received.

5 If you want to record the payment method, select the 
method in the Payment Method field. Click Details if 
you want to enter further details about the payment. For 
example, if you are being paid by credit card, you can 
record the credit card number and expiry date.

6 If you want to, change the memo and payment date. You 
can also change the ID number that is automatically 
generated. However, we recommend that you use the 
default number to make sure you do not enter duplicate 
IDs.

7 In the scrolling list in the bottom half of the window, 
indicate which sales are covered by the payment by 
entering amounts in the Amount Applied column. If the 
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customer is paying a deposit for an order, look for the 
word Order in the Status column.

If a customer overpays, you should still enter the amount 
received. The full payment should be entered in the 
Amount Received field and in the Amount Applied 
column in the scrolling list. When you record the payment, 
a credit invoice for the overpaid amount is created 
automatically. This can either be refunded to the 
customer or applied to a future invoice. For more 
information, see ‘To apply a customer credit to an open 
invoice’ on page 79.

8 Click Record to record the customer payment.

A Discount If you intend to award an early-payment discount 
for a sale, assign the discount to the appropriate 
invoice in this column. Note that you won’t be 
able to assign a discount to an invoice that is not 
being settled in full. If you want to give the 
customer a discount, you can give them a 
customer credit. For more information, see 
‘Customer credits’ on page 78.

B Amount 
Applied

Type how much of the customer payment you 
want to apply to each sale in this column.

C Finance 
Charge

If part of the payment was used to pay finance 
charges, type the finance charge amount here. 
For more information, see ‘Finance charges paid 
by customers’ on page 77. 

D Out of 
Balance

The Total Applied amount (plus finance 
charges) must equal the amount that appears in 
the Amount Received field, and the Out of 
Balance amount must be zero before you can 
record the transaction. 

A

C

D

B



P R I N T I N G  P A Y M E N T  R E C E I P T S   7 4

Printing payment receipts

For each cash receipt transaction you record, a corresponding 
receipt can be printed. Receipt transactions can be recorded 
using the following windows:

 Bank Register

 Receive Money

 Receive Payments

 Sales (New Invoice and New Order using Paid Today)

 Settle Returns & Debits (Receive Refund view).

Receipt transactions for which receipts cannot be printed 
are:

 reversed receipt transactions

 voided receipts

 bank transactions such as bank deposits or interest 
earned.

Payment receipts correspond directly to receipt transactions. 
That is, when you record a receipt transaction, the 
information you entered in the transaction can be printed on 
a payment receipt. Because of this relationship, if you change, 
reverse or remove a receipt transaction, the payment receipts 
that have been printed may no longer be valid.

To print payment receipts

1 Go to either the Sales or Banking command centre and 
click Print Receipts. The Review Receipts Before 
Printing window appears.

2 If you print receipts on preprinted stationery, type the 
number of the first receipt in the Number of First 
Receipt in Printer field.

3 Type the number of receipts you want to print in the 
Print field.

4 If you want to filter the information to be displayed on the 
customer receipt, click Advanced Filters. For more 
information, see ‘Advanced filters’ on page 188.

5 Click in the select column ( ) next to each receipt you 
want to print.

6 Click Print. 

For more information about printing and customising forms, 
see Chapter 13, ’Forms,’ starting on page 185.
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Credit control

In ABSS software, you can control credit by:

 setting and enforcing customer credit limits. See ‘Credit 
limits’ below.

 placing customer accounts on hold. See ‘Credit holds’ on 
page 76.

 adding finance charges to customer statements. See 
‘Finance charges paid by customers’ on page 77.

Credit limits
A credit limit is the maximum amount of credit you allow a 
customer to charge to their account. You can set a default 
credit limit for all new customers or set a specific credit limit 
for a single customer.

To enforce credit limits, you can set your preferences to:

 warn users before recording a sale that will exceed a 
customer’s credit limit 

 prevent certain users from recording a sale that will 
exceed a customer’s credit limit. When you use this 
preference, you set an override password to allow 
approved users to record the sale.

To set or change the credit limit for a single 
customer

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears.

2 Click the Customer tab and select the customer for 
whom you want to set a credit limit.

3 Click Actions and choose Edit Credit Limit & Hold. 
The Credit Limit & Hold window appears.

4 Type the customer’s credit limit in the Credit Limit field.

5 Click OK. The Card Information window appears.

6 Click OK to return to the Cards List window.

To receive a warning when a customer 
exceeds the credit limit

1 Go to the Setup menu and choose Preferences. The 
Preferences window appears.

2 Click the Sales tab.

3 Select the If Credit Limit is Exceeded on Sale 
preference and select Warn and Continue from the 
drop-down list.

4 Click OK.
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To prevent the recording of a sale when a 
customer exceeds the credit limit

1 Log in to your ABSS company file as Administrator.

2 Go to the Setup menu and choose Preferences. The 
Preferences window appears.

3 Click the Sales tab.

4 Select the If Credit Limit is Exceeded on Sale 
preference and select Prevent Unless Overridden 
from the list. The Credit Limit Override Password 
window appears.

5 Type an override password and password confirmation.

6 Click OK. The Preferences window appears.

NOTE : Changing the credit limit override 
password If you are logged into your company file as the 
Administrator, you can change the credit limit override 
password in the Credit Limit Override Password 
window. To open this window, choose Preferences from 
the Setup menu, click the Sales tab and then click Set 
Override. 

7 Click OK to close the Preferences window.

Credit holds
You can place a credit hold on a customer’s account to 
prevent further sales being made to the customer. For 
example, you may want to place a customer on credit hold 
when the customer’s account is overdue. 

To place a customer on credit hold

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears.

2 Click the Customer tab and select the customer that 
you want to place on credit hold.

3 Click Actions and choose Edit Credit Limit & Hold. 
The Credit Limit & Hold window appears.

4 Select the Place this customer on Credit Hold 
option.

5 Click OK. The Card Information window appears.

6 Click OK to return to the Cards List window.

NOTE : Recording sales to customers on credit hold
To record a new sale, you will need to remove the credit hold. 
To do this, deselect the Place this customer on Credit 
Hold option in the Credit Limit & Hold window for the 
customer’s card.
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Finance charges paid by customers
Finance charges are amounts added to an outstanding 
balance as a penalty for late payment. A finance charge is 
added to a customer’s statement. The amount paid by a 
customer to cover the charge is then recorded in the 
Receive Payments window.

To set up finance charges

1 Go to the Setup menu, choose Linked Accounts and 
then Sales Accounts. 

2 Select the I assess charges for late payment option 
and select an income account to record the late payment 
charges.

3 Click OK.

4 Go to the Card List in the Card File command centre, 
then select the Customer tab.

5 In the % Monthly Charge for Late Payment field of 
the Selling Details tab of the customer card you want 
to charge, set the percentage you will be charging for late 
payments and click OK.

To record a finance charge

1 Go to the Sales command centre and click Print/Email 
Statements. The Review Statements Before 
Delivery window appears.

2 Click Advanced Filters and select the Add Finance 
Charges to Amount Due option. 

3 Select any other report filters you want to apply and click 
OK.
For more information about customer statements, see 
‘Send customer statements’ on page 247.

When your customer pays the late-payment charge, enter the 
amount in the Finance Charge field of the Receive 

Payments window. For more information, see ‘To record 
payments against invoices’ on page 72.

To receive finance charge payments

1 Select Receive Payment from the Sales command 
centre. The Receive Payments window appears.

2 Type the full amount received and fill in the transaction 
details. See ‘To record payments against invoices’ on 
page 72.

3 Type the late fee amount in the Finance Charge field 
and click Record.

Tracking finance charges Although the history of 
finance charges is not tracked, you can perform an account 
inquiry (using Find Transactions) on the income account 
you have set up to record late charges.

The finance charges payable by your customers only appear 
on their statements, so you may want to keep copies of the 
statements sent to customers.

How finance charges are calculated For each open 
invoice, ABSS software calculates its due date using the terms 
specified in the Selling Details tab of the Card 
Information window. The overdue balance is then increased 
by 1/30th of the monthly charge for late payment for every 
day it is overdue.
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The monthly charge is calculated by multiplying the amount 
overdue by the % Monthly Charge for Late Payment 
value you specified in the customer’s card.

If the customer makes a partial payment during the overdue 
period, the finance charge is adjusted accordingly.

Deleting finance charges When you enter a finance 
charge in the Receive Payments window, two transactions 
are recorded—the full customer payment, including the 
finance charge, is recorded in the receipts journal and a 

transaction for the finance charge is recorded in the sales 
journal. 

Therefore, if you want to delete a finance charge payment, 
you must delete both transactions. If only one entry is 
deleted, the 

Receivables Reconciliation Summary report may show 
an out-of-balance amount equal to the finance charge. 

When you delete one of the entries, you are reminded to 
delete the other entry for the finance charge. Note that a 
warning appears even though you may have already deleted 
the corresponding invoice or payment.

Customer credits

Recording credits
You can create a customer credit note in the following ways:

 Reverse an existing sale. Use this method if you are 
crediting the customer for the entire sale.

 Manually create a credit. Use this method if you are 
crediting the customer for part of a sale.

To reverse a sale

To reverse a sale, the sale transaction must be unchangeable, 
that is, the Transactions CAN’T be Changed; They 
Must Be Reversed option must be selected in the 
Security view of the Preferences window.

1 Find and display the invoice for the sale. See ‘Finding a 
transaction’ on page 161.

2 Go to the Edit menu and choose Reverse Sale. A credit 
note appears in the Sales window. Note that the invoice 
amount is a negative amount.

3 If you want, you can make a few changes to the customer 
credit note (such as changing the date and memo), but 
you cannot change the accounts, amounts and quantities 
that are associated with the credit. 

4 Click Record Reversal. A customer credit appears in the 
Sales Register window.

To manually create a credit for a non-item 
sale 

Use this method if you want to credit the customer for a part 
of a non-item sale.

NOTE : Before you manually create a credit of this type, you 
need to have an account for tracking returns and allowances. 
Check your accounts list for an income account named ‘Sales 
Returns and Allowances’. If it doesn’t exist, you need to create it. 
For more information about creating an account, see ‘To create 
an account’ on page 21. 
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1 Go to the Sales command centre and click Enter Sales. 
The Sales window appears.

2 Type or select the customer you are creating a credit for.

3 Select the Invoice status from the drop-down list in the 
top left corner of the window. 

4 Click Layout, choose Miscellaneous and then click OK.

5 In the Description column, enter a description of the 
credit for your records.

6 Select the account to be credited. This is normally an 
income account called ‘Sales Returns and Allowances’. 

7 In the Amount field, type the amount of the credit as a 
negative amount.

8 Click Record. A customer credit appears in the Sales 
Register window.

To manually create a credit for an item sale

Use this method if you want to credit the customer for part of 
an item sale.

1 Go to the Sales command centre and click Enter Sales. 
The Sales window appears.

2 Type or select the customer you are creating a credit for.

3 Select the Invoice status from the drop-down list in the 
top left corner of the window. 

4 Click Layout, choose Item and then click OK.

5 In the Ship column, type the number of items being 
returned as a negative number. The costs of the items 
appear as negative amounts.

6 Click Record. A customer credit appears in the Sales 
Register window.

Settling credit notes
You can choose to settle a customer credit by:

 applying the credit to one or more of the customer’s open 
invoices, thereby reducing the amount of money the 
customer owes you, or 

 recording a refund payment.

To apply a customer credit to an open invoice

1 Go to the Sales command centre and click Sales 
Register. The Sales Register window appears. 

2 Click the Returns & Credits tab. A list of customer 
credits appears. 

3 If the credit you want to settle is not showing, select 
Customer from the Search By list to display a credit for 
a particular customer. Enter the customer’s name in the 
adjacent field and press TAB. A list of credits for that 
customer appears. 

4 Highlight the credit you want to apply and click Apply to 
Sale. The Settle Returns & Credits window appears, 
listing all open invoices assigned to the customer.
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5 Enter the amounts you want to apply to one or more open 
invoices in the Amount Applied column.

If the Apply Customer Payments Automatically 
to Oldest Invoice First preference is set, amounts will 
appear next to the oldest invoices in the Amount 
Applied column. 

However, you can apply the credit amount to any one 
transaction or you can divide it among many transactions 
in the list. Note that the total amount you apply in the 
Amount Applied column must equal the amount that 
appears in the Credit Amount field. This amount comes 
from the customer credit you selected above.

6 Enter an amount in the Finance Charge field if you want 
to apply part of a customer credit to any unpaid finance 
charges the customer may have accrued.

7 Click Record to apply the credit. 

To record a refund payment

1 Go to the Sales command centre and click Sales 
Register. The Sales Register window appears. 

2 Click the Returns & Credits tab. A list of customer 
credits appears. 

3 If the credit you want to settle does not appear, select 
Customer from the Search By list. Enter the customer’s 
name in the adjacent field and then press TAB. A list of 
credits for that customer appears. 

4 Select the credit you want to refund and click Pay 
Refund. A refund cheque for the amount of the credit 
appears in the Settle Returns & Credits window. 

5 In the Account field, enter or select an account.

For example, if you’re paying a credit card refund and you 
group all your credit card sales, choose your undeposited 
funds account. 

6 If you want to, change other information in the window, 
such as the transaction date. 

7 If you are paying by cheque and you have already written 
it, select the Cheque Already Printed option.

8 Specify how you want to send a remittance advice by 
selecting a delivery option from the Remittance 
Advice Delivery Status list and then click Record.
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Dealing with a customer who is also a supplier

If your business sells goods and services to a business from 
which you also make purchases, you need to record the 
transactions using a separate customer and supplier card. You 
can then record a contra payment to offset the receivable 
and payable amounts. 

Before you can record contra payments, you need to create a 
bank account called Contra Suspense. For more information, 
see ‘To create an account’ on page 21.

To record contra payments

1 Record a payment from the customer.
a In the Receive Payments window, click Deposit to 

Account and type or select the Contra Suspense 
account. 

b In the Customer field, type or select the customer’s 
name.

c Type the amount that you are offsetting against an 
invoice and click Record.

2 Record a payment made to the supplier:
a In the Pay Bills window, type or select the Contra 

Suspense account in the Pay from Account field. 
b In the Supplier field, type or select the supplier’s 

name.
c Type the amount that you need to offset against a 

purchase. 

After these entries are made, your bank accounts will not 
have been affected; yet the receivable and payable accounts 
have been reduced. The Contra Suspense account should be 
zero.

Accounting for bad debts

When you know that a debt will not be recovered, you need to 
write it off.

1 Create a Bad Debt expense account in your accounts list. 
For more information, see ‘To create an account’ on 
page 21.

2 Create a credit sale for the customer.
a Go to the Sales command centre and click Enter 

Sales.
b In the Sales window, click Layout. 

c In the Select Layout window, click Miscellaneous 
and then click OK. 

d In the Customer field, type or select the customer’s 
name.

e In the Description field, type a description of the 
transaction.

f In the Acct No. field, type or select the account for Bad 
Debts. 
If you account for bad debts by posting a provision to an 
asset account, you can select that account.
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g In the Amount field, type the bad debt amount as a 
negative number.

h Click Record. 

In the Settle Returns & Credits window, apply the 
credit against the customer’s original open invoice.
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6  Purchases
This chapter explains how to enter information about your purchases. You record a purchase by specifying the supplier details, the 
purchase form layout (item, service, professional or miscellaneous), status of the purchase (quoted, ordered or billed) and details of the 
purchased items or services. 

This chapter also explains how to pay your suppliers for these purchases, how to deal with a supplier who owes you money (settling a 
supplier debit) and how to analyse your entire purchasing activity with a variety of reports and analytical tools.

Creating a supplier card

Before you can record a purchase order, you need to create a 
card for your supplier.

To create a supplier card

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears.

2 Click New. The Card Information window appears.

3 Select Supplier from the Card Type list.

4 Select the designation of the card: company or individual.

5 Type the name of the supplier and press TAB. Additional 
fields appear.

6 Enter a code to identify this supplier in the Card ID field. 
For more information, see ‘Card identification codes’ on 
page 212.

7 Enter contact details for the supplier.

If you want to enter more contact information, select 
Address 2 from the Locations list and enter the 
additional details. You can enter contact details for five 
locations.

8 Click the Card Details tab. You can enter notes about 
the supplier, insert a picture and assign attributes to 
group and sort the card.

If you want to... See

insert a picture page 213

assign identifiers to the card page 204

assign an attribute from a custom list page 205

enter additional information in a 
custom field 

page 212
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9 Click the Buying Details tab and enter your buying 
details.

10 [Optional] Click the History tab and type the dollar value 
of the purchases made prior to your conversion month. 
You can also type or select the date that the contact 
became a supplier.

11 Click OK to close the Card Information window.

A Buying 
informati
on

The selections you make here will be used, 
by default, on quotes, orders and bills that 
you create for this supplier. You can override 
these selections when recording the 
purchase. 

B Credit 
terms

The credit terms you entered earlier appear 
here by default. You can override them here 
for this supplier. The credit terms entered 
here are used as the default terms for all 
purchases from the supplier, but can be 
changed at any time.

C Tax 
informati
on

The supplier’s tax information is entered 
here. If the supplier’s tax status takes 
precedence over that of the item or service 
being sold, select the Use Supplier’s Tax 
Code option. For more information, see 
‘Assigning tax codes to cards’ on page 153.

A

B

C
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Entering purchases

You can enter a purchase as a quote, order, receive item 
or bill.
 You can enter a quote to store an estimate or quote you 

received from one of your suppliers. A quote has no 
impact on your inventory levels and can be changed to an 
order or a purchase when you are ready to purchase.

 An order is a purchase where no service or item has been 
received. While orders do not affect your financial figures, 
they are included in your inventory reports. Orders do not 
create transactions unless you have paid a deposit to the 
supplier. An order can be changed to a purchase but not to 
a quote.

 A receive item purchase records the receipt of items 
you have ordered but have not yet been billed for. When 
you record items received, the item is added to your 
inventory and the cost of the item is added to an accrual 
account for inventory items until you record a purchase 
for it. You record items received against an order.

 A bill is usually created when you receive the items or 
services you ordered and are required to pay the supplier 
(that is, you have been charged for the purchase). 
Recording a bill will update the appropriate accounts, 
including the account for tracking payables. Bills can be 
open (unpaid), closed (paid) or debit (negative purchase). 
A bill cannot be changed to a quote or an order.

You can enter a purchase in:

 the Purchases window

 the Bank Register window.

The procedure described in this section is for entering 
purchases in the Purchases window, which enables you to 
record full details about a transaction.

Bank Register window Entering a purchase in the Bank 
Register window is a fast way to enter a purchase 
transaction. However, you can enter less detail about the 
purchase than if you entered it in the Purchases window. For 
more information, see ‘To enter a transaction in the Bank 
Register window’ on page 48. 

Entering a purchase transaction
Complete the following steps to enter a purchase 
transaction:

Task 1: Enter information about the 
supplier
1 Go to the Purchases command centre and click Enter 

Purchases. The Purchases window appears.

2 In the Supplier field, select the supplier’s name.
The terms shown in the Purchases window are the terms 
recorded in the supplier’s card.

Task See

1 Enter information about the supplier below

2 Choose the type of purchase page 86

3 Enter the items or services you are purchasing page 86

4 Enter additional information about the 
purchase

page 87

5 Complete the purchase page 88
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3 Complete the fields as described in the table below.

Task 2: Choose the type of purchase
Choose the status and layout for the purchase. The default 
layout displayed in the Purchases window is determined by 
the selection you made when you set up purchase details 
(using the Purchases Easy Setup Assistant) or created 
the supplier’s card. 

1 Check whether the default layout is appropriate. 

There are four layouts to choose from: Service, Item, 
Professional and Miscellaneous. To change the default 
layout:
a Click Layout. The Select Layout window appears. 
b Choose the layout you want to use and click OK.

2 Select the status from the list in the top left corner of the 
window: Quote, Order, Receive Item or Purchase. Receive 
Item only appears if you choose Item layout. 

Task 3: Enter the items or services you 
are purchasing
The scrolling list in the middle of the Purchases window is 
where you enter details of what you are buying. In this area, 
you enter item numbers, descriptions, account numbers (or 
account names, depending on your selection in the 
Preferences window) and other information about your 
transaction.

One row in the scrolling list is one line item of the transaction. 
You can enter as many line items for a purchase as you want.

The fields in the scrolling list differ according to the type of 
purchase you are creating. The following illustration shows 
the fields for a purchase with an Item layout and a Bill status.

A Click the zoom arrow ( ) to alter the terms for this 
purchase only. If you want to change the credit terms for all 
future purchases to this supplier, you must make that 
change on the Buying Details tab of the supplier’s card.

B Type the purchase order number or accept the default 
number in the Purchase # field.

C If the supplier gave you an invoice number, enter it in the 
Supplier Inv# field.

D If the purchase amounts you want to enter include tax, 
select the Tax Inclusive option. Do not change this 
option after entering an amount in the Amount column.

CBA D

A Bill The quantity you have been invoiced for.

B Received This field is read-only. It displays the quantity of 
items received. For more information, see 
‘Receiving items without a supplier invoice’ on 
page 89.

C Backorde
r

The quantity of the item back ordered. An order 
for this amount will be created automatically when 
you click Record. 

D Item 
Number

Pressing TAB here displays the item list from which 
you can choose the item being purchased. 

E Descripti
on

A description of the item appears automatically. 
You can change this if you want. 

A B C E F G HD I J K

Item layout
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The following illustration shows the fields for a purchase with 
a Service layout and a Bill status. This also applies to the 
Professional and Miscellaneous layouts.

NOTE : Add lines, subtotals and headers to purchases
You can add lines, headers and subtotals to purchases to make it 
easy to separate and subtotal different groups of line items on 
one purchase. For more information, see ‘Adding lines, headers 
and subtotals to purchases’ on page 88.

Task 4: Enter additional information 
about the purchase
The fields that appear at the bottom of the Purchases 
window differ, depending on the type of purchase you are 
creating.

F Location [ABSS Premier range only] If you store this item in 
multiple locations, you can select the location 
where the item will be received. For more 
information, see ‘Multiple inventory locations’ on 
page 110.

G Price The price of the item appears automatically. You 
can change this if you want. 

H Disc% [Optional] The volume discount as a percentage. 

I Total The total price is calculated automatically. 

J Job [Optional] Selecting a job number here assigns a 
line item to a specific job. 
For more information about jobs, see ‘Setting up 
jobs and sub-jobs’ on page 232. 

K Tax Type or select a tax code for the line item.

A Descripti
on

 A description of the goods or services purchased.

B Acct # or 
Account 
Name

The account to assign to the purchase. Pressing TAB 
here displays the accounts list from which you can 
choose an account. 
This should be an expense or cost of sales account. 
You should not select your payables account for 
ordinary purchases. 

C Amount The amount you have been invoiced.

D Tax Type or select a tax code for the line item.

A B C D

Service layout

A Optional 
fields

Enter optional details, such as a comment, shipping 
method and the date the goods or services were 
promised. 

B Freight Type any charges for freight. 

C Freight tax Type or select the tax code for the freight charges. 

D Tax Click the zoom arrow ( ) if you want to view or 
change the tax amounts assigned to the sale.

E Journal 
Memo

The journal memo is generated automatically. You 
can change it if you want.

A

B C

D

FE

G
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NOTE : Recap transaction Before you record this transaction, 
you can use the recap transaction feature to view the journal 
entries that will be created when the transaction is recorded. 
This is useful for confirming that the journal entries are posted 
to the correct accounts. To recap, choose Recap Transaction 
from the Edit menu.

Task 5: Complete the purchase
After you have finished entering the details in the Purchases 
window, there are several ways to complete the transaction.

TIP : Save the purchase as a recurring purchase Click 
Save as Recurring. In the Edit Recurring Schedule 
window, enter the necessary information and click Save. For 
more information, see ‘Recurring transactions’ on page 167.

 If you want to record the purchase without printing or 
sending it, click Record. 

 If you want to record the purchase and print, send or save 
it as a PDF, complete the relevant procedure below.

Adding lines, headers and subtotals to 
purchases
You can add lines, headers and subtotals to purchases. 

To insert a blank line 

1 In the Purchases window, click in the line below where 
the blank line is to appear.

2 Go to the Edit menu and choose Insert Line.

To insert a header

You can group several line items by inserting a header.

F Paid Today Type an amount here to indicate how much money 
you paid at the time of the purchase or, if you are 
creating an order, how much money you gave as a 
deposit.

G Bill Delivery 
Status

If you want to print or email the purchase in a 
batch, select the required delivery method from 
the list. For more information, see ‘Sending forms in 
a batch’ on page 187. 

To… Do this...

Print Click Print and choose the type of form you want 
to use. For more information about printing, see 
Chapter 13, ’Forms,’ starting on page 185.

Print 
preview

Click Print and choose Preview to preview the 
purchases form for this transaction.
Note that the transaction will be recorded before 
the form is displayed.

Email Click Send To and choose Email. Review and 
make entries in the Email window and click Send. 
The email, which will include a PDF (Portable 
Document Format) attachment, will be sent to 
the Outbox of your default email software. Send 
the email from your email software. 

Fax Click Send To and choose Fax. A window from 
your fax software appears. Send the fax, using 
your fax software as you normally do.

Save as 
PDF

Click Send To and choose Disk. In the window 
that appears, enter a name and location for the 
PDF file and click Save. 
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1 In the Purchases window, click in the line below where 
the header is to appear.

2 Go to the Edit menu and choose Insert Header. A blank 
line will appear in the scrolling list with the cursor 
positioned in the Description column.

3 Type the text for the header. The text appears in grey.

4 Press TAB to complete the header entry.

To insert a subtotal

1 In the Purchases window, click in the line below the 
items to be subtotalled.

2 Go to the Edit menu and choose Insert Subtotal. A line 
appears displaying the subtotal of the individual amounts 
that appear above the subtotal line and below the last 
subtotal, if there is one.

To delete a blank line, line item, header or 
subtotal

1 In the Purchases window, click anywhere on the blank 
line, line item, header or subtotal you want to delete.

2 Go to the Edit menu and choose Delete Line.

Receiving items without a supplier invoice

If you receive items from a supplier and have not been 
invoiced for them, you may not know the actual amount 
payable to the supplier. However, if you inventory these items, 
you will need to add them to your on-hand inventory before 
you can sell them. But, as you do not know the amount 
payable, you shouldn’t record an amount owed to the supplier 
at this time.

Instead, you can record the receipt of these items using a 
purchase transaction with a Receive Item status. When you 
record a purchase with a Receive Item status, you enter an 
estimated purchase amount, which is then allocated to an 
accounts payable accrual account. Your accounts payable is 
not affected at this time. 

Later, when your supplier invoices you for the items, you can 
record a bill with the actual purchase amount. When you 

record the bill, the actual purchase amount is allocated to 
your accounts payable and the estimated amount is removed 
from the accrual account.

Before you can record items received without a supplier 
invoice, you need to set up an accrual account for them. 

Setting up an accrual account for items 
received without a supplier invoice
When you record items received without a supplier invoice, 
you need to allocate the anticipated purchase amount to a 
creditors accrual account. 

If the account doesn’t exist, you need to create it. The 
account should be a liability account named, for example, 
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APAccrual - Inventory. For information on creating an 
account, see ‘To create an account’ on page 21. 

Before you can allocate transactions to this account, you 
need to make it the default linked account for items received 
without a supplier invoice.

To link an account for items received

1 Go to the Setup menu, choose Linked Accounts and 
then Purchases Accounts. The Purchases Linked 
Accounts window appears.

2 Select the I can receive items without a Supplier 
bill option.

3 In the Liability Account for Item Receipts field that 
appears, type or select the accrual account, for example, 
APAccrual - Inventory.

4 Click OK.

Recording items received without a 
supplier invoice
You need to record items received against a supplier purchase 
order. If the order already exists, simply record the items 
received against the order. If no order exists, you can create 
one when you record the items received. 

To record items received against an order

You can record items received against an existing order in the 
Purchases window or from the Purchases Register 
window.

1 Locate the order:
 In the Purchases window, type or select the name of 

the supplier whose order you want to update. Select 
the order from the list that appears and click Use 
Purchase, or

 In the Purchases Register window, click the Orders 
tab. Find the required order and highlight it. 

2 Click Receive Items. The Purchases window appears 
with the Receive Item status.
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3 In the Receive field, type the item quantity received.

4 [ABSS Premier range only] If you keep items at multiple 
locations, type the location where you received the items 
in the Location field, or select it from the list. Note that 
the Location field only appears if you have multiple 
locations.

5 Click Record. The items are recorded in your inventory 
and the original order is updated with the number of 
items received.

When you receive the supplier’s bill, you need to convert 
the order to a purchase. For more information, see ‘To 
convert an order to a bill’ on page 93.

To create an order when you record items 
received

If there is no purchase order for the items received, you can 
create an order when you record the receipt.

1 Go to the Purchases command centre and click Enter 
Purchases. The Purchases window appears.

NOTE : Recording items received from the Inventory 
command centre You can also record items received by 
clicking Receive Items from the Inventory command 
centre. The Purchases window appears with the Receive 
Item purchase status. 

2 In the Supplier field, type the supplier’s name, or select 
it from the list. 

3 If the Item layout does not appear:
a Click Layout. The Select Layout window appears.
b Select Item and then click OK.

4 Select Receive Items from the status list in the top-left 
corner of the window.

5 Enter the purchase date and your order number. 

6 In the Ordered field, type the quantity you ordered. This 
can be more than the quantity received.

7 In the Receive field, type the quantity received. 

8 In the Item Number field, type the number of the item 
received, or select it from your items list.

9 [ABSS Premier range only] If you keep items at multiple 
locations, type the location where you received the items 
in the Location field, or select it from the list. Note that 
the Location field only appears if you have set up 
multiple locations.

10 In the Price field, enter the estimated price for the items.

11 Click Record. The items are recorded in your inventory 
and a purchase order is created with the number of items 
received.

When you receive the supplier’s bill, you need to convert 
the order to a purchase. For more information, see ‘To 
convert an order to a bill’ on page 93.
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Creating a purchase order from a sale
If you want to order items to fulfil a sale, you can create a 
purchase order using sales quote or sales order details that 
you have recorded.

To create a purchase order from a sale

1 Go to the Sales command centre and click Sales 
Register. The Sales Register window appears.

2 Locate and select:
 a quote—click the Quotes tab and select the required 

quote
 an order—click the Orders tab and select the required 

order. 

3 Click Create PO. The Purchases window appears with 
the new purchase order displayed. The items you entered 
for the sale automatically appear as line items on the 
purchase order.

4 Select a supplier in the Supplier field. Note, if you have 
nominated a supplier for these items in the item setup, 
this supplier will appear by default.

5 Enter the cost of the items in the Price column.
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6 Complete the purchase order as you normally would. For 
example, you may want to change the transaction date to 
today’s date, or add items to the order.

7 Click Record. The new purchase order is created and the 
original sales quote or order remains in the Sales 
Register window.

Changing the status of a purchase

If you enter a quote or an order, you can easily convert it to a 
bill once the amount is payable. A quote can be converted to 
an order or a bill. An order can only be converted to a bill. 
Quotes and orders must be converted to bills to show as 
payable.

To convert a quote to an order or a bill

You can convert a quote to an order or a bill from the 
Purchases window or from the Purchases Register 
window.

1 Go to the Purchases command centre and click 
Purchases Register. The Purchases Register 
window appears.

2 Click the Quote tab. 

3 Find the required quote and select it.

4 If you want to convert the quote to: 
 an order, click Change to Order. The Purchases 

window appears.
 a bill, click Change to Bill. The Purchases window 

appears.

5 If you want to, you can update the information in the 
Purchases window, such as the transaction date.

6 Click Record. The bill or order is recorded. 

The original quote will remain in the Purchases 
Register window unless you have indicated in the 
Preferences window that you want quotes to be 
deleted once they are recorded as orders or bills. 

To convert an order to a bill

You can convert an order to a bill in the Purchases window 
or from the Purchases Register window. If you want to 
convert several orders to bills simultaneously, see ‘To 
simultaneously convert several orders to bills’ on page 94.

1 Go to the Purchases command centre and click 
Purchases Register. The Purchases Register 
window appears.

2 Click the Orders tab. 

3 Find the required order and select it. 

4 Click Change to Bill. The Purchases window appears, 
displaying the bill.

5 If you want to, you can update the information in this 
window, such as the transaction date.

6 Click Record. A new bill is recorded and the original order 
is removed from the Purchases Register. 
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To simultaneously convert several orders to 
bills

You can simultaneously convert several orders to bills in the 
To Do List window. 

1 Click To Do List from any command centre. The To Do 
List window appears. 

2 Click the Orders tab to display a list of all your orders. 

If you want to view details about a specific order, click the 
zoom arrow ( ) to the right of the supplier’s name.

3 Select the orders you want to convert to bills by marking 
the select column ( ).

4 Click Record as Actual.
5 In the window that appears, enter a date for the selected 

transactions. This is the date that the transactions will be 
recorded in your accounts.

6 Click OK. 

Reviewing your purchase information

There are several tools that you can use to review your 
purchases information. 

To view purchases information using Business 
Insights
Business Insights presents a summary of your purchases 
information, including which suppliers you owe money to and 
how much is overdue. You can also see how much you owe 
suppliers for each ageing period, as well and view your 
purchases history with your suppliers.

To find information specific to your needs, sort the table 
columns by clicking a column heading. For example, you can 
find the most overdue supplier payments or the largest 
overdue amounts.

Tool Description See

Business 
Insights

Use Business Insights to analyse 
purchases and supplier information.

below

To Do List The To Do List displays all open 
purchases, recurring purchases and 
orders, sorted by due date.

page 95

Analyse 
Payables

The Analyse Payables window 
provides details of your purchase 
activities.

page 96

Purchase 
reports

Purchase reports help you keep track 
of your purchase activities.

page 96

Purchase 
history

Purchase history lets you view seven 
years of purchase history for an item 
or a supplier.

page 96

Find 
Transactio
ns

The Find Transactions window 
helps you find purchase transactions 
quickly.

page 162

Purchases 
Register

The Purchases Register window 
gives you a complete picture of your 
purchase activity—open and closed 
purchases, orders, quotes, returns, 
and so on.

page 162

Transactio
n Journal

The Transaction Journal window 
lists journal entries of your purchases 
and other transactions.

page 164

Tool Description See
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1 Go to the Accounts command centre and click Business 
Insights. The Business Insights window appears.

2 View the Suppliers I need to pay panel. 

This panel shows the total payments you owe suppliers 
and details of each overdue supplier payment (based on 
their credit terms), including the number of days overdue.

3 Click Analyse suppliers to view graphs and information 
about the money you owe suppliers and the payment 
history of each supplier. 

You can use this information to:
 Keep on top of your supplier 

payments Identify which supplier payments are due 
or which suppliers you owe the most money to.

 Negotiate a payment or discount with a 
supplier View your payment history with the 
supplier, such as the average number of days it takes you 
to pay them.

4 If you want to use one of the graphs or tables in another 
document, right-click it and choose:
 Copy to Clipboard. This copies the graph or table to 

the clipboard, ready to paste into a document. Note 
that you can edit table information after it is pasted in a 
document.

 [Graphs only] Save As. Choose where you want to 
save the image and click Save. This saves the graph as 
an image file, so you can use it later.

5 Click Close to return to the main Business Insights 
window.

For more information about the calculations shown in 
Business Insights, see the Help Centre.

To view a list of all unpaid bills sorted by days 
overdue
You can view a list of all unpaid bills in the To Do List and 
enter supplier payments for those purchases. 

1 Click To Do List in any command centre. The To Do List 
window appears.
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2 Click the A/P tab. A list of all unpaid purchases appears. 

The Overdue column shows the number of days a bill is 
overdue (a negative number in the Overdue column 
indicates that the payment is not yet due). The number of 
days a bill is overdue is calculated by checking the original 
date of purchase, comparing it to today’s date and 
looking at your credit terms with the supplier.

To analyse payables

The Analyse Payables window enables you to view 
detailed information about how much you owe suppliers and 
how long you have owed them. This analysis is based on all 
purchases and payments recorded in your company file. 

1 Go to the Purchases command centre and click 
Analysis. The Analyse Payables window appears.

2 Click Filters. The Ageing Date window appears.

3 Set your filters in the Ageing Date window and click OK.

4 Select the required view of the Analyse Payables 
window:
 The Summary view displays all the money that you 

owe suppliers, totalled by supplier. 
 The Supplier Detail view displays all the money that 

you owe the supplier selected in the Supplier Detail 
field.

 The Purchase Detail view displays all the 
transactions assigned to the purchase selected in the 
Purchase Detail field.

The information in this window is based on the entries you 
made above in the Ageing Date window, and the 
selections you made in the Ageing fields in the Reports 
& Forms tab of the Preferences window. 

To view purchase reports 

There are several purchase reports that can help you track 
your purchase activity. For example, you can run a Payables 
Reconciliation Summary report if you want to analyse 
your payables at a given date. The Analyse Purchases 
Items Spreadsheet report shows you the inventory items 
which are costing you the most money. 

1 Go to the Reports menu and choose Index to 
Reports. The Index to Reports window appears.

2 Click the Purchases tab. A list of purchase reports 
appears. For information on displaying, customising and 
printing your reports, see Chapter 12, ’Reports,’ starting 
on page 175.

To view purchase history 

You can view the purchase history for an item or a supplier. 

1 Display the Item Information window for an item or 
the Card Information window for a supplier.

2 Click the History tab. 

The History tab displays a total of seven years of 
purchase history for the item or card: the five years 

Paying bills
If you have recorded a bill, you pay the supplier in the Pay 
Bills window. In this window you can record the payments to 
one or more of your outstanding bills.

You can also make payments to suppliers in the Bank 
Register window, especially if you have several bills to pay 
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and do not need to record detailed information for each 
payment. 

When you use the Bank Register window to make supplier 
payments, the entire payment is automatically allocated to 
the oldest bill first. For more information, see ‘Entering 
transactions in the Bank Register window’ on page 48.

You can pay several outstanding bills at once in the To Do 
List window. For more information, see ‘To pay several bills at 
once’ on page 99.
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The options for recording payments are summarised in the 
following diagram.

To pay bills

1 Go to the Purchases command centre and click Pay 
Bills. The Pay Bills window appears.

2 If you want to change the default account to pay the bill, 
type or select a different account in the Account field.

3 Type the supplier’s name or select the supplier from the 
list using the search icon ( ).

NOTE : If you receive an alert message If you have 
outstanding supplier debits with this supplier, a message 
may appear. You will have the opportunity to settle the 
supplier debits immediately or at a later date. See ‘Settling 
supplier debits’ on page 101.

4 [Optional] Change the memo and payment date if 
necessary.

5 In the scrolling list in the bottom half of the window, 
indicate which bills are covered by the payment by 
entering amounts in the Amount Applied column.

A Pay All Click Pay All if you are settling your account 
in full. The total payment amount appears in 
the Amount field and the individual payment 
amounts are applied to each open bill.

B Discoun
t

If you are taking an early-payment discount for 
a purchase, assign the discount to the 
appropriate bill in this column. 
Note that you cannot assign a discount to a bill 
that you are not settling in full. If this is the 
case and you want to record a discount that 
the supplier has given you, you can create a 
supplier debit. See ‘Creating supplier debits’ 
on page 100.

C Amoun
t 
Applied

The amount of the payment you want to apply 
to each bill. The amounts you apply in this 
column are accumulated in the Total Applied 
field. 

CBA

D
E
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6 If you are recording a cheque payment and the cheque has 
already been written, or if you are recording a transaction 
that doesn’t require a printed cheque (such as a 
petty-cash payment or Internet payment), select the 
Cheque Already Printed option.

7 If you want to send remittance advice in a batch, select an 
option from the Remittance Advice Delivery Status 
list. 

After you have recorded a number of payments, say, the 
day’s payments, you can print or email remittance advices 
in a batch. For more information, see ‘Forms’ on page 185.

8 If you want to preview the remittance advice or cheque 
for this transaction, click Print and then choose 
Preview Cheque or Preview Remittance Advice. 
Note that the transaction is recorded before it is 
displayed.

9 If you want to print a cheque or remittance advice now, 
click Print and select the form type you want to print. 
Note that the payment is recorded before it is printed.

10 Click Record.

To pay several bills at once

You can pay several bills at once in the To Do List window. 
The linked account for paying bills will be used for all supplier 
payments made from this window. 

1 Click To Do List in any command centre. The To Do List 
window appears.

2 Click the A/P tab. A list of all unpaid bills appears.

3 If you want to view details about a specific purchase, click 
the zoom arrow ( ) next to the bill.

4 Click in the select column ( ) next to each bill you want 
to pay. 

5 Click Pay Bills. 

D Finance 
Charge

If part of the payment was used to pay finance 
charges, enter the finance charge amount here.

E Out of 
Balance

The Out of Balance amount must be zero 
before you can record the transaction. 
This field will show an amount if there is any 
variance between the Total Paid amount and 
the Amount field in the top half of the 
window. If this happens, correct the amounts in 
the Amount Applied and Finance Charge 
fields. 
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6 In the window that appears, enter a date for the selected 
transactions. This is the date that the transactions will be 
recorded in your accounts. 

7 Click OK and then click Close.

Creating supplier debits 
A supplier debit is money that a supplier owes you.

Recording supplier debits
You can create a supplier debit in one of two ways:

 Reverse an existing purchase. Use this method if you 
have been debited for the entire purchase. 

 Manually create a debit. Use this method if you have 
been debited for part of a purchase. 

To reverse an existing purchase

Your company file transactions must be set to unchangeable 
before you can reverse a purchase; that is, the Transactions 
CAN’T be Changed; They Must be Reversed option 
must be selected in the Security tab of the Preferences 
window.

1 Find and display the purchase. For more information, see 
‘Finding a transaction’ on page 161.

2 Go to the Edit menu and choose Reverse Purchase. A 
supplier debit appears in the Purchases window.

3 If you want, you can make some changes to the supplier 
debit (such as changes to the date and memo), but you 
cannot change the accounts, amounts and quantities that 
are associated with the debit. 

4 Click Record Reversal. 

To manually create a debit for a non-item 
purchase

1 Go to the Purchases command centre and click Enter 
Purchases. The Purchases window appears.

2 In the Supplier field, type the supplier’s name or select it 
from the list. 

The terms and delivery address shown in the Purchases 
window are the details recorded in the supplier’s card. 

3 Select Bill from the list in the top left corner of the 
window. 

4 Click Layout, select Miscellaneous and then click OK.

5 In the Description field, type the reason for the supplier 
debit.

6 In the Acct # field, type the account number to be 
debited or select it from the list. This is normally an 
expense account called Purchases Returns. 

7 In the Amount field, type the amount of the debit as a 
negative amount.

8 Click Record. 



C R E A T I N G  S U P P L I E R  D E B I T S   1 0 1

To manually create a debit for an item 
purchase

1 Go to the Purchases command centre and click Enter 
Purchases. The Purchases window appears.

2 In the Supplier field, type the supplier’s name or select it 
from the list. The terms and delivery address shown in the 
Purchases window are the details recorded in the 
supplier’s card.

3 Select Bill from the list in the top left corner of the 
window. 

4 Click Layout, select Item and then click OK.
5 In the Bill field, type the quantity of the item you are 

returning as a negative number. 

6 In the Item Number field, type the item number or 
select it from the list. The cost of the item is displayed as 
negative amount in the Total field. 

7 Click Record.

Settling supplier debits
You can settle a supplier debit in one of two ways: 

 Apply the debit to an unpaid purchase. Use this method to 
apply the supplier debit to one or more of your unpaid 
purchases from the supplier, or 

 Receive a refund. Use this method to record the receipt of 
a refund cheque from the supplier.

To apply a supplier debit to an unpaid 
purchase

1 Go to the Purchases command centre and click 
Purchases Register. The Purchases Register 
window appears.

2 Click the Returns & Debits tab.

3 Select Supplier from the Search By list. Enter the 
supplier’s name in the adjacent field. A list of debits for 
that supplier appears. 

4 Highlight the debit you want to apply and click Apply to 
Purchase. The Settle Returns & Debits window 
appears, listing all open purchases that you have made 
from the supplier. 

5 Enter the amount you want to apply to a purchase in the 
Amount Applied column. 

If the Apply Supplier Payments Automatically to 
Oldest Bill First preference is selected in the 
Purchases view of the Preferences window, amounts 
will appear next to the oldest purchase in the Amount 
Applied column. You can apply the debit amount to any 
one transaction or you can split it over any of the 
transactions in the list, but the total amount you apply in 
the Amount Applied column must equal the amount 
that appears in the Debit Amount field.

6 If you want to apply part of the supplier debit to any 
unpaid finance charges you have accrued, type an amount 
in the Finance Charge field. 

7 Click Record to apply the supplier debit.

If the transaction is unbalanced, that is, if the total 
amount entered in the Amount Applied column 
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doesn’t equal the amount displayed in the Debit 
Amount field at the top of the window, a message 
appears. Click OK to close the message and then check 
that the amounts you have applied to the various 
transactions are correct. 

To record a refund cheque

1 Go to the Purchases command centre and click 
Purchases Register. The Purchases Register 
window appears. 

2 Click the Returns & Debits tab.

3 Select Supplier from the Search By list. Enter the 
supplier’s name in the adjacent field. A list of debits for 
that supplier appears. 

4 Highlight the debit that is being refunded and click 
Receive Refund. A refund cheque for the amount of the 
supplier debit appears in the Settle Returns & Debits 
window.

5 Click Record to record the refund cheque.
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Adding finance charges paid to suppliers

Finance charges are amounts added to an outstanding 
balance as a penalty for late payment to one of your suppliers. 
If your supplier has added a finance charge to your account, 
you can enter the amount in the Pay Bills window.

Setting up and recording finance 
charges
Before you can record finance charges, you need to select an 
account for tracking the charges. Go to the Setup menu, 
choose Linked Accounts and then Purchases Accounts. 
Select the I pay charges for late payment option and 
select an expense account to record the late payment 
charges.

Although you cannot track the history of finance charges, you 
can perform an account inquiry (using Find Transactions) 
on the finance charge linked account to view the amounts 
paid.

Deleting finance charges
If you enter a finance charge in the Pay Bills window, two 
transactions are recorded:

 the full supplier payment, including the finance charge, is 
recorded in the disbursements journal, and

 the finance charge is recorded in the purchases journal.

Therefore, if you want to delete a finance charge 
payment, you must delete both transactions. If only one 
entry is deleted, the Payables Reconciliation 
Summary report may show an out-of-balance amount 
equal to the finance charge. When you delete one of the 
entries, you will be reminded to delete the other entry 
for the finance charge. Note that the warning will appear 
even though you may have already deleted the 
corresponding payment.
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7  Inventory
The inventory feature enables you to track the quantity and value of the items you have in your inventory. You can:

 compensate for inventory variations. For example, you may find that, from time to time, your recorded inventory levels differ from 
what is on the shelves. These variations can be caused by data-entry errors, spoilage and theft, etc. 

 revalue your inventory. Sometimes the quantity of items recorded may be correct, but their values are incorrect. For example, a range 
of items may become outdated.

 track the assembly of individual items into finished items. Many retailing and manufacturing businesses combine a number of 
inventory items to create finished items. For example, a retailer may combine a bottle of perfume, lotion and bath salts to make up a 
gift pack.

Creating items

Before you begin to track your inventory, you need to create a 
record for each item of inventory. An item can be:

 a physical unit that your company may buy, sell or 
inventory

 a service that your company wants to include on item 
invoices, for example, ‘Shipping’, ’Handling’, and so on.

When you create an item record, you can choose to buy, sell 
or inventory the item. These selections determine what 
functions you can use the item with. For example, if you want 
to include a service item on an invoice (such as installation), 
you need to specify that you sell the item.

An item that you inventory is an item whose quantities and 
values you want to track. Maintaining an accurate record of 
on hand levels of these items requires you to do regular 

maintenance tasks. For example, you may need to record an 
inventory adjustment to write-off damaged stock.

Select... For...

I Buy this Item Items or services you want to include on an 
item purchase order.
This includes items that are not for resale, 
and you do not need to track their 
quantities and values. For example, items 
for office use only.
It can also include raw materials you use as 
components to build other inventory 
items.
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Inventory opening balances If you have existing 
on-hand quantities of inventory items, you need to record the 
opening inventory level for each item. For more information, 
see ‘Enter your inventory opening balances’ on page 37.

To create an item

1 Go to the Inventory command centre and click Items 
List. The Items List window appears.

2 Click New. The Item Information window appears.

3 In the Item Number field, type a unique identifier and 
press TAB.

4 In the Name field, type the name of the new item.

TIP : Copy From button To copy another item’s 
information to this item record, click Copy From. From the 
displayed list, choose the item whose information you want 
to copy. All information for that item will be copied to the 
current item record except the item number, item name, 
supplier number, auto-build information and history 
information.

5 Specify whether you buy, sell and/or inventory this item 
by selecting the relevant options.

As you select the options, fields appear next to them. 
These fields change according to the combination of 
selections you make.

6 Enter the appropriate accounts:

 In the Cost of Sales Account field, type or select the 
account you want to use to record the costs associated 
with producing this item. 

 In the Income Account for Tracking Sales field, 
type or select the account you want to use to record 
the income you receive from the sale of this item. 

 In the Asset Account for Item Inventory field, 
type or select the account you want to use to record 
the total value of this item.

 In the Expense Account for Tracking Costs field, 
type or select the account you want to use to record 
costs associated with purchasing this item. 

7 Click the Buying Details tab. The Buying Details view 
of the Item Information window appears. Complete 
the fields as explained below.

I Sell this Item Items or services you want to include on an 
item invoice.

I Inventory this 
Item

Items you buy or sell and whose quantity 
and values you want to track.
It can also include intermediate goods used 
in the productions process, such as parts 
used to manufacture finished goods. 

Select... For...

A [Optional] Enter the standard cost of an item.
To use the standard cost price as the default price of an 
item, select Use Standard Cost as the Default Price 
on Purchase Orders and Bills preference in the 
Preferences window (Inventory tab). 

B Type the unit of measure (such as ‘each’ or ‘unit’) by which 
you purchase the item. The buying unit is printed on the 
purchase order. For example, if you buy eggs by the carton 
unit, when you order five units in a purchase you are ordering 
five cartons. 

A
B

D

E

C
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8 Click the Selling Details tab. The Selling Details view 
of the Item Information window appears. Complete 
the fields in this tab as explained below.

C Enter the number of items that comprise a single buying 
unit. This is the number that is added to your on-hand 
inventory. For example, if you buy eggs by the carton unit 
but want to track their purchase individually, enter 12 as the 
number of items per buying unit. When you order one carton 
unit, your item inventory is updated by twelve items. If you 
leave this field blank, the value defaults to one. 

D Enter the restocking information:
• Enter the minimum level of this item you want to keep in 

your inventory. When you drop below this level, a re-order 
reminder appears in the To Do List.

• Enter the supplier from whom you usually re-order this 
item. 

• Enter the supplier’s number for the item.
• Enter a re-order level quantity for the item here. If you 

have set a minimum level for restocking alert, you can 
create an order for the items easily using the Stock 
Alert tab in the To Do List. The default quantity 
showing on the order will be taken from this field.

E Choose the tax code you want to use when you purchase 
this item. Note that you can override the tax code when you 
record the purchase.

A Type the retail price of one selling unit.

B Type the selling unit of the item (such as ‘each’ or ‘unit’). 
You can type up to five characters. The selling unit is 
printed on the item invoice. If for example you sell by the 
six-pack, when you sell five units, you will be selling five 
six-packs.

C Type the number of items that comprise a single unit in this 
field. This is the number that is subtracted from your 
on-hand inventory for every selling unit. For example, if you 
sell by the six-pack, enter 6 as the number of items per 
selling unit. When you sell one six-pack, your item 
inventory is reduced by six items.

D [ABSS Premier range only] You can set pricing levels for 
different customers. See ‘Creating custom price levels’ on 
page 121.

E Select the tax code you want to use when you sell this 
item. Note that you can override the tax code on invoices.

F If you want to indicate that all prices on the Selling 
Details tab are tax inclusive, select the Prices are Tax 
Inclusive option. Deselect this option to indicate that the 
prices are tax exclusive.

A

B
C

D

E
F
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9 Click the Items Details tab and enter additional 
information about the item.

10 [ABSS Premier range only] If this item is stored in multiple 
locations, click the Locations tab and select the default 
location for buying and selling the item.

11 Click OK.
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Average Cost, Last Cost and Standard 
Cost
Average Cost is calculated as the total cost of an item 
(the total amount you have paid to purchase the item or the 
cost entered when you transferred the item into inventory) 
divided by the number of units of that item you have on hand. 

Last Cost is the most recent purchase price for the item.

Standard Cost can be used instead of the last purchase 
price as the default price on purchases. To use the standard 
cost price as the default price, select Use Standard Cost 
as the Default Price on Purchase Orders and Bills 
option in the Preferences window (Inventory tab).

Making inventory adjustments

From time to time you may need to adjust item quantities and 
values. For example, if items get damaged, you may have to 
write off some of your inventory or revalue it. 

Use the Adjust Inventory function to make an adjustment 
to one or a few items. If you need to update the quantities of 
several items, use the Count Inventory function, see 
‘Performing stocktakes’ on page 116. 

NOTE : Print the Items List Summary report When 
making inventory adjustments, you may find it useful to print 
the Items List Summary report. This report displays on-hand 
quantities and values of your items.

To make an inventory adjustment

1 Go to the Inventory command centre and click Adjust 
Inventory. The Adjust Inventory window appears.

2 Enter details of the adjustment.

A Enter the item number by clicking in the Item Number 
column. Press TAB and then select the item from the list that 
appears.

B Enter the quantity variation amount in inventory units, not 
buying or selling units. If you enter a positive number, that 
number is added to your on-hand inventory. If you enter a 
negative number, that number is subtracted from your 
on-hand inventory.

C Enter the cost of each unit transferred into or out of 
inventory. The average cost of the item appears by default. 
If these are new items, enter their purchase cost.

D The Amount field displays the quantity multiplied by the 
unit cost.

E The allocation account is usually a cost-of-sales or expense 
account. 

DA CB E
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3 Click Record to save the inventory adjustment.

The following are some examples of inventory adjustments. 

Example 1 In the following example, the inventory 
adjustment will increase the number of units on hand by two 
and the total value of the items on hand by $200.

Example 2 In the following example, the inventory 
adjustment will decrease the number of units on hand by two 
and the total value of the items on hand by $200.

Example 3 In the following example, the inventory 
adjustment will increase the number of items on hand by two 
but will not adjust the total value of the items. The average 
cost of the items will decrease as a result of this adjustment.

Example 4 In the following example, the inventory 
adjustment will increase the total value of the items on hand 
by $200 but will not change the number of items on hand. 
The average cost of the items will increase as a result of this 
adjustment.

Multiple inventory locations

ABSS Premier range only.

If you hold inventory in multiple locations, you can keep track 
of item quantities held at each location by recording:

 the location at which a purchased item is received (see 
‘Entering purchases’ on page 85)

 the location from where a sold item is shipped (see 
‘Entering sales’ on page 60)

 the movement of items between locations (see 
‘Recording inventory movements between locations’ on 
page 112).

The multiple locations feature is optional. If you do not track 
inventory quantities and values, or all your inventory is held at 
one location, there’s no need for you to use this feature. 

NOTE : Primary location The primary location is 
automatically created in your company file. When you set up 
multiple locations, your existing stock is assigned to this 
location. You can change the primary location ID and name, if 
you want, but you cannot delete it. For instructions on how to 
move items from the primary location to another location, see 
‘To record inventory movements’ on page 112.

If you want to use multiple locations, you need to create a 
record for each inventory location. When you create one or 
more locations, a Location field is added to the Purchases 
and Sales windows. When you record an item purchase or 
sale, you can enter the receiving or selling location for the 
item in this field.
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You can select a default receiving and selling location for your 
items. For more information see ‘To create an item’ on 
page 106.

To create inventory locations

1 Go to the Inventory command centre and click 
Locations. The Locations List window appears.

2 Click New. The Location Information window 
appears. 

3 In the Location ID field, type an identifier (of up to ten 
characters) for the new location and press TAB.

4 Enter the name and address of the location and contact 
details. 

5 If you do not receive items at or sell items from this 
location (for example, this location is your storage 
warehouse), click Items cannot be sold or shipped 
from this location. 

If you select this option, you can only move items to and 
from this location by using the Move Items feature.

6 Click OK. The new location appears in the Locations 
List window.

7 Click Close.
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Recording inventory movements 
between locations
Use the Move Items window to record the movement of 
inventory between your locations. 

Although a transaction is not created when you move 
inventory items, you can display the Item Movement 
Audit Trail report to view the details of inventory 
movements.

To record inventory movements

1 Go to the Inventory command centre and click Move 
Items. The Move Items window appears with a list of all 
your items, on-hand quantities and locations.

NOTE : Moving items using the Item Information 
window You can also record an item movement by clicking 
Move Items in the Location tab view of the Item 
Information window.

2 Select the item you want to move. You can locate an item 
by scrolling or by typing the item number in the Search 
field.

3 Record the quantities held at each location

4 Repeat step 3 for each item you want to move.

5 Click Move Items to record the movements.

A The On Hand column shows the total quantity available 
in your inventory across all locations. 

B Increase the quantity for locations receiving items and 
reduce the quantity for locations where items are moved 
from.

C The value in the Out of Balance field must be zero 
before you can record the movement. 

A

C

B
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Building items 

Building items is the process of taking two or more items, 
known as components, to make up another item, known as a 
finished item. 

You do this by transferring the inventory quantities of the 
components to that of the finished item. For example, you 
could transfer the inventory quantity of timber and fabric 
(components) to furniture (the finished item). 

You can build items in two ways:

 manually, for a one-off transfer of inventory. See To build 
items manually, below. 

 automatically, for a transfer you make repeatedly. See 
Auto-building items, below.

Note that before you can build a finished item, you need to 
create an item record for it.

To build items manually

1 Go to the Inventory command centre and click Build 
Items. The Build Items window appears.

2 Type or select the item numbers of the finished item you 
want to make and the component items you want to 
transfer. 

3 Type the transfer quantity. Type a positive number for the 
finished item (this number is added to your on-hand 
inventory). Type a negative number for the component 
items (this number is subtracted from your on-hand 
inventory).

The value in the Out of Balance field must be zero 
before you can record the transaction. That is, in the 
Amount column the amount for the finished item must 
be equal to the sum of the amounts for the components.

4 [ABSS Premier range only] If you store an item at multiple 
locations, select the location where the item is held. Note 
that this field only appears if you use more than one 
location in your company file. For more information, see 
‘Multiple inventory locations’ on page 110.

5 Enter the unit cost of each item to be included in the 
build.

6 Click Record to save the inventory transfer.

Auto-building items
For items that you repeatedly build, you can use the 
Auto-Build function to build the finished items. 

Before you can build a finished item using the Auto-Build 
function, you need to define what items are needed to build 
the item.

TIP : Auto-build from the To Do List You can also 
auto-build items using the To Do List. (In the Stock view of 
the To Do List, select the items you want to build and click 
Order/Build.)

To define an Auto-Build item 

1 Go to the Inventory command centre and click Items 
List. The Items List window appears.

2 Click the zoom arrow ( ) of the item you want to build. 
The Item Information window appears. 

3 Click the Auto-Build tab. 
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4 In the Minimum Level for Restocking Alert field, 
type the minimum level of the item you want to have in 
inventory.

5 Click Edit List. The Auto-Build Information window 
appears.

6 In the List what it takes to build field, type the 
number of item units you want to be made. If bulk 
quantities of materials are purchased to build an item, it 
may be easier to specify the materials required to build a 
greater quantity of the item, such as 10 or 20.

7 Enter the details for each of the components required to 
build the item. 
a Click in the Item Number column and press TAB. Your 

items list appears. 
b Select a component item required to build the new 

finished item and then click Use Item. The details of 
the component appear in the Item Number and 
Name columns.

c In the Quantity column, type the number of 
component items required to build the specified 
quantity of the finished item.

d Repeat from step a for each component required to 
build the new finished item.

8 Click OK when you have entered all the components.

9 Click OK and then click Close to return to the 
Inventory command centre.
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To auto-build an item

1 Go to the Inventory command centre and click 
Auto-Build Items. The Auto-Build Items window 
appears.

2 Type the quantity of finished items you want to build in 
the Qty. to Build column. (Click None if you want to 
change all numbers in this column to zero).

3 Click Build Items to begin transferring component 
items to finished items. The Build Items window 
displays the details of the transfer that will occur when 
the finished item is built.

4 Review the entries in this window to make sure that the 
quantities, unit costs and total inventory values are 
correct. Note that the quantities of the components in 
the list appear as negative numbers, while the quantities 
of the finished items in the list are shown as positive 
numbers.

5 Click Record to update your inventory quantities and 
values.A This column displays all items that you have designated as 

finished items.

B The On Hand, On Order and Net on Hand columns 
show the current levels of your finished items.

C Type the number of finished items you want to build. 

BA

C
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Performing stocktakes

You entered your opening stock quantities in the Count 
Inventory window when you set up your company file. 

You can also use the Count Inventory window to make 
adjustments to item quantities during regular stocktakes or 
any time you find discrepancies between the actual 
quantities of items on hand and your records of those 
quantities.

Each inventory adjustment must be allocated to an account 
so your accounting records accurately reflect the reasons 
why your inventory needed adjusting. For example, you can 
use an expense account —called ‘Shrinkage/Spoilage’—to 
track loss or theft of items.

Before you perform a stocktake

 [ABSS Premier range only] Record any inventory 
movements between locations before counting your 
inventory. For more information, see ‘Multiple inventory 
locations’ on page 110. 

 Record any build item or auto-build transactions before 
counting your inventory. Otherwise, a missing inventory 
item that was used to build another item will be 
accounted for as an expense, such as loss or shrinkage. For 
more information, see ‘Building items’ on page 113. 

 Count the actual items in your inventory. You can print the 
Inventory Count Sheet report, which lists all your 
inventory items, and manually record quantities on it.

NOTE : Inventory-count filtering options You can 
print the Inventory Count Sheet either by clicking Print 
in the Count Inventory window or from the Index To 
Reports window, where you can also set report filters.

To perform a stocktake

1 Go to the Inventory command centre and click Count 
Inventory. The Count Inventory window appears.

This window lists all the items and their current on-hand 
quantities. Quantities are inventory units, not buying 
units or selling units. For example, if you buy soft drinks by 
the six-pack and store it by the can, a quantity of 24 in the 
On Hand column means you have 24 cans in your 
inventory, rather than 24 six-packs.

2 [ABSS Premier range only] If you store inventory at 
multiple locations, select the way you want to group your 
items. You can group items by item number or by location.

3 [ABSS Premier range only] If you store inventory at 
multiple locations and you need to record a quantity for 
an item that previously had no recorded on-hand quantity, 
select the Include Zero On-Hand Quantities option.

4 In the Counted column, type the actual quantities of the 
items. Any discrepancy between the counted quantity 
and the on-hand quantity appears in the Difference 
column.
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5 Click Adjust Inventory. If there are differences between 
on hand and counted values, the Adjustment 
Information window appears.

6 [Optional] You can select a default adjustment account for 
tracking all the adjustments you entered in the Count 
Inventory window. This account is normally an expense 
account such as Shrinkage/Spoilage. It should not be your 
inventory asset account. 

If it’s necessary for you to use different accounts to track 
the adjustments you made in step 4, do not enter an 
adjustment account here. Instead, enter the accounts 
next to each adjustment transaction, see step 8 below. 

7 Click Continue. The Adjust Inventory window 
appears, displaying a line item for each adjustment you 
entered in the Count Inventory window in step 1.

8 If you didn’t enter a default adjustment account in step 6, 
enter the accounts you want to use to track each item’s 
change in quantity in the Account column for each line 
item.

If you entered a default adjustment account, that account 
appears in the Account column for each line item. 

9 [Optional] Add a reason for the adjustment in the Memo 
field (for example, ‘Annual stocktake 2009’).

10 Click Record.
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Reviewing your inventory information

The following tools help you review your inventory 
information. 

To view a list of all items that need to be 
built or purchased

The Stock Alert view of the To Do List displays all items 
that need to be built or purchased to fulfil customer orders.

In this window, you can:

 automatically record a transaction for the items that you 
need to buy or build

 change the details of an order or auto-build transaction. 

1 Click To Do List from any command centre. The To Do 
List window appears.

2 Click the Stock Alert tab. A list of all items that need to 
be ordered or built appears. The On Hand column shows 
the quantity of each item actually on hand. The On 
Order column shows the quantity of each item already on 
order. The Committed column shows the quantity of an 
item on backorder for customers.

3 If you want to:
 automatically order or build items, click the select 

column ( ) next to each item you want to build or 
order and then click Order/Build. A date window 
appears with the current date displayed. If you want to, 
enter a different date and click OK. 
An order will automatically be created for the items 
that need to be purchased. The restocking information 
entered in the Buying Details view of the Item 
Information window is used to determine the 
supplier and quantity to order or the items to build.

 change the details of an order or auto-build 
transaction, click the zoom arrow ( ) next to the 
transaction. Complete the transaction in the window 
that appears.

Tool Description See

To Do List Displays an alert for items that need 
to be purchased or built.

below

Analyse 
Inventory

Gives you a list of all your items, 
including the number on hand, 
number committed and number on 
order. If you use multiple locations 
for inventory items, you can group 
the items by number or location.

page 119

Inventory 
reports

Inventory reports help you keep 
track of your item quantities and 
value. 

page 119

View 
history

You can view the sales and purchase 
transaction histories of an item or 
supplier for seven years.

page 119

Find 
Transactio
ns

Find Transactions helps you find 
inventory transactions.

page 162

Items 
Register

Gives you a list of your inventory 
transfers, adjustments, sales and 
purchases for all items, or it can be 
filtered to show the history of a 
single item. 

page 163

Transactio
n Journal

Lists journal entries of your 
inventory transactions.

page 164
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When you have finished, close the To Do List.

To analyse inventory

The Analyse Inventory window shows detailed 
information about your inventory. 

1 Go to the Inventory command centre and click 
Analysis. The Analyse Inventory window appears.

2 Display the required view of the Analyse Inventory 
window.

To view inventory reports 

There are several reports that you can generate to keep track 
of your inventory. The following are some of the reports you 
may find useful. For information on finding, customising and 
printing reports, see Chapter 12, ’Reports,’ starting on 
page 175. 

 Analyse Inventory Summary report. The summary 
and detailed versions of this report can serve as your order 
book. You can view a list of all your sales orders and 
purchase orders for all or selected items.

 Items List Summary report. This report shows 
information about your items including their on-hand 
quantities and total value. The Items List Summary 
report also shows an item’s current average cost price, 
which is important to know when making inventory 
adjustments. You can use this report to compare your total 
inventory value to the total of your inventory asset 
accounts. 

 Price Summary report. This report lists your item 
prices, and is useful for sending to your customers. You can 
convert this report to HTML and post the list on an 
intranet or Internet site. 

To view sales and purchases history for an 
item

1 Go to the Inventory command centre and click Items 
List. The Items List window appears.

2 Click the zoom arrow ( ) next to the item you want to 
view. The Item Information window appears.

3 Click the History tab. The History view displays the 
purchase and sales history for the item for seven years: five 
past years, the current year and the next year. 

For users of... The following views are 
available...

ABSS 
Accounting

• Summary—displays all inventoried 
items.

• Item Number—displays all customer 
and supplier orders for a selected item.

ABSS Premier 
range

• Group by Item—displays all 
inventoried items.

• Group by Location—displays all 
inventoried items grouped by location 
(if you have multiple locations).

• Item Number—displays all customer 
and supplier orders for a selected item.
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Setting item prices

You can change the default selling prices of the items you sell 
using the Set Item Prices window. You can still change an 
item’s price at the point of sale, which will override the 
default price for that sale only.

Average Cost and Last Cost

Average Cost is calculated as the total cost of an item (the 
total amount you have paid to purchase the item or the cost 
entered when you built an item) divided by the number of 
units of that item you have on hand. 

Last Cost is the most recent purchase price for the item.

To change the price of an item

1 Go to the Inventory command centre and click Set 
Item Prices. The Set Item Prices window appears. 
This window lists all your inventory items and their 
current prices. The last cost or the average cost of each 
item is shown, depending on whether the Last Cost 
button or the Avg Cost button is clicked. 

If an item is not listed, it means that you have not entered 
the item, or have not selected the I Sell This Item 
option on the Profile tab of the Item Information 
window.

2 Click in the Current Price column of an item and enter a 
new price. Do this for each item price you want to change.

You can enter prices with up to four decimal places. The 
total amount is rounded to two decimal places on the 
invoice.

3 Click OK.

To update the prices of multiple items at 
once

1 Go to the Inventory command centre and click Set 
Item Prices. The Set Item Prices window appears.

2 Click the select column ( ) next to the items that require 
a price update.

3 Click Shortcuts. The Pricing Shortcuts window 
appears.
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4 Indicate how you want the price rounded, the basis for 
calculating the price, and so on. 

For example, if you want to mark up the items’ prices by 
10%, select the Percent Markup option and type 10 in 
the adjacent field.

5 If you want to:
 update the items you marked in step 2, click Update x 

Items Only 
 update the prices of all items, click Update All Items. 

Customising inventory

Your ABSS software provides a number of inventory 
customisation features:

 Custom price levels [ABSS Premier range only] You 
can assign up to six price levels to different types of 
customers. For example, you can set a lower price for your 
wholesale and long-term customers. 

You can also set up to five quantity breaks for each 
customer type and offer a discounted price for each 
break. For example, you might have quantity breaks of five, 
ten, twenty, fifty and one hundred. For each of these 
breaks, you can set six different price levels. 

 Custom fields You can ensure certain information is 
always recorded for an item, such as warranty, serial 
number and manufacturer. Use these fields for information 
that you do not need to use as report filters.

 Custom lists You can record information about an item 
and then run reports based on the custom lists. For 
example, if you are running a trailer-rental business, you 
might have custom lists of colour, type, and location. This 
means you could run a report to include only blue cage 
trailers at the Main Street station.

Creating custom price levels
ABSS Premier range only.

You can customise your pricing according to customer status 
and sales quantities. 

For example, a level-three customer might pay $350 for a 
single quantity of the item, but if they purchase ten units of 
the item they will only have to pay $330 each for them. A 
level-four customer might be charged $310 and $290 
respectively.

NOTE : Volume discounts The volume in the Volume 
Customer Discount field in a customer’s card applies in addition 
to the quantity-break price levels you set up. 

To set custom price levels, you can give each level a name and 
then type a price for each level for each quantity break.

To name your price levels

This task is optional. If you do not give names to price levels, 
default names will be used (Level A, Level B, and so on).

1 Go to the Lists menu, choose Custom List & Field 
Names and then Price Levels. The Custom List and 
Field Names window appears.
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2 Enter names for the price levels as you want them to 
appear in the Selling Details view of the Item 
Information window.

3 Click OK.

To specify price levels and quantity breaks 
for an item

1 Go to the Inventory command centre and click Items 
List. 

2 Select the item and click Edit. The Item Information 
window for the item appears. 

3 Click the Selling Details tab.

The base selling price you entered for this item in the 
upper section of the Selling Details view appears at 
Level A (or whatever name you have chosen for this field). 

4 In the remaining fields (Levels B to F, or whatever you 
chose to name them), enter the selling price of this item. 
Make an entry for each price level you want to use. 

5 If you want to specify quantity breaks for a price level:
a Enter the first quantity break in the first Over field and 

enter the price for orders over the quantity break.
b In the next Over field, enter the new quantity break. 

Assign a price for this quantity break.

c Continue to enter up to five quantity breaks, and assign 
up to six price levels. Note that each quantity break 
must be greater than the previous quantity break.

6 Click OK.

To assign a price level to a customer

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears. 

2 Locate the customer card you want to assign a price level 
to and click the zoom arrow ( ) next to it. 

3 Click the Selling Details tab.

4 Select the price level you want to assign to the customer 
in the Item Price Level field.

If you do not assign one of the six price levels, the item’s 
base selling price is used instead. 

5 Click OK.

6 Click Close.
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Creating custom lists
Custom lists enable you to sort and group your inventory 
items on reports. 

For example, when you run the Analyse Inventory 
Summary report, you can just include items sorted by the 
same list name, such as by location or colour.

To name a custom list

1 Go to the Lists menu, choose Custom List & Field 
Names, and then click Items. The Custom List and 
Field Names window appears.

2 Enter a name for each custom list you want to create and 
click OK. These names will now appear in the Item 
Information window.

To create custom list entries

1 Go to the Lists menu, choose Custom Lists and then 
Items. The Custom Lists window appears. 

2 Select the list to which you want to add entries in the 
Custom List field.

3 Click New, enter the name of a list entry and then click 
OK. For example, if you have a colour list, you could enter 
Yellow.

4 Repeat step 3 until you have created all your list entries.

5 Click Close to close the Custom Lists window.

To assign a custom list entry to an item

1 Go to the Inventory command centre and click Items 
List.

2 Click the zoom arrow ( ) to the left of the item. The 
Item Information window appears.

3 Click the Item Details tab and select the required entry 
from the custom list.

Custom lists and inventory reports

You can generate reports using your custom lists as report 
filters. For example, you can generate a report that includes 
only those items with a certain list entry, such as the colour 
red. For more information on setting report filters, see ‘Select 
the data to be printed’ on page 180.
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Creating custom fields
Custom fields can be used to record additional information 
about an inventory item, but cannot be used to filter 
inventory reports. Examples of how you might name the 
custom fields are ‘Warranty,’ ‘ID No.’ and ‘Manufacturer’.

To name custom fields

1 Go to the Lists menu and choose Custom List & Field 
Names and then Items. The Custom List and Field 
Names window appears.

2 Type the new field names in the Name of Custom Field 
fields and click OK. 
These field names will appear on the Item Details tab of 
the Item Information window for all items.

Printing custom field entries on your 
purchase orders and invoices
You can customise your invoices and purchases to include one 
or more custom fields. For more information on customising 
forms, see Chapter 13, ’Forms,’ starting on page 185.

abss Web Store
New Fields for abss Web Store
There are a series of new fields made available in every Item 
card within ABSS application. Information captured in these 
new fields can be export via ODBC and use by the online abss 
Web Store. For more details, please visit 
https://www.abssasia.com/sg/abss-webstore. 

Access the New Fields
To access these new fields, please go to ’Command 
Centres’ and select ‘Items List’. Then open up any Item 
Card, switch to ‘Item Details’ tab and select ‘abss Web 
Store’ button.
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’abss Web Store’ window then appears:

These empty new fields are to capture necessary information 
pertaining to that Item Card, which subsequently can be 
export via ODBC and ready to use by the online abss Web 
Store.
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8  Time Billing
Time billing is only available in the ABSS Premier range.

The time billing feature allows you to track the time spent by employees and suppliers to complete tasks and services (activities) for 
clients and customers. You can also track incidentals (such as items used) to complete the work. 

About the time billing feature

Time billing is suitable for businesses that predominantly sell 
time (such as accountants and lawyers) and businesses that 
sell both time and items (such as interior designers and 
mechanics). 

You can establish billing rates based on the activity itself, 
such as consulting at $40 per hour and photocopying at 10 
cents per copy. You can also establish billing rates based on an 
hourly charge-out rate for a particular employee. For example, 
employee John Smith’s hourly consulting rate may be $60 per 
hour and subcontractor Acme Industries’ charge-out rate 
may be $80 per hour. You can even set an underlying cost to 
the activity where, for example, you estimate that the cost to 
employ John Smith is $45 per hour and Acme is $60 per hour.

An activity can be chargeable or non-chargeable. The ability 
to track non-chargeable activities can be very useful for 
businesses that want to record such costs as entertainment, 
which generally cannot be charged to the customer. The 
activities can be entered individually or grouped together on 
activity slips. The information can be adjusted quickly to 
generate time billing invoices, ready to send to your 
customers. Any items that you have sold to your customers 
can also be included with the activities in a single time billing 
invoice. 

Time billing reports can be filtered to give you just the 
information you want. These reports monitor how you and 
your staff spend their time and whether it is spent profitably.
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Setting time billing preferences

You need to set preferences before you start billing for time:

To set time billing preferences

1 Go to the Setup menu and choose Preferences. The 
Preferences window appears.

2 Click the System tab. 

3 Select the required time billing preferences and options.

4 Click OK.

Preferen
ce Description

Special 
billing 
units

Special billing units is a useful feature for 
organisations that need to track billable time in units 
of 1, 6, 10, 12, 15 or 30 minutes. The unit of time you 
select here will be the default billing unit when you 
create hourly activity slips. For example, you can 
select six-minute time billing units, where an hour 
would be 10 billing units of time. Any activity slips 
you have already created will be updated to use the 
special billing unit of time.

Rounding 
time in 
time 
billing

Time billing allows you to set a preference for how 
you want units of time to be rounded when you use 
the timer. 
Choose to round up to next, down to previous 
or to nearest. For example, if you have chosen up 
to next and are using 30-minute billing units, 10 
minutes would be rounded up to 30 minutes on an 
activity slip. As another example, if you have chosen 
to nearest and are using 30 minute billing units, 15 
minutes would be rounded up to 30 minutes on an 
activity slip.
If you are not using a special billing unit of time—that 
is, you are billing in hours—you can specify the 
rounding increment. For example, if you want to 
round the actual time you clock using the timer up to 
the next minute, choose up to next and type 1 in 
the Minute Increment field. That way, if you clock 
21 minutes and 32 seconds of an activity, 22 minutes 
will be entered automatically in the Units field.
Note: If you have specified a special time billing unit 
and a rounding rule, the Minute Increment field 
here is redundant and therefore not displayed.

Including 
items on 
time 
billing 
invoices

If you select the I Include Items on Time Billing 
Invoices option in the Preferences window, you 
can include items on your time billing invoice and 
charge your customers for both activities and items 
on a single invoice. If this preference is marked, the 
selection list that appears when entering a time 
billing invoice includes both your activities and 
items.
Note that only items for which you have selected the 
I Sell This Item option in the Item Information 
window can be included on a time billing invoice. 

Timeshee
ts

This preference allows you to include time billing and 
activity slip information in an employee’s pay, and to 
create activity slips when you record employee hours 
using a timesheet.

Preferen
ce Description
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Setting billing rates

You can set billing rates that will automatically appear when 
you create an activity slip. However, you can override these 
rates when you create the activity slip. The billing rate can be 
set for the customer, supplier, or for the activity itself.

For example, for an activity such as the time spent 
photocopying, you might use a flat rate for all customers, in 
which case you would use the activity’s billing rate. For other 
activities, you might charge the customer according to the 
employee who performed the activity, the billing rate 
depending on factors such as the expertise and experience of 
the employee.

To set a billing rate for an activity

You can set up a billing rate for each activity regardless of the 
customer you are billing or the employee or supplier who 
performed the activity. The billing rate for an activity is set in 
the Activity Information window (see ‘To create an 
activity’ on page 130).

To set a billing rate for a customers

You can set up billing rates for a customer on their card. This 
option is useful if you perform the same activities for several 
customers and want to charge each customer a different rate.

1 Display the Card Information window for the relevant 
customer and click the Selling Details tab.

2 Enter the hourly billing rate for the customer in the 
Customer Billing Rate field and click OK. 

3 Set the activity to use the customer’s billing rate (see ‘To 
create an activity’ on page 130).
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To set a billing rate for a supplier or 
employee

You can set a billing rate for an employee or supplier on their 
card. This option allows you to bill an activity at different 
rates according to the employee or supplier performing the 
activity. You can also track the costs associated with having 
the activity performed. This is particularly useful if you are 
subcontracting work to a supplier. 

1 Display the supplier’s or employee’s Card Information 
window. Then do the following:
 Supplier cards—click the Buying Details tab.
 Employee cards—click the Payroll Details tab and 

then click Time Billing. 

2 In the Supplier Billing Rate field or the Employee 
Billing Rate field, type the hourly billing rate, excluding 
tax, for the supplier or employee. 

3 In the Cost per Hour field, type the hourly cost to you 
of having this activity performed.

4 Click OK.

Creating activities

The term activity is used to describe a task or service 
provided by your business for which you can track costs and 
bill customers using time billing invoices. Activities are 
primarily defined by their type—hourly or non-hourly—and 
whether they are chargeable or non-chargeable.

To create an activity

1 Go to the Time Billing command centre and click 
Activities List. The Activities List window appears.

2 Click New. The Activity Information window appears.



C R E A T I N G  A C T I V I T I E S   1 3 1

3 In the Profile tab, type a unique identity code for the 
activity in the Activity ID field and press TAB. 

4 In the Activity Name field, type a name for the activity.

5 Enter a description of the activity in the Description 
field. 

6 If you want the description of the activity to appear 
instead of the activity name on time billing invoices, 
select the Use Description on Sales option.

7 Specify the type and status of the activity.

For this 
type...

And this 
status... Do this...

Hourly Chargeable Choose the billing rate 
you want to use. The 
rate is the price you 
charge for one unit of 
the activity. You can 
either: 
• use the hourly rate 

you set up on the 
card for the 
customer, supplier 
or employee, or

• type a rate for this 
activity only in the 
Activity Rate 
field.

Non-Chargeabl
e

Go to step 10.

Non-hourly Chargeable Enter the unit of 
measurement in the 
Unit of 
Measurement field 
and activity rate in the 
Activity Rate field.

Non-Chargeabl
e

Enter the unit of 
measurement in the 
Unit of 
Measurement field 
and then go to step 10.

For this 
type...

And this 
status... Do this...
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The default unit of measurement for hourly activities is 
Hour. If you specified a special billing unit of time in the 
System view of the Preferences window, this field will 
still be displayed as Hour, but time will be billed 
according to the special billing unit.

8 In the Income Account field, type or select the account 
you want to use to track the income you receive for this 
activity. 

9 In the Tax Code when Sold field, type or select the tax 
code that you want to appear as the default when you 
create a sales invoice for this activity.

10 Click OK. The new activity is listed in the Activities List 
window. 

To change, inactivate or delete an activity

Creating activity slips

Activity slips are used to record activities undertaken for a 
customer and form the basis for the invoices you send your 
customer. 

You can invoice the full amount for the activity or invoice part 
of it, leaving the balance to a later date. 

You can create an activity slip in three ways.

 Create a single activity slip. This allows you to enter 
the most detail about the activity slip 

 Create multiple activity slips. You can enter multiple 
activity slips at once for an employee, while not entering 
quite as much detail for each.

 Create a timesheet. You can enter the hours per day an 
employee spends to complete work for clients and 
customers, while automatically creating an activity slip. 
For more information, see ‘Timesheets’ on page 122.

You can also create a timesheet entry by assigning an 
hourly payroll category to an activity slip.

When you create an activity slip, you can select two 
cards—one for the employee or supplier who performed the 
activity for your company and the other for the customer for 
whom your company performed the activity. If you are 
creating an activity slip for a chargeable activity, you must 
enter both cards. 

If you want to... See

change details of an activity page 155

inactivate an activity page 155

remove an activity from your 
records 

page 156
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To create an activity slip

1 Go to the Time Billing command centre and click Enter 
Activity Slip. The Enter Activity Slip window 
appears.

2 In the Activity Slip tab, enter details about the activity, 
such as the name of the employee who performed the 
activity, the name of the customer for whom the activity 
was performed, the activity ID number and the number of 
units to be charged. 

3 Type any adjustments in the Adjustment fields. Enter 
the number of units of the adjustment in the first field. 
You can override the amount of the adjustment that 
automatically appears in the adjacent field. 

You can enter adjustment units or amounts as negative 
numbers if you want to indicate fewer hours or a lesser 
amount.

4 If you have billed the customer on an invoice for part of 
this activity, type the number of units already billed in the 
first Already Billed field. (You can override the amount 
that appears in the adjacent field.) Your entry is 
subtracted from the Billable units and amount. The total 
units and amount that have not been billed yet appear in 
the Left to Bill fields.

NOTE : Where Already Billed amounts are recorded
If you enter units or an amount in the Already Billed fields 
of the Enter Activity Slip window, the amount won’t 
appear in the Sales Journal or in the activity’s history. It will 
only be recorded for the activity slip.

5 [Hourly activities only] If you pay the employee based on 
the activity performed: 
a Select the Include Hours in Employee’s Pay option.
b Enter an hourly wage payroll category in the Payroll 

Category field. 

The activity hours (units) recorded for this activity are 
assigned to this wage category on the employee’s 
timesheet. 

NOTE : Activity hours are assigned to timesheets on 
the activity slip date When you record the activity 
slip, the activity hours are assigned to the employee’s 
timesheet on the date entered on the activity slip. If you 
want to record activity hours over a number of days or pay 
periods, you need to record the hours in the Enter 
Timesheets window (see ‘Timesheets’ on page 122).

6 Click Record. The activity slip is now recorded and will 
appear on reports.

If you entered a chargeable activity on the activity slip, 
the activity will be available for billing in the Prepare 
Time Billing Invoice window. 

NOTE : If you change the view, the activity slip will 
be recorded If you click the Multiple Activity Slips 
tab while creating an activity slip and you have entered the 
minimum required information in the Activity Slip view, 
the activity slip will be recorded before the new tab appears.

To create an activity slip using the timer

The Enter Activity Slip window has a timer that allows you 
to record the time you spend on an activity. When you have 
completed the activity, the information is already in the 
Enter Activity Slip window, eliminating extra data entry. 
The timer appears on activity slips for hourly activities only.

To use the timer, you must leave the Enter Activity Slip 
window open until the activity is completed. You can still use 
other programs or access other windows during this time.
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1 Go to the Time Billing command centre and click Enter 
Activity Slip. The Enter Activity Slip window 
appears.

2 Enter the employee name, date and customer name. 

3 In the Activity field, type or select an hourly activity ID. 
The timer fields appear at the bottom of the window.

4 Click Start to start the timer. If you have not entered a 
start time in the Start Time field, your computer’s 
current system time appears, and the timer starts 
incrementing the time in the Elapsed Time field.

NOTE : Entering a start time that is before the 
current system time If you enter a start time that is 
before the current system time, the difference will be added 
to the elapsed time measured by the timer. For example, if 
you entered 8:00 a.m. in the Start Time field and then 
clicked Start at 9:00 a.m., 1:00:00 will appear in the 
Elapsed Time field and the time calculated by the timer 
will be added to that amount.

Leave the Enter Activity Slip window open as you 
undertake the activity. This allows the timer to track the 
time you spend on it.

5 When you have completed the activity, or you want to 
pause the timer, click Stop.The current system time 
appears in the Stop Time field. The number of billing 
units corresponding to the elapsed time appears 
automatically in the Units field. 

You can edit the start and stop times. The entries in the 
Actual Units and Elapsed Time fields will be updated 
automatically.

You can round your timer entries in the Units field 
automatically. See ‘Setting time billing preferences’ on 
page 128.

6 If you want to resume timing the activity, click Start 
again. The entry in the Stop Time field will be cleared. 
The timer will continue incrementing, starting from your 
current elapsed time.

7 [Hourly activities only] If you pay the employee based on 
the activity performed: 
a Select the Include Hours in Employee’s Pay option.
b Enter an hourly wage payroll category in the Payroll 

Category field. 

The activity hours (units) recorded for this activity are 
assigned to this wage category on the employee’s 
timesheet. 

NOTE : Activity hours are assigned to timesheets on 
the activity slip date When you record the activity 
slip, the activity hours are assigned to the employee’s 
timesheet on the date entered on the activity slip. If you 
want to record activity hours over a number of days or pay 
periods, you need to record the hours in the Enter 
Timesheets window (see ‘Timesheets’ on page 122).

8 When you have completed the activity, click Record. 

If you entered a chargeable activity on the activity slip, 
the activity becomes available for billing in the Prepare 
Time Billing Invoice window. 

NOTE : To reset the timer Click Clear at any time to clear 
the Elapsed Time, Start Time, Stop Time and Units fields.

Creating multiple activity slips
In addition to being able to create single activity slips, you 
can also create multiple activity slips simultaneously. In the 
Multiple Activity Slips tab of the Enter Activity Slip 
window, one line in the list represents one activity slip. 
Although this view limits the information you can enter on 
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the activity slip, you can view any activity slip in the 
Activity Slip view and enter more detail at a later stage.

NOTE : The Multiple Activity Slips view cannot be used 
to add activity hours to a timesheet In the Multiple 
Activity Slips view, you cannot choose to include an activity’s 
hours on a timesheet.

To create multiple activity slips

1 Go to the Time Billing command centre and click Enter 
Activity Slip. The Enter Activity Slip window 
appears. 

2 Click the Multiple Activity Slips tab. 

3 In the Employee or Supplier field, type or select the 
name of the employee (or supplier) carrying out the 
activity. Any activity slips you have created for the 
employee or supplier are listed, with each line 
representing a single activity slip.

4 On the first blank line, enter details of the activity slip you 
want to create.

5 Press TAB or click Record to record the activity slip and 
move the insertion point to the next line where you can 
begin creating a new activity slip for the employee (or 
supplier) you entered in the Employee (or Supplier) 
field.

NOTE : Activity slips are recorded as you create 
them on a line-per-line basis Once you have entered 
an activity slip and pressed TAB to move to the next line, the 
activity slip is recorded. If you click Cancel after moving to 
the next line, the previous activity slip is still recorded. A 
white zoom arrow ( ) displayed next to an activity slip 
indicates that the activity slip has been recorded.

6 Repeat from step 4 for each activity slip you want to 
create. When you have entered and recorded all the 
activity slips you want to create, click Cancel to close the 
window.

Reviewing and changing activity slips

To review an activity slip

1 Go to the Time Billing command centre and click 
Activity Log. The View Activity Log window 
appears.

2 Enter the name of the employee or supplier who 
undertook the activity and, if you know it, the date range 

within which the activity was undertaken. All activities 
that match the criteria are listed. 

3 Click the Diary View tab and the Detail View tab to 
display different types of information about the activity 
slip. Click the zoom arrow ( ) next to an activity slip to 
view the activity slip in the Enter Activity Slip window. 
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To change an activity slip

If you want to review, edit or delete an activity slip, follow the 
relevant procedures below. 

1 Go to the Time Billing command centre and click 
Activity Log. The View Activity Log window 
appears.

2 Enter the name of the employee or supplier who 
performed the activity and, if you know it, the date range 
within which the activity was recorded. All activities that 
match the criteria are listed. 

3 Select the activity slip you want to change and then click 
Edit. The activity slip appears in the Enter Activity 
Slip window.

4 Make the required changes either in the Activity Slip 
view or the Multiple Activity Slips view and click OK 
or Record.

To delete an activity slip 

You can not delete an activity slip that has been billed. 

1 Go to the Time Billing command centre and click 
Activity Log. The View Activity Log window 
appears.

2 Enter the name of the employee or supplier who 
performed the activity and, if you know it, the date range 
within which the activity was recorded. All activities that 
match the criteria are listed. 

3 Select the activity slip you want to delete.

4 Go to the Edit menu and choose Delete Activity Slip.

NOTE : Deleting activity slip details in timesheets
When you remove timesheet entries with activity slip 
details, the linked activity slip is also removed.
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Creating time billing invoices

There are two ways of creating a time billing invoice:

 In the Prepare Time Billing Invoice window. 
(Recommended) Use this method if you want to record 
full details of activities and activity slips. See ‘To create a 
time billing invoice using the Prepare Time Billing Invoice 
window’ below. 

 In the Sales window. Use this method for activities that 
do not need to be recorded on activity slips. Note that the 
activity will not appear in time billing reports that use 
activity slip information. See ‘To create a time billing 
invoice using the Sales window’ on page 138.

To create a time billing invoice using the 
Prepare Time Billing Invoice window

The Prepare Time Billing Invoice window allows you to 
enter and adjust the billing information for activity slips just 
as you would in the Enter Activity Slip window. As you 
make changes in the Prepare Time Billing Invoice 
window, your activity slip records are updated automatically.

1 Go to the Time Billing command centre and click 
Prepare Time Billing Invoice. The Time Billing 
Customers window appears.

2 Select the customer for whom you want to create a time 
billing invoice and click OK. The Prepare Time Billing 

Invoice window appears, listing any activity slips with 
billable amounts for the selected customer.

A Filters Use these filters to find the required 
activity slip(s). 

B Bill Type the amount or number of hours you 
want to bill for each activity slip here. Any 
activity slip with 0.00 units or $0.00 in the 
Left to Bill column is considered billed in 
full.

C Adjustmen
t

Type any adjustments you want to make in 
this column.

D Print 
Options

Select the relevant option if you want to:
• sort activity slips according to job 

number.
• consolidate all activity slips with the 

same activity and job number on the 
invoice.

• print the activity slip notes on the 
invoice.

A

B
C

D
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3 Click Prepare Invoice. The Sales - New Time Billing 
window displays the details of the time billing invoice.

4 If you have selected the I Include Items on Time 
Billing Invoices option in the Preferences window, 
you can enter items on this invoice. See ‘Setting time 
billing preferences’ on page 128.

5 If you are invoicing for sold items, you can enter: 
 the date in the Date field.
 the quantity being sold in the Hrs/Units field
 the item number in the Activity field or press TAB and 

select the item from the list of items and activities that 
appears

 the price of the item in the Rate field
 the appropriate tax code
 the job number.

6 If you want to group and subtotal the items and activities 
separately on the invoice, you can do so by inserting 
headers, blank lines and subtotals. For more information, 
see ‘Adding and deleting transaction lines, subtotals and 
headers in sales transactions’ on page 63.

7 Enter additional information about the sale, such as the 
salesperson, referral source and delivery.

8 Complete the invoice in any of the following ways: 
 Record the invoice. Click Record to record the invoice 

but print it later. 
 Print and record the invoice. Click Print and then 

choose the form you want to use for this invoice. For 
more information about printing invoices, see ‘Sending 
forms’ on page 186.

 Save the invoice as a recurring transaction. Click Save 
as Recurring. Enter the necessary information about 
the template in the Edit Recurring Schedule 
window and click Save. For more information about 
recurring transactions, see ‘Recurring transactions’ on 
page 167.

NOTE : No activity slips for recurring time-billing 
invoices You can save time-billing invoices as recurring 
invoices, but no activity slips will be created when you 
use the recurring sale in the future. Also, recording the 
recurring sale will not update the activity slips you used 
to create the invoice in the Prepare Time Billing 
Invoice window. 

To create a time billing invoice using the 
Sales window

NOTE : Activities billed using this procedure will not 
appear in most time billing reports  No activity slip 
records will be created if you use this method to create a time 
billing invoice. Most time billing reports are based on activity slip 
records, therefore, if you want to print time billing reports, you 
should create activity slips and then use the Prepare Time 
Billing Invoice window to create the invoice.

1 Go to the Sales command centre and click Enter Sales. 
The Sales window appears.

2 In the Customer field, type or select the customer you 
want to invoice.

3 Click Layout. The Select Layout window appears. 
4 Select the Time Billing option to select the Time 

Billing layout and then click OK. 

5 For each billable activity enter: 
 the date the activity was performed
 the number of units or hours being billed in the 

Hrs/Units field
 the activity name or press TAB in the Activity field and 

select the required activity from the list 
 the rate charged for a single unit or hour of the activity 

in the Rate field
 [optional] the job number
 the tax code, if the activity is taxable
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6 If you are invoicing for sold items, enter:
 the date in the Date field
 the quantity being sold in the Hrs/Units field
 the item number in the Activity field or press TAB and 

select the item from the list of items and activities that 
appears 

 the price of the item in the Rate field
 the tax code if the item is taxable
 the job number.

7 If you want to group and subtotal the items and activities 
separately on the invoice, you can do so by inserting 
headers, blank lines and subtotals. For more information, 
see ‘Adding and deleting transaction lines, subtotals and 
headers in sales transactions’ on page 63.

8 Enter additional information about the sale, such as the 
salesperson, referral source and comments. 

9 Complete the invoice in any of the following ways:
 Record the invoice. To record without printing it, click 

Record.
 Print and record the invoice. To print and record the 

invoice, click Print and then choose the form you want 
to use for this invoice. For more information about 
printing invoices, see ‘Sending forms’ on page 186.

 Save the invoice as a recurring transaction. You can save 
the invoice as a recurring transaction so that you can 
use it again in the future. Click Save as Recurring. 
Enter the necessary information about the template in 
the Edit Recurring Schedule window and click 
Save. For more information about recurring 
transactions, see ‘Recurring transactions’ on page 167.

NOTE : No activity slips for recurring time-billing 
invoices You can save time billing invoices as recurring 
invoices, but no activity slips will be created when you 
use the recurring sale in the future. Also, recording the 
recurring sale will not update the activity slips you used 
to create the invoice in the Prepare Time Billing 
Invoice window. 

Work in progress

Work you have done for your clients that you have not billed 
yet is called work in progress. Work in progress is indicated on 
activity slips by a value other than zero in the Left to Bill 
field. 

Your accounting records will only reflect a sales transaction 
when you bill the activities. However, some accountants 
consider that, from an accounting perspective, your clients 
owe you for your work in progress even if you have not yet 
billed your clients for it.

If your work in progress routinely represents a significant 
amount of money, you should consider adjusting your 
accounting records to reflect it. Consult your accountant for 
advice on how to do this.
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9  International transactions
International transactions (multiple currencies) are only available in the ABSS Premier range.

You can enter transactions in a number of currencies in addition to your local currency, the Malaysian ringgit or Singapore dollar. You can 
record transactions in ringgit, dollars, pesos, pounds, euros, yen or any other currency you use when buying and selling goods and 
services. You can also track overseas bank accounts and foreign assets and liabilities.

About the multiple-currency feature

If you deal in multiple currencies, it’s important to track the 
effects of currency exchange fluctuations on your business. 
ABSS Premier provides detailed reports to help you manage 
both unrealised gains and losses (potential changes in the 
value of overseas transactions) and realised gains and losses 
(the actual changes in the value of your assets, liabilities and 
equity that occur when you exchange foreign currency for 
your local currency).

The multiple currencies feature is optional. If all your business 
is conducted with customers and suppliers in your local 
currency (for example, Malaysian ringgit or Singapore dollar), 
there’s no need for you to use this feature. If you do want to 
use it, you need to set a preference.

You will also have to perform a number of setup tasks 
described in this chapter. For example, you need to set up 
special accounts to track the transactions you make in each 
currency. If, for instance, you plan to make sales in euros, you 
need to create a separate receivables account for your sales in 
Europe. 

Every foreign currency account you create requires a 
companion account, known as an exchange account, to track 
changes in the value of the transactions assigned to the 
account. Only balance sheet accounts—asset, liability and 
equity accounts—can be assigned a foreign currency. All other 
types of accounts are tracked using your local currency.

Your local currency (for example, Malaysian ringgit or 
Singapore dollar) is set up automatically for you. As this 
currency is used to determine the value of all other 
currencies, it cannot be deleted and its exchange value is 
fixed at 1. Before you begin entering transactions, you need to 
select the appropriate currency for all your overseas 
customers and suppliers. Only one currency can be used for 
each customer or supplier (unless you choose to set up 
multiple cards for them). This ensures that your records 
remain accurate and it speeds up the task of entering 
transactions.

For simplicity, the examples in this chapter use the Singapore 
dollar as the local currency.
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Setting up multiple currencies

Before you can record transactions for multiple currencies, 
complete the following setup steps. 

Once the setup is complete, you can enter foreign currency 
transactions the same way you enter transactions based on 
local currency.

Task 1: Select the multiple currency 
option
1 Go to the Setup menu and choose Preferences. The 

Preferences window appears. 

2 In the System tab, select the I Deal in Multiple 
Currencies option. A message appears.

NOTE : This selection cannot be undone Once you 
begin entering multicurrency transactions, you cannot 
deselect this option.

3 Click OK to prepare your company file for multiple 
currencies.

4 Click OK to close the Preferences window.

Task 2: Set up records for foreign 
currencies
Records for several commonly used foreign currencies, as well 
as your local currency, have been set up by default.

If you do business in any other currency, you will need to 
create a record for the currency and enter its current 
exchange rate. 

1 Go to the Lists menu and choose Currencies. The 
Currencies List window appears. 

2 Click New. The Currency Information window 
appears. 

3 Enter details of the currency such as a code, name and 
current exchange rate. For detailed field help, click Help 
and choose Help for This Window. 

At this stage, you only need to complete the Currency 
Profile tab.

4 Click OK and then click Close.

Task 3: Create accounts to track 
foreign currency transactions
In order to track transactions in a foreign currency, you must 
create a number of accounts that use that currency rather 
than dollars. You cannot simply use the same accounts you use 
for your local currency transactions because your currency 
and other currencies rarely trade at par with one another 

Tas
k See

1 Select the multiple currency option below

2 Set up records for foreign currencies below

3 Create accounts to track foreign currency 
transactions

below

4 Assign accounts to foreign currencies page 144

5 Assign currencies to foreign customers and 
suppliers

page 144
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(that is, one Singapore dollar rarely buys exactly one 
monetary unit in any other currency). NOTE : Foreign currency accounts linked to exchange 

accounts A linked exchange account is needed for every 
foreign currency account you create. For example, if you create a 
yen cheque account, it must be linked to a yen exchange 
account. ABSS software uses these dual accounts so that both 
the foreign currency amount and the local currency equivalent of 
a transaction can be viewed in your balance sheet.

You can let your ABSS software create the linked exchange 
account for you or you can select one yourself. To create an 
account yourself, see ‘To create an account’ on page 21. You 
need to select the correct currency and exchange account in 
the Account Information window.

Before you create an account, we suggest you review the 
following sections to get an understanding of the accounts 
you need to create.

If you make foreign sales

Following is a list of the accounts you are likely to need if you 
accept payment from customers in a foreign currency. 

 Asset account for tracking receivables (for instance, 
‘Receivables Accounts Euro’). This account must be 
assigned the foreign currency and not your local currency.

 Bank account where customer receipts in the foreign 
currency will be deposited. This can be your local currency 
account if your bank accepts deposits in other currencies.

 Liability account for deposits received (if you allow 
customers to make deposits on orders). This account can 
be assigned the currency code for either the foreign 
currency or your local currency.

NOTE : Grouping with undeposited funds Only receipt 
transactions that are in your local currency may be grouped with 
undeposited funds. Also, you can only use your local currency 
account as the linked account for undeposited funds. 
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If you make foreign purchases

Following is a list of accounts you are likely to need if you 
make payments to suppliers in a foreign currency: 

 Liability account for tracking payables (for instance, 
‘Payables Accounts Euro’). This account must be assigned 
the foreign currency and not your local currency.

 Bank account that will be used to pay debts in a foreign 
currency. This can be your local currency account if your 
bank writes cheques for you in other currencies.

 Asset account for deposits paid (if you make deposits on 
orders). This account can be assigned the currency code 
for either the foreign currency or your local currency.

 Liability account for import duties collected (if you're 
required to pay duty on goods you import). This account 
can be assigned the currency code for either the foreign 
currency or your local currency.

If you track unrealised gains and losses

When you activate the multiple-currency feature in your ABSS 
company file, a Currency Gain Loss account is created 
automatically. If you plan to track unrealised gains and losses, 
you need to create an income account for this purpose, 
naming it ‘Unrealised Currency Gain/Loss’ or something 
similar. 

We recommend that you consult your accountant to 
determine whether your business needs to track unrealised 
gains and losses and, if it does, the most appropriate way for 
it to do so. See ‘Tracking currency gains and losses’ on 
page 146 for more information. 

Depending on your business, you may need to create 
additional accounts to track foreign bank accounts, assets 
held overseas and the like. If you are unsure about the 
accounts, ask your accountant or an ABSS Professional 
Partner.

Task 4: Assign accounts to foreign 
currencies
1 Go to the Lists menu and choose Currencies. The 

Currencies List window appears.

2 Click the zoom arrow ( ) next to the currency you want 
to assign to one or more accounts. The Currency 
Information window appears.

3 Select the required tab. Click either: 
 the Receivable Accounts tab if customers pay you in 

this currency or
 the Payable Accounts tab if you pay bills in this 

currency.

4 Enter the relevant accounts in the appropriate fields. In 
the bottom section of the window, select the options 
that apply to your business. As you select options, 
additional fields will appear and you can enter the 
accounts you will use to track various parts of your 
transactions such as deposits and discounts. Click OK. 
For detailed field help, click Help and choose Help for 
This Window.

5 Repeat this procedure for each currency you want to 
assign to the relevant accounts, then click Close.

Task 5: Assign currencies to foreign 
customers and suppliers
The currency used to make a transaction is determined by the 
currency assigned to the customer or supplier card you are 
using. 

A card can only use a single currency so if you deal with a 
customer or supplier in multiple currencies, you will need to 
create a separate card for each currency. 
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NOTE : A card with transactions You cannot change the 
currency of a card that you have already used in transactions. You 
will need to create a new card for the customer or supplier. 

Any transactions recorded for a customer or supplier card will 
be in the currency linked to the card. 

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears.

2 Click the zoom arrow ( ) next to the required card to 
display the Card Information window. 

3 In the Profile tab, type or select the currency you want 
to assign to the card in the Currency field. (The local 
currency is selected by default.) 

4 Click OK.

5 Repeat this procedure for each card that you want to 
assign a foreign currency, then click Close.

Exchange rates

Foreign currency transactions can be recorded for: 

 Sales, Receive Payments, and Settle Returns & Credits

 Purchases, Pay Bills, and Settle Returns & Debits

 Spend Money, Receive Money, Reconcile Accounts and 
General Journal entries.

Specifying the exchange rate for a 
transaction
When entering a transaction, you can either use the default 
exchange rate for the currency or enter a new rate for the 
transaction. 

To change the exchange rate

1 Calculate the exchange rate using the Currency 
Calculator. See ‘Using the Currency Calculator’ below.

2 Open a transaction window and enter the transaction 
details.

3 Click Rate at the bottom of the transaction window. The 
Exchange Rate window appears.

4 Enter the new exchange rate in the Transaction 
Exchange Rate field.

This will only affect the transaction that is currently 
displayed.

If you want to change the exchange rate for all future 
transactions that use this currency, select the Update 
Current Exchange Rate in the Currency List with 
Transaction Exchange Rate option.
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5 Click OK.

Using the Currency Calculator
If you receive a payment for a foreign currency invoice in your 
local currency, you can use the Currency Calculator to 

calculate the exchange rate based on the foreign and local 
amounts, or to calculate the foreign amounts based on the 
local amounts and the exchange rate.

To access the Currency Calculator from any window in 
your ABSS software, click the Help menu at the top of the 
screen and choose Currency Calculator. 

Tracking currency gains and losses

Whenever you have a foreign bank account, changes in the 
currency exchange rates between that country and your 
home country can cause the value of your foreign currency to 
fluctuate. When your local currency weakens relative to the 
foreign currency, the value of your foreign account increases, 
creating a currency gain. When your local currency 
strengthens, your foreign account experiences a loss in real 
value. Your ABSS software can track these fluctuations.

Gains or losses in the value of a foreign account are 
considered unrealised while the money is still sitting in the 
foreign account. Conversely, when the money is withdrawn 
from the account, either by using it to pay for a purchase or 
by converting it to local currency, the gain or loss is 
considered realised.

Tracking realised currency gains and 
losses
Realised currency gains and losses on sales and purchases are 
tracked differently to realised currency gains and losses on 
deposits and withdrawals. 

For realised gains or losses on sales and purchases, a posting is 
made automatically to the Currency Gain/Loss account.

For realised currency gains and losses on transfers—deposits 
and withdrawals—you need to make a general journal entry to 
the Currency Gain/Loss account.

When you activate the multiple-currency feature in your ABSS 
company file, a Currency Gain/Loss account is created 
automatically.
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NOTE : Large foreign currency exposure If you have a 
large foreign currency exposure, you may require a more detailed 
analysis than posting to a single Currency Gain/Loss account 
provides. In this case, we recommend that you consult your 
accountant for further advice about managing your foreign 
currency exposure.

Sales and purchases

At the time a currency gain or loss is realised, that is, a 
payment is received or made, an automatic posting is made 
to the Currency Gain/Loss account and to the exchange 
account for the foreign currency.

The Currency Realised Gain/Loss report lists the 
currency gains and losses that have been posted 
automatically through sales and purchases during the month 
for foreign-currency transactions.

Example You sell goods for $300 at an exchange rate of 
$3.00 to the pound to a British customer. your ABSS software 
records the sale at $300 and records the £100 as owed by the 
British customer. The £100 is posted to British receivables 
account: $200 to the British receivables exchange account 
and $300 to the sales account.

The following month the British customer pays their account 
by depositing £100 into your British bank account, but the 
exchange rate has changed from $3.00 to $2.75 to the pound. 
The deposit is valued at $275.

You originally made a sale of £100 that at the time was worth 
$300. When you received payment, it was worth only $275. 
Therefore the $25 difference is a realised currency loss, and 

will be posted to the British receivables exchange account 
and to the Currency Gain/Loss account.

Transfers

Currency gains and losses that occur through the transfer of 
funds need to be recorded by a general journal entry.

At the end of the month, you can look at the value of your 
foreign accounts and use the Currency Calculator (from the 
Help menu at the top of the screen) to calculate their true 
values in local currency at that time. 

You can then create a general journal entry where losses are 
posted as credits to the exchange account with a 
corresponding debit to your Currency Gain Loss account. 
Gains are posted as debits with a corresponding credit to 
your Currency Gain Loss account.

Example The original balance in your British bank account 
is zero and you transfer £100 at an exchange rate of $3.00 to 
the pound to it. The £100 is converted to S$300 and your 
ABSS software posts £100 to the British bank account and 
$200 to the British bank exchange account.

The following week you withdraw that £100 from the bank at 
an exchange rate of $2.75 to the pound. Your ABSS software 
values the withdrawal at $275. You put £100 into the account 
that at the time was worth $300. When you withdrew the 
£100 from the account, it was worth only $275. Therefore, the 
$25 difference is a realised currency loss.

If you now looked at your balance sheet, you would see a zero 
value for the British bank account, but $25 remaining in the 
British bank exchange account. You need to post the $25 in 
the exchange account to your Currency Gain Loss account.
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Unrealised currency gains and losses
An unrealised gain or loss is a potential gain or loss at any 
point in time between the recorded sale or purchase and the 
receipt or issue of payment. No automatic postings are made 
to track unrealised gains or losses on foreign currency 
transactions.

Not all businesses need to track unrealised currency gains or 
losses. You should check with your accountant to determine 
whether your business needs to track them.

The Currency Unrealised Gain/Loss report lists the gain 
or loss made on each foreign currency. You can then use this 
information to make adjustment postings to each of your 
foreign currency accounts for your balance sheet and also to a 
profit and loss account. 
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Miscellaneous transactions

Transferring funds to a foreign account
You may want to transfer funds from a local-currency account 
to a foreign account. This is done using the Spend Money 
window.
1 Go to the Banking command centre and click Spend 

Money. The Spend Money window appears.
2 Click Currency. In the Exchange Rate window, choose 

the currency of the account into which you want to make 
a deposit and click OK.

3 In the Pay from Account field, type or select the local 
currency bank account from which the amount is being 
withdrawn.

4 Enter the date, amount, payee, and memo.
5 In the Account No. (or Name) column, type or select 

the foreign account into which you want to make the 
deposit. 

6 Click Record.

Entering foreign-currency transactions 
in a local account
In ABSS software, you can enter foreign-currency transactions 
in a local-currency account. For example, you can accept a 
cheque from a customer in GB pounds and bank it in a 
Singapore bank account.

Example Let’s look at an example of how to accept a 
foreign-currency cheque into a local-currency account. Our 
example uses British pounds. Let’s also assume the exchange 
rate has changed from $3.00 to $2.80 since you made the 
original sale. 
1 Go to the Sales command centre and click Receive 

Payments. The Receive Payments window appears. 

2 Select the customer. The currency for this customer card 
is British pounds, so the Rate button displays GBP. 
You have received a cheque from your customer for 
£5,000 for an outstanding invoice, and you want to bank 
it in your Singapore cheque account. 

3 Process the customer payment in the usual way, but make 
sure you enter your Singapore bank account when you 
select the Deposit to Account option.

4 Click Rate to check the default currency rate for the 
British pound. Change the rate from the default rate of 
$3.00 to $2.80 and click OK. 

5 Enter £5,000 in the Amount Received field and 
allocate it to the outstanding invoice.

6 Click Record.

Reconciling accounts containing 
foreign transactions
When you are reconciling your bank statement, the foreign 
currency transaction amounts listed in your statement will 
often not match those listed in your ABSS company file. This 
is because the exchange rate used by the bank is different 
from the rate used in your ABSS company file at the time of 
the transaction. There are two methods by which you can 
reconcile accounts containing foreign transactions:

 If you have your security preferences set to allow records 
to be changed, simply click the zoom arrow ( ) next to 
the transaction in the Reconcile Accounts window to 
display the original transaction. Click Rate and change 
the exchange rate to match the bank statement.

 If you have the security preferences set so that records 
cannot be changed, click the zoom arrow ( ) next to the 
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transaction, choose Reverse [...] Transaction from the 
Edit menu, and re-enter the transaction with the correct 
exchange rate.
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10  Lists
Your company file consists of different types of records —customers, accounts, recurring transactions, and so on. Records of the same 
sort are grouped into lists.

Lists help you to keep track of the customers that owe you money, the items that you sell, the accounts or items being used, and so on. 
Lists can be modified to suit your requirements. For example, you can modify account and job levels to alter how they appear in reports. 
You can also inactivate records you use infrequently to keep your lists up to date.

Lists can be combined in a number of ways. For example, you can use a combination of custom lists, identifiers, contact logs and email 
addresses to create a list of customers who have contacted you in the past six months. Accounts and cards of the same type can be 
combined into one record. For example, you may want to combine the income accounts of two sales departments that have 
amalgamated, or combine the cards of two customers whose businesses have merged. 

Adding a record

Lists are made up of individual records. For example, each 
item in your items list is a record, as is each job in your jobs 
list. You can add as many records as you want to a list. 

To add this type of record... See

Account page 21

Card page 197

Category page 231

Department [ABSS Premier Plus only] page 152

Foreign currency [ABSS Premier range 
only]

page 142

Inventory location [ABSS Premier range 
only]

page 110

Item page 105

Job page 232

Payroll Categories [ABSS Premier Plus 
only]

page 108

Position [ABSS Premier Plus only] page 152

Recurring transaction page 167

Sales and purchases information page 152

Tax code below

Time billing activity [ABSS Premier range 
only]

page 130

To add this type of record... See
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Setting up departments or positions The 
departments and positions that you create are used in the 
Card Information window when you create an employee’s 
information.

To add a record

1 Go to the Lists menu and choose the list to which you 
want to add a record. 

For example, if you want to add a position, go to the Lists 
menu, and choose Positions.

2 Click New. The entry window for the record you are 
creating appears.

3 Type the information that is required and then click OK.

Adding records using Easy-Add
You can create new records easily using the Easy-Add 
feature. Accounts, cards, categories, comments, custom list 
items, jobs, referral sources and shipping methods can be 
added to your lists when entering transactions.

To create a record using Easy-Add

Let’s assume you want to add a customer card while entering 
a sale.

1 In the Sales command centre, click Enter Sales. The 
Sales window appears.

2 Type the customer’s name and press TAB. If there is no card 
for this customer, the Select from List window appears.

3 Click Easy-Add. A new customer card is added to your 
cards list. You can now complete your task with the new 
card.

NOTE : Easy-Add is not available from some 
transaction windows In windows such as Spend 
Money, the type of card you want to create is not 
immediately obvious, so Easy-Add is not available. 

Setting up tax codes

Tax codes are used to track tax paid to and by your business. 
Each tax code represents a particular type of tax, which is 
used to calculate tax on your transactions. 

To create a tax code

1 Go to the Lists menu and choose Tax Codes. A list of tax 
codes appears. 
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2 Click New. The Tax Code Information window 
appears. 

3 In the Tax Code field, type a tax code (up to three 
characters) and press TAB.

4 Complete the fields in this window.

Assigning tax codes to accounts You can assign a tax 
code to each account in your accounts list. The tax code you 
assign will then appear as the default tax code for 
transactions where you allocate a deposit, cheque, or a 
non-item sale or purchase to this account.

For example, you have assigned a tax code to your Electricity 
expense account. When you write a cheque to settle your 
electricity bill in the Spend Money window and allocate it 
to this account, the tax code will appear in this window by 
default. 

To allocate a tax code to an account, open the Edit 
Accounts window by going to the Accounts command 

centre, clicking Accounts List and double-clicking the 
required account from the list.

Assigning tax codes to items Each item you create 
needs a tax code assigned. You can assign a tax code for when 
you sell an item and different code for when you buy the item. 
The tax code you assign will apply to sales and purchases of 
that item, unless you have specified that the customer’s or 
supplier’s tax code be used instead (see ‘Assigning tax codes 
to cards’ below).

Tax codes can be assigned to items in the Buying and 
Selling tabs of the Item Information window. For more 
information, see ‘To create an item’ on page 106. 

Assigning tax codes to cards You only need to select a 
default tax code for customers and suppliers if the customer’s 
or supplier’s tax status takes precedence over that of the item 
or service being sold or purchased.

 Customers tax codes Tax codes are assigned to 
customers in the Selling Details tab of their Card 
Information window. 

Make sure you select the Use Customer’s Tax Code 
option. (If this option is not selected, the customer’s tax 
code will not be used, even if one has been assigned.)

 Suppliers tax codes Tax codes are assigned to 
suppliers in the Buying Details tab of their Card 
Information window. 

Make sure you select the Use Supplier’s Tax Code 
option. (If this option is not selected, the supplier’s tax 
code will not be used, even if one has been assigned.)

 Once you have assigned tax codes to customer and 
supplier cards, they will be used as the default codes for 
sales and purchases. For example, the customer’s tax code 
will override the item’s tax code in an item sale, and 
override the allocation account’s tax code in a non-item 
sale.

A Enter the tax code description, type and rate. If you 
select the Goods & Services Tax type, also select the 
appropriate GST code.

B The fields in this section vary depending on the tax type. 
Make any other selections and then click OK.

A

B
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Finding a record
Records are stored and displayed in lists. For example, the 
Jobs List window lists the jobs you have created, the 
Accounts List window lists your accounts, and so on. When 
lists get long, it can take time to locate a record. Use the 
following tools to find a record quickly. 

Tabs Some lists are divided into separate views using tabs. 
For instance, the Accounts List is divided into eight tabs 
each representing an account type, making it easier for you to 
find an account. For example, if you are looking for an asset 
account, click the Asset tab. Within the tab window you can 
scroll to find a record.

Search fields The Cards List window, Activities 
window, Items List window, and Locations window have a 
search feature that you can use to locate a record quickly. 
From the Search by list, select a search filter and then type a 
few characters in the adjacent field. Then press ENTER or TAB.

The first matching record is selected.

Advanced search filters You can use advanced search 
filters such as recontact date and postcode to search for a 
single card or a group of cards. To do this, click Advanced in 
the Cards List window and enter the relevant filters to 
narrow your search. The Cards List window will display only 
those cards that fit your search criteria.
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Changing a record 

You can make changes to:

 accounts

 cards

 categories

 foreign currencies [ABSS Premier range only]

 tax codes

 items

 jobs

 time billing activities [ABSS Premier range only]

To change a record 

1 Display the list to which the record belongs. For example, 
if you are making changes to an account, display the 
Accounts List window; if you are changing an item, 
display the Items List window, and so on. You can do this 
from the Lists menu. 

2 Locate the record you want to change in the list. Use a 
search method described in ‘Finding a record’ on 
page 154, if necessary.

3 Once you locate the record, click the zoom arrow ( ) 
next to it. Details of the record are displayed. 

4 Make the required changes and click OK.

Inactivating or reactivating a record

If you have accounts, cards, items, inventory locations [ABSS 
Premier range only], activities, or jobs that you rarely use—for 
example, a card you created for a one-off sale or 
purchase—inactivating them after use will remove them from 
selection lists. Your list of records will be shorter and finding 
the record you need will be easier. You can still use an inactive 
record in transactions by manually entering the record name.

To inactivate (or reactivate) a record

1 Display the list to which the record belongs. You can 
display the list from the appropriate menu or command 
centre. For example, if you are inactivating a card, go to 

the Lists menu and choose Cards, or go to the Card 
File command centre and click Cards List. 

2 Locate the record you want to inactivate or reactivate and 
click the zoom arrow ( ) next to it. The record’s details 
appear. For cards, accounts, activities and items, click the 
Profile tab.

3 Select or deselect the Inactive [...] option. For example if 
you are inactivating an account, select the Inactive 
Account option. If you are reactivating a customer card, 
deselect the Inactive Card option.
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Deleting a record

You can delete a record that you no longer use. However, a 
record must meet certain criteria before it can be deleted. For 
example, most records cannot be deleted if they have been 
used in transactions.

Deleting an account
You can delete an account if:

 the account is not a level-1 account

 the account has a zero balance

 no journal entries are posted to the account

 none of your recurring templates uses the account

 the account is not used as a linked account 

 the account is not linked to an inventory item. 

To delete an account

1 Go to the Accounts command centre and click 
Accounts List. The Accounts List window appears.

2 Click the zoom arrow ( ) next to the account you want to 
delete. The account details are displayed in the Edit 
Accounts window.

3 Go to the Edit menu and choose Delete Account.

Deleting other records
You can only delete: 

 a card, foreign currency, tax code, item or job that has not 
been used in a transaction. If transactions exist, you need 

to delete the transactions before you can delete the 
record.

 a card that has not been used in a quote, order or recurring 
template

 an item with a zero quantity in inventory

 an activity slip, provided the time billing invoice on which 
it was billed has been deleted or purged [ABSS Premier 
range only] 

 an activity, provided all the activity slips you have 
recorded for it have been purged [ABSS Premier range 
only] 

 a foreign currency record that has not been linked to a 
card [ABSS Premier range only]. 

To delete other records

1 Go to the Lists menu and choose the list to which the 
record belongs. For example, if you are deleting an item, 
choose Items; if you are deleting a card, choose Cards, 
and so on. 

2 Locate the record you want to delete and click the zoom 
arrow ( ) next to it. The record details appear in the 
Information window. 

3 Go to the Edit menu and choose Delete [...]. For 
example, if you are deleting a customer card, choose 
Delete Card.
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Combining records

In some situations you may want to combine two records. For 
example, if you have records in your cards list for two suppliers 
who have merged their operations, or if you have separate 
accounts for two departments whose sales figures you now 
want to combine. 

When you combine two records, you identify one as the 
primary record and the other as the secondary record. The 
primary record becomes the owner of all the transaction 
details (transactions, jobs, history, and so on) currently linked 
to the secondary record and the secondary record is deleted. 

NOTE : History for closed financial years is not 
combined When you complete the Start a New Financial Year 
routine, the previous financial year is closed and your 
transactions are locked. When you combine records, the history 
for closed financial years is not updated; hence your historical 
reports will not display combined amounts for these periods.

Combining cards
You can combine customer, supplier and personal cards, 
providing that the cards are of the same type. 

You cannot combine:

 cards of different types

 cards with different currencies [ABSS Premier range only]

 cards if the primary card is inactive.

When cards are combined, the non-transaction card 
information for the primary card—such as card name, address 
and buying and selling details—is retained as the default 
information for the combined card. The transaction details 
for the secondary card are added to the primary card. 
Non-transaction information for the secondary card is 
deleted. 

To combine two cards

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears. 

2 Select the primary card. This is the card that the 
transaction details will be transferred to.

3 Click Actions and choose Combine Cards. The 
Combine Cards window appears. 

The primary card appears under the Primary - Move all 
transactions to list. If you want to, you can choose a 
different primary card from the list.
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4 Select the secondary card from the Secondary - 
Remove all transactions from list.

CAUTION : The next action cannot be undone Before 
continuing, check that you have selected the correct cards 
to be combined. If you combine the wrong cards, you will 
have to restore them from a backup and re-enter 
transactions posted to those cards since the backup.

5 Click Combine Cards. A confirmation window appears.

6 Click OK to confirm you want to combine the two cards.

Combining accounts
You can only combine accounts that are:

 local currency accounts [ABSS Premier range only]

 accounts of the same account type (for example, asset 
and expense accounts cannot be combined) and

 detail accounts.

You cannot combine header accounts or accounts that are 
linked to other accounts.

When accounts are combined, the non-transaction account 
information for the primary account—such as account name, 
description and bank details (for banking accounts)—is 
retained as the default information for the combined 
account. The transaction details and opening balance of the 
secondary account are added to the primary account. 
Non-transaction information for the secondary account is 
deleted.

NOTE : Budgets and job budgets not combined Budgets 
and job budgets for the secondary account are not added to the 
budgets and job budgets of the primary account. You need to 
revise the budgets of the primary account after combining 
them. 

To combine two accounts

1 Go to the Accounts command centre and click 
Accounts List. The Accounts List window appears.

2 Select the primary account. This is the account that the 
secondary account transaction history and opening 
balance will be transferred to.

3 Click Combine Accounts. The Combine Accounts 
window appears.

The primary account appears under the Primary - Move 
all transactions to list. If you want to, you can choose 
a different primary account from the list.

4 Select the secondary account from the Secondary - 
Remove all transactions from list.

CAUTION : The next action cannot be undone Before 
continuing, check that you have selected the correct 
accounts to be combined. If you combine the wrong 
accounts, you will have to restore from a backup and 
re-enter transactions posted to the accounts since the 
backup.

5 Click Combine Accounts. A confirmation window 
appears.
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To confirm you want to combine the two accounts, click 
OK.



1 6 0   C H A P T E R  1 0 L I S T S



F I N D I N G  A  T R A N S A C T I O N   1 6 1

11  Transactions
A transaction is an entry that changes the balance of accounts. Your ABSS software creates transactions when you record entries such as 
sales invoices, purchase orders and inventory adjustments. 

You can change, delete and reverse transactions—depending on how your preferences are set up.

If you have transactions that need to be entered periodically, you can set up recurring transaction templates. You can use these recurring 
templates to store details of transactions you record regularly and to set up reminders to record them. You can also set up your ABSS 
software to record recurring transactions automatically on their due date.

Finding a transaction

There are several ways to find a transaction. The method you 
use depends on the information you have at hand. These 
methods are listed in the table below.

Use the... To find... See

Find 
Transaction
s window

journal entries, sales, purchases, 
cheques, deposits, supplier and 
customer payments.

page 162

Sales 
Register

transactions relating to sales (such 
as open and closed invoices) quotes, 
orders, credits and returns. This 
method is most efficient if you know 
the transaction date or the 
customer’s name. 

page 162

Purchases 
Register

transactions relating to purchases 
(such as open and closed bills) 
quotes, orders, debits and returns. 
This method is most efficient if you 
know the transaction date or the 
supplier’s name.

page 162

Bank 
Register

spend money, pay bills, receive 
payments and receive money 
transactions.

page 163

Items 
Register

inventory item transactions for a 
particular date range. This includes 
inventory adjustments, auto-build 
and move items transactions.

page 163

Transaction 
Journal 
window

any transaction by source journal. page 164

Use the... To find... See
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To find a transaction using the Find 
Transactions window

1 From any command centre, click Find Transactions. The 
Find Transactions window appears.

2 Click the appropriate tab—for example, the Card tab to 
search by card.

3 Filter your search using the Search By and date range 
fields. For example, to search for all transactions made 
during January 2009 relating to the customer Island Way 
Motel, you would specify the following filters on the Card 
tab.

4 If you want to narrow your search further:
a Click Advanced. The Advanced Filters window 

appears.
b Type or select your additional search filters, and click 

OK. For more information, see ‘Advanced filters’ on 
page 188.

The transactions that match your search criteria appear in 
the Find Transactions window. You can view a 
transaction in detail by clicking the zoom arrow ( ) next 
to it.

NOTE : Quotes and orders without applied payments do 
not appear in the Find Transactions window To find 
these types of transactions, go to the Quotes and Orders 
views of the Sales Register or Purchases Register.

To find a transaction using the Sales Register 
window

The Sales Register window lists all open and closed 
invoices, quotes, orders, returns and credits.

1 Go to the Sales command centre and click Sales 
Register. The Sales Register window appears.

2 Click the tab of the sales category you would like to 
view—for example, Open Invoices.

3 Filter your search using the Search By and date range 
fields.

The transactions that match your search criteria appear in 
the Sales Register window. You can view a transaction 
in detail by clicking the zoom arrow ( ) next to it.

To find a transaction using the Purchases 
Register window

The Purchases Register window lists all open and closed 
purchases, quotes, orders, returns and debits. 

1 Go to the Purchases command centre and click 
Purchases Register. The Purchases Register 
window appears.
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2 Click the tab of the type of purchase you would like to 
view—for example, All Purchases.

3 Filter your search using the Search By and date range 
fields.

The transactions that match your search criteria appear in 
the Purchases Register window. You can view a 
transaction in detail by clicking the zoom arrow ( ) next 
to it. 

To find a transaction using the Bank Register 
window

You can use the Bank Register window to find spend 
money, pay bills, receive payments and receive money 
transactions.

1 Go to the Banking command centre and click Bank 
Register. The Bank Register window appears.

2 Select the bank, credit card or petty cash account you 
used for the transaction in the Account field. 

3 In the Dated From and To fields, enter the date range 
during which the transaction was recorded. 

The transactions that match your search criteria appear in 
the Bank Register window. You can view a transaction 
in detail by clicking the zoom arrow ( ) next to it. 

To find a transaction using the Items Register 
window

When the Items Register window is filtered to show a single 
item, a running balance of the item’s quantities and values 
appears.

1 Go to the Inventory command centre and click Items 
Register. The Items Register window appears.

2 In the Search By field, select whether you want to view 
transactions for all items or a single item.

3 If you selected Item at step 2, type or select the item 
number in the field that appears to the right of the 
Search By field.

4 In the Dated From and To fields, enter the date range 
during which the transaction was recorded. 
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The transactions that match your search criteria appear in 
the Items Register window. You can view a transaction 
in detail by clicking the zoom arrow ( ) next to it. 

To find a transaction using the Transaction 
Journal window

The Transaction Journal window groups all your 
accounting entries into six journals: general, disbursements, 
receipts, sales, purchases and inventory. It also enables you to 
display all transactions.

1 Click Transaction Journal in any command centre 
(except Card File). The Transaction Journal window 
appears. 

2 Click the appropriate tab—for example, the Sales tab to 
find a sales invoice, the Disbursements tab to find a 
cheque or supplier payment, and so on.

3 In the Dated From and To fields, enter the date range 
during which the transaction was recorded. 

All transactions between (and including) these dates will 
be listed.

4 If you want to search for a range of journal ID numbers, 
enter the range in the ID From and To fields. 

The transactions that match your search criteria appear in 
the Transaction Journal window. You can view a 
transaction in detail by clicking the zoom arrow ( ) next 
to it. 

To find a recurring transaction

1 Go to the Lists menu and choose Recurring 
Transactions. The Recurring Transactions List 
window appears.

2 Locate the recurring transaction. You can:
 sort the transactions by name, type or frequency
 search for a transaction by name, amount or due date.

For more information on changing the details of a recurring 
transaction, see ‘Recurring transactions’ on page 167.
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Changing or deleting a transaction

If you are part way through entering a transaction, you can 
erase it and start again by choosing Erase [...] from the Edit 
menu. 

Occasionally, however, you may need to make changes to, or 
delete, a transaction you have already recorded. A transaction 
can be edited or deleted only if it is changeable. A changeable 
transaction is identified by a white zoom arrow ( ) next to 
it. 

You can choose to make transactions changeable or 
unchangeable by selecting or deselecting the Transactions 
CAN’T be Changed; They Must be Reversed option on 
the Security tab view of the Preferences window. By 
default, this preference is set to changeable.

If you want to maintain a strict audit trail, you should consider 
making your transactions unchangeable by setting this 
preference. An unchangeable transaction is identified by a 
grey zoom arrow ( ) next to it. If you make your transactions 
unchangeable, you need to reverse the transaction to cancel 
its effect on your accounts—see ‘Reversing a transaction’ on 
page 166. 

Changing a transaction

CAUTION : Transactions that cannot be changed You 
cannot change a customer payment, supplier payment, refund 
cheque or a bank deposit once it has been recorded. You can only 
delete or reverse these transactions.

To change a transaction

1 Find the transaction in its original transaction window. See 
‘Finding a transaction’ on page 161 for instructions.

2 Make the necessary changes and then click OK. 

Deleting a transaction
When you delete a transaction, it is permanently removed 
from your records. Note the following when deleting a 
transaction:

Sales and purchases You can only delete a sale or 
purchase that does not have a payment applied to it. If you 
have recorded a payment for a sale or purchase, you must first 
delete the payment (including any discounts) and then delete 
the transaction. If you applied a supplier debit towards a 
purchase, you must delete the debit (including the credit 
note) before you can delete the purchase.

Group receipt transactions recorded in the 
undeposited fund account If you want to delete an 
individual receipt that was recorded as part of a bank deposit 
of receipts grouped in the undeposited funds account, you 
must first delete the bank deposit. When you delete a bank 
deposit, all the cash receipts included in the bank deposit are 
returned to the Prepare Bank Deposit window. You can 
then delete the required receipt from this window. 

Negative inventory You cannot delete a purchase that 
will result in negative inventory on-hand. 

Reconciled transactions If you delete a reconciled 
transaction, your bank reconciliation will be out of balance. 
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To delete a transaction

1 Find the transaction in its original transaction window. See 
‘Finding a transaction’ on page 161 for instructions.

2 Go to the Edit menu and choose Delete [...]. For 
example, if you want to delete a sale, choose Delete 
Sale. The transaction is removed permanently from your 
records.

Reversing a transaction

If your accountant wants you to maintain a strict record of all 
your accounting entries, you should reverse a transaction 
rather than change or delete it. 

A reversal transaction is a new transaction that replicates the 
original transaction, but with debit amounts shown as credit 
amounts and vice versa. After posting a reversal transaction, 
you have two transactions (the original and the reversal), but 
the account balances appear as if the original transaction was 
never posted. 

A reversal transaction is automatically posted to the same 
account for the same amount as the original transaction. You 
cannot change the amount or account of a reversal 
transaction. 

Before you can reverse a transaction You can only 
reverse a transaction if it is unchangeable. An unchangeable 
transaction is identified by a grey zoom arrow ( ) next to it. 
To make your transactions unchangeable, select the 
Transactions CAN'T be Changed; They Must be 
Reversed preference on the Security tab view of the 
Preferences window. You can change this preference at any 
time.

Reversing a transaction can affect closed 
periods When you reverse a transaction, be aware of the 
transaction date you enter: 

 If you use the current date when you reverse a transaction 
from a prior month, the month-end financials for the prior 
month will not reflect the reversal transaction. 

 If you use the original date for the reversal transaction, 
your prior month’s financials should be reprinted because 
they will have changed.
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Customer and supplier payments Note that if an 
early payment discount was applied to a sale or purchase, you 
also need to reverse the discount. You can find a discount 
transaction by searching for a transaction with the memo 
‘Discount’ in the Find Transactions window. For more 
information about how to find a transaction, see ‘Finding a 
transaction’ on page 161. 

Negative inventory You cannot reverse a purchase that 
will result in a negative on-hand inventory count. 

To reverse a transaction

1 Find the transaction you want to reverse. See ‘Finding a 
transaction’ on page 161 for instructions.

2 Go to the Edit menu and choose Reverse [...]. For 
example, if you want to reverse a sale, choose Reverse 

Sale. A new transaction containing corresponding 
negative amounts to that of the original transaction 
appears.

3 If you want, alter the date and memo. Note that you 
cannot change the accounts and amounts. 

NOTE : Recap transaction Before you record this 
transaction, you can use the recap transaction feature to 
view the journal entries that will be created when the 
transaction is recorded. To recap, choose Recap 
Transaction from the Edit menu.

4 Click Record Reversal to record the reversal 
transaction. The transaction is reversed and all account 
balances are returned to their previous levels.

Recurring transactions

If you have transactions that you record regularly—for 
example, a rent cheque or banking fees—you can set them up 
as recurring transactions and save them for future use. 

You can set a recurring transaction to record automatically if 
the transaction details are the same each time—such as a rent 
payment. Or you can open the transaction as required, alter 
the details (for example, if you make regular sales to a 
customer and vary the items), and then record the 
transaction.

You can make the following transactions recurring: sales, 
purchases, cheques, deposits and general journal entries. 

Setting up recurring transactions
You can create a recurring transaction in a transaction 
window, or copy an existing recurring transaction to create a 
new one. Later on, you can change details of a recurring 
transaction, or delete one if it is no longer used. These tasks 
are listed in the following table.

If you want to... see

create a recurring transaction below

create a recurring transaction from an existing 
entry

page 169
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To create a recurring transaction

When you create a recurring transaction, you can specify how 
often you want the transaction to be recorded, and for how 
long you want to schedule it. For example, you can schedule 
your car payments monthly for the next 22 months. 

1 Enter the transaction details in a transaction 
window—such as the Sales window if you make regular 
sales to a customer.

2 Instead of clicking Record, click Save as Recurring. 
The Edit Recurring Schedule window appears.

3 In the Recurring Transaction Name field, type a name 
to identify the transaction.

Schedule the transaction

4 Select the transaction frequency from the Frequency 
list. 

5 In the Starting on field, type the date the transaction is 
first due.

6 Indicate how long you want the recurring transaction to 
continue. Click:
 Continue indefinitely to schedule the transaction 

for an unlimited period.

edit a recurring transaction page 170

delete a recurring transaction page 171

If you want to... see



R E C U R R I N G  T R A N S A C T I O N S   1 6 9

 Continue until this date to schedule the 
transaction until a set date. Type the date in the 
adjacent field. 

 Perform this # of times to schedule the transaction 
for a set number of times. Type the number of times in 
the adjacent field. 

Choose Alert Options

In the Alerts section of the window, you can set a 
reminder to record the transaction, or automatically 
record the transaction and get a notification when the 
transaction is recorded. 

7 If you want to set a reminder:
a Click Remind.
b Select a reminder option from the to record this 

transaction list. 
c If you selected # days in advance, enter the number 

of days in the adjacent field.
d Select the user who needs to be reminded from the list 

adjacent to the option.
e Continue with step 9 below.

8 If you want the recurring transaction to be recorded 
automatically:
a Click Automatically record this transaction 

when due and notify.
b Select the user who needs to be notified from the list 

adjacent to the option. 

Specify the transaction Identification Number

9 Specify how you want the transaction ID number to be 
created:
 if you want the transaction ID number to be one greater 

than the previous transaction ID, click Use the next 
sequential number as the [...] #.

 if you want to specify a transaction ID, click Use the 
following as the [...] #, then type the transaction ID 
in the adjacent field. 

10 If you want to save your changes to the recurring 
transaction each time it is recorded, select the Save my 
changes when I record this recurring 
transaction option.

11 Click Save. The transaction window appears. 

12 Click Cancel to close the transaction window. A warning 
window may appear.
a If you do not want to record the transaction 

immediately, click Erase.
b If you want to record the transaction, click cancel, then 

click Record.

The new recurring transaction will now appear in the 
Recurring Transactions List window. See ‘To find a 
recurring transaction’ on page 164.

To create a recurring transaction from an 
existing entry

You can create a recurring transaction by copying an existing 
recurring transaction entry, then customising the details for 
the new one. This can save time if there is an existing 
recurring transaction entry that suits your needs.

1 Go to the Lists menu and choose Recurring 
Transactions. The Recurring Transactions List 
window appears.
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2 Select the recurring transaction you want to copy and 
click Create Copy. The Create Copy window appears.

3 In the Card field, click the search button ( ). 

The Select from List window appears listing only card 
types relevant to the type of recurring transaction you are 
copying. For example, a purchase transaction can only be 
applied to your supplier cards.

4 Either:
 click the select icon ( ) if you want to select all the 

cards listed, or
 mark the select column next to one or more of the cards 

required.

5 Click OK when you have finished selecting from the list. 
The Create Copy window reappears.

6 Click Save. 

7 If you need to change the schedule details or the name of 
a new recurring transaction:
a highlight the recurring transaction
b click Edit Schedule
c make the changes in the Edit Recurring Schedule 

window
d click Save. 

8 Click Close.

To edit a recurring transaction

After you have created a recurring transaction, you can edit 
its details (such as the cheque details of a Spend Money 
transaction) and update its schedule.

1 Go to the Lists menu and choose Recurring 
Transactions. The Recurring Transactions List 
window appears. 

2 If you want to change the recurring transaction details:
a Select the recurring transaction and click Edit. The 

transaction window appears for the selected type of 
recurring transaction.

b Make the necessary changes. 
c Click Save.

If you 
selected... then...

One card in the 
Select from List 
window

• The transaction window for the new 
recurring transaction appears.

• You can edit the transaction details if 
required.

• Click Save. The Recurring 
Transactions List window appears.

More than one 
card in the Select 
from List 
window

• The Recurring Transactions List 
window listing all your recurring 
transactions appears. Each new 
transaction has a unique name—the 
original name suffixed by the name of 
the relevant card.

• To change transaction details for a 
new transaction: highlight it and click 
Edit, make the changes in the 
transaction window and click Save. 
The Recurring Transactions List 
window appears.

If you 
selected... then...
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3 If you want to change the schedule of the recurring 
transaction:
a Select the recurring transaction and click Edit 

Schedule. The Edit Recurring Schedule window 
appears. 

b Change the scheduling details of the transaction as 
required.

c Click Save.

4 Click Close when you have finished editing the recurring 
transaction.

To delete a recurring transaction

Deleting a recurring transaction only removes it from your list 
of recurring transactions. Transactions recorded previously 
using the recurring transaction are not affected.

1 Go to the Lists menu and choose Recurring 
Transactions. The Recurring Transactions List 
window appears. 

2 Select the recurring transaction you want to delete and 
click Delete. 
An information message appears explaining that this 
action will not delete any recorded transactions. 

3 Click OK to delete the recurring transaction.

Recording recurring transactions
For recurring transactions that are not set up to record 
automatically, you need to decide when to record them. You 
can either:

 Record a single recurring transaction from a transaction 
window

 Record several transactions at the same time.

If you use the reminders option, you can also record a 
recurring transaction from the Reminders window. For 

more information, see ‘Responding to reminders for recurring 
transactions’ on page 172.

To record a recurring transaction from a 
transaction window

1 Open the transaction window for the recurring 
transaction you want to use. For example, open the 
Purchases window if you are creating a recurring 
purchase transaction.

2 Click Use Recurring. The Select a Recurring 
Transaction window appears listing only recurring 
transactions for this type of transaction.

3 Choose the recurring transaction from the list and then 
click Select. The transaction appears.

4 If necessary, change the date, amount, account and other 
details.

5 Click Record.

NOTE : Using the Recurring Transactions List window
You can also record a recurring transaction from the Recurring 
Transactions List window by going to the Lists menu and 
choosing Recurring Transactions. 
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To record multiple recurring transactions

1 From any command centre, click To Do List. The To Do 
List window appears.

2 Click the appropriate tab—Recurring Sales, 
Recurring Purchases or Recurring Transactions 
(for all other recurring transactions). 

In the list of recurring transactions that appears, you can 
click the zoom arrow ( ) to the left of a transaction to 
view it in detail.

3 Click in the select column ( ) next to the recurring 
transactions you want to record.

4 Click Record. A window appears requiring you to enter a 
date for the selected transactions. 

5 Enter a date for the transactions and click OK. 

Responding to reminders for recurring 
transactions
You can use your ABSS software to remind you on, or before, 
the scheduled date of a recurring transaction—see ‘Choose 
Alert Options’ on page 169. If you use this option, your ABSS 
software checks the reminder dates each time you open your 
company file. When a recurring transaction is due (or possibly 
overdue), the Reminders window appears.

The options available in this reminder window depend on the 
status of the selected recurring transaction (if more than one 
is showing). For example, if the selected transaction has a due 
date of today or is overdue, the Remind Tomorrow and 
Remind When Due buttons are not available.
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To respond to the Reminders window

1 In the Reminders window, choose the required option. 

2 Click Close to close the window and be reminded again 
next time you open the company file. 

Click... if...

Skip This 
Period

you do not want to record the transaction 
this period.
The reminder is removed from the list.

Remind 
Tomorrow

you do not want to record the transaction 
today, but want to be reminded tomorrow.

Remind When 
Due

you do not want to record the transaction 
today, but want to be reminded when the 
transaction is next due.

Record you want to record the transaction now.
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12  Reports
You can use your ABSS software to monitor your business with over 100 reports. If these do not meet your needs, you can design custom 
reports with the information and appearance you want. Then save these custom reports as templates to re-use whenever required.

Producing reports

You can print, email or fax reports, output them to various file 
formats or export them to other software for further 
modifications.

To display and print reports

1 Go to the Reports menu and choose Index to 
Reports. The Index to Reports window appears.

2 Locate the report you want to display or print. Highlight it 
and click Display. The Report Display window 
appears.

3 If you want to reposition or resize columns:
a Ensure Screen Report is selected in the View field.
b To reposition a column, position the cursor over the 

column header until the cursor changes to the hand 
icon ( ) and then drag the column header to a new 
position.

c To change the width of a column, position the cursor 
over the icon of a column border ( ) and then drag it to 
change the column’s width. Only columns that have this 
icon can be resized.

If you want to... See

display and print reports below

save a report as a file page 176

send a report by email page 176

send a report by fax page 177

view a report in Microsoft Excel page 177
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4 To limit the data that will be printed in the report, click 
Customise and select the data you want. For more 
information, see ‘Customising reports’ on page 180.

5 Select Print Preview from the View list in the report 
toolbar.

6 If you want to save the new report layout as a custom 
report:
a Click Save As. The Save As window appears.
b Type a name for the custom report.
c Click OK.

This new format will be available from the Custom tab of 
the Index to Reports window.

7 Click Print.

To save reports as files

You can save reports in various file formats so that they can be 
viewed and edited in other software.

1 Go to the Reports menu and choose Index to 
Reports. The Index to Reports window appears.

2 Locate the report you want to display and highlight it.

3 To limit the data that will appear in the report, click 
Customise and select the data you want. For more 
information, see ‘Customising reports’ on page 180.

4 Click Send To and choose one of the following file 
formats:

5 In the Save As window, specify a name and location for 
the file and click Save.

To send reports by email

When you send a report by email, the report is saved as a PDF 
file and attached to the body of the email message. Your 
recipient needs a PDF file viewer, such as Adobe Reader, to 
view the report.

Format Description

PDF (Portable 
Document 
Format)

If you save a report as a PDF file, the 
person who receives the report must have 
software, such as Adobe Reader, that is 
capable of viewing a PDF file.

HTML When you save a report in HTML 
(HyperText Markup Language) format, the 
report can be viewed in web browsers 
such as Microsoft Internet Explorer.

Tab-delimited 
Text File

When you save a report in tab-delimited 
text file format, fields in the report are 
separated by tab spaces. Tab-delimited 
text files can be opened by most word 
processing and spreadsheet software.

Comma-separat
ed Text

When you save a report in 
comma-separated text file format, fields 
in the report are separated by commas. 
Comma-separated text files can be 
opened by most word processing and 
spreadsheet software.

Simple Text File When you save a report in simple text file 
format, fields are separated by spaces so 
the appearance of the report is as similar 
as possible to a printed version of the 
report. Simple text files can be opened by 
most word processing and spreadsheet 
software.



P R O D U C I N G  R E P O R T S   1 7 7

1 Go to the Reports menu and choose Index to 
Reports. The Index to Reports window appears. 

2 Locate and highlight the report you want to email. 

3 To limit the data that will appear in the report, click 
Customise and select the data you want. For more 
information, see ‘Customising reports’ on page 180.

4 Click Send To and choose Email. The Email window 
appears.

5 In the Name field, type or select the individual or 
organisation you want to send the report to.

6 If necessary, add or change the email address. 

7 Enter the subject and message of the email.

8 Click Send. The email is sent to your email software’s 
outbox with the report attached as a PDF file.

9 Send the email and attachment from your email software 
as you normally would.

To send reports by fax

If you have fax software installed on your computer you can 
send your reports by fax. Windows 2000 and Windows XP 
include fax software; for more information, see Windows 
Help.

1 Go to the Reports menu and choose Index to 
Reports. The Index to Reports window appears.

2 Highlight the report you want to fax. 

3 To limit the data that will appear in the report, click 
Customise and select the data you want. For more 
information, see ‘Customising reports’ on page 180.

4 Click Send To and choose Fax.

5 Use your fax software to send the fax as you normally 
would.

To view reports in Microsoft Excel

You must have Microsoft Excel installed on your computer.

1 Go to the Reports menu and choose Index to 
Reports. The Index to Reports window appears.

2 Highlight the required report.

3 To limit the data that will appear in the report, click 
Customise and select the data you want. For more 
information, see ‘Customising reports’ on page 180.

4 Click Send To and choose Excel. Microsoft Excel starts 
and the selected report appears.
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TIP : Viewing saved reports in Microsoft Excel You can 
also open reports that you have saved as tab-delimited files, 
comma-separated files or unformatted text files in Excel.
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Printing report batches

A report batch is a group of reports that can be printed all at 
once. For example, you may want to create a report batch 
that contains all your regular monthly financial statements.

NOTE : Single-user access required [ABSS Premier range 
only] If you share your company file on a network, you should 
note that this task requires single-user access. For more 
information, see ‘Single-user file locking for special tasks’ on 
page 270.

To create a report batch

NOTE : Reports excluded from batches Some reports, 
such as the Reconciliation report, cannot be added to report 
batches because you need to specify information to be printed 
each time you want to print the report. Saved custom reports 
are also excluded.

1 Go to the Reports menu and choose Report Batches. 
The Report Batches window appears.

2 Click New. The New/Edit Batch window appears with 
the reports that can be batched.

3 Enter a name for the batch.

4 Click each report you want to include in the batch. 
Selected reports display a tick to the left of the row. To 
remove a report from the batch, click the report name a 
second time. 

5 Click OK. The Report Batches window appears with 
the name of the new batch in the scrolling list.

To print a report batch

1 Go to the Reports menu and choose Report Batches. 
The Report Batches window appears. 

2 Select the relevant period from the Period list.

You can choose any of the months or quarters in the 
current financial year, or you can choose to print 
information for the entire year to date.

Your selection in the Period list affects different types of 
reports in different ways. For example, if you choose 
January, activity reports will show job activity information 
from January 1 to January 31 and balance sheet reports will 
show information as of January 31. 

3 Choose a report batch for printing and click Print. Each 
report in the batch is printed.

To change a report batch

1 Go to the Reports menu and choose Report Batches. 
The Report Batches window appears. 

2 Highlight the name of the batch you want to change and 
click Edit. The New/Edit Batch window appears.

3 Change the batch name, if necessary, and the reports 
contained in the batch. (Click a report to select or 
deselect it.)

4 Click OK to save your changes.

To delete a report batch

1 Go to the Reports menu and choose Report Batches. 
The Report Batches window appears. 

2 Highlight the name of the batch you want to delete.
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3 Go to the Edit menu and choose Delete Batch.

Customising reports

You can customise a report, print it immediately and then 
revert the report to the original settings. Alternatively, if you 
want to retain a report’s modifications, you can save it. The 
saved report  will include advanced filters, report fields, and 
finishing options settings. When you save a customised 
report, it appears in the Custom view of the Index to 
Reports window. Note that you need to re-enter the 
report’s date range the next time you print the report.

Follow the steps below to customise a report.

Task 1: Select the data to be printed
You can filter the amount of information that appears in your 
reports by choosing which categories or ranges of data 
should be included. For example, if you want to print a Sales 
Customer Summary report for a customer for the months 
May to July, you can use filters to select just that customer 
and just those months.

You can filter the information that appears in a report in either 
the Report Display window or the Report 
Customisation window. 

To filter reports in the Report Display 
window

1 Go to the Reports menu and choose Index to 
Reports. The Index to Reports window appears.

2 Locate and highlight the report you want to customise. 

3 Click Display. The Report Display window appears.

4 Filter the report by making the required entries and 
selections in the toolbar that appears in the top section of 
the Report Display window. (Note, some reports do 
not have selection options.)

5 Click Redisplay. The report is refreshed with the new 
filtering options applied. To make further filtering 
selections, see ‘To filter reports in the Report 
Customisation window’ below.

Task See

1 Select the data to be printed below

2 Select the required fields page 181

3 Select finishing options page 182

4 Change the report format page 182

5 Print the report page 183

6 Save the report page 183
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To filter reports in the Report Customisation 
window

1 Go to the Reports menu and choose Index to 
Reports. The Index to Reports window appears.

2 Locate and highlight the report you want to customise.

3 Click Customise. The Report Customisation 
window appears. The customisation options that appear 
depend on the report being customised. The following 
example shows the options available for the Sales 
Summary report.

4 Specify your search criteria in the Advanced Filters tab.

Task 2: Select the required fields
In the Report Fields tab of the Report Customisation 
window, you can choose the fields to include on the report. 

A The top section of the window enables you to limit the 
report to:
• a particular customer or supplier
• records with particular values in custom lists.

B The bottom section has three tabs—Advanced Filters, 
Report Fields and Finishing. 
The Advanced Filters tab lets you set further limits on the 
data displayed (such as limiting records to those within a 
date range). The other two tabs are described later (see 
‘Select the required fields’ below and ‘Select finishing 
options’ on page 182).

A

B
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For example, if you want to print the name of the salesperson 
in a sales report, you can add the salesperson field.

To select the required fields

1 Click the Report Fields tab.

2 Select the fields you want to appear on the report.

Task 3: Select finishing options
The Finishing tab in the Report Customisation window 
provides a number of miscellaneous options, such as what 
default text to add to the report, whether you want the 
report added to the Reports menu, and so on. These options 
vary depending on which report you select.

To select finishing options

1 Click the Finishing tab. 

2 If you want to add the customised report to the Reports 
menu so that you can re-use these customised settings, 
select the Add to Reports Menu option.

3 [ABSS Premier range only] If you are on a network and 
want to prevent data from being changed when the report 
is being generated, select the Prevent Data Changes 
During Report Generation option. This will prevent 
other users from recording transactions or making other 
changes in the company file while the report is being 
printed.

4 Make any other entries or selections that apply to the 
report.

Task 4: Change the report format
You can modify the look of the report by choosing different 
font styles, sizes, colours, alignments and effects, and by 
changing the report’s page margins.

A Fields in the Available Fields column are those that are 
available for the selected report. To include a field in a new 
report, mark the field by clicking in the select column ( ). This 
adds the field name to the Selected Fields column.

B Fields in the Selected Fields column are those that will be 
printed on the selected report. From the top down, the 
sequence of fields in this column is in the order the fields will 
appear in the report. The first field will appear as the left most 
column of the report, the second field will appear in the next 
column to the right, and so on.
If you want to change the order in which the fields are printed, 
display the report and choose Screen Report from the 
View list. You can then drag the column headers to new 
positions. See ‘To display and print reports’ on page 175.

A

B
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To change the report format

1 Click Format in the Report Customisation window. 
The Report Format window appears.

2 Click OK when you have finished formatting the report.

Task 5: Print the report

To print the report

1 Click Display to display the report. 

2 To see how the report will look when printed, select Print 
Preview in the View field. 

3 To print the report, click Print. 

Task 6: Save the report
If you plan to use a report’s design and format again, you can 
customise the report once, save the changes and then re-use 
the report whenever you want. Once saved, you can access 
your custom report from the Custom tab in the Index to 
Reports window.

To save the report

1 With the report displayed, click Save As. The Save As 
window appears.

2 Enter a name and a brief description of the custom report 
and click OK. The Report Display window appears. 

3 Click Close. The Index to Reports window appears.

Note that the report you have just saved is now listed on the 
Custom tab. You can run the report again by selecting it 
from the Custom tab.

A Click the Report Line list, choose the section of the report 
you want to customise and then change the formats as 
required.

B The right side of the Report Format window shows a 
preview of the currently selected report section.

C To change the report’s margins, make entries in the margin 
fields.

D If you have formatted a report and want to change it back to 
its original format, click Default.

A

B

C

D
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Changing the default fonts
Every report is assigned default fonts. You can change these 
default fonts if you prefer your reports to have a different 
appearance.

To change the default fonts

1 Go to the File menu and choose Default Fonts. The 
Default Font Selection window appears.

2 Click Reports. The Report Format - All Reports 
window appears.

3 Choose the font style and size for the printed characters 
on your reports. The sample box previews the appearance 
of your choices.

4 Click OK when you have finished.

NOTE : Changing the default fonts will not affect the fonts on 
any custom report.
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13  Forms
You can print all the standard business documents you send to customers and suppliers: quotes, order confirmations, invoices, delivery 
orders, delivery labels, statements, bills, cheques, receipts, remittance advice and mailing labels.

You can print forms individually as you complete a transaction (for example, an invoice for a cash sale) or print batches of forms (for 
example, a monthly cheque run for supplier payments).

You can also customise the appearance of your forms. You can change the size of the form, print multiple forms on a single page, change 
fonts, move fields, create text labels, and add your own logos and graphics.

Finding forms

Forms can be accessed through the relevant functions in each 
command centre. For example, remittance advices are 
accessible through the Print/Email Remittance Advices 
function in the Purchases command centre, etc.

To find forms

1 Go to the appropriate command centre, for example, 
Sales for invoice forms.

2 Find the type of form you want and click the relevant 
command centre function—see the following tables.
 Banking command centre

 Sales command centre

Type of form Function

Cheques Print Cheques

Receipts Print Receipts

Remittance Advices Print/Email Remittance 
Advices

Type of form Function

Sales Print/Email Invoices

Delivery orders Print/Email Invoices

Labels Print/Email Invoices

Statements Print/Email Statements

Receipts Print Receipts

Type of form Function
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 Purchases command centre  Payroll command centre [ABSS Premier Plus only]

 Card File command centre

Sending forms

You can send forms immediately or as a batch. 

Sending forms immediately
You can print, email or fax forms as you enter individual 
transactions in the Sales or Purchases window. 

You can also preview and print remittance advices or cheques 
when you record transactions in the Spend Money, Pay 
Bills or Settle Returns & Credits window.

Type of form Function

Purchases (item, service 
and professional)

Print/Email Purchase Orders

Cheques (payable) Print Cheques

Remittance Advices Print/Email Remittance 
Advices

Type of form Function

Paycheques Print Paycheques

Pay slips Print/Email Pay Slips

Type of form Function

Mailing labels Print Mailing Labels

Personalised letters Create Personalised Letters
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Sending forms in a batch
Before you can include a form in a batch, you need to select 
how you want to send the form when entering a transaction.

 Sales—select To be Printed, To be Emailed,  or To be 
Printed and Emailed from the Invoice Delivery 
Status field in the Sales window.

 Purchases—select To be Printed, To be Emailed, or 
To be Printed and Emailed from the Bill Delivery 
Status field in the Purchases window.

 Remittance Advices—select To be Printed, To be 
Emailed,  or To be Printed and Emailed from the 
Remittance Advice Delivery Status field in the 
Spend Money, Settle Returns & Credits or Pay Bills 
windows.

After you have completed a number of transactions, for 
example, the invoices for the day, you can print or email a 
transaction batch. 

To print forms

1 Click on the command centre function for the forms you 
want to print. For example, if you want to print a sales 
invoice, go to the Sales command centre and click 
Print/Email Invoices. The Review Sales Before 
Delivery window appears. 

2 Click the To Be Printed tab.

3 Select the layout you want to print in the [...] Type field. 
For example, if you want to print item invoices, select 
Item.

4 Click in the select column ( ) next to a transaction you 
want to be printed. If you want to print all the 
transactions, click the icon in the heading of the select 
column.

5 If you want to view more information about a particular 
transaction, click the zoom arrow ( ) next to the 
transaction.

6 Enter the number of copies you want to print.

7 If you want to filter the transaction information or change 
the type of stationery the forms will be printed on, click 
Advanced Filters. For more information, see ‘Advanced 
filters’ on page 188.
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8 Click Print.

To email forms

1 Choose the form you want to email by going to the 
relevant command centre and clicking the function you 
want. For example, if you want to email a sales invoice, go 
to the Sales command centre and click Print/Email 
Invoices. The Review Sales Before Delivery window 
appears. 

2 Click the To Be Emailed tab.

3 Select the layout you want to print in the Sales Type 
field. For example, if you want to email item invoices, 
select Item.

4 Click in the select column ( ) next to the transaction you 
want to be emailed. 

If you want to email all the forms, click the icon in the 
heading of the select column.

5 If you want to view transaction details of a particular 
transaction, click the zoom arrow ( ) next to the 
transaction.

6 If you want to change a recipient’s email address, highlight 
their name and click the down arrow next to the Email 
Address field and select another address from the card. 

Alternatively, enter the address in the Email Address 
field. 

7 Enter a subject title and message or accept the default 
title and message. If you want to change the default title 
and message, click Email Defaults and change as 
appropriate.

8 If you want to change the type of information you are 
going to email or the type of stationery it will appear on, 
click Advanced Filters. For more information, see 
‘Advanced filters’ below.

9 Click Send Email.

Advanced filters
You can filter the amount of information, and even change the 
stationery you want to use, when you print or email a form. 
You can do this in the Advance Filters window.

1 Click Advance Filters in the Review [...] Before 
Delivery window. 

2 In the top section of the Advanced Filters window, 
select the forms you want to print or email. We are using 
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the example of a service sale type for all customers with 
outstanding payments.

3 If you want to filter the forms, enter a date range or 
reference number range (for example, invoice numbers) in 
the middle section of the window.

4 In the Selected Form for [...] field, select the 
stationery you want to use when you print or email your 
forms.

Several stationery choices are available, depending on the 
type of form you are currently working with.

5 When you have finished making your selections in the 
Advanced Filters window, click OK.

Customising forms

You can change the look and content of printed cheques, 
invoices, delivery orders, purchase orders, statements, bills 
and mailing labels. You can also change the size of a form, add 
text labels, draw lines and boxes, paste graphics on the form, 
move fields, change the size of fields, and more. Then you can 
save your customised stationery so that you can select it 
when you print the form.

[ABSS Premier range only] If more than one user is accessing a 
company file you should:

 create custom forms in the Forms folder on the host 
computer on which the company file is stored

 copy any custom forms from the host computer to the 
Forms folder on each workstation that accesses the 
company file.

Form Usage

Preprinte
d 

Select the preprinted stationery if you want to 
print on paper that already contains lines, 
columns and headings.
The preprinted stationery is designed to match 
most commonly used forms provided by 
third-party forms suppliers. Note that this type 
of stationery is not suitable for emailing forms.

Plain-pap
er 

Select plain-paper stationery if you want to 
print on blank paper. Lines, columns and 
headings are automatically printed with the 
form’s information.

Customise
d 

Select any customised stationery forms if you 
want to print a form you have already 
customised. See ‘Customising forms’ below for 
more information about customising forms.
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CAUTION : Back up your forms Back up the Forms folder 
before customising any forms so you can always revert to the 
originals.

Complete the following steps to create, save and print your 
customised forms:

Task 1: Display the form 
1 Go to the Setup menu, choose Customise Forms and 

choose the type of form you want to customise. The 
Customise Forms window appears. 

2 Select the form you want to customise in the Form to 
Customise field and click Customise. The Customise 
[...] window appears.

Task See 

1 Display the form below

2 Set up the form properties below

3 Adding and editing elements page 191

4 Preview the customised form page 192

5 Save the customised form page 192

6 Print the customised form page 192

A Tool 
palette

The tool palette provides you with 
customisation tools.

B C

A

D
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NOTE : Cheques have two parts A cheque form has two 
parts: the cheque and the stub. You customise the cheque 
and the stub separately. In the cheque Customise window, 
select the appropriate stub layout in the Layout field. For 
example, the Regular layout is assigned to cheques 
recorded in the Spend Money window and the Payable 
layout is assigned to cheques recorded in the Pay Bills 
window.

Task 2: Set up the form properties
1 Click the form properties ( ) button in the tool palette 

of the Customise [...] window. 

The Forms Properties window appears. It has two tabs: 
the Layout tab and the Options tab.

Set up the paper and form sizes

2 In the Layout tab, type the number of forms you want to 
print per page.

3 Select the required type of paper from the Paper list.

4 Type the margins for the page. 

5 Type the width and length of the form (not the paper) in 
the Form Size fields. If you are printing four cheques per 
page, type the width and length of a single cheque and 
not the width and length of the page.

Set up the grid and add a background graphic

6 In the Options tab, specify the grid options for the form. 
The grid will help you position and align form fields.

If you want to:
a make the grid visible in the layout, select Show Grid. 

Note that the grid will not be printed.
b align the top and left margins of fields with the closest 

grid lines when you are repositioning them, select Snap 
to Grid. 

c change the spacing between the grid lines, make a 
selection from the Grid Size menu.

7 If you want, select a background graphic for the form:
a Click Insert Background. The Open window 

appears.
b Select the graphic file you want to use and click Open. 

The Field Properties window displays the graphic in 
the Sample Display area.

c Using the Display menu, choose how the background 
graphic will appear on your printed form:
 Top will position the image at the top of the form.
 Centre will centre the image on the form.
 Tile will repeat the image in a grid-like pattern 

across and down the entire form.
 Stretch will enlarge the image to fill the entire form. 

(Depending on its size and shape, this setting can 
distort the image.)

8 Click OK.

Task 3: Adding and editing elements
Add, remove or edit elements—such as text, graphics and 
lines—according to your needs. For more information, see 
‘Adding and editing elements’ on page 193.

B Preview Click Preview to view your form on the 
screen.

C Layout Select the required layout for a cheque stub. 
Note that this is only displayed if you are 
customising a cheque.

D Data 
fields

Data fields contain system-generated 
information.
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Task 4: Preview the customised form
At any time during the customisation process, you can display 
a preview of your work. 

1 Click the preview button ( ) in the tools palette of the 
Customise [...] window. 

The form is displayed in the Print Preview window.

2 If you want to view the form in more detail, alter the 
default value (75%) in the Zoom field and press TAB.

3 If you want to check your current printer and page 
settings, click Print Setup.

4 When you have finished previewing the form, click Close 
in the Print Preview window.

Task 5: Save the customised form
When you are satisfied with the changes you have made to 
the form, you should save the customised form. If you want to 
save changes to a custom form you created previously, click 
Save Form.

If you want to create a new custom form stationery that 
contains the changes you have made, click Save Form As. 
The Save As window appears. Enter a name and a brief 
description for the new layout and click OK.

Task 6: Print the customised form
Printing a customised form is the same as printing an 
unchanged form. However, before you can print using your 
customised form, you need to select the form in the 
Selected Form for [...] field in the Advanced Filter 

window. For more information on printing forms, see ‘To print 
forms’ on page 187.

Changing the default fonts on forms
Every form in your ABSS software is assigned default fonts. 
You can change these default fonts if you prefer your forms to 
have a different appearance. 

1 Go to the File menu and choose Default Fonts. The 
Default Font Selection window appears.

2 Click Forms. The Change Default Forms Font 
window appears.

3 Choose the font style and size for the printed characters 
on your forms. The sample box previews the appearance 
of your choices.

4 Click OK when you have finished.
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Adding and editing elements

You can add elements to, and change elements on, a form 
using the buttons on the tool palette shown below: 

NOTE : Layout selection The Layout list only appears for 
cheque forms.

To add a data field to a form

1 Click the add data ( ) button. The Select from List 
window lists all the data fields available for the form you 
selected.

The column on the right indicates the field type (Data, 
Column) and where it appears on a form. For example, the 
Total field only appears on the last page.

2 Click the fields you require.
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3 Click OK. The selected data fields appear on the form. 
Their position depends on a number of factors, such as the 
number of records they can display, previous cursor 
position and other fields already on the form. You can 
move a field to a better position—see ‘Editing all elements 
with common commands’ on page 196.

4 If you want to change the properties of a data field, 
double-click it. The Field Properties window appears.

The Field Properties window has two tabs: the Layout 
tab where you select the text, format, background colour, 
location and size of the field, and the Borders tab where 
you select the layout, colour and width of the field’s 
borders.

5 Change the properties as required and click OK.

To add a field label to a form

1 Click the add text button ( ) and then click the form 
where you want to place the text field. A new text field 
named Text Field appears.

2 Double-click the new text field. The Field Properties 
window displays the Layout tab where you select the 
name, location, size, text format and background colour 
of the text field, and the Borders tab where you select 
the layout, colour and width of the text field’s borders.

3 Click OK to close the Field Properties window. The 
text field appears in the Customise window.

If the name is longer than the size of the text field, you need 
to resize the field—see ‘Resize’ on page 196. 

To change the name of a text field

1 Double-click the text field. The Field Properties 
window appears.

2 Change the name in the Text field on the Layout tab.

3 Click OK.

To change the font style of a data field or 
text field

1 Double-click the data field or text field to be changed. 
The Field Properties window appears.

2 Click Text Format on the Layout tab. The Text 
Format window appears.

3 Make your choices in the Font, Font Style, Size, 
Justify and Effects fields in this window. 

4 If you want to change the font colour:
a Click Font Colour and then in the Colour window 

that appears, select the new colour. 
b Click OK. The Text Format window reappears.

5 Click OK.

Adding and editing graphic elements
You can also add graphic elements to a form: rectangles to 
visually group elements, lines to separate elements, and 
icons, logos, photos, location maps and other graphic 
elements. 

To add a graphic file to a form 

1 Click the add graphic button ( ) in the Customise 
window and then click on the form where you want to 
place the graphic. A new graphic element appears.
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2 Double-click the graphic element. The Field Properties 
window appears.

3 Click Load Picture. The Open window appears. 

4 Select the graphic file and click Open. The Field 
Properties window displays the graphic in the Preview 
Picture area.

5 Type the field location and field size for the picture.

6 Click OK to close the Field Properties window. The 
picture appears in the Customise window.

To paste a graphic element into a form

You can paste almost any graphic that can be placed on the 
clipboard into a form, regardless of its graphic format.

1 Open your graphic file in any graphics software.

2 Copy the graphic to the clipboard.

3 Click the add graphic button ( ) in the Customise 
window. Then click the location on the form where you 
want the graphic to appear. A graphic element appears.

4 Double-click the graphic element. The Field Properties 
window appears. 

5 Click Paste Picture. The graphic appears in the 
Preview Picture area.

6 Type the field location and element size for the graphic.

7 Click OK. The graphic appears in the Customise window.

To draw a line on a form

You can draw a vertical or horizontal line on a form.

1 Click the draw line button ( ) and then click and hold 
the mouse on the form where you want the line to begin.

2 Drag to where you want the line to end and then release 
the mouse button.

To draw a rectangle on a form

1 Click the rectangle button ( ).

2 Click and hold the mouse at the location on the form 
where you want the top left corner of the rectangle to 
appear.

3 Drag to the right and down to where you want the 
rectangle to end and then release the mouse button.

To change the thickness of a line or rectangle

1 Double-click the line or rectangle. The Field Properties 
window appears.

2 Choose a thickness in the Line Size section of the Field 
Properties window.

3 Click OK.
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Editing all elements with common 
commands
The following editing procedures are applicable to any 
element.

There are also procedures specific to particular kinds of 
elements—see ‘Adding and editing elements’ on page 193 
and ‘Adding and editing graphic elements’ on page 194.

To... Do this...

Copy and 
paste

1 Click an element once to select it.

2 Go to the Edit menu and choose Copy.

3 Go to the Edit menu and choose Paste. A copy 
of the element appears in the window.

Note: If you want to paste the element onto another 
form, display that form in the Customise window.

Delete Select the element and press BACKSPACE or DELETE on 
your keyboard. 

Undo last 
change

To undo the last change you made to the current 
form, click the undo button ( ) or press CTRL + Z.

Resize 1 Click the element once to select it. Small 
squares, called handles, appear on the element.

2 Drag a handle to change the size of the element.

Drag and 
drop

1 Click the element and hold down the mouse 
button. Notice that the cursor changes to a hand 
pointer. 

2 Drag the element to the desired location. In the 
example below, the [Invoice No] data field is 
being dragged below its original position. 

Change 
coordinat
es

1 Double-click the element you want to move. The 
Field Properties window appears.

2 In the Field Location fields on the Layout 
tab, enter the distance from the top and left 
edges of the form to the top left corner of the 
element.

3 Click OK.

Send to 
back

1 Select the element you want to send behind 
another element.

2 Click the send to back button ( ).

Bring to 
front

1 Select the element you want to bring in front of 
another element.

2 Click the bring to front button ( ).

To... Do this...
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14  Contact management
The Card File is a repository of contact records, known as cards, that you can create for your customers, suppliers, employees and personal 
contacts. A card lets you store contact information and enables you to track and analyse the transaction history for each individual and 
business.

Creating a card

You need to create a card for an individual or business if you 
want to perform any of the following tasks:

 record sales and track the amounts owing to you

 record purchases and track the amounts owing to 
suppliers

 print mailing labels 

 print personalised letters

 record contact details.

When you set up your company file, you may have created 
cards for your customers and suppliers. In addition to these 
cards, you can create employee cards and personal cards for 
your friends and relatives.

To add a personal card 

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears.

2 Click New. The Card Information window appears.

3 Select the required card type from the Card Type list.

4 Type the name for the card and press TAB.

If you want to create a card for… See

a customer page 58

a supplier page 83

an employee page 117

a friend or relative below
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5 If you want to, complete the other fields in the Profile 
tab.

6 Click the Card Details tab. In this tab, you can:
 add a picture
 enter identifiers—these are useful for grouping your 

cards

 use custom lists and fields—you can record additional 
information about the card. 

For information about these tasks, see ‘Customising 
cards’ on page 212.

7 When you have finished entering the card details, click OK 
to save the card and close the Card Information 
window.

Keeping in touch with your contacts

At times you may want to send a letter to your contacts, such 
as payment reminders, thank you letters, or special offers. 

There are several card file features that can help you with 
these tasks, and can help you keep a record of each contact 
you make.

Personalised letters
You can create personalised letters (also known as mail-merge 
letters) for any of your contacts. A personalised letter is a 
document template that contains standard text as well as 
fields that can be automatically filled with data stored in your 
company file.

Personalised letters are useful when you need to send the 
same letter to several contacts. For example, you may want to 
send several slow-paying customers a payment reminder 
letter. Instead of entering each contact’s information on the 
letters yourself, you can set up a letter template that contains 
the text you want to appear, and insert data fields that 
automatically fill in with the contact’s name, address and the 
amount owing.

Printing personalised letters using 
Microsoft Word and OfficeLink
OfficeLink is a feature that automates the process of merging 
contact information stored in your company file with a 
Microsoft Word template (a .dot file). Your ABSS software 
includes a set of templates that you can use, and they are 
stored in the Letters folder, which is located within your 
ABSS software’s program folder.

You can edit these templates and create new ones using the 
mail-merge features of Microsoft Word. For information 
about working with mail-merge templates, see Microsoft 
Word Help.

To print a personalised letter using Microsoft 
Word

1 Go to the Card File command centre and click Create 
Personalised Letters. The Review Cards Before 
Exporting window appears.

2 Click in the select column next to each contact to whom 
you would like to send a personalised letter.
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TIP : Advanced Filters You can filter your contact list, for 
example, to only show contacts who are located within 
specific postcodes by clicking Advanced Filters and 
entering your criteria.

3 Click Mail Merge. The Select from List window 
appears.

4 Select the template you would like to use and then click 
Use Template.

Your letter appears in Microsoft Word, and depending on 
the template you have selected, you will be prompted to 
enter additional information, such as your name and title.

5 Edit the letters as required and then print them using 
Microsoft Word.

Printing personalised letters using other 
word processors
If you want to use a mail-merge letter template created using 
word processors other than Microsoft Word, you will need to 
export the data out of your company file and then merge that 
data with the letter.

To print a personalised letter using other 
word processors

1 Go to the Card File command centre and click 
Personalised Letters. The Review Cards Before 
Exporting window appears.

2 Select the contacts to whom you would like to send a 
personalised letter.

TIP : Advanced Filters You can filter your contact list, for 
example, to only show contacts located within specific 
postcodes by clicking Advanced Filters and entering your 
criteria.

3 Click Disk. A window with a list of file formats appears.
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4 Choose either the Tab-Delimited Text File or 
Comma-Separated Text File option.

NOTE : Check what file formats your word 
processing software requires Most word processing 
software allows mail-merge data to be tab-delimited (data is 
separated by tabs) or comma-separated. If your software 
requires a specific format, choose that format at this step.

5 Click Save. The Save As window appears.

6 If necessary, change the text file’s name and location and 
then click Save. 

The text file containing your contacts’ details is saved at 
the location you specified.

7 Use your word processing software to merge the data 
contained within the text file with a letter template that 
you have created.

Mailing labels
If you print and send cheques, quotes, orders, invoices, 
statements or personalised letters you may also want to print 
mailing labels that you can stick on the envelopes. 

The Print Mailing Labels function in the Card File 
command centre can be used to print your contact names and 
addresses on sheets of adhesive mailing labels. You customise 
the way mailing labels are printed, including their size, the 
number of labels per sheet and the margins. For information 
about customising mailing label forms, see ‘Customising 
forms’ on page 189.
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To print mailing labels

1 Go to the Card File command centre and click Print 
Mailing Labels. The Review Labels Before Printing 
window appears.

TIP : Print invoices and labels simultaneously When 
you print a batch of invoices using the Print/Email 
Invoices function in the Sales command centre, you can 
choose to print a label for each invoice.

2 Click Advanced Filters. The Advanced Filters 
window appears.

3 From the Selected Form for Mailing Label list, select 
the form template that best matches the size and layout 
of your labels and label sheets.

If a suitable form template is not available, you can 
customise an existing template to suit your requirements. 
For information about customising forms, see 
‘Customising forms’ on page 189.

4 Make any other selections in the Advanced Filters 
window as required (for example, you may want to filter 
your contacts list to only those living within a specific 
postcode) and then click OK.

5 Click in the select column next to each contact for whom 
you would like to print a mailing label.

6 Ensure you have enough mailing label sheets set up at your 
printer and then click Print.

Contact log
The contact log enables you to keep a detailed log of all the 
phone calls you and your contacts make to each other, and 
any other type of correspondence. 

For example, let’s say that you call customer A regarding an 
overdue invoice. You could create a log entry that records the 
date of the phone call, a summary of the outcome, and the 

date you will want to recontact them by if their invoice is still 
outstanding.

When a customer or supplier calls, you can use the contact 
log to retrieve a complete history of your business 
relationship with that contact.

TIP : Automatically create contact log entries Log 
entries can be created automatically for each sale, purchase, 
payment and receipt you record. For more information, see ‘To 
automatically create contact log entries’ on page 202.

To view the contact log

1 Go to the Card File command centre and click Contact 
Log. The View Contact Log window appears.

2 From the Name list, select the contact for whom you 
want to create a contact log entry and click Use Card.

3 If you want to view or edit the detail of an log entry, select 
the entry and click Edit, or click the zoom arrow next to 
it.

To create a contact log entry

1 Go to the Card File command centre and click Contact 
Log. The View Contact Log window appears.

2 From the Name list, select the contact for whom you 
want to create a contact log entry and click Use Card.

3 Click New. The Contact Log Entry window appears.
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4 Complete the Contact Log Entry window as described 
in the table below.

Automatic contact log entries You can choose to 
automatically create contact log entries each time you record 
a sale, purchase or banking transaction. The log entry 
contains basic information about the transaction, such as the 
invoice number, cheque number and the amount.

NOTE : Your company file’s size may increase 
significantly If you record many transactions and choose to 
automatically create log entries for them, the size of your 
company file may increase significantly. If the company file size 
becomes an issue, you can purge old contact log entries and 
other data. For more information about purging information, see 
‘Purging information that is no longer needed’ on page 268.

To automatically create contact log entries

1 Go to the Setup menu and choose Preferences. The 
Preferences window appears.

2 Click the Banking tab. 

3 To create an automatic contact log entry for each 
payment you record, select the Make Contact Log 
Entry for Every Cheque option.

4 To create an automatic contact log entry for each receipt 
you record, select the Make Contact Log Entry for 
Every Deposit option.

5 Click the Sales tab. 

Name The name of the contact. To view the contact’s 
card, click the zoom arrow.

Contact Type the name of the person that is associated 
with this entry. For example, you can record the 
name of the person you spoke to on the phone. 
If you have specified a contact person in the 
contact’s card, you can click the down-arrow to 
choose that person.

Date Type the date you spoke to or wrote to the 
contact. If you are simply entering an 
appointment or reminder, you can enter today’s 
date.

Notes Enter any information you want to save about the 
conversation or follow-up.

Elapsed 
Time

If you want to record the time you spend 
speaking to the contact, or working on a 
particular task related to the entry, type the time 
in hours and minutes. For example, if you spend 15 
minutes, enter 15. If you spend 1 hour and 15 
minutes, enter 1:15.

Reconta
ct Date

If you want to be reminded to follow up the 
contact, type or select the date you want to be 
reminded to recontact them. The reminder will 
appear in the Contact Alert tab of the To Do 
List on this date. For more information, see ‘To 
view contact alerts’ on page 214.

Log View all contact log entries for the selected 
contact.

New Record the current log entry and to create a new 
entry for this or another contact.
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6 To create an automatic contact log entry for each sale you 
record (including quotes and orders), select the Make 
Contact Log Entry for Every Sale option.

7 Click the Purchases tab. 

8 To create an automatic contact log entry for each 
purchase you record (including quotes and orders), select 
the Make Contact Log Entry for Every Purchase 
option.

9 Click OK to close the Preferences window.

More ways to keep in touch

To send an email message to a contact

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears.

2 Click the zoom arrow next to the name of the contact you 
want to email. The Card Information window appears.

3 In the Location field, select the address to which you 
want to send the email. 

4 If an email address is entered in the field, click Actions 
and choose Send Email. The Email window appears.

5 The Email Address field displays the name and email 
address from the card. You can change these if you wish.

6 Enter a message and click Send. The email is sent to your 
default email program’s outbox. Send the file from your 
email program as you normally do.

To access a contact’s website

1 Make sure your computer is connected to the Internet.

2 In the Card Information window, display the Profile 
view of the contact.

3 If a website is listed in the Website field, click Actions 
and choose View Website.

4 Your contact’s website will appear in your web browser. 

View a contact on a map

To view a contact’s location on a map

1 Make sure your computer is connected to the Internet.

2 In the Cards List window, select the card whose location 
you want to view.

3 Click Actions and choose:
 View in Google MapsTM. Your web browser window 

will appear, showing the location of your contact on a 
street map.

 View Directions. Your web browser window will 
appear, displaying a street map with directions from 
your primary business location to the contact’s address.
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Grouping your contacts 

You can group and sort your contacts according to common 
attributes by assigning identifiers to their cards and the 
appropriate attributes from custom lists you have defined. 

Grouping contacts using these features makes it easier for 
you to:

 filter reports to show only information specific to a group 
of contacts

 identify which of your contacts have a particular attribute

 filter lists so that it’s easier for you to send a batch of 
personalised letters, customer statements and other 
forms to a group of contacts.

Identifiers
Identifiers are one-letter labels you can assign to cards. 

When you create reports or view card lists, you can limit the 
information to a particular group of cards by selecting the 
identifiers that you have assigned to those cards.

For example, say you want to identify all clients who are 
not-for-profit organisations. You could assign them identifier 
N and when printing sales reports you can choose to filter the 
report to show only customers who have that identifier.

You can also assign multiple identifiers to a card. For example, 
say you assign O to your overseas customers and W to your 
wholesale customers. If you have overseas wholesale 
customers you can assign them the O and W identifiers. You 
can then filter a report to only show your overseas wholesale 
customers by specifying the OW identifiers in the Report 
Customisation window.

To define identifiers

1 Go to the Lists menu and choose Identifiers. The 
Identifiers window appears, displaying a field for each 
of the 26 letters of the alphabet. 

2 Enter a description for the identifiers you want to use.

3 Click OK.

To assign identifiers to a card

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears.

2 Click the zoom arrow next to the card you want to edit. 
The Card Information window appears.

3 Click the Card Details tab.

4 Click Identifiers. The Select Identifiers window 
appears.

5 Click next to the identifiers you want to assign to the card 
and click OK.
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Custom lists
You can set up lists of predefined attributes and assign the 
appropriate attributes to your cards. 

By assigning attributes from a custom list to your cards, you 
are able to group your contacts to a greater degree than is 
possible with identifiers.

For example, you could assign all your wholesale customers 
the W identifier. If you also set up a custom list containing 
each of your sales territories, and allocate those customers to 
the appropriate territory, you can then filter reports to only 
show information about wholesale customers who are within 
a particular sales territory.

To name a custom list

1 Go to the Lists menu, choose Custom List & Field 
Names, and then choose the card type for which you 
want to create a custom list, for example, Customers. 
The Custom List and Field Names window appears.

2 Enter names for the lists you want to create for the card 
type you have selected in the Name of Custom List 
fields.

3 Click OK. The names you have entered will now appear in 
the Card Details tab of the Card Information 
window.

To create a custom list entry

1 Go to the Lists menu, choose Custom Lists and then 
choose the card type for which you want to create a 
custom list entry, for example, Customers. The Custom 
Lists window appears.

2 Select the custom list for which you want to create an 
entry.

3 Click New. The Edit Custom List window appears.

4 Type the custom list entry’s name and then click OK.

The entry appears in the Custom Lists window.

To assign a custom list entry to a card

1 Go to the Card File command centre and click Cards 
List.

2 Click the zoom arrow next to the card you want to edit. 
The Card Information window appears.

3 Click the Card Details tab.

4 Click the search icon next to the custom list field you want 
to edit and then select the entry that you want to assign 
to the card.
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Synchronising ABSS cards and Microsoft Outlook contacts

You can synchronise your ABSS cards and your Microsoft 
Outlook contacts. If your business uses Microsoft Outlook to 
email and manage contact information, this will make it easier 
for you to keep both your ABSS cards and your Outlook 
contacts up to date. 

Your ABSS cards are your customer, supplier, employee and 
personal cards stored in your ABSS card file. Your Outlook 
contacts are your contacts stored in your Microsoft Outlook 
address book. 

When you synchronise your ABSS cards and your Outlook 
contacts, you can:

 make the details in your Outlook contacts match the 
details in your ABSS cards (by exporting your ABSS cards 
to your Outlook contacts) or

 make the details in your ABSS cards match the details in 
your Outlook contacts (by importing your Outlook 
contacts to your ABSS cards).

When you synchronise, the following details are imported 
or exported: company name or contact name, address 
details, email and web addresses and telephone, fax and 
mobile numbers. 

If you are exporting your ABSS cards to your Outlook 
contacts, you can also include your Card File custom fields in 
the export. When you do this, you will need to match your 
custom fields to the Categories, Anniversary, Birthday or 
Spouse’s name fields in your Outlook contacts. For 
information on setting up Card File custom fields see ‘Custom 
fields’ on page 212.

Synchronisation update rules As part of the 
synchronisation process, you choose whether or not you 
want to update the details for existing contacts. To do this, 
you select from one of the following update rules:

Software required You require Microsoft Outlook 2000 
(or later), ABSS Outlook Sync and ABSS ODBC Direct 
installed on your computer. For more information, refer to the 
Getting Started guide.

CAUTION : Single-user access required [ABSS Premier range 
only] Synchronising cards and Outlook contacts requires 

Update existing 
contacts

New contacts are added and existing 
contacts are updated. You will not be 
prompted to confirm updates.

Do not update 
existing contacts

New contacts are added but existing 
contacts are not updated. You are not 
prompted to confirm any updates.

Ask me to confirm 
updates

New contacts are added and you are 
prompted to confirm updates. If you 
select this rule, you need to select how you 
want to deal with the discrepancies 
between the details in your ABSS cards and 
the details in your Outlook contacts. 
You can:
• review and update the details for each 

contact 
• select to update all contacts (if you 

select this option, you will not be 
prompted to confirm any further 
updates) or

• skip an update for a contact and leave 
the details for the contact unchanged. 
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single-user access. For more information, see ‘Single-user file 
locking for special tasks’ on page 270. 

Exporting your ABSS cards to your 
Outlook contacts 
When you export your ABSS cards to your Outlook contacts, 
your contacts are saved by default to group contact folders. 
For example, Customer contacts are saved to a folder called 
ABSS Customers. 

If you use a Personal Digital Assistant (PDA) and want to 
synchronise your Outlook contacts and your PDA, your 
contacts must be saved to the Microsoft Outlook default 
contacts folder. When you export your ABSS cards to your 
Outlook contacts, you can select an option to save your 
contacts to the default contacts folder.

CAUTION : Back up your Outlook contacts Exporting your 
ABSS cards to your Outlook contacts will change the details 
recorded in your Outlook contacts. Back up your Outlook 
contacts before synchronising. See your Microsoft Outlook 
documentation for instructions.

To export your ABSS cards to your Outlook 
contacts

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears. 

2 Click Actions and choose Sync Cards. The 
Synchronise Cards window appears. 

3 Select the card types that you want to synchronise. 

NOTE : You can synchronise cards from any of the 
Cards List tabs (All Cards, Customer, Supplier, 
Employee and Personal) The default card type selected 
varies according to the tab you are on when you clicked 
Sync Cards.

4 Click Synchronise Cards. The Outlook Sync - 
Import and Export Options window appears. 
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5 If you want to include inactive cards in your 
synchronisation, select the Allow the export of 
inactive ABSS cards to Outlook option. For 
information about inactive cards, see ‘To inactivate (or 
reactivate) a record’ on page 155. 

6 Select a synchronisation rule from the Update Rules list. 
For more information, see ‘Synchronisation update rules’ 
on page 206.

7 If you want to save your ABSS cards to your Outlook 
contacts default folder (you need to do this to 
synchronise your Outlook contacts and your PDA), or if 
you want to export your ABSS custom fields to your 
Outlook contacts, click Settings. The Outlook Sync - 
Settings window appears. 

a If you want to synchronise your Outlook contacts and 
your PDA, select the Import and export all ABSS 
cards to the default contacts folder option. All 
contacts are then saved to your default Outlook 
contacts folder. 

b If you want to export your ABSS custom fields to your 
Outlook contacts, select a matching Outlook contact 
field for Custom Field 1, Custom Field 2 and 
Custom Field 3. 

c Click OK. The Outlook Sync - Import and Export 
Options window reappears.

8 Click Export. A Microsoft warning appears.

9 Select a period for your ABSS software to access your 
Outlook contacts.
a Select the Allow access for option.
b Select a period from 1 minute to 10 minutes.
c Click Yes. The export process starts. 

10 If you selected the Update existing contacts rule or 
the Do not update existing contacts rule, the 
Outlook Sync - Export Summary window appears. 
Go to step 12.

11 If you selected the Ask me to confirm updates rule, 
the Outlook Sync - Confirm Update to Outlook 
Contact window appears. 

Select how you want to deal with each update. When you 
have confirmed all updates the Outlook Sync - Export 
Summary window appears.
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12 Review the export summary.

NOTE : Outlook import log If you want to view a list of 
the records updated and the problems encountered during 
the import, refer to the OutlookImport.html file. This 
file—readable by any Internet browser—can be found in the 
OutlookSync folder, which is located in your ABSS software’s 
program folder.

Importing your Outlook contacts to 
your ABSS cards
You can import your Outlook contacts to your ABSS cards 
from either the default contacts folder, or from group 
contact folders created for each ABSS card type.

However, before you import your Outlook contacts, you need 
to identify each contact as either a customer, supplier, 
employee or personal contact. 

NOTE : Blank fields in your Outlook contacts are not 
included in the import If a field in your Outlook contact is 
blank but the corresponding field in your ABSS card is complete, 
this field will be skipped during the import process. This ensures 
that blank fields do not overwrite contact details recorded in 
your ABSS cards. 

Importing from the default contacts folder If you 
want to import your contacts to ABSS cards from the default 
Outlook contacts folder, enter the card type for each contact 
in the Categories field of the General tab.

Importing from group contacts folders You need to 
save your contacts to group contact folders labelled ABSS 
Customers, ABSS Suppliers, ABSS Employees and ABSS 
Personal. For instructions on how to set up group contact 
folders in your Outlook contacts, refer to your Microsoft 
Outlook documentation.

Added 
new 
contacts

The number of new contacts added to your 
Outlook contacts.

Updated 
duplicate 
contacts 

The number of Outlook contacts updated to 
match the details in your ABSS cards. Note that 
if you selected the Do not update existing 
contacts rule, updated duplicate contacts 
will always be 0.

Rejected 
cards

The number of cards you skipped (if you 
selected the Ask me to confirm updates 
rule) or the number of duplicate contacts (if 
you selected the Do not update existing 
contacts rule). Duplicate contacts have not 
been updated to match your ABSS cards. 
Note that if you selected the Update 
existing contacts rule, rejected cards will 
always be 0.
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Before importing your Outlook contacts Check 
that the details recorded in your Outlook contacts are up to 
date and contact in formation is entered in the correct fields. 

Back up your company file Importing your Outlook 
contacts to your ABSS cards will change the details recorded 
in your company file. To avoid losing contact details stored in 
your company file, back up your company file before 
synchronising. For more information on backing up your 
Company File, see ‘Backing up and restoring company files’ 
on page 262.

To import your Outlook contacts to your 
ABSS cards

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears. 

2 Click Actions and choose Sync Cards. The 
Synchronise Cards window appears.

3 Select the card types that you want to synchronise. 

NOTE : You can synchronise cards from any of the 
Cards List tabs (All Cards, Customers, Suppliers, 
Employees and Personal). The default card type 
selected will vary according to the tab you are on when you 
clicked Sync Cards.

4 Click Synchronise Cards. The Outlook Sync - 
Import and Export Options window appears. 

5 Select a synchronisation rule from the Update Rules list. 
For more information, see ‘Synchronisation update rules’ 
on page 206.

6 If you want to import your Outlook contacts from the 
default Outlook contacts folder, click Settings. The 
Outlook Sync - Settings window appears. If you are 
importing your contacts from group contact folders, go 
to step 7 below. 

Select the option Import and export all ABSS cards 
to the default contacts folder and then click OK.

7 Click Import. A Microsoft warning appears.
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8 Select a period for your ABSS software to access your 
Outlook contacts:
a Select Allow access for option.
b Select a period from 1 minute to 10 minutes.
c Click Yes.

The import process starts and the Blank Field Warning 
window appears.

9 Click Continue. 

10 If you selected the Update existing contacts rule or 
the Do not update existing contacts rule, the 
Outlook Sync - Import Summary window appears. 
Go to step 12 below.

11 If you selected the Ask me to confirm updates rule, 
the Outlook Sync - Confirm Update of ABSS card 
window appears.

Select how you want to deal with each update. When you 
have confirmed all updates the Outlook Sync - Import 
Summary window appears.

12 Review the import summary.

NOTE : ABSS import log If you want to view a list of the 
records updated and the problems encountered during the 
import, refer to the ABSSImport.html file. This file—readable 
by any Internet browser—can be found in the OutlookSync 
folder, which is located in your ABSS software’s program 
folder.

Updated or 
added cards

The number of cards added or updated in 
your ABSS cards.

Updated or 
added cards 
with 
warnings

The number of cards updated but the 
details in your ABSS cards may be 
incomplete.

Skipped 
contacts

The number of contacts you chose to skip 
(if you selected update rule Ask me to 
confirm updates) and the number of 
contacts that were not imported because 
they contained blank Outlook contact 
fields.
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Customising cards

Custom fields
If you need to record certain information about your 
contacts, but cannot find a suitable card field for it, you may 
want to set up a custom field.

For example, you could set up a field to record your 
customers’ birthdays or a field to record the dates of your 
employees’ most recent performance review. 

You can set up three custom fields for each card type and 
label them according to your needs. You can then enter any 
information you like in those fields. 

If you need to, you can show this information in a report by 
selecting the custom fields in the Report Fields tab of the 
Report Customisation window.

To set up custom fields

1 Go to the Lists menu, choose Custom List and Field 
Names and then choose the card type for which you want 
to set up a custom field, for example, Customers. The 
Custom List and Field Names window appears.

2 Type the names of the custom fields you want to set up 
for the card type you have selected in the Name of 
Custom Field fields. For example, you could enter 
Birthday to record your contacts’ birthdays.

3 Click OK. The names you have entered will now appear in 
the Card Details tab of the Card Information 
window.

To enter custom field information in a card

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears.

2 Click the zoom arrow next to the card you want to edit. 
The Card Information window appears.

3 Click the Card Details tab and type the information you 
want to record in the appropriate custom field.

Card identification codes
If you have assigned identification codes (IDs) such as 
customer numbers or account numbers to your customers, 
you can enter those IDs in their cards. 

You can also set a preference that will let you select 
customers by their ID instead of their last name or company 
name when entering a transaction. Customer search lists will 
also be sorted by their ID when this preference is set.For more 
information, see ‘To select contacts using Card IDs’ on 
page 213.

NOTE : The Card ID preference affects all card types If 
you choose this preference, you have to select all card types by 
their IDs. 

To enter an identification code

1 Go to the Card File command centre and choose Cards 
List. The Cards List window appears.

2 Click the zoom arrow next to the card you want to edit. 
The Card Information window appears.

3 Enter a unique code of up to 15 alphanumeric characters in 
the Card ID field.

4 Press TAB or click OK to save your changes.
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To select contacts using Card IDs

1 Go to the Setup menu and choose Preferences. The 
Preferences window appears.

2 Click the Windows tab.

3 Choose the Select Cards by Card ID, Not Card 
Name option.

You can now select cards by their IDs and your card lists 
will be sorted by ID instead of by last name or company 
name.

Card pictures
You can display a picture of your contact by linking a picture 
file to their card. The picture appears in the Card Details 
tab of the Card Information window.

Any pictures you link are copied to the Graphics folder, 
which is located within your company file’s folder. If you move 
your company file, you will need to move the Graphics 
folder as well.

NOTE : Supported picture formats Pictures need to be 
saved in one of the following formats: bmp, jpg, tif, gif, or png.

To link a picture

1 Go to the Card File command centre and click Cards 
List. The Cards List window appears.

2 Open the card for which you want to link a picture.

3 Click the Card Details tab and double-click the picture 
file area. The Picture Information window appears.

4 Click Link. The Open window appears.

5 Locate the picture file you want to display for this card 
and then click Open. The Picture Information 
window appears with the selected picture appearing on 
the right. 

6 Click OK. The picture appears in the Card Details tab.

To replace a picture

If you want to replace the picture displayed in a card with 
another one, double-click the displayed picture and continue 
with step 5 in ‘To link a picture’ above.

To remove a picture

If you want to remove the displayed picture from the Card 
Details tab, double-click the picture. In the Picture 
Information window, click Unlink and then click OK. The 
picture will be removed from the Card Details tab but the 
picture file will remain in the Graphics folder.
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Reviewing your contact information

There are several tools you can use to review your contact 
information.

To view contact alerts

1 Click To Do List in any command centre. The To Do List 
window appears.

2 Click the Contact Alert tab. A list of all individuals and 
businesses you need to contact appears.

NOTE : Reminders that fall on a closed day If the 
recontact date falls on a day that you have indicated as being 
closed in the Business Calendar (accessible from the 
Setup menu), the reminder will appear on the business day 
prior to the recontact date.

The Overdue column shows how many days have elapsed 
since the recontact date you specified on the contact log 
entry. 

To clear a reminder from the list, click in the select column 
next to the contact log entry and then click Remove.

To print card reports

1 Go to the Reports menu and choose Index to 
Reports. The Index to Reports window appears. 

2 Click the Card tab. The list of card reports appears.

3 Display or print the report that is appropriate to your 
needs. 

Following is a list of the default information displayed in 
each report. If required, you can customise the reports to 
display more or less details (for information on how to 
customise a report, see ‘Customising reports’ on 
page 180).

Tool See

To Do List The Contact Alert tab in the To 
Do List displays contact log entries 
with recontact dates on or before the 
current date.

below

Card 
reports

Card reports give you lists of contact 
information in several formats.

below

Find 
Transactio
ns

Find Transactions helps you 
quickly find all transactions for a 
contact.

page 161

Report Description

Card List 
Summary

A list of your contacts with their phone 
numbers, current balances and identifiers.

Card List 
Detail

A list of some of the information contained in 
your contacts’ cards, including Address 1 and 
Address 2.

Addresses The contact name, address and phone number 
entered for Address 1 in each card.

Card 
Transactio
ns

A list of the transactions that have been 
allocated to your contacts for a selected period.

Contact 
Log

A list of contact log entry details. The total of 
the elapsed time recorded in the log entries is 
displayed for each contact.
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Identifiers A list of the identifier codes and their 
descriptions.

Overdue 
Contacts

A list of contact log entries with recontact 
dates that are dated on or before the day you 
select in the report filter.

Report Description
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15  ABSS Payments
ABSS Payment is a new electronic payment services that integrated with ABSS application, which allows easy payment, collection, 
recording and reconciliation.

About ABSS Payments

When client made payment through ABSS Click To Pay/PayPal 
payment portal, merchant will be able to download the list of 
payments in CSV format. The CSV file can then be imported 
into ABSS application for easy recording and reconciliation of 
payments received.

Enable ABSS Payment feature in ABSS 
application

1 Merchant who subscribed ABSS Payment services will be 
provided with a Merchant Reference ID. It represents the 
merchant’s identification in ABSS Click To Pay or PayPal 
payment portal.

2 In order to enable ABSS Payment feature in ABSS 
application, merchant need to enter their Merchant 
Reference ID in File > ABSS Payments > Setup.
For PayPal > Business ID or email address
For Click to Pay > Company Token

Generate ABSS Payment Invoice

1 Once Merchant ID is entered, invoice generated via Send 
Email window will show an additional selection for Click 
To Pay/PayPal. Upon selection the respective option, 
Click To Pay/Pay with PayPal button will appear on 

top right corner of the invoice with embedded URL, that 
link to ABSS Click To Pay/PayPal payment portal.
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2 Merchant’s customer who receive this electronic invoice 
can simply click on button and pay the invoice via internet 
browser.

3 Upon connected to ABSS Click To Pay/PayPal payment 
portal, ABSS invoice particulars will be automatically 
display on the payment portal. Customer just need to fill 
in credit card information to make payment, or select 
Direct Debit option and be route to respective bank’s 
website for online payment.

Reconcile Payment Received against Invoice

Once customer made payment through ABSS Click To 
Pay/PayPal payment portal, merchant will be able to 
download the list of payments received in CSV format. The 

CSV file can then be imported into ABSS application for easy 
recording and reconciliation of payments received.

Before importing CSV file, merchant have to ensure the linked 
accounts in ABSS Payment > Setup are linked to the 
appropriate account for recording purposes.

To define linked account for ABSS Click To 
Pay/PayPal

1 Log-on to your ABSS Premier/ Accounting System.

2 Click on File
3 Select ABSS Payments
4 Click Setup
5 Select Payment Gateway that you have registered.

6 Select the appropriate linked account from the drop down 
button. 
For Click To Pay you have to setup the bank account for the 
collection received.
For PayPal you are required to specify the Date Format for 
your Paypal account which is different according to country. 
Refer to below for the standard format provided by PayPal as 
of date when this feature is created.
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Please refer to PayPal for up to date information should you 
get a different date format before you upload the CSV file.

7 Select the base currency of the country that the system 
will be use. (Applicable for International Accounting - 
PayPal only)

8 Once linked account been defined, merchant can proceed 
to import the CSV file.

9 To enable for PayPal multi currencies, have to linked each 
specific currencies with Paypal account. List > Currencies 
> United State Dollars (eg) > ABSS Payment

Import List of Payment Received

Merchant can import the payment received list in CSV format 
into ABSS application using ABSS Payments. This function 
available in menu: File > ABSS Payments.

NOTE : Have you downloaded the list of payments 
received? You need to download from merchant portal the 
list of payments received in csv format before you proceed 
further.

To import list of payment received

1 Click on File
2 Select ABSS Payment, Process ABSS Payments window 

appears
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3 Select the payment method (Click To Pay/PayPal) that is 
applicable

4 If tick on check box ‘Do not warn me for incomplete 
transaction import due to undefined currency’, user will 
not get warning if there is any transaction not being 
pickup due to currency code in csv file different from 
ABSS currency.

5 Select Browse button and locate the csv file

NOTE : Error message will be prompt if linked account has not 
been defined for payment received via ABSS Payments. To 
continue, user have to define the linked account for payment 
received via ABSS Click To Pay/PayPal.

6 Click OK button to import the list of payments received 
via ABSS Click To Pay/PayPal.

Payment Received Auto Mapped

Once list of payments received via ABSS Click To Pay/PayPal 
being imported, 

1 ‘ABSS Click To Pay/PayPal Reconciliation’ window 
appears, display all the payment received against 
matching sales invoice in ABSS application.

2 Columns Payment Date, Ref # and Payment Amount 
shows information from list of payment received via Click 
To Pay/PayPal, whilst columns Invoice Date, Invoice # and 
Total Due shows the matching invoices in ABSS application

3 As for PayPal Reconciliation, there will be an additional of 
2 columns fee and currency for Paypal fee charges and 
currencies that are being used for the payment.

4 The auto matching criteria are:
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 Identical GUID (Globally Unique Identifier) or invoice 
number, and

 Payment received amount is lesser than or equal to sales 
invoice amount

5 By default, all auto-matched transactions been selected 
and ready for confirmation. However you can manually 
select or deselect any transaction from this window, via 
check boxes on the left

6 Select ‘Confirm’, system will proceed to automatically 
create the payment received transactions for the 
matching invoices.

7 Should there be any transaction not being auto matched 
in this window, or any auto-matched transactions been 
manually deselected, they will be display in next window, 
which is ‘ABSS Click To Pay-Payment Unmatched 
Transactions’ window.

ABSS Click To Pay/PayPal - Payment 
Unmatched Transactions

In this window, it will display all the unmatched transactions. 
User have to manually select each of these unmatched 
transaction, be it payment received transaction, money 
received transaction, or even refunds transactions, and match 
their respective invoice or account in ABSS application.

Received Payment
1 To match a payment received to a specific invoice, user 

have to manually select a payment received, then click on 
‘Receive Payment’ button.

2 ‘Select from list’ window then opens and display all 
available outstanding invoices for matching.

3 User select the matching invoice and click ‘Use 
Sale/Order’ button, then payment received transaction 
will be recorded

4 The payment received recorded will now display as 
‘Processed’ 

Received Money (Applicable for Click to Pay)

1 To record money received transaction, user have to 
manually select a money received transaction, then select 
the appropriate account from the Account drop down 
selection at bottom of the window. 

2 Once account selected, click on ‘Receive Money’ 
button and money received transaction been recorded.

3 The payment received recorded will now display as 
‘Processed’

Pay Refund (Applicable for Click to Pay)

1 To record a refund transaction, user have to manually 
select a refund transaction, then click on ‘Pay Refund’ 
button.

2 ‘Select from list’ window then opens and display all 
available refund/credits for matching.

3 User select the matching invoice and click ‘Use 
Sale/Order’ button, and refund transaction been 
recorded

4 The refund recorded will now display as ‘Processed’

NOTE : Unable to import the transactions you want?
For processed transactions, they will not display in ABSS Click To 
Pay/PayPal windows when user attempt to import the same 
transactions subsequently.
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16  Peppol E-Invoice
Peppol E-Invoice is a new electronic invoice services that integrated with ABSS application, which allows easy sending invoice/credit note 
to customer and receiving bill/debit note from supplier who are Peppol network registered businesses.

About Peppol E-Invoice

Send / Receive E-Invoice
1 E-Invoice Services is an add-on service provided by ABSS 

Connect platform, where it allows ABSS Accounting and 
Premier user to send e-invoice to their customer and 
receive e-invoice from their supplier.

2 Prerequisite:
 Must have Internet connection
 Data file has to be activated

3 Following describe the changes and how it works:

A. User Sign Up / Login in ABSS Premier / 

ABSS Accounting

Go to Setup > Company Information 

a) There is a Connect button, which user to sign up / login to 
ABSS Connect services in order to access e-invoice service. 

b) Connect button will only be active / clickable if data file 
been activated and have not register for ABSS Connect 
services.
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c) Click on Connect button will launch Sign Up / Login 
window, user who wish to use ABSS Connect services need 
to Sign Up / Login. 

For new user who have not sign up before, please tick ‘New 
Sign Up’ check box, and fill up email and password to Sign 
Up.

For existing user who signed up before, no need to tick ‘New 
Sign Up’, just login with the registered email and password.

Once successful Sign Up/Login, message below will be 
prompt: 
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After successful registered the company file for ABSS 
Connect services, ‘Connect’ button will become inactive. 

B. Setup E-Invoice service via ABSS Connect 
portal

1 If E-Invoice service not already setup in ABSS Connect 
portal: 

2 User need to visit ABSS Connect portal. User can access 
ABSS Connect portal via Help > Login to ABSS Connect.

Enter the user id (email) and password which has been 
registered via ABSS Premier / ABSS Accounting, and hit 
‘Login’ button. 
1 After login, user will see company name display on top 

left. If user have registered multiple companies using same 
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login ID, then user may select company by click on User 
icon on top right, and list of companies will display.

2 Click on   ‘Connect’ button from left pane, it will 
display option connect to Pagero, an e-invoice access 
point service provider which connect to PEPPOL network.

3 User have to enable this connection in order to use 
e-invoice service.

4 Pre-requisite: Please ensure company UEN already fill up in 
Company Profile, via user icon on top right corner.

5 User will then need consent to Pagero for e-Invoicing 
service.

6 Follow the prompt, user need to provide Username to 
login 

7 * Prerequisite: Need to fill up Contact number in Profile, 
via user icon on top right corner.

8 Click here for more detail of ABSS Connect sign up 
process.

 

 



A B O U T  P E P P O L  E - I N V O I C E   2 2 6

Once entered the username particular, user will receive 
welcome email from ABSS Connect, as well as welcome email 
from Pagero Online. User have to click on the activation link 
provided in Pagero welcome email, agree to the license term 
and then provide a passwrod to login. 

C. Customer / Supplier Card File

New field ‘Peppol ID.‘ has been added into Customer / 
Supplier Card File Information screen, user required to enter 
Peppol ID in card file prior to sending or receiving invoice. 
This refers to ID that Sender / Recipient registered under 
Peppol Network. 
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Note: PEPPOL (Pan-European Public Procurement On-Line) 
E-Invoicing refers to automated direct exchange transmission 
of invoices between software systems of buyer and supplier. 
User can send E-Invoice to their customer or Receive 
E-Invoice from their supplier as long as sender and receiver 
both registered under PEPPOL network. 

D. Send e-Invoice to Customer 

New “Send” / “Re‐send” button for e‐invoice been added 
to Sales Service Invoice screen, this button will only 
activate after user registered with ABSS Connect portal, 
and also entered Peppol ID into the customer card.

“Send” button will display when open invoice that have 
not send via e‐invoice before.
“Re‐send” button will display when open invoice that has 
send via e‐invoice before.

Fields required fill-up for e-Invoice service

‐ Card ID field
‐ Contact field under “Address 2: Ship To” address
‐ Peppol ID field

‐ Customer PO#

2. Checking e-Invoice Status 

User can view the e-Invoice delivery Status from menu item 
File > Process e‐Invoice/e‐Bill. 

E.Send e-Credit Note to Customer 

User can also send Credit Note to customer via Settle 
Returns & Credits process, current e- Invoice service only 
support credit settlement which fulfilled below conditions: 
i) Credit note that settled single invoice onlly and 
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ii) Credit Note amount must be fully settled and 

iii) settlement do not incur discount and finance charge

F.Sync e-Bill from Supplier

1. e-Bill Tax Type Mapping 

For incoming Bill from supplier, as prerequisite, system 
required a completed e-Bill Tax Type Mapping in order to 
import e-Bill or e-Debit Note. It is compulsory for user to 
do the tax type mapping prior to import e-Bill or e-Debit 
Note. 

User can click on File > e‐Bill Tax Type Mapping,
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2. Sync e-Bill/e-Debit Note from Supplier

To import e-Bill/e-Debit Note from supplier, user can go to 
File > Process e‐Invoice/e‐Bill function, and select Sync 
e-Bill option. After specify Date From and Date To, and click 
[Sync] button, system will start made the API call to import 
bill and credit note records from Peppol network, transaction 
that contains error such as unmatched currency code, missing 
supplier, unmatched supplier peppol ID will be tracked in error 
log file. User can then rectify the problem and re -run the sync 
e-Bill process.

Notes: When sync e-Debit Note, if the incoming debit note 
carry bill reference number that matched with the Bill 
Number for the same supplier in the data file (bill number for 
the same supplier in the data file (bill number to be offset), 
system will automatically create the Debit Note transaction 
as well as Settle Returns & Debit transaction and auto applied 
the Debit Note. Otherwise, if bill reference number not found 
in the database, system will just create the Debit Note record 
without offset the bill transaction.
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17  Financial control
You can control finances by setting budgets, auditing your records and by reviewing and analysing your financial activities.

Tracking financial information

You can track financial information at three levels:

 Accounts level—view the profitability and financial 
details of your business as a whole.

 Categories level—view the profitability and financial 
details of your individual business divisions, departments, 
properties, offices or locations.

 Jobs level—view the profitability and financial details of 
the individual jobs or tasks carried out for customers and 
clients. 

The following example will illustrate how accounts, 
categories and jobs may be interrelated:

A car dealer has two lines of business—car sales and a service 
department. The car sales department sells both new and 
pre-owned vehicles. The service department regularly takes 
on multiple jobs for particular customers. 

You could set up your ABSS software in the following way, 
although this is just one of many ways.

Accounts
The accounts list could be set up to provide a basic overview 
of the business’s overall performance. For example, the 
following income accounts could be used:

When entering a transaction, the appropriate account is 
allocated to each individual amount. A standard profit and 
loss statement can then be printed to show income and 
expenses generated by the business.

4-0000 Income [Header
]

4-1000 Car Sales [Header
]

4-1010 New Car Sales [Detail]

4-1020 Pre-owned Car Sales [Detail]

4-2000 Service and Parts Income [Header
]

4-2010 Service Income [Detail]

4-2020 Parts Income [Detail]

4-2030 Accessories Income [Detail]
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Setting up accounts You can set up your accounts using 
the Easy Setup Assistant or in the Accounts command 
centre. For more information, see ‘To create an account’ on 
page 21.

Categories
Categories enable you to track the profitability of 
departments, offices, properties and other business 
segments.

For example, the sales department of a car dealership could 
use categories to help them track the profitability of the car 
models they sell: say, model A, model B and model C. 

When entering a transaction, you need to allocate the 
appropriate category to it. You can then prepare a profit and 
loss statement for each category.

Categories can be assigned to the following transaction 
types:

 spend money 

 receive money 

 transfer money

 general journal entries 

 sales 

 purchases 

 build items

 inventory transfers 

 inventory adjustments 

 historical sales and purchases. 

NOTE : You cannot allocate categories to certain 
transactions There are certain transactions to which you 
cannot allocate a category. These are: Pay Bills, Receive 
Payments, Prepare Bank Deposit, Settle Returns and 
Credits/Debits and Pay/Receive Refunds. When entering 
these transactions, the categories assigned to the original 

transactions will be used. For example, the categories assigned 
to purchases appearing in the Pay Bills window will also be 
assigned to the payment. 

To enable allocation of categories

1 Go to the Setup menu and choose Preferences.

2 Click the System tab.

3 Select the Turn on Category Tracking option. If you 
want to make the selection of a category mandatory for 
all transactions, choose Required from the list. 

 To create a category

1 Go to the Lists menu and choose Categories. The 
Categories List window appears.

2 Click New. The Edit Category window appears.

3 In the Category ID field, type a code that will be used to 
identify the category and press TAB.

4 In the Category Name field, type the name of the 
category.

5 In the Description field, type a description of the 
category or notes relating to the category.

6 Click OK.
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Jobs
Jobs can be set up to track income and expenses related to 
specific jobs. This is particularly useful when multiple jobs are 
performed for a single customer. When you enter a 
transaction, the appropriate job number can be assigned to 
each individual amount. This enables you to associate several 
jobs with the various amounts in a single transaction. 

For example, if a purchase includes parts for three customers, 
you could select each of the three jobs to which that 
purchase relates. A profit an loss statement can then be 
prepared for each job and actual results can be compared 
with budgeted values to produce a Jobs [Budget 
Analysis] report.

Similarly, sub-jobs allow you to track individual jobs that form 
part of a larger job. For example, if you are a graphic designer 
working on a number of print and multimedia deliverables for 
your client, you could use sub-jobs to track the individual 
deliverables: website design, business cards production and 
brochure layout. 

Setting up jobs and sub-jobs You can keep a detailed 
record of your jobs and sub-jobs. If you intend to use sub-jobs, 
you first need to create jobs, and then assign sub-jobs to 
them. 

Specific job-tracking tasks may include:

 organising jobs in a hierarchy 

 setting budgets for each job 

 linking jobs to specific customers 

 assigning jobs to individual line items on transactions

 tracking reimbursable expenses for your jobs

 preparing invoices to reimburse job expenses

 analysing the profit and loss of a job.

There are two types of jobs; header and detail.

 Header jobs total associated detail jobs (including 
detail sub-jobs). You cannot assign transactions to header 
jobs.

 Detail jobs are assigned to transactions to track 
income, costs and expenses.

To create a header job

1 Go to the Lists menu and choose Jobs. The Jobs List 
window appears. 

2 Click New. The New Job window appears. 

3 Select Header Job and enter a job number, name and 
description.

4 If you want to create this job as a sub-job of another 
header job, type or make a selection from the Sub-job 
Of field. 

5 Click OK. The header job appears in the Jobs List 
window.

To create a detail job

1 Go to the Lists menu and choose Jobs. The Jobs List 
window appears. 

2 Click New. The New Job window appears. 

3 Select Detail Job. 

4 In the Job Number field, type a code for the job and 
press TAB.

5 Enter additional information about the job, such as a job 
name, description and start date. 
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6 If you are creating a sub-job, select a header job in the 
Sub-job Of list. Note, you can only assign detail jobs to 
header jobs, not to other detail jobs.

7 If you want to link the job to a customer, type or select a 
customer in the Linked Customer field. This is useful if 
you intend to seek reimbursement for goods and services 
purchased on the customer’s behalf in the future.

You can view details of all jobs linked to a customer in the 
Jobs tab of the customer’s card.

8 Click OK. The Jobs List window reappears.

9 Review the hierarchy of jobs you have created. If you need 
to change the details of a job, select the job and click 
Edit.

To enter opening balances for jobs

If you started using ABSS software while a particular job was 
in progress, you can create the job and then enter any 
account activity generated by the job so far in the Job 
Opening Balances window. 

You can enter opening balances only for detail jobs. Header 
jobs take their balances from the detail jobs below them.

1 Go to the Setup menu, choose Balances and then Job 
Opening Balances. The Job Opening Balances 
window appears. 

2 In the Job Number field, type or select the job for which 
you want to enter an opening balance.

3 In the Opening Balances column, type the opening 
balances for each account. 

4 Repeat from step 2 for each job with an opening balance.

5 Click OK when you have finished.
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To enter budget amounts for jobs

You can enter budgets for detail jobs. The budget information 
you enter for each job is used to help you assess your progress 
on a particular job and to determine the job’s effect on the 
state of your business. The amounts you enter will be 
recorded against accounts in your accounts list for 
comparison purposes. Once you begin recording transactions 
for the job, you will be able to print the Jobs [Budget 
Analysis] report to see a comparison between the actual 
amounts and the amounts you have budgeted for the job.

1 Go to the Lists menu and choose Jobs. The Jobs List 
window appears.

2 Highlight the detail job for which you want to enter 
budgets. 

3 Click Budgets. The Job Budgets by Account window 
appears, with the number of the job you selected in the 
Job Number field. 

All your company’s income, cost of sales, expense, other 
income and other expense accounts appear in the 
scrolling list.

4 In the Budgets column, type the amounts you have 
budgeted for specific accounts for this job and then click 
OK.

Budgets

When you prepare a budget, you are predicting the financial 
state of your business. For example, you could prepare a 
budget that predicts how much you intend to spend and earn 
over the next financial year. Having a budget means that, as 
the year progresses, you can track projected data against 
actual data and take corrective action if things are not going 
according to plan. 

You can also use budgets to plan for future goals. For example, 
you may want to undertake a new business venture in the 
coming year. By creating a budget, you can work out the 
amount of money you will need for the venture, where this 
money will come from, and the impact that the venture will 
have on other aspects of your business.

What do I need to budget? You can enter budgets for 
individual detailed accounts. The accounts that require a 
budget will vary according to your business. Most people 
prepare budgets for Profit and Loss accounts such as Income, 
Cost of Sales and Expenses accounts, and Balance Sheet 

accounts for specific assets and liabilities. To decide on the 
accounts that will require a budget, consider what changes 
you anticipate in your business and the financial impacts 
these changes will have. For example, you may be considering 
taking a new loan (which will affect your Bank Loans account). 

What period can I budget for? You can create a 
budget for the current financial year and the next financial 
year.

Reviewing your budget You can review your budgets 
periodically to track your financial progress and see if it is 
going to plan. A slight variation from the budget is normal. 
Large variations, on the other hand, may need investigation. 
For example, if you have a large increase in accounts 
receivable, it may indicate that your customers are taking 
longer than expected to pay their account. 

You can compare your budgeted amount with actual account 
balances by viewing the Budget Analysis reports for Balance 
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Sheet and Profit and Loss accounts. For information on 
displaying, customising and printing reports, see Chapter 12, 
’Reports,’ starting on page 175.

Entering budget amounts
You can use the Prepare Budgets window to enter budget 
amounts for each month of the current or next financial year. 
If you want to quickly enter budget amounts for a group of 
months, you can use the Budget Shortcuts window.

As the year progresses, you can choose to either adjust 
budget figures or leave them unchanged. 

Entering positive and negative amounts By default, 
the amount you enter will be assumed to be a positive 
amount. You can enter negative budget amounts by inserting 
a hyphen before the amount (for example, -250). When you 
enter a negative amount, you are indicating that the balance 
of the account is going to reduce. 

Using existing data If you have already prepared a 
budget in a spreadsheet or in other software, you may be able 
to import that information into your ABSS software. For more 
information on how to import account budgets, see 
‘Importing data’ on page 275. 

You can also use the previous financial year’s data as a basis for 
your budget.

To enter the budget for an account

1 Go to the Accounts command centre and click 
Accounts List. The Accounts List window appears.

2 Click Budgets. The Prepare Budgets window appears.

The window lists the Profit and Loss accounts by default.

3 From the Financial Year list, choose whether you want 
to enter a budget for this financial year or the next one.

4 From the Account Type list, choose the type of account 
you want to enter a budget for—Profit and Loss or 
Balance Sheet.

5 For each month, click in the appropriate cell and type the 
amount. If you want to enter a negative amount, insert a 
hyphen before the figure (for example, -250).

As you enter data, the FY Total column will display the 
total budget for each account.

A The Account Name and FY Total columns display the list 
of accounts and their current budget totals for the financial 
year. 

B You can enter the budget amount for a specific account and 
month in this section. You can use the horizontal scroll bar to 
scroll through the months.

C Click Shortcuts to open the Budget Shortcuts window 
from where you can quickly enter budget amounts for the 
selected account.
For more details on this feature, see ‘Budget Shortcuts 
window’, on page 236.

A B

C D E
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6 Click Close to close the Prepare Budgets window.

Budget Shortcuts window
If you want to quickly enter budget figures for a group of 
months, you can use the Budget Shortcuts window. You 
can use this window to enter quarterly, half-yearly and yearly 
budgets. You can also enter a budget that increases or 
decreases by a specific amount every month.

To enter a budget using Budget Shortcuts

1 Go to the Accounts command centre and click 
Accounts List. The Accounts List window appears.

2 Click Budgets. The Prepare Budgets window appears.

3 Highlight the account you want to enter the budget for by 
clicking in the appropriate row.

4 Click Shortcuts. The Budget Shortcuts window 
appears.

5 From the Budget for list, select a time period:

The fields change according to the period you select.

6 Enter the budget amounts in the appropriate fields. 
Amounts that cover more than one month (such as 
quarterly, half-yearly and yearly amounts, and amounts for 

D Click Copy Amount to Following Months to copy the 
selected amount to the months that follow.

E Click Copy Previous Year’s Actual Data to insert the 
previous year’s account balances for the selected account 
and month.

Select If you want to...

Each Month enter the same amount for every 
month of the year or a set increase 
or decrease every month (starting 
from a base amount)

Period starting 
from selected 
Month

enter a total amount for a group of 
consecutive months

Each Quarter enter the total amount for each 
quarter

Each half of the 
Financial Year 

enter the total amount for each half 
of the year

Financial Year yyyy enter the total amount for the entire 
financial year, (where yyyy is your 
financial year)

Select a time 
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a group of months) will be divided equally among all the 
months in the group.

If you selected the Each Month option, you can also set a 
base budget amount for the first month, and the amount 
or percentage by which this will vary every month 
onwards.

7 When you have finished entering the information, click 
OK. The Prepare Budgets window reappears with the 
new amounts entered for the selected account.

If the account already has budget figures, a message 
appears asking if you want to replace the existing budget. 
Click OK to replace the budget, or Cancel if you want to 
keep the existing amounts (you will be returned to the 
Budget Shortcuts window where you may need to 
click Cancel again).

If you have not entered any amounts for the budget, a 
message appears asking if you want to enter zero 
amounts. Click OK if you want to do this, or Cancel if you 
want to change the amounts.

Auditing your records

A range of features are available to help you ensure the 
accuracy of the records in your company file. These features 
are outlined below.

Company Data Auditor
The Company Data Auditor allows you to check the accuracy 
of the records in your company file. You can use the auditor to 
perform maintenance tasks and reconcile bank and credit card 
accounts.

The auditor also checks your transactions for exceptions such 
as invoices that do not reconcile with your receivables 
account, future-dated transactions, and audit trail changes. 
For more information on how to use the Company Data 
Auditor, see ‘Run the Company Data Auditor’ on page 243.

Audit trail tracking system
You can track specific transactional, account and system 
changes made to your company file using an audit-trail 

tracking system. You can then print an Audit Trail report 
which lists all the changes recorded in a specified date range.

To track changes, go to the Setup menu, choose 
Preferences and then select the Use Audit Trail 
Tracking option in the Security tab. 

The changes that are recorded are outlined below:

Change type Description

Transactional • deletion of transaction
• change of card selection 
• change of ID # 
• change of date 
• change of amount on any line 
• change of account on any line 
• change of item selection 
• change of job selection. 

Account • change of the current account number
• change of the account’s opening balance
• addition of a new account 
• deletion of an account.
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System • Change of the linked account selection in 
any of the Linked Accounts windows

• change to the lock periods security 
preference (this includes changes of the 
lock period date and the 
selection/deselection of the preference)

• change to the Transactions CAN'T be 
Changed; They must be Reversed 
preference

• change to the Use Audit Trail 
Tracking preference.

Payroll [ABSS 
Premier Plus 
only]

• Changes to SOCSO [Malaysia] or CPF 
[Singapore] schemes, including name, 
employer member number and trustee 
details

• Changes to department names
Changes to employee cards, including:
• pay rate , monthly salary, hours in a full 

time work week, or hours in a full time 
work day

• default wages, EPF, SOCSO expenses and 
payable accounts and tax payable account 
[Malaysia]

• default wages, CPF, SDL and FWL expenses 
and payable accounts [Singapore]

• ‘Carry Over’ entitlements 
• pay history
• termination details
• payment method
• tax category and no. of child relief 

[Malaysia].
Changes to the setup of a payroll category, 
including:
• Type of Wages selection
• Type of Entitlement field
• Type of Deduction field or Deduction 

Limit field
• Type of Expense field and Expense 

Limit field.

Change type Description
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Reviewing financial information

There are several tools that you can use to review your 
financial information:

Business Insights

Business Insights enables you to analyse key financial 
information using a range of interactive tables and graphs. 
You can use it to analyse your available cash, cash flow, profit 
and loss, and the money that you owe suppliers and the 
money that customers owe you. You can open Business 
Insights from the Accounts command centre.

The Business Insights window presents different types of 
financial information in four summary panels. From each 

panel, you can open additional windows to analyse 
information in more detail.

You can sort the information in tables by clicking in the 
relevant table column heading. For example, you can sort the 
list of your accounts by account name or type.

You can also save a graph or table as an image so you can use it 
in another document. To do this, right-click it and choose:

 Copy to Clipboard. This copies the graph or table to 
the clipboard, ready to paste into a document.

 [Graphs only] Save As. Choose where you want to save 
the image and click Save. This saves the graph as an image 
file, so you can use it later.

About the Business Insights panel

Bank accounts and credit cards This panel displays 
the balances of your bank and credit card accounts and shows 
the total amount of available cash.

Click Analyse performance and select the financial year 
you want to analyse from the Financial Year list. You can 
view a graph comparing income to expenses each month, a 
profit and loss graph, and information about your top ten 
selling items and top ten customers for that selected financial 
year.

Yo can use this information to:

 Identify excessive spending Compare income 
against expenses and view the resulting profit or loss over 
a selected financial year.

 Review your sales performance Identify your top 
ten customers and top-selling items over a selected 
financial year.

Tool Description See

Business 
Insights

Business Insights enables you to 
analyse information about your 
cashflow and current cash 
position

below

Analyse 
Balance 
Sheet 
window

This window provides details 
about your asset, liability and 
equity accounts in both graphical 
and ledger views.

page 240

Analyse 
Profit & Loss

This window provides detailed 
information about your Profit & 
Loss accounts in both graphical 
and ledger views.

page 240

Analyse Jobs This window allows you to view 
information about your progress 
on a particular job, broken down 
by account.

page 240

Financial 
reports

Financial reports help you review 
of your financial information.

page 241
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 Check account balances Before making a large 
payment, ensure that the account it is drawn from has 
sufficient funds.

 Compare performance between financial 
years Get a visual comparison of the profit and loss and 
sales performance of one financial year to another.

Cash position estimate This panel forecasts your cash 
balance for the current month and for the next two months. 
The forecasts are based on your current cash balance and the 
money you will receive or spend in the forecast period. The 
forecast information is calculated using the following 
formula:

total cash balance to date

plus estimates of the customer payments and receive 
money payments (including recurring payments) that are 
due to be received during the forecast period

less estimates of the supplier payments and spend money 
payments (including recurring payments and paycheques) 
that are due to be paid during the forecast period.

Click Cash analysis to view details of the forecast shown. 

You can use this information to:

 Plan your expenditure Work out what effect a major 
purchase or hiring more staff would have on your cash 
position.

 Predict cash flow issues View a forecast of your 
cash flow for the coming two months.

Customer and supplier analysis For more information 
about analysing sales and purchases, see ‘Reviewing your sales 
information’ on page 68 and ‘Reviewing your purchase 
information’ on page 94.

To analyse your balance sheet

1 Go to the Accounts command centre and click 
Analysis. The Analyse Balance Sheet window 
appears.

2 Click Filters and choose the time periods and other 
criteria you want to view. 

3 Click OK. The information you selected appears in the 
Analyse Balance Sheet window.

To analyse your profit or loss

1 From any command centre, click the Analysis down 
arrow and choose Profit and Loss from the menu. The 
Analyse Profit & Loss window appears.

2 Click Filters and choose the time periods and other 
criteria you want to view. 

3 Click OK. The information you selected appears in the 
Analyse Profit & Loss window.

To analyse your jobs

1 From any command centre, click the Analysis down 
arrow and select Jobs. The Analyse Jobs window 
appears.

2 In the Job Number field, type or select the job you want 
to analyse. 

3 If you use budgets to track the progress of this job, enter 
a value in the Percent Complete field. The budget 
amounts are adjusted to represent the percentage of the 
job completed. 
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To view financial reports

1 Go to the Reports menu at the top of the screen and 
choose Index to Reports. The Index to Reports 
window appears.

2 Click the Accounts tab.

There are several account reports that can help you track 
your financial information. These reports are listed below.

For information on displaying, customising and printing 
reports, see Chapter 12, Reports, on page 175.

Report Description

Audit Trail Reviews changes made to recorded 
transactions, account details and system 
settings. 
Note that before you can track and report 
changes, you need to activate the audit 
trail tracking preference. For more 
information, see ‘Audit trail tracking 
system’ on page 237.

Profit & Loss 
Statement

Shows your profit and loss figures.

Balance Sheet Reviews your financial position as of the 
end of a period. 

Summary Trial 
Balance

Identifies amounts incorrectly entered. 
When reviewing this report, check for:
• entries that seem unusually high or low 

for the account that has been affected
• debit amounts for accounts that 

normally have credit entries and vice 
versa

• unusually high or low ending balances
• an unusually high or low number of 

entries for a specific account.

Balance Sheet 
[Budget 
Analysis] 

Lists account balances as at the end of a 
selected period, along with the budgeted 
amounts for them. If you have determined 
that changes need to be made to the 
amounts you have budgeted for the 
coming months, you can adjust your 
budget.

Profit & Loss 
[Budget 
Analysis]

Lists account balances for a selected 
period, along with the budgeted amounts 
for them. If you have determined that 
changes need to be made to the amounts 
you have budgeted for the coming 
months, you can adjust your budget.

Statement of 
Cash Flow

Shows how your cash position has 
changed over a period of time, what 
profit you have earned, where you 
received additional cash, and where your 
cash was spent.

Report Description
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18  End-of-period procedures
It is important to ensure that your accounting records are accurate. Reconciling the accounts regularly will help you and your accountant 
know that your books are complete, accurate and balanced.

Month-end procedures You should reconcile your company file records with any source documents and resources available to you. For 
example, your bank account can be reconciled with the bank statement, payable balances can be checked against supplier statements, 
and customer’s balances verified. Typical end-of-month procedures include reviewing your trial balance, reviewing your budgets and cash 
flow, and purging information that is no longer needed.

Year-end procedures End-of-year procedures are carried out at the end of your financial year and include any adjustments you need to 
make to your company file so that it agrees with your accountant’s final records before you start a new financial year. If possible, your 
inventory should be counted, valued and, where necessary, adjusted in your company file. Follow the procedures in this chapter to 
reconcile the system and close the year. By closing the year in your company file, you are effectively bringing the company file up to date 
and removing information not required in the new year.

Month-end procedures

The following is a list of tasks we suggest you complete at the 
end of each month. Depending on the nature of your 
business, some of these tasks may not apply to you.

Task See

1 Run the Company Data Auditor page 243

2 Reconcile your bank accounts page 51

3 Review reports page 247

4 Send customer statements page 247

5 Record depreciation page 248

6 Lodge sales tax and GST returns page 249

7 Lodge the CPF Payment Advice 
[ABSS Premier Plus (Singapore) only]

page 250

8 Lock periods page 250

Task See
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Task 1: Run the Company Data Auditor
The Company Data Auditor is a series of windows that guides 
you through the process of checking and ensuring the 
accuracy of the records in your ABSS company file. You can 
use the auditor to:

 display basic information about the company file, such as 
the file name, release number, location, size, locked 
periods, last backup date, etc.

 perform maintenance tasks, such as back up your company 
file and set lock periods

 display bank and credit card account details, including the 
current balance and the date when they were last 
reconciled

 reconcile your bank and credit card accounts

 check your transactions for exceptions and audit trail 
changes. 

To run the company data auditor

1 Go to the Accounts command centre and click 
Company Data Auditor. The Company File 
Overview window appears.

This window shows you:
 the company file name
 the ABSS software release number
 the location of the company file
 the size of the company file
 the date on which the company file was last backed up
 the date on which the company file was last verified
 the end month and year of the current fiscal year
 the locked period, if one has been specified.

If necessary, you can perform the following maintenance 
tasks from this window:

If you want to... Do this... See

Back up your 
company file

Click Backup and 
complete the backup 
procedure.

page 26
3

Check your 
company file for 
errors

Click Verify and 
complete the verification 
procedure. 

page 26
7

Set the locked 
periods for your 
company file

Click Lock Periods and 
select the month before 
which data cannot be 
entered. 

page 25
0

Load tax\SOCSO 
tables [ABSS 
Premier Plus 
(Malaysia) only]

Click Load Tax\SOCSO 
Tables and complete the 
procedure for loading tax 
or SOCSO tables.

‘Set up 
payroll’ 
on 
page 32

Load CPF tables 
[ABSS Premier 
Plus (Singapore) 
only]

Click Load CPF Tables 
and complete the 
procedure for loading CPF 
tables.

‘Set up 
payroll’ 
on 
page 32
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2 When you have completed the required maintenance 
tasks, click Next. The Account Reconciliation 
Review window appears.

This window shows you:
 your bank and credit card accounts
 the balance of each account
 the date on which each account was last reconciled.

3 If you want to reconcile an account, select the account 
and click Reconcile Accounts. For more information, 
see ‘Reconcile your bank accounts’ on page 51.

4 Click Next. The Transaction Review window appears.

5 Enter the start date and end date of the period you want 
to review.

6 Click Run Review. The following tasks are undertaken.

Reconcile 
invoices with 
the linked 
receivables 
account

The total of all customer balances is 
compared to the current balance of the 
linked accounts receivable account. If 
there is an out-of-balance amount, click 
Display to view the Receivables 
Reconciliation Exceptions report 
and review, customise or print the 
details of the report.

Reconcile 
purchases with 
the linked 
payables 
account

The total of all supplier balances is 
compared to the current balance of the 
linked accounts payable account. 
If there is an out-of-balance amount, 
click Display to view the Payables 
Reconciliation Exceptions report 
and review, customise or print the 
details of the report.

Compare item 
values with the 
linked inventory 
account

The total value of inventory on-hand is 
compared to the current balance of the 
linked inventory account. 
If there is an out-of-balance amount, 
click Display to view the Inventory 
Value Exceptions report and review, 
customise or print the details of the 
report.

Scan for 
future-dated 
transactions

The company file is checked for any 
transactions dated after the date of the 
current session (that is, the current 
date). 
If there are transactions dated after the 
current session, click Display to view 
the Future Dated Transactions 
report and review, customise or print 
the details of the report.
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Scan for prepaid 
transactions

The company file is checked for any 
prepaid transactions. These 
transactions include all customer and 
supplier payments (excluding deposit 
payments) that have a payment date 
prior to the date of the invoice or 
purchase. 
If there are payments made prior to the 
invoice or purchase date, click Display 
to view the Prepayment 
Transactions report and review, 
customise or print the details of the 
report.

Scan for 
deposits paid

The company file is checked for any 
deposits paid (within the date range 
specified) on sales orders or purchase 
orders. 
If any orders have a payment flagged as 
a deposit transaction, click Display to 
view the Deposit Transactions 
report and review, customise or print 
the details of the report.

Review audit 
trail changes

If you have selected the Use Audit 
Trail Tracking [System-wide] 
option in the Preferences window 
(Security tab), the company file is 
checked for any transactional, accounts, 
and system changes. 
If any changes occurred within the date 
range specified, click Display to view 
the Audit Trail report and review, 
customise or print the details of the 
report. For more information on audit 
trail tracking, see ‘Audit trail tracking 
system’ on page 237.

Check for job 
exceptions 
[Cash 
Transactions]

If you have selected the Warn if Jobs 
Are Not Assigned to All 
Transactions [System-wide] option 
in the Preferences window (System 
tab), the company file is checked for 
cash transactions (within the date range 
specified) that have no job number. 
If any transactions are detected with no 
job number, click Display to view the 
Job Exceptions [Cash 
Transactions] report and review, 
customise or print the details of the 
report.

Check for job 
exceptions 
[Invoice 
Transactions]

If you have selected the Warn if Jobs 
Are Not Assigned to All 
Transactions [System-wide] option 
in the Preferences window (System 
tab), the company file is checked for 
sales and purchase transactions (within 
the date range specified) that have no 
job number. 
If any transactions are detected with no 
job number, click Display to view the 
Job Exceptions [Invoice 
Transactions] report and review, 
customise or print the details of the 
report.
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7 When you have finished viewing and, if necessary, printing 
the Transaction Review reports, click Next. The Tax 
Exception Review window appears.

8 Click Run Review. The following tasks are undertaken.

9 Click Finish. A message appears asking if you would like to 
print a report summarising the audit findings. Click Yes to 
print the report or click No to close the Company Data 
Auditor window without printing the report.

Task 2: Reconcile your bank accounts
To ensure the accuracy of your business records, you should 
keep your record of each bank account balance matched up 
with your bank’s records. 

If you are reconciling your bank account for the first time 
since you started using your ABSS software, see ‘Do an initial 
bank reconciliation’ on page 34. 

Check for tax 
code amount 
variances [Sales]

The company file is checked for 
variances between the tax code amount 
posted and the tax code amount 
calculated for the tax codes assigned to 
sales transactions. If a variance is found, 
click Display to view the Tax Code 
Amount Variance report and review, 
customise or print the details of the 
report.

Check for tax 
code amount 
variances 
[Purchases]

The company file is checked for 
variances between the tax code amount 
posted and the tax code amount 
calculated for the tax codes assigned to 
purchase transactions. If a variance is 
found, click Display to view the Tax 
Code Amount Variance report and 
review, customise or print the details of 
the report.

Check for tax 
code exceptions 
(invoice 
transactions).

The company file is checked for sale and 
purchase transactions without a tax 
code assigned or where the entered tax 
code is different to the default tax code.
If any invoice transactions are detected 
with no tax code or the wrong code, 
click Display to view the Tax 
Exemptions [Invoice Transactions] 
report and review, customise or print 
details of the report.

Check for tax 
code exceptions 
(cash 
transactions).

The company file is checked for Spend 
Money and Receive Money 
transactions without a tax code 
assigned or where the entered tax code 
is different to the default tax code.
If any cash transactions are detected 
with no tax code or the wrong code, 
click Display to view the Tax 
Exemptions [Cash Transactions] 
report and review, customise or print 
details of the report.
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Task 3: Review reports
There are several reports that we recommend you review at 
the end of each month. You can use these reports to identify 
and correct any discrepancies in your records, as well as spot 
any trends in your business. These reports are listed below.

TIP : Create a report batch You may find it useful to create 
a report batch for your month-end reports and print them all in 
one go. For more information, see ‘Printing report batches’ on 
page 179.

Task 4: Send customer statements
Most businesses send statements to customers who have 
outstanding balances at the end of each month. You can 
either print out and send these statements through the mail 
or send them via email.

Report Description

Receivables 
Reconciliation

Lists all your outstanding receivables.

Payables 
Reconciliation

Lists all your outstanding payables.

Analyse Sales 
[Customer]

Lists your company’s sales activity and 
trends on a month-by-month basis.

Analyse Purchases 
[Supplier]

Lists your company’s monthly purchases.

Items List 
[Summary]

Shows what’s on-hand and what needs to 
be ordered.

Audit Trail Reviews changes made to recorded 
transactions, account details and system 
settings. 
Note that before you can track and report 
changes, you need to activate the audit 
trail tracking preference. For more 
information, see ‘Audit trail tracking 
system’ on page 237.

Profit & Loss 
Statement

Shows your profit and loss figures.

Balance Sheet Reviews your financial position as of the 
end of a period. 

Summary Trial 
Balance

Identifies amounts incorrectly entered. 
When reviewing this report, check for:
• entries that seem unusually high or low 

for the account that has been affected
• debit amounts for accounts that 

normally have credit entries and vice 
versa

• unusually high or low ending balances
an unusually high or low number of entries 
for a specific account.

Balance Sheet 
[Budget Analysis] 

Lists account balances as at the end of a 
selected period, along with the budgeted 
amounts for them. If you have determined 
that changes need to be made to the 
amounts you have budgeted for the 
coming months, you can adjust your 
budget.

Profit & Loss 
[Budget Analysis]

Lists account balances for a selected 
period, along with the budgeted amounts 
for them. If you have determined that 
changes need to be made to the amounts 
you have budgeted for the coming 
months, you can adjust your budget.

Statement of 
Cash Flow

Shows how your cash position has 
changed over a period of time, what profit 
you have earned, where you received 
additional cash, and where your cash was 
spent.

Cash Flow 
Worksheet

Enables you to estimate your short-term 
cash needs. 

Report Description
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Statement types You can choose from two types of 
customer statement; invoice and activity.

 Invoice statements list all invoices aged as at a 
specified date.

 Activity statements list all sales invoices, payments, 
and orders with a customer deposit within a specified 
date range. Activity statements include a running account 
balance.

To print a customer statement

1 Go to the Sales command centre and click Print/Email 
Statements. The Review Statements Before 
Delivery window appears.

2 Click the To Be Printed tab.

3 In the Statement Type field, select the statement type.

4 Specify the statement period.
 If you selected Invoice as the statement type, enter an 

aging date to display invoices outstanding as at that 
date. 

 If you selected Activity as the statement type, enter 
the statement period in the From and to fields.

5 In the Print field, type the number of statements you 
want to print per customer.

6 Click Advanced Filters to filter and customise the 
information to be displayed in the customer statement. 
For more information, see ‘Advanced filters’ on page 188.

7 Click in the select column ( ) next to the name of each 
customer you want to print statements for.

8 Click Print.

To email a customer statement

1 Go to the Sales command centre and click Print/Email 
Statements. The Review Statements Before 
Delivery window appears.

2 Click the To Be Emailed tab.

3 In the Statement Type field, select the statement type.

4 Specify the statement period.
 If you selected Invoice as the statement type, enter an 

aging date to display invoices outstanding as at that 
date. 

 If you selected Activity as the statement type, enter 
the statement period in the From and to fields.

5 If you want to include invoices up to the specified 
statement date, select the Only include invoices up 
to Statement Date option.

6 Click in the select column ( ) next to the name of each 
customer you want to email statements to.

7 If you want to change a customer’s email address, 
highlight their name and select an address from the Email 
Address list ( ). Alternatively, type the email address in 
the Email Address field. 

8 Type the subject and message of the email or accept the 
default subject and message. If you want to change the 
default message, click Email Defaults and make the 
changes as appropriate.

9 If you want to filter or customise the statement, or to 
change the type of form it will be printed on, click 
Advanced Filters. For more information, see ‘Advanced 
filters’ on page 188.

10 Click Send Email.

Task 5: Record depreciation

NOTE : If you depreciate your assets at the end of the financial 
year, make this step a part of your end-of-year routine. Consult 
your tax adviser or accountant for information on when to 
depreciate your assets.
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Your company’s vehicles and equipment lose value each year. 
Part of the cost of vehicles and equipment can be allocated as 
an expense to your company each year you benefit from their 
use. The allocation of the cost of a piece of equipment over 
its useful life is called depreciation. 

There are several methods of depreciation. Consult your 
accountant to see whether you should be depreciating 
vehicles and equipment and, if you should, which method is 
best for you.

You record your depreciation figures using a journal entry.

To record depreciation expense

1 Create a new asset account for each type of asset you 
depreciate. Add the words ‘Accum Dep’ (for Accumulated 
Depreciation) at the end of each new account name. Give 
the new account a number that allows it to come directly 
after its corresponding asset account in the accounts list. 
For more information, see ‘To create an account’ on 
page 21.

In the following example, we have a header account, 
Vehicles, numbered 1-1600, and a detail account, Vehicles 
Original Cost, numbered 1-1610. We have created a new 
asset account called Vehicles Accum Dep, numbered 1-1620.

2 Create an expense account for depreciation.

3 Once you have determined your depreciation amounts, 
make journal entries to credit the accumulated 
depreciation asset accounts and debit the depreciation 
expense account. The accumulated depreciation asset 
accounts will always have a negative balance to show a 
reduction in the value of the depreciable assets.

Task 6: Lodge sales tax and GST returns
Many businesses are required by the government to submit 
tax returns. To determine the amounts you need to include on 
your tax returns, you need to produce the tax reports that are 
available in your ABSS software. 

To view a list of the tax reports, go to the Index to Reports 
window and select the GST/Sales Tax tab.
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Task 7: Lodge the CPF Payment Advice
[ABSS Premier Plus (Singapore) only] 

If you are required to submit a CPF Payment Advice each 
month, you can do this using the Print Tax/CPF Forms 
assistant in the Payroll command centre. For instructions, 
see ‘Prepare income tax and statutory forms’ on page 255.

Task 8: Lock periods
After you have completed your month-end tasks, you should 
lock that month using the Lock Periods feature. This will 
prevent you from inadvertently making an entry in a month in 
which you do not want new entries. 

1 Go to the Setup menu and choose Preferences. The 
Preferences window appears. 

2 Click the Security tab. 

3 Select the Lock Periods: Disallow Entries Prior to 
option and choose the relevant date. This selection places 
a temporary lock on the period before that date. If you 
need to make an entry in a locked period at a later 
time—for example, you locked October, and now want to 
make an entry in September—you can unlock that period 
in the Preferences window.
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Starting a new financial year

With ABSS software, you do not need to close your financial 
year at any particular time. You can continue to use your 
company file after the last month of your current financial 
year. 

Complete the tasks listed below to close your financial year 
and start a new one.

Task 1: Complete month-end tasks
Make sure you complete each of the month-end tasks. See 
‘Month-end procedures’ on page 242.

Task 2: Perform a stocktake
If you track inventory quantities and values, you should 
perform an inventory count when all transactions affecting 
inventory for the financial year have been entered. 

To perform a stocktake

1 Go to the Inventory command centre and click Count 
Inventory. The Count Inventory window appears. 

2 Click Print to print the Inventory Count Sheet 
report.

3 Count the inventory on-hand and note down the 
quantities on the Inventory Count Sheet. 

4 Make the necessary adjustments in the Count 
Inventory window so that the inventory quantities 
shown in your company file match your counted items 
on-hand. For more information, see ‘Performing 
stocktakes’ on page 116. 

Task 3: Provide information to your 
accountant
Once you have completed your year-end tasks, you can send 
your accounting data to your accountant. 

Accountants routinely ask their clients to provide financial 
information in an electronic format that can be loaded into 
their software. This makes it easier for the accountants to 
examine and analyse their clients’ records. After examining 
these records, accountants may make adjustments to the 
records that need to be entered into your ABSS software. 

If your accountant requests an electronic copy of your 
accounting records, you can export your accounts list, 
account balances and journal entries and send these files to 
your accountant. For more information, see ‘Exporting data’ 
on page 274.

Task See

1 Complete month-end tasks below

2 Perform a stocktake below

3 Provide information to your 
accountant

below

4 Enter end-of-year adjustments page 252

5 Back up your company file page 254

6 Start a new financial year page 254

7 Optimise your company file page 254
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To export information to your accountant

NOTE : ABSS Accountants Office This procedure is only 
relevant if your accountant uses ABSS Accountants Office.

1 Go to the File menu and choose AccountantLink and 
then Send to Accountant. The Send to Accountant 
window appears. 

2 From the Dated to end of list, select the relevant. 
Transactions recorded to the end of this month will be 
exported.

3 If you want to include journal entries in the export file, 
select the Include Journal Entries in Export File 
option.

4 Choose the method you want to use to send the 
information.
 Email—If you want to email the file, select your 

accountant’s name in the Email to field and then click 
email. The email address entered on the accountant’s 
card will be used when the email is created in your email 
program. The default name for the export file is 
companyfilename.MYE.

 Disk—If you want to save the file to disk and send it by 
post, click Disk. Enter a name and location for the 
export file in the window that appears. The default 
name for the export file is companyfilename.MYE. You can 
change the file name if you want but you must retain 
the ‘.MYE’ extension. Click Save.

Task 4: Enter end-of-year adjustments
Your accountant is likely to provide you with a number of 
adjustments, such as journal transactions. If they have been 
provided electronically, you can import these transactions (see 
‘Importing data’ on page 275). If the adjustments have been 
provided on paper, you can manually enter them in the 
Record Journal Entry window.

If you send information to your accountant using the 
AccountantLink feature (see ‘To export information to 
your accountant’ above), you can import the adjusting 
journals your accountant sends you. For more information, see 
‘To import general journals from your accountant’ on 
page 254. Make sure your accountant has sent you the journal 
adjustment file as a text file with a .txt extension. 

To record adjustments manually

If your company file is set to 13 accounting periods in the 
financial year, assign your adjustments to the 13th period by 
entering an asterisk (*) before the date, for example, 
*30/9/2012.

1 Go to the Accounts command centre and click Record 
Journal Entry. The Record Journal Entry window 
appears.

The general journal number and transaction date appear 
by default. You can change these if necessary.
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2 [Optional] In the Memo field, type a comment to 
describe the journal entry, for example, Depreciation of 
Motor Vehicles.

Each row of information entered in the scrolling list is a 
line item. The line item details are provided by your 
accountant.

3 For each line item:
a Type or select the account number (or name) from the 

account list.
b In the Debit and Credit fields, type the debit or credit 

amount for the line item. 
c [Optional] In the Job field, enter the job number for the 

line item.
d [Optional] In the Memo field, type a description of the 

line item.
e In the Tax column, enter the appropriate tax code for 

the adjustment.

NOTE : Journal entry must be balanced The journal 
entry cannot be recorded until the Out of Balance field is 
zero.

4 Click Record to record the journal entry.
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To import general journals from your 
accountant

1 Go to the File menu, choose AccountantLink, 
Receive from Accountant and then Lists of 
Accounts. A message appears, informing you that the 
levels within your existing accounts list may need to be 
amended. 

2 Click Yes to continue the import. The Open window 
appears.

3 Locate and select the file containing the general journals 
sent by your accountant. 

4 Click Open. The accounts are imported and a message 
appears, giving you the results of the import. If there are 
any errors, read the information in the ABSSLOG file [ABSS 
Accounting] or ABSSPLOG file [ABSS Premier range] which 
can be found in the folder where your company file is 
stored.

Task 5: Back up your company file
Make a backup of your company file after you have finished 
entering adjustments and store it in a safe location. See 
‘Backing up and restoring company files’ on page 262. Make 
sure you verify the company file as part of the backup 
process. See ‘Checking your company file for errors’ on 
page 267.

Task 6: Start a new financial year
If you have completed steps 1–5, you are now ready to start a 
new financial year.

Make sure that all transactions for the year that’s ending are 
entered in your company file before you begin closing the year. 
That way, you can avoid making adjusting general journal 
entries in the new year and your yearly records will be more 

accurate. This will also make it easier for you to compare your 
company’s performance from one year to the next. 

If you have an accountant who produces your year-end 
financial reports, you may need to wait for your accountant 
to provide you with any adjusting entries that may be needed.

When you start a new financial year:

 The previous financial year’s monthly totals for all 
accounts are changed to ‘last year’ categories. If ‘last 
year’ amounts already existed, those amounts will be 
replaced.

 The balance of your current-year earnings account is 
transferred to your retained earnings account.

 The balances of your income, cost of sales, expense, other 
income and other expense accounts are returned to zero.

 Closed sales, closed purchases and journal entries 
assigned to closed sales and closed purchases are kept or 
purged according to your selections in the Start a New 
Financial Year assistant.

To start a new financial year

NOTE : Single-user access [ABSS Premier range only] Note 
that this task requires single-user access. For more information, 
see ‘Single-user file locking for special tasks’ on page 270.

1 Go to the File menu, choose Start a New Year and then 
Start a New Financial Year. The Start a New 
Financial Year window appears. 

2 Follow the instructions that appear. If you need help, click 
Help and then choose Help for This Window.

Task 7: Optimise your company file
Once the Start a New Year procedure is complete, we 
recommend that you optimise and verify your company file. 
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For more information, see ‘Optimising your company file’ on 
page 267.

Starting a new payroll year 

Payroll is only available in ABSS Premier Plus.

You must close the payroll year in the last month of your 
payroll year or soon after. Otherwise, you will not be able to 
enter pays for the next payroll year. 

Do the following tasks to close your current payroll year and 
start a new payroll year.

Task 1: Process the last pays for the 
year
You must make sure that all pays for the payroll year you are 
about to close have been entered. For more information, see 
‘Processing your payroll’ on page 125. 

Task 2: Print payroll reports
Review the following reports to make sure payroll 
transactions are correct.

 Payroll Register Detail report—shows the pay history 
of your employees.

 Payroll Register Summary report—shows the pay 
amounts recorded. 

Task 3: Prepare income tax and 
statutory forms
You can use your ABSS software to print the following forms:

Task  See

1 Process the last pays for the year page 25
5

2 Print payroll reports page 25
5

3 Prepare income tax and statutory forms page 25
5

4 Back up your company file page 25
8

5 Start a new payroll year page 25
9

6 Check that you have the latest tax, 
SOCSO or CPF tables

page 25
9

7 Optimise and verify your company file. page 25
9 Malaysia Singapore

Income Tax (Borang EA) Income Tax (Form IR8A)

Income Tax (Borang CP 159) CPF (Payment Advice)

Income Tax (Borang CP 39) CPF (Form CPF 92)
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Most of the information required for these forms will 
automatically be extracted from:

 your employee cards

 the General Payroll Information window (accessible 
from the Setup menu)

 the Company Information window (accessible from 
the Setup menu)

 the pays that you have processed for the employees.

Use the assistant to view the information that will be 
included on the forms and to make any necessary changes.

[Malaysia] To prepare income tax and 
statutory forms

1 Go to the Payroll command centre and click Print 
Tax/EPF/SOCSO Forms. The Print Tax/EPF/SOCSO 
Forms assistant appears.

2 Select the form you want to prepare and the payroll year.

3 [Borang CP 39, 39A, 8A or A] Select the month for which 
you are reporting.

4 [Borang CP 39A only] From the Bonus paid for list, 
select the year you paid tax on employees’ bonus.

5 [Borang EA form only] Click Configuration. 

Link each field in the left column to the appropriate 
payroll categories in the right column. This will ensure 
that all activity recorded against the payroll categories is 
transferred to the appropriate fields on the tax form.

When you have finished linking the fields with the payroll 
categories, click OK. 

6 Click Next.

7 Type a contact name and the employee’s designation.

Income Tax (Borang CP 
39A)

EPF (Borang A)

SOCSO (Borang 8A)

Malaysia Singapore
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8 If required, type your company’s contact and company 
details. 

9 Click Next. Complete the tasks relevant to your form.

[Borang EA only] Select the employees for whom you want 
to print a tax form by clicking in the select column. If you 
want to view or edit the details that will be printed on an 
employee’s form, click the zoom arrow next to the 
employee’s name and make any changes in the window 
that appears. When finished, click OK.

[Borang CP 159] Click Details to view your payment 
details and record your receipt numbers. When finished, 
click OK.

[Borang CP 39, CP 39A, 8A or A] Click Details to record 
your payment details and receipt numbers. Note that the 
details in this window vary according to the form you are 
preparing. When finished, click OK. 

10 Click Next. If you are ready to print the selected forms, 
click Next and you will be prompted to print the forms.

11 If you want to save PDF copies of the forms you have 
printed, select the I require a copy of the form to 
be saved option. When you click Finish you will be 
prompted to save the PDF file.

12 Click Finish.

[Singapore] To prepare income tax and CPF 
forms

1 Go to the Payroll command centre and click Print 
Tax/CPF Forms. The Print Tax/CPF Forms assistant 
appears.

2 Select the form you want to prepare and the payroll year.

[CPF Payment Advice or Form CPF 92] Select the month 
for which you are reporting.

3 [CPF Payment Advice or IR8A form only] Click 
Configuration. 

Link each field in the left column to the appropriate 
payroll categories in the right column. This will ensure 
that all activity recorded against the payroll categories is 
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transferred to the appropriate fields on the form you are 
preparing.

When you have finished linking the fields with the payroll 
categories, click OK.

4 Click Next. If required, type your company’s contact 
details.

If the company’s address has changed since the last form 
was submitted, select the Employer Address Change 
option. The address entered in the Company 
Information window (accessible from the Setup 
menu) will be printed on the forms.

5 Click Next. Complete the tasks relevant to your form.

[IR8A form only] Select the employees for whom you want 
to print a form by clicking in the select column. If you want 
to view or edit the details that will be printed on an 
employee’s form, click the zoom arrow next to the 
employee’s name and make any changes in the window 
that appears. When finished, click OK.

[CPF Payment Advice and Form CPF 92] Click Details to 
view and enter your payment details. When finished, click 
OK.

6 Click Next. If you are ready to print the selected forms, 
click Next and you will be prompted to print the forms.

7 If you want to save PDF copies of the forms you have 
printed, select the I require a copy of the form to 
be saved option. When you click Finish you will be 
prompted to save the PDF file.

8 Click Finish.

Task 4: Back up your company file
Before you start a new payroll year, make sure that you back up 
your company file. Once the year is closed, detailed payroll 
information will no longer be available for editing. Backing up 
your company file allows you to restore a closed payroll year 
so you can print reports. 

For more information, see ‘Backing up and restoring company 
files’ on page 262.
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Task 5: Start a new payroll year 

NOTE : Single user access This task requires single-user 
access. For more information, see ‘Single-user file locking for 
special tasks’ on page 270.

Starting a new payroll year will:

 prevent you from printing payroll reports for the previous 
year. (Note that you can print prior year tax and CPF 
forms.)

 carry over entitlement balances that have the Carry 
Remaining Entitlement Over to Next Year 
preference set in the Entitlement Payroll Category 
window of employee cards

 clear any entitlement balances that do not have the 
Carry Remaining Entitlement Over to Next Year 
preference set in the Entitlement Payroll Category 
window of employee cards

 prevent you from editing or deleting pay amounts for the 
previous year.

To start a new payroll year

1 Go to the File menu, choose Start a New Year, and then 
Start a New Payroll Year. 

2 If you want to create a backup file before purging the 
information, click Backup and follow the instructions in 
the windows that appear.

3 Click Continue. Follow the on-screen instructions to 
complete the process.

Task 6: Check that you have the latest 
tax, SOCSO or CPF tables

[Malaysia] To check tax and SOCSO tables

 To check that you have the correct tax or SOCSO tables 
for the new payroll year, go to the Help menu and choose 
Check for Product Updates (requires Internet 
access).

 To load the latest tax or SOCSO tables, go to the Setup 
menu and click Load Tax\SOCSO Tables. In the Load 
Tables window that appears, select the tables to load 
and click Load Tables.

[Singapore] To check CPF tables
 To check that you have the correct CPF tables for the new 

payroll year, go to the Help menu and choose Check for 
Product Updates (requires Internet access).

 To load the latest CPF tables, go to the Setup menu and 
click Load CPF Tables. In the Load Tables window that 
appears, click Load Tables.

Task 7: Optimise and verify your 
company file
Once the Start a New Payroll Year procedure is complete, we 
recommend that you optimise your company file. See 
‘Optimising your company file’ on page 267.
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19  Managing user accounts and 
company files

Your company’s accounting information is kept in a single file called a company file. This includes your accounts list, details about your 
customers, suppliers, your list of items and all your transactions. To open the company file, you need to log in with a user ID and password.

This chapter explains how you can perform maintenance tasks on your company file (including backing up, restoring and optimising) and 
how to control access to your company file using user accounts.

Managing user accounts

If several people enter transactions into the same company 
file, you can control which command centres, windows and 
transactions they can access with user accounts. The ability 
to limit users’ access can help to minimise fraud. For example, 
you can prevent a person who places orders with suppliers 
from also being able to pay suppliers, minimising the 
likelihood of paying false bills. 

User accounts A user can only open a company file by 
completing the Sign-on window. The user must enter a user 
ID and password to gain access to the user account. Then, 
whenever a user enters a transaction, it is labelled with the 
user ID. This allows you to keep track of who entered 
particular transactions, which is useful when following up 
disputes with suppliers or customers and pinpointing 
fraudulent transactions.

TIP : Restrict access to employee information User IDs 
can be set up to restrict access to employee payroll, banking and 
contact information stored in the card file and on reports. You 
can select the full restrictions, such as disallowing access to the 
employee card file, or you can set specific restrictions, such as 
viewing employee banking details. If you want to prevent a user 
from editing and viewing all payroll details, you need to restrict 
access to payroll reports as well as to employee card information 
and payroll command centre functions.

Administrator account The Administrator account is a 
default user account always present in all company files and 
cannot be deleted. This special user account is the only one 
with access to all command centres, functions and windows.
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The person logged on as Administrator is able to create, edit 
and delete ordinary user accounts. For that reason, as soon as 
you create a company file, you should supply a password for 
the Administrator account; otherwise, any user can log in and 
enter, edit and delete transactions without leaving a trace. 
For more information, see ‘Set a password for the 
Administrator user ID’ on page 25.

Simultaneous users Your ABSS software allows more 
than one user to access a company file. Though your ABSS 
software provides you with a single network licence at the 
time of purchase, you can buy additional licences (also known 
as workstation seats) whenever the need arises.

To create a user account

1 Log in to your ABSS company file as Administrator.

2 Go to the Setup menu and choose Preferences.

3 In the Preferences window, click the Security tab and 
then click User IDs. The User Access window appears.

4 Click New to open the New User Details window.

5 Type the user’s name in the User ID field, then type the 
password in the Password and Confirm Password 
fields. 

6 If you want to copy the restrictions you have set up for 
another user, type or select an existing user account in the 
Copy Restrictions field.

7 Click OK. The new user account appears in the User ID 
column of the User Access window.

8 Click the new user account in the User ID column, then 
click in the Not Allowed column next to those command 
centres or functions to be denied to the user. 

9 Click OK. 

[ABSS Premier Plus range only] To obtain 
additional workstation licences

When the volume of transactions is too large for one person 
to process, you can purchase extra workstation licences to 
allow additional users simultaneous access to the company 
file. 

Before you begin, have your credit card on hand. 

1 Start your ABSS software and open the company file 
requiring extra workstation licences. 

2 Go to the Setup menu and choose Company 
Information. 

3 In the Company Information window, click License. 



B A C K I N G  U P  A N D  R E S T O R I N G  C O M P A N Y  F I L E S   2 6 2

4 Call Customer Service at the number given in the Enable 
Licence window and follow the Customer Service 
representative’s instructions. 

NOTE : Write down the confirmation code Ask the 
customer service representative for the company file’s 

confirmation code—you may need it to activate the extra 
workstation licences you have purchased. 

5 Confirm the extra workstation licences.
 If you can connect to the Internet, click Enable Online 

Backing up and restoring company files

Backing up is the copying of a company file to some form of 
storage medium, such as a disk, CD, a different hard disk or 
other media. You can also use the backup function in your 
ABSS software to create a compressed archive file with a 
‘.ZIP’ extension that takes up less space.

The Restore command closes the company file you’re 
currently using, decompresses a backup file so you can use it, 
and then opens the backup file. 

CAUTION : Single-user access required [ABSS Premier 
Plus range only] Making and restoring a backup requires 
single-user access. For more information, see ‘Single-user file 
locking for special tasks’ on page 270. 

Precautions when backing up Avoid common 
mistakes that can cause you to lose backups of company files:

 Take care when backing up multi-user company 
files If multiple users access a company file on a host 
computer, back up the host company file—especially if 
you include custom forms, and letter and spreadsheet 
templates in the backup. 

By making a full backup, you ensure that the most recent 
versions of custom forms and templates are backed up.

 Do not store backups on the same hard disk as 
the currently used company file A single disaster 
can wipe out all your records.

 Make separate backups A disk failure can corrupt 
your data in such a way that you may not notice it during a 
session. If you accidentally copy some corrupted data 
over your previous backup file, that backup is no longer 
valid. Without a valid backup, you would need to re-create 
your company file. You can reduce the risk by making 
separate backups to protect your company data— for 
example, at the end of each business day.

 Store backups off-site Store monthly and yearly 
backups in a safe place, preferably away from your office. 
Except for daily rotational backup, do not re-use media.



B A C K I N G  U P  A N D  R E S T O R I N G  C O M P A N Y  F I L E S   2 6 3

To make a backup of your company file

The Backup command creates a backup of the company file 
you are currently using and compresses it to a smaller, more 
manageable size. 

CAUTION : Backups and multi-user company files [ABSS 
Premier Plus range only] If there are multiple users 
accessing a company file on a host computer, back up the host 
company file—especially if you are doing a full backup that 
includes custom forms, and letter and spreadsheet templates.

1 Go to the File menu and choose Backup. A backup 
window appears. 

CAUTION : If the backup process does not work If 
warning or error messages appear at any stage of the backup 
process, contact ABSS Support.

2 Select the type of backup you want.

3 Choose whether to check your company file for errors 
before making your backup. 

NOTE : Maintaining data integrity We recommend 
checking for errors so that if you need to revert to a backup, 
data integrity is ensured. 

4 Click Continue.

 If you selected the Do not check Company File for 
errors option, go to step 6 below.

 If you selected the Check Company File for errors 
option, note that this verification process may take 
several minutes.

5 Click OK in the window that appears when the 
verification process has finished. This window appears 
whether or not errors have been found in the company 
data file.

For more information about checking your company file 
for errors, see step 2 of ‘To check your company file for 
errors’ on page 267.

6 In the Backup window that appears, choose where you 
want to store the backup file.

The default filename assigned to the backup file is 
MYmmdd.zip; mmdd is the month and day from your 
computer’s clock. The file extension .zip cannot be 
changed. 

7 If you want, change the name of the backup file.
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Note that you need to name all your backups with enough 
information to tell you when they were done and where 
you were up to in data entry—for example, ‘Friday, 11.07.12’ 
or ‘Backup as of 11.07.12’.

8 Click Save.

9 When storing the backup file on a removable storage 
device, label all your backups with enough information to 
tell you when they were done and where you were up to in 
data entry—for example, ‘Friday, 11.07.09’ or ‘Backup as of 
11.07.09’.

To restore a backup 

1 Go to the File menu and choose Restore. The Restore 
window appears.

If the Prompt for Data Backup When Closing 
option is selected in the Preferences window, a window 
appears asking if you want to back up your company file. If 
you want to back up your company file now, click Yes and 
follow the prompts, otherwise click No.

2 In the Restore window, locate the backup file you want to 
restore, select it and click Open.

NOTE : If the backup file is on a removable disk, insert the 
disk into the disk drive.

3 Select where you want to save the restored file. By 
default, the restored file will be saved in the same folder 
as the backup file. If you want to save it in a different 
location, select the folder name in the Save in field.

4 When you have specified the location and file name, click 
Save. A message appears showing that the company file 
will be restored to the selected folder. 

5 Click OK to complete the restore.

When you restore a file that has not been activated, the 
Company File Activation window appears. If you do not 
need to enter transactions into the restored file, click I want 
to mark this file as Read Only and then click Continue 
to open the file in read-only mode. If later you need to 
activate the read-only file, go to the Help menu and choose 
Activate Company File.

NOTE : Restoring from a CD or DVD If you are restoring a 
backup file from a CD or DVD, the file will be read-only. To read 
data from the file, you need to change the file’s attributes by 
right-clicking the file, choosing Properties and deselecting the 
Read-only option.
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Confirming activated company files

After a company file is activated, once or twice a year you 
must confirm its activation for the life of the file. The 
confirmation verifies to ABSS that you are running a legal 
installation of ABSS software. When confirmation is due and 
you attempt to open an activated company file, the 
Company File Confirmation window appears. 

You have a period of grace in which to confirm the company 
file, indicated under the Confirm Your Company File 
heading. If you do not want to confirm immediately, click the 
I want to confirm my company file later button and 
click Continue to open the file. After the period of grace 
expires, the company file can only be opened in read-only 
mode, in which you can still view transactions, print reports 
or export data, but will not be able to enter any data. 

NOTE : Confirming a read-only file If you have elected to 
open a company file overdue for confirmation in read-only 
mode, but then change your mind, go to the Help menu and 
choose Confirm Company File. The Company File 
Confirmation window appears. 

These procedures show you how to confirm an activated 
company file or set up automatic confirmation: 

 ‘To confirm a company file online’ below.

 ‘To confirm a company file by telephone’ below.

 ‘To set up automatic company file confirmation’ on 
page 266.

To confirm a company file online

1 Ensure you are connected to the Internet.

2 In the Company File Confirmation window, click I 
want to confirm my company file online.

3 Click Continue. Your serial number and company file 
code are sent to the ABSS confirmation server, which 
returns a confirmation code and extends the file 
activation. 

The Company File Confirmation – Confirmed 
window appears.

4 If you prefer your ABSS software to perform subsequent 
confirmations automatically, select the I want to use 
Automatic Confirmation option. 

5 Click OK and in subsequent windows choose the options 
relevant to your business needs until the command centre 
appears. The company file has been confirmed and you 
can continue to enter transactions. 

NOTE : Frequent requests to confirm If, after 
confirming a company file, ABSS software asks you within a 
short time to confirm it again, contact Technical 
Support—see ‘Troubleshooting activated company files’ on 
page 266. Under normal circumstances, confirmation only 
occurs once or twice a year.

To confirm a company file by telephone

1 In the Company File Confirmation window, click I 
want to confirm my company file by phone. 

2 Click Continue. The Company File Confirmation – 
By Phone window appears.

3 Call ABSS at the telephone number displayed under the 
Company File Code field.

4 Follow the instructions to receive your confirmation code.

5 Type the confirmation code in the Confirmation Code 
field and click Continue. 
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NOTE : Confirmation code only used once After you 
confirm your company file, the confirmation code cannot be 
used to confirm this or any other company file again. You 
must get a new confirmation code from ABSS each time your 
ABSS software requests confirmation. 

6 If you have an Internet connection and you prefer your 
ABSS software to perform subsequent confirmations 
automatically, select the I want to use Automatic 
Confirmation option.

7 Click OK and respond to subsequent windows as you wish 
until a command centre appears. The company file has 
been confirmed and you can continue to enter 
transactions. 

NOTE : Frequent requests to confirm If, after 
confirming a company file, ABSS software asks you within a 
short time to confirm it again, contact Technical 
Support—see ‘Troubleshooting activated company files’ 
below. Under normal circumstances, confirmation occurs 
only once or twice a year.

To set up automatic company file 
confirmation

After a company file has been activated, ABSS software asks 
you to confirm it once or twice a year. You can manually 
confirm the company file either over the Internet (see 
page 265) or by telephone (above). But, if you prefer, you can 
confirm company files over the Internet automatically. 

NOTE : Internet connection required When ABSS software 
attempts to confirm the activation of the company file 
automatically and you are not currently connected to the 
Internet, a window appears requesting you to connect. 

1 Open your ABSS company file.

2 Go to the Setup menu and choose Preferences.

3 In the Preferences window, click the Security tab. 

4 Select the I Prefer to Use Automated Online 
Company File Confirmation option and click OK. 

From now on, your ABSS software confirms the company 
file automatically and displays this notification of 
successful confirmation each time.

Troubleshooting activated company 
files
The activation and confirmation of company files is sensitive 
to date changes in your computer’s system clock. 

In some circumstances, changes or discrepancies in the 
system date start an immediate confirmation process. 

Workstations out of synchronisation If multiple 
users on different workstations are accessing a company file 
simultaneously and the dates in the system clocks of one or 
more workstations differ, you will need to synchronise clocks 
and confirm the company file the next time you open it. 

Date changed while company file is open If you 
open a company file and change the date in your computer’s 
system clock while the file is open, then close the file, you 
may need to confirm the company file next time you open it. 
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Servicing your company file

Checking your company file for errors
In addition to checking for errors when you create a backup, 
you can check your company file for errors any time you 
choose.

By checking your company file for errors, you can identify 
minor problems in the file before they cause serious problems.

To check your company file for errors

CAUTION : Single-user access required [ABSS Premier 
Plus range only] Checking a company file for errors requires 
single-user access. If you normally have multiple users accessing 
a shared company file on a host computer, verify the company 
file from the host computer when no other users are logged on. 
See ‘Single-user file locking for special tasks’ on page 270.

1 Go to the File menu and choose Verify Company File. 
A confirmation window appears. 

2 Click OK to confirm that you want to verify your company 
file. Your company file is scanned for errors. When the file 
verification process is complete, a message appears 
describing the results of the process. 

If no errors were found, click OK to end the 
verification process. 

If your company file is corrupted, you can:
 Attempt to repair the company file by optimising it—see 

‘Optimising your company file’ below—and repeat this 
procedure to check if the errors have been fixed.

 Restore the company file from your most recent 
backup—see ‘To restore a backup’ on page 264.

Optimising your company file
Over time, your company file will grow considerably in size. 
As you enter transactions, then remove or purge them, the 
file will have unused areas that once contained these 
transactions. These unused areas can affect the efficiency 
with which operations are performed in the company file. We 
recommend that you use the Optimisation Assistant to 
remove the unused areas in the company file and keep your 
accounting software running efficiently.

To optimise a company file

CAUTION : Optimising multi-user company files [ABSS 
Premier Plus range only] If multiple users are accessing a 
shared company file on a host computer, optimise the company 
file on the host.

1 Open the company file to be optimised. 

2 Go to the File menu, choose Optimise Company File. 
An information window appears. 

3 Click OK to continue.

4 If an optimisation file exists, we recommend that you click 
Yes to retain a copy of it.

5 Click OK. 
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Purging information that is no longer 
needed
Purging is the process of removing data from your company 
file. After you have used your ABSS software for a long time, 
you will notice that the size of your company file has grown 
considerably. 

The procedure for purging information (below) applies if you 
are purging:

 journal entries

 sales

 purchases

 business contacts

 contact logs

 activity slips

 sales history figures

 timesheets [ABSS Premier Plus only].

When your company file has grown larger than you want it to, 
you can purge, that is remove information, that is no longer 
needed. After transactions are purged, they will no longer 
appear on any report.

Special considerations for purging activity 
slips [ABSS Premier range only] and 
timesheets [ABSS Premier Plus only]

When purging activity slips and timesheets, note the 
following:

 If you have billed an activity slip on an invoice, you can 
purge that activity slip only if the invoice on which it was 
billed has been purged. 

 You can purge a timesheet only if an employee payment 
for the timesheet’s hours has been made using the 
Process Payroll assistant.

 If you purge activity slips, any slips with hours on 
timesheets are not purged. You must purge timesheets to 
purge those activity slips.

 If you purge a timesheet, any activity slips on the 
timesheet are also purged (only if an employee payment 
for the timesheet’s hours has been made using the 
Process Payroll assistant).

To purge information

CAUTION : Purging multi-user company files [ABSS 
Premier Plus range only] Purging a company file requires 
single-user access. If you normally have multiple users accessing 
a shared company file on a host computer, purge the company 
file on the host computer when no other users are logged on. 
See ‘Single-user file locking for special tasks’ on page 270.

1 Open the company file to be purged.

2 Create a backup file. 

3 Go to the command centre to be purged. The information 
you can purge is dependent upon the command centre 
you are in. For example, if you are in the Sales command 
centre, you can only purge closed invoices.

4 Go to File menu and choose Purge [...].

5 Click Continue and follow the instructions in the Purge 
[...] wizard.
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Troubleshooting file-locking problems
When a company file is open, a temporary file called a lock file 
is created in the folder where the company file is stored. This 
file, called Lock000*.flk, keeps track of who is using the 
company file. When you log out of the company file, the lock 
file is deleted automatically. 

Sometimes, however, the lock file is not deleted. This can 
happen if your computer crashes or an error causes your 

company file to close unexpectedly. Lock files can 
accumulate in the company file folder, resulting in error 
messages appearing when you try to access your company 
file again. 

To resolve these error messages, you must exit your ABSS 
software. Open the folder that contains the company file and 
delete any lock files. You should then be able to open your 
company file without an error.

Special considerations for networked company files

NOTE : ABSS Premier Plus range only The following 
networking information is only applicable to ABSS Premier Plus 
and ABSS Premier Plus users. 

When multiple users access a company file over a network, 
you need to be aware of factors that affect the way you work 
that are not present when only a single user accesses the 
company file. See:

 Preferences in a network environment, below.

 Preventing data entry while generating reports, page 271.

 Storing custom reports on a network, page 271.

 Displaying up-to-date information, page 272.

 Improving performance, page 273.

Preferences in a network environment
Some of the choices in the Preferences window of your 
ABSS software can affect how everyone works with your 
company file. These preferences are clearly marked 
System-wide.

Multi-user file locking for daily transactions

Multi-user file locking ensures that changes cannot be made 
in some windows while related data is being changed by 
another user in another window. 

For example, a situation could arise where a user is recording 
information in a sales transaction window while another user 
is changing details of the customer card being used in the 
sales transaction. In such a situation, multi-user file locking 
prevents changes being saved in one of the windows until the 
changes have been saved in the other window.

If you would like to know when another user has changed data 
in a window, go to the Setup menu, choose Preferences, 
click the System tab, and select the Automatically 
Refresh Lists When Information Changes option. 
Now, if another user changes information you are viewing, 
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your ABSS software closes your window. When you reopen it, 
the data is updated.

TIP : View a list of users If you have been prevented from 
accessing the company file, you can identify which user is 
locking you out. To do this, go to a computer that has access to 
the company file and view the list of active users (by going to 
the File menu and choosing Active Workstations).

Single-user file locking for special tasks
Although several users must be able to share a company file 
for entering daily transactions, there are times when only one 
user should have access. Many of these tasks are file 
maintenance procedures such as backing up and checking and 
optimising the company file. For example, optimising a 
company file rearranges its internal structure, so you do not 
want someone else accessing the file while this process is 
taking place. Other single-user tasks are part of bookkeeping 
practice. For example, when you print a report, you do not 
want anybody to change data that will appear in the report 
while it is being printed.

TIP : View a list of users To check whether any other users 
are currently using the company file, before you set a single-user 
lock, go to the File menu and choose Active Workstations.

Single-user file locking prevents all but the first logged-in 
user from accessing a shared company file—other users 
cannot even log in. To enable single-user access after starting 
your ABSS software, click Single-user access in the 
Sign-on window.

The tasks that require single-user file locking include:

 backing up a company file

 restoring a backup file

 company file verification

 purging data

 exporting data

 importing data

 starting a new financial year

 creating, changing or deleting report batches

 optimising a company file

 setting up, changing or removing user accounts.

Problems with lock files
To let you know when another user is already accessing a 
shared company file, your ABSS software displays the File is 
busy; access denied message when you try, at the same 
time, to save a transaction or otherwise write data. When you 
see this message, wait a few moments for the other 
transaction to finish and for your ABSS software to delete the 
lock file, and then click Retry.

If the power fails, or you switch off your computer while your 
ABSS software is running, or your system crashes, your ABSS 
software is unable to delete the lock file and you need to 
delete the locked file manually. See ‘To delete lock files’ on 
page 271. The following situations can cause lock files to 
accumulate in the folder where the company file is kept, 
resulting in various error messages when you try to open a 
company file:

 Someone else is currently signed on with the 
same User ID
Someone else is using the company file with your user ID 
or a lock file from an irregularly ended session is present. 

 No more than ten company files in any folder 
may be opened at one time
There are more than ten lock files—the maximum 
permitted—in the folder where the company files are 
kept. This can occur legitimately if there are more than ten 
company files in the folder, ten of which are open 
simultaneously, so that an eleventh open file would create 
an (illegal) eleventh lock file.
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It is unlikely that ten company files in a single folder will be 
open simultaneously. More likely, ten lock files have 
accumulated in the folder owing to crashes and other 
problems.

 You have reached the maximum number of 
simultaneous users allowed under your ABSS 
software Workstation Licence
If you know this is incorrect, the problem may be a lock 
file.

To delete lock files

Any of the above messages may mean that there are old lock 
files cluttering the folder where you store the company file. 
You need to delete the lock files before your ABSS software 
will function correctly.

1 Ask all users to close the shared company file and log out 
of your ABSS software.

2 Go to the File menu and choose Active Workstations 
to check whether any users are still logged in. If there are, 
ensure they have logged out before continuing. 

3 Log out of your ABSS software.

4 Navigate in Windows Explorer to the folder where you 
keep the shared company file.

5 Delete all lock files1.

6 Restart your ABSS software and re-open the shared 
company file.

Preventing data entry while generating 
reports
If there are multiple users accessing a company file 
simultaneously and you want to print or view a report, we 
recommend that you prevent data changes being made 
during report generation. If you do not, other users will be 
able to continue making entries in the company file and your 
report may not be accurate. If another user changes 
information that affects the report while it’s being printed or 
displayed, that particular entry may be indicated by zeros or 
blank spaces on the report. In addition, new entries that other 
users make might affect the total amounts on some reports. 
For this reason, consider printing or displaying the report at a 
time when you know that no entries are being made that will 
affect its accuracy.

Before you print or display a report, open the Report 
Customisation window for the report and select the 
Prevent Data Changes During Report Generation 
option (on the Finishing tab of the Report 
Customisation window). This activates multi-user file 
locking and prevent other users from adding, changing or 
removing any information from the company file while your 
ABSS software is generating the report. When you print or 
display the report while this option is selected, the report will 
be up-to-date and accurate.

A few reports take some time to be generated. Consider 
printing these lengthy reports at times when other users 
won’t have to wait for the report to be generated before they 
can resume making entries in the company file.

Storing custom reports on a network
When you create custom reports and forms, information 
about them is stored on your workstation’s hard disk and not 
on the network. Other users of the same company file won’t 
be able to use your custom reports or forms unless you copy 

1. The file is named Lock####.flk, where #### represents 
a number from 0001 to 0010. If there is more than one 
company file in the same folder, the number allows ABSS 
software to create a different named lock file for each 
company file.
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them to the appropriate locations on their workstations. 
(Your system administrator may need to perform this task.)

Custom reports are stored in the Custom folder and custom 
forms in the Forms folder. Both these folders are located 
under the folder where your ABSS software is installed on 
your workstation.

Displaying up-to-date information
Each time you open a list window (such as the Find 
Transactions window) or display a report in the Report 
Display window, the information that is displayed matches 
the contents of the company file as of the moment you 
opened the list or displayed the report. 

However, if you keep the list or report displayed on your 
computer screen for some time, the data that other users 
entered during that time will not be included in your list or 
report. You can update the information automatically or 
manually:

 Automatic update Go to the Setup menu, choose 
Preferences and then click the System tab. Select the 
Automatically Refresh Lists when Information 
changes option.

NOTE : Automatic refreshing slows response
Consider whether you need to have on-screen information 
refreshed automatically. If you choose this option, your ABSS 
software will operate more slowly for everyone who is 
accessing the company file. If speedier data entry is a 
priority, we recommend that you choose to manually refresh 
information regularly.

 Manual update Go to the Window menu and choose 
Refresh All. To update an on-screen report in the 
Report Display window, click Redisplay. 
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Improving performance
The following list outlines a number of ways in which you can 
get the most out of your ABSS software: 

 Use single-user access whenever possible.

 Optimise your company file frequently—see ‘Optimising 
your company file’ on page 267.

 Do not select the Automatically Refresh Lists when 
Information Changes option in the Preferences 
window.

 Do not select the Warn for Duplicate [...] Numbers 
on Recorded Purchases option in the Purchases tab 
of the Preferences window.

 Use Easy-Fill when entering card names, account names, 
and item numbers or names.

 Avoid leaving list windows open.

 Use only a few linked accounts for inventory items.

 Combine line-item quantities on sales and purchases.

 Generate large reports when you’re the only person using 
the company file.

Print reports by choosing a specific month instead of by 
entering a date range.
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Appendix A: Importing and 
exporting data 

Exporting data

You can take various data entered in your company file and 
use it in other software or in other ABSS company files. This 
process is called exporting data.

Some of the data types you can export are accounts, items, 
general journal entries, inventory adjustments, receive money 
transactions, spend money transactions, sales, purchases, 
cards, jobs, custom lists, contact logs, activities and activity 
slips [ABSS Premier range only] and timesheets [ABSS Premier 
Plus only]. 

NOTE : Exporting timesheets [ABSS Premier Plus only] When 
you export timesheets, only the entries that do not have activity 
slips associated with them are included. You must export activity 
slips to complete the process.

The data can be exported to a tab-delimited or 
comma-separated values (CSV) file. 

NOTE : Single-user mode required for data export
[ABSS Premier range only] You cannot export data when more 
than one user is logged in. For more information, see ‘Single-user 
file locking for special tasks’ on page 270.

To export data

1 Go to the File menu, choose Export Data and then 
choose the type of data you want to export. The Export 
File window appears. 

2 Select the export file format and enter other information 
in this window. For detailed field help, click Help, and 
then choose Help for This Window. 

3 Click Continue. The Export Data window appears.
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4 Choose the fields you want to export and the order in 
which you want to export them. To do this, click on the 
first field you want to export in the ABSS [...] Fields 
column. The title Field 1 appears in the Export Order 
column next to the field you selected. The field name will 
appear at the top of the Export Fields column on the 
left side of the window. 

5 Repeat step 4 for each field you want to export.

6 If you want to remove a field name from the Export 
Fields column, click the name in the ABSS [...] Fields 
column. 

If you want to export all the fields in the order they are 
shown in the column, click Match All.

7 Click Export. The Save As window appears. 

8 Enter a file name and location for the export file and click 
Save. The file is exported.

Before you import data you should make a backup of your 
company file. See ‘Backing up and restoring company files’ on 
page 262.

Importing data 

You can take various data entered in other software programs 
and add it to your company file. You can also add data entered 
in one ABSS company file into another ABSS company file. 
This process is called importing data. 

If you want to import data from ABSS RetailManager or 
ABSS RetailBasics, see ‘Importing data from ABSS retail 
software’ on page 276.

You can import the following data: accounts, items, general 
journal entries, receive payments transactions, receive money 
transactions, spend money transactions, pay bills 
transactions, sales, purchases, cards, jobs, custom lists, 
contact logs, activities and activity slips [ABSS Premier range 
only] and timesheets [ABSS Premier Plus only]. 

NOTE : Importing timesheets [ABSS Premier Plus only] When 
you import timesheets, only the entries that do not have activity 
slips associated with them are included. You must import 
activity slips to complete the process.

The data can be imported from a tab-delimited or 
comma-separated values (CSV) file. 

NOTE : Single-user access required for data import 
[ABSS Premier range only] Please note that you must not import 
data when more than one user is logged in. For more 
information, see ‘Single-user file locking for special tasks’ on 
page 270.

To import data

Before you start the import procedure below, you need to 
export the data from the software used to create the data 
and save it in a tab-delimited or comma-separated file 
format. 

1 Go to the File menu, choose Import Data and then 
choose the type of data you want to import. The Import 
File window appears. 

2 Select the import file format, the type of the first record, 
and the method of handling duplicate records. For more 
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information, click Help and then choose Help for This 
Window.

3 Click Continue. The Open window appears.

4 Locate the import file and click Open. The Import Data 
window appears.

5 Match the import fields with the ABSS [...] Fields 
column. 
a Highlight the name of a field in the Import Fields 

column. 

b Click the matching field in the ABSS [...] Fields 
column. 
The import field you selected appears in the Matching 
Import Field column. 

NOTE : Some fields must be imported Fields that 
have asterisks (*) next to them must have matching 
import fields assigned to them.

c Click a field in the Matching Import Field column to 
remove it. 

d If all fields in the import file match those in the ABSS 
[...] Fields column, click Match All. 

6 Click Import to import the data. If you get a warning or 
error message indicating that the import was not 
successful, refer to the import log file in your ABSS 
software installation folder for a list of errors or warnings. 
The import log file is a text file—readable by most word 
processors—that lists the problems encountered during 
the import.

Importing data from ABSS retail software

If you use ABSS RetailManager or ABSS RetailBasics as your 
point-of-sale software, you can import certain information to 
your ABSS company file.

For example you can import: 

 your supplier details

 goods received transactions (which are imported into 
your ABSS company file as bills)

 general journal entries summarising other transactions 
(such as sales income and cost of sales).

NOTE : Exporting from RetailManager or 
ABSS RetailBasics Before you can import your data, you 
must export the data from RetailManager or RetailBasics as a 
text file (Retail.TXT) and save it in the ABSS software program 
folder. The import file will be detected and the import process 
will automatically begin when you open your ABSS company file. 
Note that if you save the import file in another location, you will 
need to import it manually.
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To import RetailManager or RetailBasics data

1 In your ABSS software, go to the Setup menu and choose 
Preferences. The Preferences window appears.

2 Click the System tab and select the I use 
ABSS RetailManager option. Click OK and exit ABSS 
software.

NOTE : You only need to set this preference the first time 
you import from RetailManager or RetailBasics.

3 Open your ABSS company file. If there are transactions to 
be imported, the import process will occur automatically. 

If you get a warning or error message indicating that the 
import was not successful, refer to the import log file in 
the ABSS software installation folder. This is a text 
file—readable by most word processors—that lists any 
errors or warnings encountered during the import.
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Appendix B: Networking 
company files
Note that you might need to consult an IT professional to make sure your network is configured to suit your business requirements.

Overview
The ABSS Premier range of software are network-ready 
applications that comes with one licence. However, if the 
volume of your transactions grows too great for one person 
to handle, you can purchase additional workstation licences 
so that several users can access the company file 
simultaneously. See page 261 for more information. 

If multiple users will be simultaneously accessing a company 
file, it should be stored on a host computer where it can be 
accessed across the network from other Windows 
workstations. The host computer and workstations must be 
running Windows Vista, 2000 or XP. Note that the 
workstations do not all need to be running the same version 
of Windows.

NOTE : Setting up networks needs expert skills Because 
setting up routers or hubs, cabling computers and configuring 
network hardware and software require expert knowledge, you 
may need to employ an expert with the necessary skills. ABSS 
softwareABSS Accounting2020ABSS Premieryour ABSS software

If setting up a network for the first time, show this appendix 
to a networking expert. To locate a networking-qualified 

ABSS Professional Partner near you, contact ABSS customer 
service in your region.

This section starts from the point where the network is 
already set up and running. A local area network (LAN) can be 
set up in many different ways. The procedures in this section 
describe the most common situation where a LAN is 
protected from the external internet by a firewall on a router 
or gateway computer. 

NOTE : Network access privileges required In a Windows 
network, access can be set at the domain or user level. If you are 
unable to carry out the procedures in this section because you 
do not have sufficient access privileges, contact the person who 
set up your network for assistance.

All users who need to access the company file automatically 
belong to the Everyone user group.This group is used as the 
default group in these procedures as it simplifies the sharing of a 
host folder. The members of the Everyone group will be given 
permission to open, read from and write to the shared company 
file. 
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NOTE : The Everyone user group may be a security risk
The Everyone user group allows anyone on the network to access 
the shared company file. If some employees are not authorised 

to access your accounting data, read Windows help or consult a 
networking expert to set up more secure access.

Setting up the network hardware

Unless you are an expert, employ a networking consultant to 
set up your network hardware. 

Show the consultant these requirements for the host 
computer, and the hardware and software requirements for 
the workstations specified in the Getting Started guide. 

Setting up a company file folder on a Windows host

Before users can work with a company file simultaneously, it 
must be stored on a host computer to which each user has 
access. Consider these tips for choosing a suitable host:

 Host the company file on the most powerful 
computer in the network Users on workstations 
will enjoy better performance if the company file is stored 

Networking Local area network (LAN), peer-to-peer

Windows 
host

Windows Vista, 2000 or XP

Equipment • Pentium processor, with 1GHz and 128MB 
RAM, or better

• Older computers may need a network 
interface card (NIC)

Protocols • Ethernet (10BASE-T twisted pair cable, 
shielded or unshielded) or 

• Fast Ethernet (100BASE-TX twisted pair 
cable, shielded), with Windows networking 
(NetBIOS, NetBEUI, or TCP/IP)
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on the most powerful computer in your network—the 
fastest with the most memory.

 Host the company file on the key employee’s 
computer If one employee will use the company file 
more than anyone else, consider storing the company file 
on that employee’s computer. This person will experience 
better performance from accessing the company file 
directly, compared with accessing it across the network. 

 Host the company file on a backed-up 
computer If you store all your important files on a 
central host that is backed up frequently, it is a good idea 
to also store your company file on that host. The company 
file will then be backed up along with all your other vital 
data. 

Complete the set up tasks relevant to your operating system.

To share a folder on Windows 7

This procedure applies to Windows 7 users. If this procedure 
does not apply to your network configuration, consult a 
networking expert or read Windows 7 help to set up 
appropriate sharing access and permissions.

1 Log in as an administrator if only administrators can set 
permissions on your computer. 

2 In Windows Explorer, create a folder named 
Company_Files in a convenient location, for example, 
c:\Company_Files. This folder is where the shared 
company file will be stored.

3 Right-click the Company_Files folder and choose 
Share with, then select to share the folder with a 

homegroup or with specific people. The File Sharing 
window appears.

4 If you selected Specific people, enter the names of the 
users or select Everyone.

5 Click in the Permission Level column next to the user 
group to set the read and write permission for the user.

6 Select Read/Write to enable full control permission.

NOTE : Everyone group If the Everyone group does not 
appear in the list, select it from the menu field above the list 
and click Add, then assign access permission as per the 
above step.

7 Click Share. In the confirm window that appears, click 
Done.

8 In Windows Explorer, move the company file to the shared 
Company_Files folder you just created on the host. 

To share a folder on Windows Vista

This procedure applies to Windows Vista. If this procedure 
does not apply to your network configuration, consult a 
networking expert or read the Windows help to set up 
appropriate sharing and access permissions. 

1 Log in as an administrator if only administrators can set 
permissions on your computer. 

2 In Windows Explorer, create a folder named 
Company_Files in a convenient location, for example, 
c:\Company_Files. This folder is where the shared 
company file will be stored.

3 Right-click the Company_Files folder and choose 
Share. The File Sharing window appears.

4 Click in the Permission Level column next to the 
Everyone user group and choose Co-owner. This 
enables full control permission.

If your host computer is running 
Windows… See

Windows 7 below

Windows Vista below

Windows XP page 281
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NOTE : Everyone group If the Everyone group does not 
appear in the list, select it from the menu field above the list 
and click Add, then assign access permission as per the 
above step.

5 Click Share. In the confirm that appears, click Done.

6 In Windows Explorer, move the company file to the 
Company_Files folder you created step 2 above. 

To share a folder on XP

This procedure applies to Windows 2000 Professional and XP. 
If you are using Windows 2000 Standard, see ‘To share a 
folder on Windows 2000 Standard’ on page 267. If this 
procedure does not apply to your network configuration, 
consult a networking expert or read the Windows help to set 
up appropriate sharing and access permissions. 

1 Log in as an administrator if only administrators can set 
permissions on your computer. 

2 In Windows Explorer, create a folder named 
Company_Files in a convenient location, for example, 
c:\Company_Files. This folder is where the shared 
company file will be stored.

3 Right-click the Company_Files folder and choose 
Properties.
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4 In the Company_Files Properties window, click the 
Sharing tab and set the fields and controls as shown 
below. 

5 If your network does not have workgroups or you are 
logged in to a domain, continue with step 8.

6 Click Permissions.

7 In the Permissions for Company_Files window, click 
the Everyone user group, set the Allow and Deny 
options in the Permissions list as shown below and 
click OK.  

Share this 
folder
(Share this 
folder in the 
network)

Click this option. If your network does not 
have workgroups or you are logged in to a 
domain, select the Share this folder 
option, and then complete the wizard that 
appears. 

Share name Type the name that will be seen by users 
accessing the folder from their 
workstations, for example, 
Company_Files. 

Comment Type a description that users will be able 
to read in the folder’s Property window. 
This option is not present if your network 
does not have workgroups or you are 
logged in to a domain. 

Maximum 
allowed

Choose this option to allow as many users 
as possible to simultaneously access the 
company file. This option is not present if 
your network does not have workgroups or 
you are logged in to a domain. 

Allow network 
users to 
change my 
files

Click this option. This option is not present 
if your network does not have workgroups 
or you are logged in to a domain.
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8 In the Company_Files Properties window, click OK.

9 In Windows Explorer, move the company file to the 
Company_Files folder you created step 2. 

Permissions for 
Everyone Allow Deny

Full control Mark Clear

Change Mark Clear

Read Mark Clear



A C C E S S I N G  T H E  S H A R E D  C O M P A N Y  F I L E  F R O M  A  W O R K S T A T I O N   2 8 4

Accessing the shared company file from a workstation

Workstations are Windows computers that access a company 
file stored on another computer, referred to as a host 
computer. Accessing the remote company file folder on the 
host requires you to complete these procedures for each 
Windows workstation on the local area network (LAN). This 
process is also known as mapping network drives. 

When you are able to access the company file folder 
containing the shared company file, you can create a desktop 
shortcut to the file. Clicking the shortcut starts your ABSS 
software and opens the shared company file.

Setting up workstations to access the 
company file
Complete the set up procedure relevant to your operating 
system. You need to do this on every workstation that is to 
access the shared company file. 

NOTE : Access may be password protected If a password 
is required to access the shared company file folder, a window 
will request you to enter a user name and password when you 
attempt to access it.

To access a shared folder on Windows Vista

1 Select Network from the Windows start menu.

2 Locate the Company_Files folder on the host computer.

3 Right-click the Company_Files folder and click Map 
Network Drive. The Map Network Drive window 
appears.

4 Accept the proposed drive letter or choose another, 
select the Reconnect at logon option, and click 
Finish. If access to the folder is password protected, a 
logon window may appear. If so, type the password and 
click OK. 

In Windows Explorer, the Company_Files folder now 
appears as a network drive under Computer. For 
example, you might see the shared folder listed as 
Company_Files on 'Hongs-pc' (V:).

5 Open the shared Company_Files folder. You should be 
able to see the shared company file in it. 

To access a shared folder on other Windows 
versions

1 In Windows Explorer, open Network Neighborhood 
(or My Network Places). 

2 Locate the Company_Files folder on the host computer.

If a Connect to hostName window appears, complete 
the User Name and Password fields, select the 
Remember my password option and click OK. You 
should now be able to see the Company_Files folder. 

NOTE : Navigating network folders may not be 
necessary In some versions of Windows, depending how 
the network access is set up, all networked computers may 
be visible in Network Neighborhood (My Network Places) 
without you needing to navigate to network folders. 

3 Right-click the Company_Files folder and choose Map 
Network Drive. 
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4 In the Map Network Drive window (or wizard), accept 
the proposed drive letter or choose another, select the 
Reconnect at logon option, and click OK (Finish). If 
access to the folder is password protected, a logon 
window may appear. If so, enter the password and click 
OK. 

In Windows Explorer, the Company_Files folder now 
appears as a network drive under My Computer. For 
example, you might see the shared folder listed as 
Company_Files on 'Hongs-pc' (V:).

5 Open the shared Company_Files folder to see the 
shared company file in it. 

Setting up a shortcut
A fast way to start your ABSS software and open a company 
file is to put a shortcut to the program and company file on 
the Windows desktop. Then you only have to double-click the 
shortcut to be up and running. 

NOTE : Do not create a shortcut only to the company 
file If you are knowledgeable about shortcuts, you might be 
tempted to create just a shortcut to the company file. 
Unfortunately, there are not enough letter combinations to 
ensure that the.myo file extension is unique to ABSS software. 
So, double-clicking a shortcut just to a company file might start 
another program that works with a different kind of .myo file.

To set up a shortcut

1 Right-click an empty area of the desktop and choose New 
and then Shortcut. 

2 In the Create Shortcut wizard, type the path to the 
your ABSS software program file (ABSSprem.exe) in the 
Command line field (or in the Type the location of 
the item field) and click Next. Alternatively, you can 
click Browse and navigate to and select the program file, 
and then click Next.

3 Either accept the proposed name for the shortcut or type 
your preferred name in the Select a name for the 
shortcut field (or the Type a name for this 
shortcut field), and click Finish. 

4 Right-click the new shortcut and choose Properties. 

5 In the ABSSprem.exe Properties window, click the 
Shortcut tab. The Target field displays the location of 
the program you entered in step 2. 

6 [Windows 2000 and XP users only] Enclose the location of 
the program file in double quotation marks (“): 
"C:\Premier\ABSSprem.exe" for example. 

If you double-clicked this shortcut on the desktop now, it 
would only start your ABSS software. You have to modify 
the Target field so that the shortcut also opens the 
company file.

7 In the Target field, type a space after the program 
location and then type the location of the company file, 
including the .myo file extension. 

[Windows 2000 and XP users only] The path to this 
location should also be enclosed in its own quotation 
marks: "C:\Premier\ABSSprem.exe" "V:\Clearwtr.myo" 
for example. 
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8 Copy the location of the company file from the Target 
field, minus the name of the company file, and paste it into 
the Start in field, for example “V:\” as shown below. 
(Note: there should be no quotation marks in Windows 
Vista.)

9 Click OK to close the Shortcut to ABSSprem.exe 
Properties window. 

10 Double-click the shortcut on the desktop to test it. Your 
ABSS software should start on this workstation and 
immediately open the specified company file, whether it 
is stored on a remote host or this workstation. 

Repeat from step 1 on each workstation that needs access 
to the company file. 
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account Something to which transactions are assigned. 
Accounts in ABSS are in one of eight categories:

 Asset

 Liability

 Equity

 Income

 Cost of sales

 Expense

 Other income

 Other expense

Accounts are classified as header or detail. Transactions are 
assigned directly to detail accounts. Header accounts are 
used to summarise multiple detail accounts. Each ABSS 
account must have a unique number.

account number The account number is what identifies 
an account. Each ABSS account must have a unique number.

accounting period A part of your financial year. ABSS 
treats each calendar month as a separate accounting period. 
Additionally, ABSS provides an optional 13th period for 
year-end adjustments.

accounts list Commonly referred to as a chart of 
accounts, this is a list of all your asset, liability, equity, income, 
cost of sales, expense, other income, and other expense 
accounts.

accounts payable What you owe someone else for goods 
or services delivered. The sum of all accounts payable is 
recorded as a liability account. Any time you record a 
purchase in the Purchases command centre, the unpaid 
balance of the purchase is added to your accounts payable. 

Every time you pay a bill (using Pay Bills in the Purchases 
command centre), the amount is subtracted from your 
accounts payable balance.

accounts receivable What your customers owe you. Any 
time you record a sale in the Sales command centre, the 
unpaid balance of the sale is added to your accounts 
receivable balance. Every time you enter a customer payment 
(using the Sales command centre), the amount is subtracted 
from your accounts receivable balance.

accrual method (basis) This is a method of accounting 
which records sales and purchases at the time they are 
delivered, not at the time they are paid for.

accrued expenses These are expenses for goods or 
services received but not yet paid.

activity A task or service provided by your business for 
which you can track costs and bill customers using time 
billing invoices.

aging: payables The number of days between receiving a 
bill from a supplier and an aging date (usually today).

aging: receivables The number of days between 
invoicing a customer and an aging date (usually today).

allocation accounts In ABSS when writing a cheque or 
recording a payment, the allocation accounts are the 
expense, income, etc. accounts that balance the transaction.

assets Assets are things you own. Your bank account is an 
asset. So is your computer. If someone owes you money, the 
total owed to you is an asset. Current Assets are assets that 
can be turned into cash within a relatively short period of 
time (less than a year). Things that take longer to turn into 
cash, like your factory building, are called Fixed Assets. Assets 
normally have a debit balance.

Glossary
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audit trail A list of the transactions that make up the 
balance of an account or accounts.

B

bad debt Money owed to you that is unlikely to be paid. 
Many businesses create a contra-asset account to 
approximate the value of their bad debt. That way, they have 
a clearer picture of the actual value of their assets.

balance The sum of all the money added to and subtracted 
from an account.

balance sheet The balance sheet is a financial snapshot of 
a company’s position at a particular time. A balance sheet lists 
the company’s asset, liability and equity accounts. It is called 
a balance sheet because the total value of the asset accounts 
minus the total value of the liability accounts always equals 
the total of the equity accounts.

bill The record of a supplier’s invoice.

budgets Expected monthly net activity for an account. 
Budgets are useful for planning for the future and for 
analysing actual performance against planned performance.

C

cash drawer Where the money is kept between leaving 
the customers’ hands and being deposited in the bank. Many 
businesses set up their cash drawer as a bank account.

cash flow The net flow of money in minus money out over 
a selected date range.

cash method (basis) The opposite of the accrual 
method of accounting. The cash method records the sale and 
purchase of goods and services at the time they are paid for, 
not when they are delivered.

category A category is an entity for grouping 
transactions. For example, a category can be a department, 
profit centre, geographic division or any other subset of your 
business that requires separate reporting.

cleared A withdrawal or deposit is cleared when your bank 
adjusts your account balance for it.

closed period An accounting period in which all entries 
are completed. ABSS does not require that you actively close 
a period. However, in the Preferences window you can 
prevent accidental posting to a closed (locked) period.

closed purchases Purchases that have been paid in full.

closed sales Sales that have been paid in full.

company information Found in ABSS’s Setup menu, 
your company information contains your company’s name, 
address, tax information and information about your 
company’s financial year.

contra account This is an account that normally carries 
the opposite balance of the accounts of the same type. 
Assets for example, normally have a debit balance; a common 
contra-asset account is the accrued depreciation of an asset. 

By using a contra account, you can show a a car company 
that’s worth $12,000, by listing the asset at its $15,000 
purchase price followed by the -$3,000 balance of the 
accrued depreciation account. 

conversion month The conversion month is the earliest 
month in the financial year for which transactions are to be 
recorded. For example, suppose you purchase ABSS software 
in October but want to record transactions dated from 1 
September. In this case, your conversion month is September. 
The conversion month determines the opening balances you 
will enter when you set up your company file. 
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cost item The cost of an inventory item. ABSS uses 
average cost. That is, the total cost of all your purchases for a 
particular item currently on hand divided by the number of 
items on hand.

cost of sales Sometimes called “cost of goods sold” this 
account type works just like an expense account. The only 
difference is where it appears on the profit & loss statement. 
Cost of sales accounts appear after your income accounts, 
but before your expense accounts. Cost of sales is subtracted 
from your income to produce gross profit. Your expenses are 
subtracted from your gross profit to produce net profit. In 
ABSS, you are not required to use Cost of sales accounts.

credit amount Appears on the right side of the ledger (a 
debit amount occupies the left side). A credit amount 
increases the balance of accounts with a credit balance and 
decreases the balance of accounts with a debit balance. 
Accounts that normally carry a credit balance are liability, 
equity and income accounts.

credit invoice A credit invoice is a sale with a negative 
balance due. Usually caused by a return or adjustment, a 
credit invoice is settled by writing a refund cheque or 
applying the amount to another open invoice.

credit terms Terms are the agreed upon rules governing 
the number of days between delivery and payment discounts 
for early payment and penalties. In ABSS, you can set default 
terms for all customers.

creditors A creditor is someone to whom you owe money. 
See also ‘accounts payable’ on page 288.

current assets Assets that can be turned into cash within 
a relatively short time (less than a year are called current 
assets. Some of your current assets are your bank accounts, 
accounts receivable and petty cash. Current assets usually do 
not lose their value over time. Current assets normally have a 
debit balance.

current liabilities Liabilities that become payable within 
the next year are called current liabilities. When recording a 
liability that is to be paid over a long period, many 
accountants split it into two liabilities. The part that is to be 
paid off within the next year is entered as a current liability; 
the remaining is entered as a long-term liability.

current year earnings Current year earnings is an equity 
account. Its balance equals your income minus cost of sales 
and expenses. Current year earnings are zero at the beginning 
of a financial year. Current year earnings are kept as a running 
total as the financial year progresses. When you start a new 
financial year, current year earnings are reset to zero by 
moving its balance into the account called Retained Earnings.

customer Someone to whom you sell goods or services. In 
ABSS you must enter a customer card before you record a sale.

D

debit amount Appears on the left side of the ledger (the 
credit amount occupies the right side); a debit amount 
increases the balance of accounts with a debit balance and 
decreases the balance of accounts with a credit balance. 
Accounts that normally carry a debit balance are asset and 
expense accounts.

debit purchase A debit purchase is a purchase with a 
negative balance due. Usually caused by a return or 
adjustment, a debit purchase is settled by recording a 
supplier’s refund cheque or by applying the amount to 
another open bill.

debtor A debtor is someone who owes you money. See 
also ‘accounts receivable’ on page 288.

department Department is for you to determine which 
team or section your employee’s are placed in the company.
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deposits from customers Advances received for goods 
or services not yet delivered. Customer deposits are kept in a 
liability account. 

deposits to suppliers Advances paid to suppliers for 
goods or services not yet delivered. 

depreciation The expense allocation of the cost of an 
asset over a period of time. Most accountants create a 
contra-asset account to track the depreciation of an asset. 
See Contra Account. A typical depreciation transaction 
credits the contra asset account and debits a depreciation 
expense account. Depreciation is most often recorded as a 
general journal entry.

detail accounts ABSS accounts to which transactions 
can be assigned.

discount early payment The amount taken off the 
balance due in return for payment within an agreed number 
of days.

discount volume purchase The amount taken off an 
item’s cost because of a special supplier or customer 
arrangement.

discount days Discount days are the number of days from 
a sale or purchase within which full payment of the balance 
due entitles the payee to a discount.

double-entry accounting A method of bookkeeping in 
which every entry is balanced by another entry. Correct 
double-entry accounting always provides a balanced set of 
books; that is, the total value of your asset accounts minus 
the total of your liability accounts will equal the total of your 
equity accounts.

E

earnings Income minus cost of sales and expenses. See 
Current Year Earnings.

entitlements Hours that accumulate on paycheques; used 
to pay special wages, such as holiday or sick pay.

equity This is a company’s net worth. The equity of a 
company equals its assets minus its liabilities. Equity is an 
account type in ABSS. Equity accounts usually carry a credit 
balance. Some common equity accounts are current year 
earnings, retained earnings and shareholder’s equity.

expense A cost associated with running a business. 
Expense is an account type in ABSS. Expense accounts usually 
carry a debit balance.

F

finance charge The amount added to an outstanding 
balance as a penalty for late payment.

financial statements The balance sheet and income 
(profit & loss) statement. The balance sheet is your 
company’s financial picture at a particular time. The income 
statement shows your company’s financial performance over 
a period of time.

financial year The 12-month period you use to define 
your accounting year. ABSS does not require that it match the 
calendar year. ABSS also provides an optional 13th period for 
making year-end adjustments that you do not want to affect 
a particular month.

fiscal year See ‘financial year’ above.
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fixed assets Fixed assets are assets that have a relatively 
long life. Your buildings, cars and computers are fixed assets. 
Fixed assets are usually depreciated; that is, they lose some of 
their value as you use them.

G

general journal A journal used to record miscellaneous 
transactions not entered in other journals. For example, 
year-end adjustments and depreciation expense.

general ledger This is where all your account 
information—sales, purchases, inventory, cash in, cash 
out—come together. You draw your financial statements 
(balance sheet and income statement) from the general 
ledger.

gross profit Gross profit is your income minus cost of 
sales.

H

header account A header account in ABSS is used to 
group similar detail accounts. You cannot post a transaction 
to a header account.

historical balance The balance of an account prior to 
converting your records to ABSS. You are not required to 
enter historical balances in ABSS. Enter them only if you wish 
to compare a current month’s activity to the activity for the 
same month last year. 

I

identifiers A one-letter code used to sort and select 
cards in the card file. You can assign up to 26 identifiers to a 
card.

income Revenue from the sale of goods or services. 
Income is an account type in ABSS. Income accounts usually 
carry a credit balance.

income statement Also called a profit & loss statement, 
the income statement shows your company’s performance 
over a period of time. 

An income statement begins with income. It then subtracts 
cost of sales to produce gross profit. Expenses are subtracted 
from gross profit to produce operating profit. “Other 
income” accounts are added to operating profit and “other 
expense” accounts are subtracted from operating profit to 
produce net profit.

inventory Physical items kept for possible sale to a 
customer. Most accountants record an inventory’s value in a 
current asset account.

invoice The written record of a sale. 

item A unit in your items list. An item can be physical 
inventory, like a widget or a pair of shoes, or it can be 
non-physical, like an hour of your time.

J

job A job is work for which you wish to track income and 
expenses. In ABSS, a job can be a profit centre, a product line, 
a project or any other subset of your business that requires a 
separate income statement.

journal A journal is a tool for organising your accounting 
entries. ABSS groups all entries into one of six journals: 
general, disbursements, receipts, sales, purchases or 
inventory.
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L

liability Liabilities are things you owe. Your working capital 
loan is a liability. Your accounts payable, what you owe 
someone for a purchase, is also a liability. Liabilities that are 
due within the next year are called current liabilities. When a 
liability is not due for more than a year, it is called a long-term 
liability. Liabilities normally have a credit balance.

linked account Linked accounts are what ABSS uses to 
post your inventory, payroll, sales and purchase transactions 
to the proper account. For example, when you link your 
receivables account, you are telling ABSS which account to 
post the balance due from a sale.

long-term liability Something you owe that does not 
have to be paid for at least a year.

M

miscellaneous purchases Miscellaneous purchases are 
used in ABSS to record non-item purchases that do not 
require a printed purchase order.

miscellaneous sales Used in ABSS to record non-items 
sales that do not require a printed invoice.

N

net income Net income (net profit or loss) is the total of 
all income accounts minus the sum of your expense and cost 
of sales accounts.

net profit The total of all income accounts minus the sum 
of your expense and cost of sales accounts. Also called “net 
income”.

O

open bill A purchase with an outstanding balance due.

open sale A sale with an outstanding balance due.

opening balance The balance of an account as at the 
start of the first day of your conversion month. 

operating profit This is your profit before considering 
Other Income and Other Expense.

other expenses An ABSS account type used to record 
expenses that are not directly related to your company’s 
operations. Use other expense accounts to record expenses 
that are outside the normal operation of your business such as 
loan interest, fines, etc. Other expense accounts usually have 
a debit balance.

other income An ABSS account type used to record 
income that is not directly related to your company’s 
operations. Use other income accounts to record income that 
is outside the normal operation of your business such as 
interest income. Other income accounts usually have a credit 
balance.

out of balance When the total credit amount does not 
equal the total debit amount in a transaction, it is out of 
balance. ABSS does not allow you to record an out of balance 
transaction.

P

paid-up capital The amount of money paid by 
shareholders in excess of the par value of the shares.

payables What you owe someone else for items or services 
delivered. See ‘accounts payable’ on page 288.
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pay period The duration selected to process your 
employee pays.

payroll year The 12-month period you use to define your 
payroll year. ABSS requires the payroll year to start on January 
and ends in December. The payroll year that you create will 
not affect your financial year.

position Position is your employee’s job in the company.

profit & loss statement See ‘income statement’ on 
page 292.

profit centre A subset of your business for which you 
want to track income and expenses. ABSS calls profit centres 
“jobs”.

purging The act of erasing old data. ABSS allows you to 
purge journal entries, closed sales, closed purchases and 
contact logs.

R

recap transaction An ABSS function that lets you look 
at a journal entry before it is recorded. Recap transaction is 
particularly useful for those transactions, such as invoices and 
bills, for which the journal entry is not immediately obvious.

receivables What someone else owes you for items or 
services delivered. See ‘accounts receivable’ on page 288.

reconciling The process of checking that your records 
agree with your bank’s records.

recurring transaction An accounting entry that is made 
periodically, such as weekly payroll, monthly rent, etc. 

retained earnings Money from previous years’ earnings 
that has been left in the company. At the end of a financial 
year any money earned (or lost) during the financial year is 

transferred to retained earnings. Retained earnings are 
recorded in an equity account.

revenue Income from the sale of goods or services. 
Revenue is recorded in an income account in ABSS. Income 
accounts usually carry a credit balance.

reversing The process of cancelling a transaction by 
entering a new transaction with the same amounts but with 
opposite signs.

S

shareholder’s equity The owners’ stake in the company. 
It is the amount the owners invested in the company plus the 
current year earnings and retained earnings.

settle a credit invoice When a customer returns 
something, and you record an invoice that has a negative 
balance due, it is called a credit invoice. Paying off this 
negative amount is called settling a credit invoice. 

settle a debit purchase When you return something to 
a supplier, and you record a purchase with a negative balance 
due, it is called a debit purchase. Paying off this negative 
amount is called settling a debit purchase.

standard pay The current values of an employee’s payroll 
details (wages, entitlements, deductions, employer expense 
and taxes) that are automatically used when processing the 
employee’s pay.

sub-tax The tax codes that make up a Consolidated tax 
type.

supplier Someone from whom you buy goods or services. 
In ABSS you must enter a supplier card before you can record a 
purchase. See also ‘accounts payable’ on page 288.
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T

terms Terms are the agreed upon rules governing the 
number of days between delivery and payment, discounts for 
early payment and penalties for late payment.

transaction An entry in ABSS that affects the balance of 
accounts.

trial Balance This is a report showing all the activity for 
an account or accounts within a selected date range. It shows 
the balance of the account at the beginning of the date 
range, the activity within the date range, and the balance at 
the end of the date range. A trial balance is useful for 
checking your entries prior to doing your period-end 
processing.
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account levels
to track financial 

information 218
Account Opening Balances 

window 24

account types 20

accountant
receiving accounts list 

from 240
AccountantLink

receiving accounts list from 
Accountants Office 240

accountants
receiving adjustments from 239
sending data to 238

accounting periods
locking 231 237
number of 16

accounts
adding 21
adjusting to reflect work in 

progress 153
assigning tax codes to 164
budgets for 222
changing 166
classifications 20

for statement of cash 
flows 22

combining 169
creating 21
deleting 167
exporting

to accountants 239

exporting to other 
applications 259

finding 165
grouping, detail 23
header 21
importing 260
indenting 23
list of 17
multiple currencies, 

tracking 155
new 21
numbers 20
opening balances 23

bank accounts 23
reconciling 47 50 234

for the first time 32
transferring

funds to foreign account 160
money between 45

types of 20
undo reconciliation 234

Accounts List window 21

accounts payable
paying 88
reconciling accounts at

month-end 232
year-end 232

accounts receivable
reconciling accounts at

month-end 232
year-end 232

accrual accounts
setting up for items received 82

accruals, employee
linked wages category 101

actions menu 12

activation of company files
circumstances requiring 18
confirming activation

automatically 252
by telephone 251

over the Internet 251

activities
billing rates, setting 144
changing 146
creating time billing 145
definition of 145
deleting 146
exporting 259
importing 260
inactivating 146
setting billing rates for 144

Activities List window 145

Activity Information 
window 145

activity slips
adjusting book value of work in 

progress 153
creating

multiple 149
single 147

creating a slip to pay an 
employee 148

deleting 150
exporting 259
finding 150
importing 260
including in employee’s pay 112
multiple 149
reviewing 150
single 147
using timer to create 148

adjustments
entering in 13th period 16 239
importing from 

accountants 239 240
making at year-end 239

administrator account
passwords 25
See also user accounts

Ageing Date window 87

analyse payables 87

Analyse Payables window 87

analyse receivables 64

Analyse Receivables 
window 64

Analyse Sales window 64

Analysis menu (command 
centres) 12

arrows. See search icons

assets accounts 20

assets, recording 
depreciation 236

audit trail 225

auditing company file 
information 231

Auto-Build Information 
window 131

Auto-Build Items window 132

auto-building items 131

average cost 127 137

B

backing up
company file 248

Backorder List window 60

backorders
items purchased on 79
items sold on 56 79

backup files, restoring 250

bad debts
writing off 75

bank accounts
adding 21
opening balances 23
reconciling

Index
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at month-end 47 50
at year-end 47
for the first time 32
out-of-balance amounts, 

correcting 48

bank deposits, preparing 40

bank reconciliation
undoing a 49

Bank Register window
finding a transaction using 172
Bank Feeds button 50
recording receipts in 38
Split button 45

bank service charges, 
recording 48

bank statements
adding transactions from 51
importing 50

formats supported 50
reconciling 50

billing for time. See time billing

billing rates, setting for
activities 144
customers 144
employees 145
suppliers 145

bills
customising 194
recording 78
 See also purchases

blank lines, inserting 
between line items 58 81

Budget Shortcuts 
window 223

budgets 222
allocating for accounts 22
allocating for jobs 222
choosing accounts for 222
half-yearly 224
monthly 224
quarterly 224
reports for 222
yearly 224

build items 130

business calendar 12

business contacts, 
maintaining list of 204

C

calculator
currency 158
pop-up 13

calendar 12

Card ID field 215

Card Information window 76

cards
active 166
adding 201

employee 104
supplier 76

assigning tax codes to 164
changing 166
creating for

customers 53
employees 104
suppliers 30

custom lists and fields 208
deleting 167
employee payroll 

information 104
exporting 259
finding 165

using advanced search 
filters 165

using search fields 165
identification code 215
importing 260
inactive 166
organising in groups 207
synchronising cards and Outlook 

contacts 209
view a contact on a map 206

categories
changing 166
creating 218 219
deleting 167
enabling assignment to 219
finding 165
setting up 218
tracking financial information, 

using 218
See also payroll categories

charging for time. See time 
billing

cheques
customising for printing 194
entering 41–43

printing 191
recording in the

Bank Register window 44
Spend Money window 42

recurring 43 46
voiding 43
See also payroll

columns, moving and resizing 
in reports 182

combining accounts 169

command centres 10–12

Company Data Auditor 225 
231–234

Company File Confirmation 
window 251

company files
activating

circumstances requiring 18
auditing 231
backing up 248
checking for errors 253
confirming

automatically 252
by telephone 251
over the Internet 251

creating 15
optimising 253
purging unwanted data 

from 254
restoring from backups 248
serial number, entering 19
sharing on a network

factors affecting how they 
work 255

unable to open 255
verifying 231 253

company files folder. See 
network

components, using to 
auto-build items 130
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confirmation codes
entered during

confirmation by 
telephone 251

generated by
confirmation server over the 

Internet 251

confirmation of company 
files

automatic confirmation 252
by telephone 251
over the Internet 251 252

contact log 204
automatic entries 205

contact management 201
See also cards

contra accounts 75

contra payments 75

conversion month 16

Copy From button 125

cost of a stock item
average 127
last 127

cost of an inventory item
average 137
last 137

cost of sales accounts 21

cost of sales, account for 
tracking 125

counting inventory 133

CPF
employee details, entering 106
paying 118
payroll categories

creating 96
definition 96

CPF Information window 99

CPF tables

checking for latest 245
loading 245

credit card statements
adding transactions from 51
matching transactions with 50

credit cards
paying 51
recording purchases 51

credit control
credit holds 70
credit limits 69
credit terms 56
finance charges

applying 71
calculating 71
deleting 72

Credit Limit & Hold 
window 69

Credit Limit Override 
Password window 70

credit limits
password, changing 70
prevent recording sales if 

customer exceeds 70
setting 69
warn if customer exceeds 69

credit notes 73

credit terms
changing for

all sales 56
this sale 56

changing when recording a 
purchase 79

creditors. See accounts payable

Currencies List window 155

currency
accounts 155
calculator 158
new 155
See also multiple currencies

Currency Information 
window 155

current financial year 16

custom fields
recording card details using 215
recording item details using 141

custom forms
adding graphics and logos 198
custom cheques 195
data fields 197
drawing lines on 199
drawing rectangles on 199
elements of 200
page properties, setting 195
previewing 196
printing 196
removing elements 198
resizing elements 200
saving 196
setting up page properties 195
size of 195
tool palette 197

custom lists
creating 208
filtering inventory reports 

with 140
grouping items with 140

custom price levels 138
assigning to a customer 139

customer credits
deleting 174
issuing 72
recording 72
settling credit notes

applying to open invoices 73

customer payments 65
discount for early payment 67
group with undeposited 

funds 66
See also receiving payments
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customer statements
customising 194
emailing 236
printing 191 235
sending at month-end 235

customers
billing rates for 144
cards, creating 53
credit holds 70
credit limits 69
credit terms 56
credits

applying to open invoices 73
deleting 174
issuing 72
recording 72

discounts
for early payment 67
for volume sales 57

invoices
entering 55
payments for 44 65

payments from 44
price levels for 139
quotes 55
who are also suppliers 75

D

data
exporting

to other applications 259
importing

from accountant 240
from RetailBasics 261
from RetailManager 261
from other applications 260

limiting access to. See user 
accounts

purging 254

data fields
adding to forms 197
changing font 

characteristics 198
changing size of 200
font characteristics 198
resizing 200

data files. See company files

dates, entry with calendar 12

Deduction Information 
window 101

deductions
definition 96
paying 118
paying payroll 118
payroll categories

changing 101

deleting, transactions 174

delivery orders, 
customising 194

deposits
preparing 40
recording in the Bank Register 

window 44
saving as recurring 40

depreciation
accounts for 236
recording 236

detail
jobs 220

discounts
early payment discounts

giving 67
receiving 89

reversing customer payments 
with 175

volume discounts
giving 57
receiving 80

E

early payment discounts 67 
89

Edit Accounts window 21

Edit Recurring Schedule 
window 176

emailing
customer statements 236
invoices 58 81
reports 183
sales forms 58 81

employees
activity slips, including in 

pay 112
bank information 108
bank instructions 116
billing rates

setting 145
cash payments 116
cheque 116
creating cards for 104
holiday pay, distributing 114
hours worked, entering 113
pay details, editing 113
pay history

entering 31 108
viewing 121

paying 111–117
payment method 108
payments, changing, deleting or 

reversing 115
payroll deductions

paying 119
reviewing 123

payroll information
analysing 123
entering 104
viewing 121

printing paycheques 116

setting billing rates for 145
sick pay, distributing 114
standard pay, entering 107
terminating 120
time billing information

including in employee 
pays 112

timesheets 108
viewing sales history for 65

Employer Expense 
Information window 102

employer expenses
definition 96
paying 118
payroll categories

changing 102

employment category, 
entering 105

employment status, 
entering 105

end-of-month. See month-end

end-of-year. See year-end

entitlements
balances

changing 122
viewing 122

definition 96
payroll categories

changing 100

Entitlements Information 
window 100

EPF
employee details, entering 106
paying 118
payroll categories

creating 96
definition 96

EPF Information window 99

equity accounts 20
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errors, checking for in 
company file 253

Excel, viewing ABSS reports 
in 184

exchange accounts for 
tracking foreign 
transactions 155

exchange rates 158

expense accounts 21

Export Data window 259

Export Summary Window 211

exporting data
to Outlook 210

exporting data to other 
applications 259

F

faxing
reports 184
sales forms 58 81

file locking
multi-user mode 255
single-user mode 256
to protect your data 256

finance charges
customer

calculating 71
charging 71
deleting 72
setting up 71

supplier
deleting 93
paying 93
setting up 93
using to track late 

payment 93
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financial year
budgets for 222
closing 238
end-of-year tasks 238
starting a new year 240
year-end tasks 238

Find Transactions menu 
(command centres) 12 136

Find Transactions 
window 171

finding
records 165
transactions 170–173

finished items 130

fonts
changing on forms 198
changing on reports 188
default 197

foreign currency
adding a new currency 155
changing 166
deleting 167
See also multiple currencies

foreign purchases. See multiple 
currencies

foreign sales. See multiple 
currencies

forms
adding fields to 197
batch 191
customising 194
emailing 191
faxing 191
finding 190
printing 191

freight
paying suppliers for 80

G

general journal entries
assigning categories to 219
creating recurring transactions 

for 176
exporting 259
importing 260
recording 239

general payroll information
entering 95

Getting Started guide 8

graphics 198–199
changing size of on forms 200

H

half-yearly budgets 224

header
accounts 21
jobs 220

headers, using to group line 
items in transactions 58 
81

help, online resource 9

historical
purchases 88

host computer
setting up 264
system requirements 264
See also workstations

HTML format, saving reports 
in 183

I

Identifiers, using to group 
cards 207

Import and Export Options 
window 210 213

import file formats, for 
importing statements 50

import log file 261–262

Import Summary window 214

importing data
from accountants 239
from Outlook 213

See also synchronising cards 
and Outlook contacts

from RetailBasics 261
from RetailManager 261
from other applications 260

importing statements
file formats supported 50
foreign currency 50
Bank Feeds button 50
matching transactions 50
online banking 50

inactivating records not used 
frequently 166

international transactions. 
See multiple currencies

Internet banking
importing statements 50

inventory
adjusting 127
auto-building items 131
average cost of an item 137
building 130
changing prices of 137
counting 133
custom fields 141

custom lists and reports 140
custom price levels 138
locations 128
minimum levels 126
moving between locations 129
opening cost values, 

entering 36
opening quantity values, 

entering 36
prices, setting 137
quantity breaks 138 139
receiving items without a 

supplier invoice 82
reconciling at year-end 238
recording 133
transferring 129
See also items

inventory count sheets, 
printing 36 133

inventory movements
recording 129

inventory transfers. See build 
items

invoices
bad debts 75
customising 194
emailing 58 81 191
entering 55
faxing 58 81
inserting blank lines in 58
line items, entering 56
overdue 64
printing

in a batch 192
recurring 58 81
subtotals, adding 58
time billing invoices, 

creating 151
using headers to group line 

items 58
See also customer statements

Item Information 
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window 125
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items
adding 125
adjusting quantities and 

values 127
asset account for tracking value 

of 125
assigning tax codes to 164
auto-building 131
average cost 127 137
base selling price 127 137
building 130
changing prices of 137
cost of sales account for 

tracking 125
counting 133
creating 125
custom lists to group 140
default location 126
default supplier number 126
deleting 167
expense account for 

tracking 125
exporting 259
finding 165
finished item, defined 130
I Buy this Item option 124
I Inventory this Item option 124
I Sell this Item option 124
importing 260
last cost 127 137
locations 128
moving between locations 129
negative on-hand quantities 59
number per selling unit 126
opening quantities and values, 

entering 36
price levels

changing 137
setting custom 138

purchase history, viewing 88 
136

received
setting up accrual account 

for 82

receiving without a supplier 
invoice 82

recording stocktakes 133
sales history, viewing 65 136
setting up 124
standard cost 125
time billing invoices, including 

on 143
transferring 129
using custom fields for recording 

details of 141
See also inventory

Items List Summary 
report 136

Items Register window, 
finding transactions 
using 172

J

jobs
assigning to

payroll categories 114
purchases 80
Receive Money 

transactions 39
sales 57
Spend Money transactions 42

budget allocation 222
budget amounts, entering 222
changing 166
creating 220
deleting 167
detail jobs 220
exporting 259
finding 165
header jobs 220
importing 260
job-tracking tasks 220
opening balances, entering 221

setting up 218
sub-jobs 220
using to track income and 

expenses 218–220
journal entries

creating recurring transactions 
for 176

exporting 238 259
finding 170
importing 260

from accountants 239 240
listing for

purchases 86
recapping transactions for 58 

80 175
recording 239

L

last cost of an item 127 137

layout
choosing for a

purchase 79
sale 56

See also custom forms
learning tools 8

leave payments 114

letters
mail merge 202
personalised 202

creating 191

liability accounts 20

licenses, obtaining extra 
workstation seats 247

line items
entering for purchases 79
entering for sales 56
inserting blank lines 

between 58 81
showing subtotal of 58 81
using headers to group 58 81

lines, drawing on forms 199

lists
adding records to 162
deleting records from 167
inactivating records in 166

locations, inventory
adding 128
changing 166
creating 128
default 126
deleting 167
inactivating 166
moving items between 129

lock file problems 255 256

locking periods 237

logos
adding to forms 198
changing size on forms 200
See also pictures

M

Mail Merge button 64

mailing labels
customising 194
printing 191

mailing labels, printing 203

master password. See 
administrator account
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Match Transaction 
window 50

Microsoft Outlook contacts.
See synchronising cards and 

Outlook contacts
minimum inventory 

levels 126

money
 See receiving money
 See spending money

month-end 230
accuracy of records, 

checking 225
entering budgets 222
locking periods 237
reconcile bank accounts 234
reconciling bank accounts 47
recording depreciation 236
reviewing reports 234
running the Company Data 

Auditor 225 231–234
sending customer 

statements 235
monthly budgets 224

mouse shortcuts 13

multiple currencies
’I Deal in Multiple Currencies’ 

preference 155
accounts for tracking foreign

purchases 156
sales 156

adding a new foreign 
currency 155

currency calculator 158
depositing foreign 

currencies 161
exchange accounts 155
exchange rates 158
setting up 155
tracking realised currency 

gains/losses 159
transferring funds to foreign 

account 160
multiple locations 128

multi-user mode
file locking 255

problems 255 256
improving performance 258
obtaining additional 

licenses 247
refreshing displayed data 258
See also network; single-user 

mode
ABSS Accountants Office

importing journal 
adjustments 240

ABSS Help 9

ABSS RetailBasics, importing 
from 261

ABSS RetailManager, 
importing from 261

N

navigation shortcuts 11

network
file locking

multi-user mode 255
single-user mode 256

hardware required 264
how preferences work on 255
improving performance 258
shared public folder

accessing from 
workstations 269

setting up 269
sharing company files

factors affecting how they 
work 255

storing custom reports on 257

system requirements 264
New Time Billing window 152

new year
starting a new financial 

year 240
starting a new payroll year 245

O

OfficeLink
collection letters, creating 64
creating personalised 

letters 202
online banking, importing 

statements 50

online help 9

opening balances
items 36
jobs 221

optimising your company 
file 253

orders
converting one

to a purchase invoice 85
to a sales invoice 62

converting several 
simultaneously

to purchase invoices 86
to sales invoices 62

purchase orders, entering 78
receiving 55
sales orders, entering 55
sending 78

Outlook contacts.
See synchronising cards and 

Outlook contacts
overdue invoices

creating collection letters using 

OfficeLink 64
viewing list of 64
See also credit terms
See also credit terms; bad debts

P

passwords. See administrator 
account; user accounts

Pay Bills window 89

Pay Deductions window 119

Pay Employee window 113

Pay History section 121

pay slips
email 118
emailing 118

after processing a pay run 116
printing 117 118

after processing a pay run 116

pay suppliers
sending remittance advice 90

payables
analysing 87
reconciling accounts at

month-end 232
year-end 232

paycheques, printing 116

paying employees 111–117
See also payroll

payment method, default
employee 108

payments
exporting 259
importing 260
making 42 44 89
receiving 38 44
recurring 176
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payroll
activity slips

including in employee 
pays 112

advice, printing 116
categories 96–103
CPF

checking for latest 245
loading CPF tables 245

deduction payments 118
earnings, printing 116
employee information, 

entering 104
entitlement balances 122
information 121

analysing 123
pay history 121
pay slips

emailing 118
printing 118

paycheques, printing 116
processing pays 111–117
reports 242
setting up 94

using the Payroll Easy Setup 
Assistant 31

SOCSO
checking for latest 245
loading SOCSO tables 245

tax returns 242
taxes

checking for latest 245
loading tax tables 245

timesheets
changing details during pay 

run 112
entering employee hours 109
excluding from a pay run 112

See also CPF or EPF
payroll categories

accrual
linked wages category 101

base daily

adjusting 114
base hourly

adjusting 114
base salary

adjusting 114
calculated value 108
changing 97–102
creating 96
editing 103
reviewing 31

Payroll Category List 
window 96 103

payroll deductions
paying 119
reviewing 123

Payroll Details tab 105

payroll year
end-of-year tasks 241
starting a new year 245
when to close 241

payslips
printing 118

pending purchases. See 
purchase orders

pending sales. See sales orders

periods
closing 237
locking 231 237

personalised letters
creating 202
printing 191

petty cash accounts
allocating expenses to 47
transferring money to 46

pictures
adding to

cards 216
forms 198

changing the size of on 
forms 200

removing 216
replacing 216

Portable Document Format 
(PDF) file

saving sales as 58 81
preferences

Allow the sale of items with 
insufficient on-hand 
quantities 59

Apply Customer Payments 
Automatically to Oldest 
Invoice First 74

how they work on a 
network 255

I Deal in Multiple Currencies 25
I Prefer to Use Automated Online 

Company File 
Confirmation 18

I use ABSS RetailManager 262
I Use Timesheets for ... and My 

Week Starts on ... 109
If Credit Limit is Exceeded on 

Sale 70
Prevent Data Changes During 

Report Generation 257
system-wide preferences 255
time billing 143
Transactions CAN’T be Changed, 

They Must be Reversed 25 
175

Use Audit Trail Tracking 25
Prepare Bank Deposit 

window 40 174

Prepare Budgets 
window 223

price levels
creating custom 138
for customers 139
setting 137

prices
average cost of an inventory 

item 127 137
last cost of an inventory 

item 127 137
quantity breaks 139
standard cost of an item 127

printing
cheques 43 90
customer statements 184 235
forms 191
invoices 58 81

in a batch 192
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paycheques 116
personalised letters 191
purchases

in a batch 192
receipts 68
remittance advice 90
reports 184

year-end 234

problems, troubleshooting 9

Process Payments 
window 115

Process Payroll window 111

purchase
remittance advice 43

purchase activity, 
viewing 171

purchase debits, creating 91

purchase forms
customising 194

purchase orders
customising 194
entering 78

purchases
applying a supplier debit to an 

unpaid purchase 91
assigning a tax code to a 

purchase 80
assigning job to 80
changing credit terms when 

recording 79
changing status of 85
choosing type of 79
credit card 51
credit terms, entering 79
debits, creating 90
deleting 174
emailing purchase forms

in a batch 191
entering 78

additional information 80
exporting 259

from overseas suppliers. See 
multiple currencies

headers, adding 81
history, viewing 88
importing 260
inserting blank lines in 81
layout

customising 194
line items on, entering 79
making payment

using the Bank Register 
window 44

using the Pay Bills window 88
using the Spend Money 

window 41
orders, entering 78
paying 88

several at once 90
printing

in a batch 192
order forms 191

purchase activity, viewing 171
quotes 78
receiving items without a 

bill 82
recording 78

in the Bank Register 
window 44

reports 88
reversing 90
reviewing purchase 

information 86
sending 191
subtotals, adding 81
unpaid purchases, viewing 87 

135
using headers to group line 

items 81
Purchases Register window

finding transactions using 171
Purchases window 78 81

purging information 254

Q

quantity breaks, 
inventory 138 139

quarterly budgets 224

quotes
converting to

orders or invoices 62
orders or purchases 85

customer 55
supplier 78

R

rates, setting billing 
rates 144

realised gains and losses
tracking on

sales and purchases 159
transfers 160

recapping transactions 58 80 
175

receipts, printing 68

receivables
reconciling accounts at

month-end 232
year-end 232

Receive Payments 
window 66

receiving money 38 44
cash payments 38
cheque payments 38
credit card payments 38
customer payments 65
definition of 38
exporting transactions 259

grouping with undeposited 
funds

cash transactions 39 66
credit card 66

importing transactions 260
invoice payments 65
recording receipts 38
See also receiving payments

receiving payments 65
customer payments 65
grouping with undeposited 

funds
cash transactions 39 66
credit card 66

importing transactions 260
invoice payments 65
recording in the Bank Register 

window 44
See also receiving money

reconciled transactions, 
deleting 174

reconciling
accounts 47 50
out-of-balance amounts, 

correcting 48
payables accounts 232
receivables accounts 232

Record Journal Entry window
entering adjustments 239

records
active 166
adding 162

using Easy-Add 163
changing 166
deleting 174
inactivating or reactivating 166
inactive 166
removing 174

rectangles, drawing on 
forms 199

recurring 
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transactions 176–181
automatically recording 177
changing 178
cheques 43 46
creating 176
creating from an existing 

entry 177
deleting 179
deposits 40
editing 178
recording

multiple 180
single 179

rescheduling 179
responding to reminders 

for 180
sales 58 81
scheduling payments 176
setting reminders for 177
setting up 176

Recurring Transactions List 
window 179

refreshing lists in a 
multi-user 
environment 258

refund cheque, receiving 92

refund payments 74

refunds. See customer credits

registration. See activation of 
company files

Reminders window 180

remittance advices
printing

in a batch 192

reports
batches

changing 185
creating 185
deleting 185
printing 184

columns, moving and 
resizing 182

custom reports 189
storing on a network 257

customising 186
emailing 183
faxing 184
filtering information appearing 

on 186
printing 182

when several users active 257
purchases reports 88
reviewing at month-end 234
sales reports 65
saving as

comma-separated value (CSV) 
files 183

HTML files 183
PDF files 183
simple text files 183
tab-delimited value files 183

sending 183
storing custom reports on 

network 257
using custom lists as filters 140
viewing in Microsoft Excel 184

Reports menu (command 
centres) 12

restoring backup files 250

RetailBasics
importing from 261

RetailManager
importing from 261

returns. See customer credits

Review Sales Before Printing 
window 192 193

rounding time, in time 
billing 143

S

sales
analysing sales activity 64
assigning a tax code to a sale 57
batch printing 191
changing status of 62
choosing type of 56
creating a purchase order 58
customer payments 65
deleting 174
emailing 58 81

in a batch 191
entering 55
exporting 259
faxing 58 81
forms, customising 194
history, viewing for item, 

customer or employee 65
importing 260
income account for tracking 

sales 125
invoice 55

customising 194
layout 56

customising 194
order 55
printing 58 81

in a batch 191
quotes 55
recording in the Bank Register 

window 44
recurring 58 81
reports 65
reversing 72
reviewing information about 63
saving as a PDF file 58 81
to overseas customers. See 

multiple currencies
unpaid sales, viewing 64

Sales Register window

finding transactions using 171
viewing and editing sales in 171

Sales window 55

search icons 13

seats, obtaining extra 
licenses 247

See also synchronising cards 
and Outlook contacts

Select & Edit Employee’s Pay 
window 113

select columns 13

Select Pay Period window 112

serial number
entering into company files

while activating by 
telephone 19

while activating over the 
Internet 19

Set Item Prices window 137

Settle Returns & Credits 
window 73

Settle Returns & Debits 
window 92

shared public folder. See 
company files; host computer; 
network

single-user mode
file locking 256
when required 256
See also multi-user mode

SOCSO tables
checking for latest 245
loading 245

spell check feature 14

Spend Money window 42

spending money 41 89
exporting transactions 259
importing transactions 260



I N D E X   3 0 8

sending remittance advice 43
Split button 45

standard cost 125

standard pay 107

starting a new financial 
year 238

Starting a new payroll 
year 241

statements
bank

correcting out-of-balance 
amounts 48

importing 50
customer

customising 194
emailing 236
printing 184

reconciling
out-of-balance amounts, 

correcting 48

stock. See inventory; items

stocktakes
default adjustment accounts 

for 134
recording 133
See also inventory; counting

sub-jobs 220

subpasswords. See user accounts

subtotals
showing in

purchase transactions 81
sales transactions 58

supplier debits
creating 91
deleting 174
recording 90
refund cheques 92
settling 91

suppliers

billing rates, setting 145
cards, creating 30 76
credit terms, changing when 

recording purchase 79
debits

creating 90
deleting 174
recording 90
refund cheques 92
settling 91

discounts
receiving for early 

payment 89
volume 80

paying 41 88
using the Bank Register 

window 44
purchases, entering

quotes, orders and bills 78
receiving items without an 

invoice 82
sending remittance advice 90
setting billing rates for 145
who are also customers 75

Synchronise Cards 
window 210

synchronising cards and 
Outlook contacts

export cards to Outlook 
contacts 210

import Outlook contacts to 
cards 212

including custom fields 209 211
when you use a PDA 210 211

system requirements
host computer 264
network 264

T

tabs, using to find records in 
lists 165

tax
change amount assigned to

receive money transaction 39
sale 57 80
spend money transaction 42

tax codes
assigning to

accounts 164
cards 164
items 164
purchases 80

sales 57
creating 163
importing 260

tax returns
printing 242

tax tables
checking for latest 245
loading 245

Termination Details 
window 120

termination of 
employment 120

text fields
adding to forms 198
changing font characteristics 

of 198
changing size of on forms 200
description of 195

thirteen accounting 
periods 16

time billing
activities

creating 145
defining 145
deleting 167
finding 165

activity slips
creating 147
including in employee 

pays 112
multiple 149
single 147

adjusting accounts to reflect 
work in progress 153

changing 166
including items on invoices 143
invoices

creating in the Prepare Time 
Billing Invoice window 151

creating in the Sales 
window 152
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preferences 143
rounding time 143
setting billing rates for 

activities 144
setting preferences 143
timer 148

entering start time before 
system time 148

resetting 149
using special billing units 143
work in progress 153

timesheets
changing details during pay 

run 112
delete 108
employee hours, entering 108
excluding from a pay run 112
report 112
setting up 109
time billing information, 

entering 108
unpaid hours

clearing 110
deleting 110
reporting 112

view timesheet reports 108
To 118

To Do List
making supplier payments 

from 87
viewing and editing 

purchases 87
To Do List menu (command 

centres) 12 136

tool palette 195 197

Transaction Journal window
finding transactions using 173

transactions
adding from bank or credit card 

statement 51
changing 174
create recurring 176

create recurring from an existing 
entry 177

deleting 174
exporting 259
finding 12 170–173

using Items Register 172
identifying user who 

entered 246
importing 260

from bank or credit card 
statement 51

Pay Bills transactions 260
matching during statement 

importing 50
recapping 58 80 175
recurring 176–181
reversing 175
types that can be imported 260
unchangeable 174 175

Transactions CAN’T be 
Changed, They Must be 
Reversed preference 174 
175

Transfer Money window 45

transferring
inventory 129
money between accounts 45

troubleshooting 9 255 256

U

unchangeable 
transactions 174 175

uncleared transactions, 
matching 50

undeposited funds
deleting transactions 174
grouping with

account transactions 39

cash transactions 66
payments 66

preparing bank deposit of 40
Undo Last Reconciliation 

window 49

Use Recurring button 179

user accounts
creating 247
listing active users 256
managing 246
maximum licensed number 

reached 256
passwords 247
purpose of 246
restricting access to windows 

and functions 247
user IDs. See user accounts

V

verify company file 231 253 
256

View Contact Log 
window 204

voiding a cheque 43

volume discounts
giving 57
receiving 80

W

wages
definition 96
payroll categories

changing 97 98 99
See also payroll, employees

Wages Information 
window 97 98 99

work in progress
adjusting accounts to 

reflect 153
tracking 153

workstations
accessing shared company file 

folder 269
obtaining extra licenses 247
See also host computer; network

write-offs 75
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Y

year
financial 238
payroll 241
starting a new financial 

year 240
year-end

entering budgets 222
financial

adjustments, entering 239
optimising company file 241
providing information to your 

accountant 238
reconciling accounts 232
reconciling inventory 238
starting a new year 240

payroll 241–245
year-end tasks

adjustments in 13th period 16
payroll 241–245

back up company file 244
print payroll reports 242
process the last paycheques 

for the year 242
start a new payroll year 245

yearly budgets 224

Z

zoom arrows 13


